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1
1 Introduction

INTRODUCTION
ABOUT THIS GUIDE

This Operations Guide describes the features of Income Tax Planner and it 
provides instructions on how to use program.
A separate guide – the Tax Reference Guide – provides descriptions of the 
program’s worksheets and details on what to enter for each item on the 
worksheets. It also explains how the program computes the amounts in calcu-
lated rows. 

You can access the latest version of these guides on the program’s Help menu.

CUSTOMER SUPPORT
If you have questions about using the program, please call our toll-free number 
800.424.2938. Bloomberg Tax Technology Customer Support is available 
during regular business hours, 9:00 am to 7:00 pm (ET) to answer any 
questions you may have..
We invite you to send us comments on the program and guides by submitting 
a Support Form via our Website at https://bnasoftware-support.force.com. 
You can also submit your comments by mail.

Bloomberg Tax Technology
1801 S. Bell Street
Arlington, VA 22202
You will receive prompt notification of program updates or enhancements, and 
discounts on update prices.
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CONVENTIONS USED IN THIS GUIDE
KEYBOARD

You can use the mouse or keyboard to perform most tasks in the program. If a 
task requires that you press a single key, the key is shown:

Press W.

If a task requires that you press several keys consecutively, the keys are 
separated by a comma:

Press N, Enter.
If a task requires that you press several keys concurrently, the keys are 
separated by a plus sign:

Press Alt+F.

MOUSE POINTERS
Use the mouse pointer to set the cursor’s position when you click the left 
mouse button. The pointer is represented in various ways in the manual, 
depending on the task.

Single-arrow pointer ( ) — Appears on dialogs, menus, title bars, icons, 
buttons, etc., and points to selections you can make. A single-arrow 
pointer appears on dialogs, menus, title bars, buttons, etc., and points to 
selections you can make.

Double-arrow pointer ( ) — The single-arrow-shaped pointer changes 
to a double-arrow pointer when the pointer is on a window’s border. A 
double-arrow indicates that you can click and drag the window’s border.
Plus-shaped pointer ( ) — Appears on cells in a worksheet.

I-beam pointer ( ) — Appears on boxes in which you can enter text, such 
as the Assumptions dialog’s Client Name text box.
Circle-shaped pointer ( ) — Appears over linked information that has 
been pasted into the client letter.

GETTING TO KNOW THE PROGRAM
INTRODUCTION TO INCOME TAX PLANNER

Income Tax Planner with Fifty States is one in a series of tax software 
products from Bloomberg Tax Technology. It is a sophisticated planning tool 
that provides a fast and accurate way of evaluating alternative tax plans for 
clients.
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Using a standard Windows interface, the program computes all the alternative 
income taxes for individuals and fiduciaries for 1987 and subsequent years. 
With Income Tax Planner with Fifty States, the program also computes 
resident state income taxes for all 50 states and the District of Columbia, fully 
integrating the results with the federal calculations, as well as the nonresident 
state income taxes for:

For details of the state calculations, see Chapter 2 of the Tax Reference 
Guide, available on the program’s Help menu.
The program’s powerful spreadsheet format allows simultaneous calculation 
and display for multiple years and cases, multiple years within cases, multiple 
cases within years, or projections for a single year or case. Additional modes 
of analysis include a “difference” analysis (showing the difference between two 
cases in the same year), an “adjustment” analysis (useful for audits and other 
adjustment situations), and a “taxpayer/spouse” analysis (showing the effects 
of a married couple filing separately as well as jointly). Each analysis can have 
up to twenty columns of data at a time.

You can easily change data in any cell – the program instantly recalculates and 
displays the new results on-screen. 

SYSTEM OF INTERACTIVE WORKSHEETS
The multi-level worksheets provide maximum flexibility for data entry. Informa-
tion can be entered with as much or as little detail as desired. In most cases, 
data required at different points in the program need be entered only once. This 
“tree-structured” worksheet system consists of:  

a Main Worksheet with 28 rows of tax input data and calculated results. 
This worksheet provides an instant overview of all major categories of 
input and output data. The data can be entered directly into the Main 
Worksheet or posted there automatically from other worksheets.

Alabama Arizona Arkansas California

Colorado Connecticut Delaware Georgia

Hawaii Idaho Iowa Illinois

Indiana Kansas Kentucky Louisiana

Maine Maryland Massachusetts Michigan

Minnesota Mississippi Missouri Montana

Nebraska New Jersey New Mexico New York

North Carolina North Dakota (2) Ohio Oklahoma (2)

Oregon Pennsylvania Rhode Island South Carolina

Utah Vermont Virginia West Virginia

Wisconsin
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subworksheets for entering the details of items on the Main Worksheet. 
Results are automatically calculated and posted to the Main Worksheet 
and to other subworksheets as appropriate. 
supporting worksheets for entering the details of items on a 
subworksheet. 

custom worksheets that you design yourself for entering additional levels 
of detail. The program can handle up to 100 custom worksheets.
Individual Activities worksheets for convenient entry of items on K–1s 
and 1099s on an activity-by-activity basis.

A batch input worksheet provides an alternative method of data entry 
to the other worksheets. Client data items are entered as a list of 
numbered row items and posted automatically to the appropriate 
worksheets for calculation and display.

When entering data into either the batch input worksheet or the other 
worksheets, you can have calculations turned on or off. Turning the 
calculations off will speed up the data entry process. 

OPENING THE PROGRAM
1. To load the program, click Start > Programs > Income Tax Planner > 

Income Tax Planner. Alternatively, you can click Start > Run, type ITWIN, 
then click OK.

Note. You can also launch the program and open an existing client file by 
double-clicking the client file name in Windows Explorer. 

2. When loading is complete, the Main Worksheet appears within the 
program workspace.
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PARTS OF THE SCREEN
This section identifies and describes elements of the program window.

SYSTEM ICON
The system icon is located in the upper-left corner of each window’s title bar. If 
you click the system icon of an application window (e.g., Income Tax Planner), 
a menu drops down and you can select basic window operations such as Size, 
Move, Maximize, etc. If you click a worksheet window’s system icon, you can 
select the same windows operations as you can for an application window plus 
select Next to move through the open worksheet windows.

TITLE BAR
The title bar, located across the top of a window and to the right of the system 
icon, displays the name of the application or window. If the window does not 
take up the full screen, you can usually click and drag on the Title Bar to move 
the window around the screen.

MENU BAR
The Menu Bar along the top of the window provides access to all program 
functions and the Help system. One of the items on the menu bar, Assump-
tions, is a dialog where you specify changes to the default program setup of 
three years/two cases. The Assumptions dialog is also used for specifying the 

Title Bars

Menu Bar

Cursor/Active Cell

Program 
Workspace

Calculated 
Row

Worksheet

System icon Minimize, Maximize & Close icons

Toolbar

Worksheet tabs

Worksheet 
List

Worksheet Row NumbersScroll bars
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first year of analysis; selecting an Annualization, Minor Child, Difference, or 
other type of analysis; and setting up case titles (and, with Income Tax 
Planner with Fifty States, choosing resident and nonresident state 
specifications).

 

SELECTING A MENU BAR ITEM
There are three ways to select an item from the menu bar: (1) using the mouse; 
(2) using the keyboard shortcut keys, or; (3) using the left and right arrow keys.

To select an item using the mouse, click on the item on the menu bar.
To select an item using the keyboard, press Alt+ the underscored letter in the 
menu’s title. For example, pressing Alt+F pulls down the File menu. If the 
command you want is not on the menu you originally pulled down, you can use 
the left and right arrow keys to move across the menu bar and highlight the 
desired item. Press Enter to open the item’s menu or dialog.

SELECTING COMMANDS
Once you select a menu on the menu bar, you will see a list of commands. 
There are three ways to select a command: (1) click on the command; or (2) 
use the arrow keys to move the cursor to the command, then press Enter; or 
(3) press the underscored letter in the command title. Any of these methods will 
execute the command. If further commands for that command are available, an 
ellipsis (...) appears next to the command title.

QUICK ACCESS TO COMMON EDIT COMMANDS
Right-clicking a cell in a worksheet opens a shortcut menu, providing you with 
quick access to commonly used Edit menu commands.

TOOLBAR
Located beneath the menu bar, the Toolbar provides access to several 
program functions.

 

If you have a client letter open, you will have additional sets of toolbars present. 
Those are explained in detail in Chapter 8.

MenuBar.png

Toolbar.png
Available only with Income Tax 
Planner with Fifty States
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Purpose or Function
Equivalent Menu Com-
mand

Moves the input focus from the current worksheet to 
the worksheet that had previously been opened or 
had the input focus (not due to use of the back or 
forward icon).

The back icon is available only 
on the Toolbar.

Moves the input focus from the current worksheet to 
the worksheet that had been subsequently been 
opened or had the input focus (not due to use of the 
back or forward icon).

This forward icon is available 
only on the Toolbar.

Opens a new client file after closing any client file 
currently open. Reloads all default settings.

File menu, 
New Client File command

Opens the Open Client File dialog, allowing you to 
select a file to open.

File menu, 
Open Client File command

Saves the client file (worksheets and client letter). If 
you are saving the file for the first time, opens the 
Save Client File As dialog, where you can choose a 
file name. If you are saving a file that has been saved 
before, saves with the same name and does not open 
the dialog.

File menu, 
Save Client File command

Opens the Print dialog. Allows you to select which 
worksheets to print, as well as output options.

File menu, 
Print command

Opens the Print Preview window. Displays client file 
as it will print. Allows you to preview the file on-screen 
before printing.

File menu, 
Print Preview command

Places a copy of the selected cells on the Clipboard. Edit menu, 
Copy command

Pastes the cells from the Clipboard to a cell or range 
of cells.

Edit menu, 
Paste command

Cancels the last entry in a cell. Edit menu, 
Undo Last Entry command

Opens the Note dialog. Lets you create, edit, and 
delete a note that acts as a footnote for any input cell. 

Edit menu, 
Note command

Displays a calculator. You can calculate a value and 
post it into the cell.

Edit menu, 
Math Calculator command

Increases the value of the previous cell by a percent-
age and enters the new value in the current cell.

Edit menu, 
Increase by Constant or % 
command

Increases the value of the previous cell by a dollar 
amount and enters the new value in the current cell.

Edit menu, 
Increase by Constant or % 
command

Hides or displays columns on screen or for printing 
purposes

Edit menu, Hide Columns com-
mand

Protects the column you are in by locking the data in 
the column.

Edit menu, 
Protect Columns command

Unlocks the column you are in. Edit menu, 
Unprotect Columns command
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WORKSHEET LIST
The Worksheet List contains a list of worksheets available to the analysis, 
sorted in an alphabetic list or a tree structure. Each worksheet’s icon reveals 
the status of the worksheet within the current analysis: open and active, active, 
or inactive. You can double-click a worksheet item in the list to open it, or right-
click an item to open, close, kill, or display help for the worksheet. Displayed on 
the left as an initial default, at your option the Worksheet List can be displayed 
on the right or closed altogether.

WORKSHEET ROW NUMBERS
Row numbers correspond to each row title on each built-in worksheet. This 
feature, accessed on the Options menu, helps you when reading the help file 
descriptions of certain worksheet rows that cite row numbers in the description. 
Worksheet row numbers are displayed by default.

Increases the size of the screen font. Edit menu, 
Screen Fontsize Increase com-
mand

Decreases the size of the screen font. Edit menu, 
Screen Fontsize Decrease 
command

Opens/closes Worksheet List pane, which contains 
all active, open, and inactive worksheets.

Options menu, 
View Worksheet Left/Right 
commands

Opens the Summary Report, which shows the details 
behind the analysis’ worksheet calculations.

Worksheets menu,
Summary Report command

Closes all open worksheets, except the Main Work-
sheet (Main Worksheet cannot be closed).

Worksheets menu, 
Close All Subworksheets com-
mand

Displays all open federal worksheets that have been 
minimized.

Worksheets menu, 
View Worksheets, Federal 
worksheets command

Displays all open state worksheets for your resident 
state that have been minimized. If none are open, 
displays the resident State Tax – Main Worksheet.

Worksheets menu, 
View Worksheets, Resident 
State Worksheets command

Displays all open New York state nonresident work-
sheets that have been minimized. If none are open, 
displays the New York Nonresident Tax worksheet (if 
New York has been selected as a nonresident state).

Worksheets menu, 
View Worksheets, NY Nonresi-
dent State Worksheets com-
mand

Displays all open nonresident state tax worksheets 
(other than New York). If none are open, displays the 
Nonresident State Tax – Main Worksheet, provided 
a nonresident state has been selected.

Worksheets menu, 
View Worksheets, Other Non-
resident State Worksheets 
command

Purpose or Function
Equivalent Menu Com-
mand
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APPLICATION WORKSPACE
The application workspace is the area within the Income Tax Planner’s 
window that holds the open worksheets that you are working with. The 
workspace is below the menu bar and toolbar.

WORKSHEET TABS
Located above (or at your election, below) the application workspace, a 
Worksheet tab is displayed for each open worksheet. Click on a tab to quickly 
access an open worksheet. Right-click on a tab to access a shortcut menu of 
commands (Open, Close, etc.).

MINIMIZE & MAXIMIZE ICONS
The Minimize and Maximize icons are located in the upper-right corner of each 
window’s title bar. The minimize icon is the icon with the thick underline. When 
you click the minimize icon on a program window, the program will be 
minimized and added as an icon to the taskbar. If you click the minimize icon 
on a worksheet window, the worksheet will be reduced to an icon and placed 
above the taskbar. The maximize icon is the icon with the window picture on it.

CLOSE ICON
The Close icon  is the icon located in the upper-right corner of each window’s 
title bar and on some dialogs. If you click this icon, its window will close. If you 
click the Close icon on the program’s title bar, the program will close.

CURSOR
The cursor holds the active position in a window. It can be placed using the 
keyboard keys or the mouse. (See Mouse Pointers on page 12.)

ACTIVE CELL OR ACTIVE ROW
This is the cell or row in which you are making an entry. You can distinguish it 
from other, inactive cells or rows because it is highlighted in a different color. 
The cursor marks the active cell.

SCROLL BAR
The scroll bar is a horizontal or vertical bar at the bottom or right of the window. 
This bar is marked at the ends with a box that contains a directional arrow. It 
includes a slider button that allows you to scroll through a list box or window.
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INSERTION POINT
The insertion point is the place in the active cell where entries are inserted. 
When you enter data in a cell for the first time, for instance, the insertion point 
is at the far right.

HIGHLIGHTING
Highlighting is a method used to indicate an active area of the window by 
changing the area’s color.

DIALOG 
A dialog is a special type of window that provides information and/or allows you 
to enter information in the program. Dialogs frequently provide a selection of 
options.

For a more detailed discussion of the parts of an Income Tax Planner 
worksheet, see Parts of a Worksheet on page 37.

TYPES OF ROWS

INPUT ROWS
You enter the facts of a client analysis in input rows. Also called entry rows, 
these rows allow you to directly enter data without using an underlying 
subworksheet. All non-calculated numeric rows on a worksheet can expand to 
a supporting subworksheet, either a built-in subworksheet or a custom 
subworksheet.

CALCULATED ROWS
Calculated rows are rows that the program computes based on your entries 
elsewhere. You cannot make entries in or make direct changes to the amounts 
on calculated rows. Calculated rows are indicated by a different color than 
input rows.

ACCESS ROWS
Access rows are rows that you can use to access a subworksheet. Some 
access rows allow summary data entries. Other access rows, such as Individ-
ual Activities, do not allow data entries — you can only use them to access 
subworksheets. The program posts the results from the accessed subwork-
sheet back to the access row.
Access rows provide access to other input worksheets; they also display the 
results of these entries. Access rows are designated with a worksheet icon:

 Inactive worksheet icon — indicates that a subworksheet is available 
but inactive for that row
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 Active worksheet icon — indicates that a subworksheet has been 
activated

You can access a worksheet by double-clicking the row or, when the cursor is 
on an access row, by pressing W.

You can also access a worksheet by double-clicking the worksheet item on the 
Worksheet List (if the Worksheet List is not displayed, click the Show/Hide 
Worksheet List icon  on the toolbar). Or, when the Worksheet List is not 
displayed, you can access a worksheet by pressing Ctrl+W to display the 
Select Worksheet dialog. 

PROGRAM CALCULATIONS AND FEATURES

CALCULATIONS

LIMITATIONS AND PHASEOUTS
Phaseout of personal exemptions based on AGI.
Standard deduction including additional amounts for taxpayers who are 
over 65 or blind and additional amounts for property taxes and disaster 
losses.

Passive activity income and loss computations.
The $25,000 exemption for “active” real estate activities with the 
phaseout based on AGI.
Carryover and application of suspended losses in the year the activity 
is sold or has income.

Material participation rental real estate allowance for real estate 
professionals.
Publicly traded partnership income and loss limitations.

Audit trail that shows the allowed gains and losses for each item in 
each activity and each item type for all activities.

Regular and Roth IRA limitations, including Roth modified AGI.
Keogh and SEP deductions.

Foreign Earned Income Exclusion.
Foreign Housing Deduction
Section 1231 and casualty gains and losses.

Capital gains and losses, limitations and carryovers.
Calculates includible portion of Social Security benefits.
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Calculates excludable allowable portion of Series EE educational bond 
interest.
Calculates the deduction for interest on educational loans.

Calculates the deduction for higher education expenses.
Calculates the deduction for domestic production activities.
Calculates includible portion of employer provided dependent care 
expenses.

Calculates includible portion of employer provided adoption assistance.
Applies special rules for taxpayers who must itemize.
Calculates the Excess Business Loss Limitation under IRC § 461(l).

Calculates Net Operating Losses and Carryovers for years after 2017.
Calculates the Qualified Business Income Deduction Under IRC § 199A.

ITEMIZED DEDUCTIONS
Calculates the limitations on:

Medical, casualty, and employee business expenses and miscella-
neous itemized deductions
Residence Interest Deduction including mortgage insurance.
Personal interest deduction

Investment interest, taking into account:
The 5-year phase-in allowance
Carryovers from prior years and to future years

Adjustment of net investment income for phase-in of preenact-
ment passive losses
The breakdown of deductions and carryovers between Schedule 
A and Schedule E. Automatically computes net investment income 
including capital gain offset.

Regular tax charitable contributions, taking into account carryovers 
from prior years and to future years for:

Public charities
Private, non-operating foundations

Capital gain property in all categories
Carryovers in all categories from prior years and to future years.

Incorporates the 3% floor limitation to itemized deductions effective for 
years before 2018 and after 2025.
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Automatically applies special rules for taxpayers who must itemize.
Calculates deduction for state estimated and withholding tax payments. 
Automatically applies tax benefit rule to refunds.

Calculates deduction for state and local sales taxes including the optional 
table amounts.
Optimizes standard deduction vs. itemized deductions.

CREDITS
Child tax credit with AGI phaseout.

Hope Scholarship and lifetime learning credits with AGI phaseout.
D.C. Homebuyer credit with AGI phaseout.
Adoption credit and exclusion.

Dependent Care credit and exclusion.
Credit for Elective Deferrals and IRA Contributions.
Nonbusiness Energy Property

Residential Energy Efficiency
Minimum Tax credit, including refundable minimum tax credit.
2001 10% Bracket credit.

Automatically computes earned income credit and the supplemental 
earned income credit. Computes modified AGI and disqualified income.
Automatically computes credit for taxes paid to another state for all fifty 
states.
Making work pay credit (2009–2010)

2008 recovery rebate credit
First-Time Homebuyer credit (2008–2011)

Affordable Care Credit (effective 2014)

TAXES
Regular tax
Future year indexing based on user-entered inflation factor.

Alternative capital gains tax
Alternative capital gains tax for 1987 and years after 1990, including 
treatment of qualified dividends, 28% rate gains and losses (including pre-
5/7/97 gains and losses); unrecaptured section 1250 gain; collectibles 
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gain; 5-year gain from sale of property purchased before 2001; and small 
business stock gain (Section 1202).
Farm income averaging tax
Calculates the farm income averaging tax described in IRC § 1301 appli-
cable to years after 1997.
Foreign Earned Income Tax
Calculates the foreign earned income tax described in IRC § 911 applica-
ble to years after 2005.

Alternative minimum tax
Takes into account adjustments for the standard deduction, personal 
exemptions, personal interest, medical expense, miscellaneous 
itemized, state taxes, and refunds.
Recomputes passive loss, capital gain/loss, and investment interest 
for alternative minimum tax purposes with carryovers.

Recomputes charitable contribution limitations and carryovers.
Recomputes medical and personal casualty loss deductions.
Recomputes publicly traded partnership losses, deductions, and 
carryovers.

Recomputes Section 1231 and casualty gains and losses.
Recomputes investment interest limitations and carryovers.
Keeps records of carryover passive losses by individual activity.

Selects the proper exemption amount.
Computes and applies minimum tax credit.

Calculates AMT adjustment for the 3% floor under itemized 
deductions.
Phaseout of exemption from the alternative minimum tax.
AMT alternative capital gains tax including treatment of 28% rate gains 
and losses (including pre-5/7/97 gains and losses); unrecaptured 
Section 1250 gain; collectibles gain; 5-year gain from sale of property 
purchased before 2001; 5-year gain from sale of property purchased 
after 2000; and small business stock gain (Section 1202).

AMT rules for children under 14.
Self-employment tax

Applies dollar limitations; takes into account FICA wages.

Automatically computes the income tax deduction for self-employment 
taxes in post-1989 years.
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Applies applicable ceilings on the Hospital Insurance (Medicare) 
element (pre-1994) and the old age, survivor, and disability insurance 
(OASDI) element in the self-employment tax.
Handles wages subject only to HI (Medicare) portion of FICA tax.

Handles statutory employee wages.
High-Income Hospital Insurance Tax (effective 2013)
Medicare Investment Tax (effective 2013)
Shared Responsibility Payment (effective 2014–2018)
Net tax liability
Shown after application of credits, and after computation of earned income 
credit.

State tax
Allows entry of user calculated state tax amount, or, with Income Tax 
Planner with Fifty States, automatically calculates and integrates 
state income taxes for any state. Automatically deducts state tax for 
federal purposes.
Special worksheets provided for entry of state tax payments and calcu-
lation of state refundable credits, as well as federal deductions and 
refunds. Separate worksheets for resident and nonresident states.

Resident state income tax for all fifty states, as well as New York City 
and Washington, D.C. Includes special California computations, such 
as the California Minimum Tax credit.
Nonresident taxes for California, Connecticut, New Jersey, New York, 
Ohio, and 36 other states. Supports simultaneous calculation of New 
York nonresident taxes and nonresident tax for a second nonresident 
state.

Computes other state tax credit (credit given by one state for taxes 
paid to another state).
Computes the New York Metropolitan Community Transportation 
Commuter Tax.
Computes the tax for multiple non-resident states.

Estimated Tax
Automatically performs quarterly annualization for purposes of 
required estimated tax payments.
Produces 1040–ES estimated payment vouchers for individuals and 
1041–ES vouchers for Estates and Trusts. 

Supports both regular and annualized installment methods.
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For annualization, all quarters are shown at once. Required 
payments are based on complete tax calculation, including AMT, 
self-employment tax, etc., on annualized amounts for each period.
Easy entry of amounts either by period with automatic annualiza-
tion or evenly spread throughout the year.

Computation of required payments based on quarterly amounts or, 
if lower, annual amounts.
Required quarterly payment shown before and after application of 
withholding and prior period over- or underpayments.
Elect to apply previous period under- or overpayments when you 
do next quarterly payment.

Minor child
Simultaneous parent and child computations for unearned income of minor 
children. Option to include income on parent’s return or tax child 
separately.
Lump sum taxes

Five-year and ten-year forward averaging.
Computation of all six alternatives available to taxpayers who qualify.
Separate computations for taxpayer-spouse.

Calculated with or without election to treat entire amount as subject to 
5- or 10-year averaging.

PRESENT VALUE COMPUTATIONS
A special worksheet calculates the net present value of taxes and cash flows 
for each year in the analysis.

OTHER FEATURES OF THE PROGRAM
Supported OS: Windows Server 2012 R2, Windows Server 2016, 
Windows Server 2019, Windows 8 32, Windows 8 64, Windows 8.1 32, 
Windows 8.1 64, Windows 10 32, and Windows 10 64.
Easy-to-use interactive Worksheet List shows the current status of all 
worksheets within the open analysis at a glance. Allows you to open, close, 
kill, or print worksheets from a tree diagram (or optional alphabetical list) of 
worksheets. Also allows you to zap custom worksheets.
Tab interface allows quick access to any open worksheet.

Toolbar allows easy access to common operations including save, print, 
and print preview.
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The Security Transaction Analyzer worksheet lets you enter security 
transactions, i.e., sales of stocks and bonds, on an individual transaction 
basis. Automatically determines type of gain, taxable amount, and tax. 
Each transaction can be posted to a specific case or cases.
Note feature lets you create (and optionally print) a Note that acts as a 
footnote for a worksheet input cell, including custom worksheet cells. 
Notes allow you to provide additional explanation to distinguish the cases 
within the analysis.

The Watch Window allows you to watch certain rows as you change the 
data.
File merge allows you to combine information saved in a file with the 
information in the currently open analysis.
Files can be e-mailed as a date file or as a PDF printout.

Client files can be password protected.
Forward and Back icons allow quick access to open worksheets.
Linked Client Letter lets you write a client letter while still in the program 
and link any amounts from the worksheet to the letter. These figures are 
automatically updated in the letter whenever the worksheets are changed. 

Template feature allows creation of model letters for use with multiple 
clients.
Graph feature opens a window containing a graph of your client’s data. 

You can select the items to be depicted on the graph, the type of 
graph, the properties of the graph (vertical or horizontal, colors or 
patterns, etc.), and the titles for the top, bottom, and sides of the graph. 

Graphs are dynamic, each change in data on the worksheet is 
reflected automatically on the graph.
Graph settings are customizable.

Cut and Paste feature allows you to transfer information to this and other 
programs.
Special worksheets handle input from K–1s and 1099s on activity-by-
activity basis with complete audit trail showing amount of each item from 
each activity.
On-screen math function eliminates the need for a calculator.

Accepts data files from previous Windows versions of the program.
Allows up to 500 passive activity items and up to 500 non-passive items 
worksheets.
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Multiple windowing feature lets you see numerous worksheets and compu-
tations side-by-side on the screen.
The optional Use Same Window feature lets you tile the graph and a 
worksheet side-by-side, then have newly-opened worksheets open on top 
of the worksheet. This allows you to see the graph update dynamically as 
you make changes in the analysis.

The Save Desktop feature lets you save the size and location of the 
worksheets on the program workspace when you leave the program, so 
that when you re-open the analysis, everything is placed back the way you 
left it.
The Print Preview option lets you review and modify your client reports 
on-screen before printing.
A wide range of printer and screen fonts gives you utmost flexibility in 
tailoring the program output to your needs.

Preset and customizable color formats allow you to select from a wide 
range of colors for screen text, backgrounds, separator lines, and 
underlines. 
The Auto Backup feature allows you to back up your client data files as 
you work as often as you wish. 
Online help messages include references to Internal Revenue Code 
sections where pertinent. 

Pop-up help messages provide additional explanation for each tax 
item.
Help facility is completely indexed with hypertext jumps to other topics 
of relevance and hyperlinks to relevant worksheets in program.

Client data files can be opened, saved, renamed, and deleted through the 
program’s simple file routine. 
Client files can also be stored in text format for subsequent editing with 
word processing programs, in data format for use in database or spread-
sheet programs such as Lotus 1–2–3TM and Microsoft® Excel, or in Adobe® 
Acrobat® format for easy e-mailing and presentation. 
A detailed summary report for clients follows the general format of pages 1 
and 2 of federal Form 1040.

Multiple users may access the program simultaneously over a Local Area 
Network (LAN) (additional licenses required). 
Dynamic Data Exchange (DDE) allows you to share or “link” data with 
other Windows programs. 
A lock/protect column option allows you to protect historical data.
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A hide column option allows you to hide columns on-screen and when 
printing.
The Print Columns feature lets you select specific columns for printing so 
that a single column of historical data can be printed along with multiple 
cases of new years.

The Page Style feature provides you with a wide variety of preset report 
styles from which you can select when you print worksheets. Page Style 
also allows you to select other combinations of style features to customize 
the look of the printed worksheets, as well as save a combination of styles 
as your preferred default.
Program can automatically restore the default header or footer for old or 
bridged files and automatically supply default headers and footers for files 
without them.
Save a default list of worksheets to be printed with each client file.

Complete reports with table of contents and index.
Ability to select state tax law to apply makes it easy to compare tax 
burdens of different states.
<<desktop program edition only>> Ability to automatically check for and 
download program updates via the Internet and install these updates over 
the currently installed program version.

Right-clicking a cell in a worksheet opens a shortcut menu, providing you 
with quick access to commonly used Edit menu commands.

BRIDGING TAX DATA FROM OTHER PROGRAMS
Many tax preparation software companies provide bridge programs that allow 
you to convert and export your client data to a file that is compatible with 
Income Tax Planner. The data in the exported file can then be quickly and 
easily imported to Income Tax Planner, where you can compare tax informa-
tion from different years and plan for future tax years. 

The following tax preparation programs have bridges for Income Tax Planner:
Lacerte Tax (Intuit)
ProSystem fx Tax (CCH)

UltraTax CS (Thomson Reuters)
GoSystem Tax RS (Thomson Reuters)

You can find instructions on how to bridge using these products in our 
Customer Support knowledge base. Go to https://bnasoftware-
support.force.com and enter Bridge in the Search knowledge field.
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For information about a specific bridge, contact your tax preparation software 
company.
<<Web program edition>> Even though the tax preparation software 
company may not state that they provide a bridge specifically for the Web 
program edition, the Income Tax Planner engine is the same in both the 
desktop and Web editions. This means that the data in the exported file can be 
quickly and easily imported to either program edition.

ASSUMPTIONS
The Assumptions dialog is used to specify the general assumptions about the 
tax information you are entering, such as the number of years and/or cases in 
the analysis, the type of analysis, (Adjustment, Difference, Taxpayer & Spouse, 
Annualization, Minor Child), the first year of analysis, or (for minor child 
calculations), the number of children.

 

You should complete this dialog before you enter client tax data into the 
worksheets and subworksheets. See Chapter 5 for more information on the 
items and their default settings.
Once you have completed the Assumptions, you are ready to run through 
some tax calculations. 
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Note. If you are using Income Tax Planner for the first time, you may wish to 
follow the scenarios in the Tutorial, accessible on the program Help menu, to 
work through some sample cases before using data of your own.

LOADING FILES FROM PREVIOUS VERSIONS
This version of the program will automatically handle files created by all prior 
versions of Income Tax Planner. However, please note that the program has 
changed over the years with successive versions reflecting tax law changes 
and program enhancements and you should check your final data carefully to 
be certain that it is properly categorized in the current version.

OPENING A CLIENT FILE
To open a client file, click the Open icon on the Toolbar or select Open Client 
File from the File menu. To create a new client file, select New Client File from 
the same menu.

ENDING A SESSION
When you’ve finished running the calculations, make sure you have stored 
everything you need by selecting Save Client File or Save Client File As on 
the File menu. Then click the Close icon  in the title bar or select Exit (from 
the File menu) to quit the program.
If you do not save your data before trying to exit the program, you will be 
prompted to save your data.

If the file has not been saved previously and you select Yes, the Save Client 
File As dialog will appear and you can then save your data and exit the 
program. (See Save Client File on page 64 and Save Client File As on page 
65 for detailed instructions on saving data files.) If the file has been saved 
previously and you select Yes, the program saves the file and exits. If you 
select No, you will be exited from the program. Select Cancel if you change 
your mind and decide not to exit the program.

BACKING UP CLIENT FILES
In addition to saving client data through the program’s “File” routine, it is also 
advisable to make backup copies of client files using backup software. This will 
prevent loss of client data in the event your files are inadvertently erased or 
your data disk is lost or damaged. See your Windows manual for instructions.
You are also cautioned to protect your client data files from access by unautho-
rized persons. For client files requiring maximum security, confidentiality is best 
served by storing data files on floppy disks in a secure location. 
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INSTALLING PROGRAM UPDATES
<<desktop program edition only>>
For detailed instructions about program installation and activation, see the 
separate Installation Guide that was sent to you. For information about Web 
updates, please see Web Update command on page 267.

SINGLE WORKSTATION INSTALLATION
If you are installing a program update and you already have a previous 
version of the program installed on your hard disk, the new files will replace the 
files from the previous version. The installation process will not damage or 
overwrite client data files on your hard disk that were created with earlier 
versions of the program. 

Make sure that you have exited Income Tax Planner before starting to install 
the new version.

NETWORK INSTALLATION
Bloomberg Tax Technology recommends that you install to the same drive and 
folder as the previous version. While you are installing be sure no one is 
running the program. The program will automatically recognize the activation 
code that you entered previously.
If you install to a different drive/directory or if a single-user installation was run 
at each licensed workstation, then the workstation setup or program installa-
tion, respectively, must be run at each licensed workstation.

For most program updates, after setting up the server component, workstation 
setup is not required. However, some program updates require each worksta-
tion to be set up after setting up the server component. If running the 
workstation setup is required, and if you choose not to run the workstation 
setup at each workstation, then end users who attempt to open the program at 
their workstations will receive the following message:

Income Tax Planner has upgraded components requiring existing 
network workstation installations to upgrade by first running the worksta-
tion setup. Please choose OK to run the workstation setup and 
automatically install the required updated files.

Choosing OK causes the program to automatically run the workstation setup. 
If Cancel is chosen, the program will not run the workstation setup.
After workstation setup has refreshed the appropriate file(s), the current 
version of the program starts automatically. No further action should be 
required.
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STATES USERS
If you are installing into a folder that contains state specifications files from a 
previous version, the specification files will be updated. If the specification file 
you were using as the default was a modified version of the original version 
supplied by Bloomberg Tax Technology, and the Bloomberg Tax Technology 
version has been updated to reflect changes in state law, the installation 
program will use the updated Bloomberg Tax Technology version as your 
default. If your changes reflected local taxes or other specifications that are not 
included in the new Bloomberg Tax Technology version, you will need to re-
enter the changes, file the altered specifications under the name you used 
previously, and then reassign the file as your default state. 
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2
2 Worksheets & Menus

WORKSHEETS & MENUS
OVERVIEW OF WORKSHEETS

At the heart of the program is a series of multi-level worksheets on which client 
tax data is entered and calculations are performed. Tax data can be entered in 
detail or summary form and calculations are processed instantaneously. Data 
is posted continuously among the relevant worksheets.
The program uses a menu system to access these worksheets and other 
program functions. The menu bar, which lists the operations that you can 
perform with the program, appears at the top of the screen as soon as you load 
the program. It provides access to the Assumptions dialog and the tax 
planning worksheets, as well as to other functions such as printing, saving, and 
opening client files; setting calculation and display options; and, if you have 
Income Tax Planner with Fifty States, selecting and changing state 
specifications.

   

Other chapters in this guide detail each item of each menu. For details on the 
Worksheets menu, see Chapter 6.

TYPES OF WORKSHEETS
Client tax information can be entered into the program by using either the 
regular worksheet system of Main Worksheet and subworksheets, or the 
Batch Input worksheet.
The Batch Input worksheet is a worksheet that contains all of the program’s 
detail-level input rows, sequentially numbered and grouped under each 
worksheet title. The Batch Input worksheet is discussed on page 169.

Custom worksheets provide an additional level of detail that can be personal-
ized to meet the needs of individual clients. Custom worksheets can be created 

MenuBar.png
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using either the regular worksheets or the Batch Input worksheet. For more 
information, see Custom Worksheets on page 41.
Other types of worksheets allow you to enter individual activities and to see the 
Summary Report or Alternative Capital Gains expanded output or present 
value calculations. 

TYPES OF ROWS
Some rows on the worksheets are data entry rows, some are calculated rows, 
while others are rows for accessing subworksheets. For details about the row 
types, see Types of Rows on page 20.

WHAT IS AN ACTIVE WORKSHEET?
The program can post amounts to the calculated rows of an active worksheet. 
An active worksheet can be open or closed. 

WHEN TO USE SUBWORKSHEETS
When using the regular worksheets, client data can be entered into the Main 
Worksheet either directly or through the subworksheets. In many situations 
(for example, the calculation of certain alternative and supplementary taxes), 
you should always use the corresponding subworksheets, because the details 
needed to compute the tax accurately can only be entered through 
subworksheets.

WHY ARE SOME WORKSHEETS ACTIVATED 
AUTOMATICALLY?

Some of these worksheets, for example, the subworksheets for calculating 
credits and alternative minimum taxable income (and their supporting 
worksheets), are activated automatically by the program and must remain 
active so that the program does not overlook the alternative minimum tax 
calculation and the minimum tax credit, both of which are calculated automati-
cally without separate user input.

Even though the program automates these calculations on the basis of infor-
mation available from other worksheets, you may need to make some 
additional entries on these “always active” worksheets to ensure accurate 
computation of the alternative minimum tax and the credits.
In some cases it will be best to use a subworksheet for some items while using 
the Main Worksheet for others. For example, to assess the effect of additional 
ordinary income or loss on the alternative minimum tax, it is advisable to use 
the subworksheets for the Alternative Minimum Tax and Itemized Deduc-
tions. These subworksheets automatically pick up changes to taxable income 
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whether the changes are made on the Main Worksheet or on subworksheets. 
You can, therefore, make changes to ordinary income on the Main Worksheet 
and immediately see the effect on itemized deductions, alternative minimum 
taxable income, and the alternative minimum tax. 
In other cases, using the subworksheet cannot be avoided. For example, the 
input rows for nonrefundable credits and the alternative minimum tax on the 
Main Worksheet, and certain rows on other worksheets, can only be used to 
access the subworksheet and cannot be used for entering summary informa-
tion directly. (See the individual row descriptions in the Tax Reference Guide 
for more details.)

USE SUBWORKSHEETS FOR BEST RESULTS
In general, you are advised to use the subworksheets to enter information until 
you are familiar enough with the program and the law to be certain that the 
calculations and limitations on the subworksheets do not apply. For example, if 
the Charitable Contributions worksheet is not used, the program will not 
apply the charitable contributions limitations. If you are certain the limitations 
do not apply, then you can enter charitable contributions directly on the “Chari-
table Contributions” row of the Itemized Deductions worksheet. Otherwise, 
you should use the subworksheet. A similar rule applies to virtually every other 
subworksheet.

WHICH WORKSHEETS DO I NEED?
Use the diagram of program worksheets at the beginning of the Tax Reference 
Guide and the summary descriptions that follow that diagram to determine 
which subworksheets you may need to use. The summary descriptions outline 
the purpose of each subworksheet and the calculations that are derived from 
it. See, also, the discussions of individual worksheets in the Tax Reference 
Guide.

PARTS OF A WORKSHEET
The program’s worksheets are accessed by double-clicking the name of the 
desired worksheet in the Worksheet List. The main parts of a worksheet are 
illustrated and described below:
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Column headings reflect the relevant year and/or case number for each 
column. In the case of Minor Child computations, the first column is the parent 
and each subsequent column represents a child under 14. In the case of an 
Annualization analysis, each column heading represents a specific period of 
the year.
Row titles down the left side of the worksheet describe the individual row items 
to be entered or calculated. A different color (in the manual shown as blue) 
denotes a row whose values will be automatically calculated and displayed 
when that row on the worksheet is active.
Cells are the places within a worksheet where data is entered or a calculated 
amount is displayed. They are located in the grid area beneath the column 
headings and to the right of the row titles. The active cell is where the cursor 
rests and is displayed in reverse video. When you type an amount, it is entered 
into the active cell.
A vertical scroll bar appears if there are worksheet rows that cannot fit in the 
window. A horizontal scroll bar appears if there are additional columns that 
cannot fit in the window. 

SELECTING A WORKSHEET
If you want to open a subworksheet from a worksheet row, you can double-
click on the row or press W when the insertion point is in a cell in that row. If 
available, the built-in subworksheet will open. If not, a custom worksheet will 
open. Rows titled “Individual Activities” will open an Individual Activities 

Worksheet Tab Title Bar Minimize, Maximize 
& Close icons

Column Headings: 
Analysis Years

Column 
Headings: 
Case 
Titles

Calculated row

Input or data 
entry row

Row title

Dimmed icon 
indicates that a 
subworksheet 
is available but 
inactive

Active Cell: Reverse 
video indicates 
cursor location

Note indicator

Row 
numbers

Bright icon 
indicates that 
this row has 
an active 
subworksheet

wiMainWorksheet.png
Be sure to add a note before capturing image.
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worksheet. (For details on these types of worksheets, see Overview of 
Worksheets on page 35.)
You can also use the Worksheet List (displayed on the left or right of the 
workspace, depending upon your selection on the Options menu) to open 
specific worksheets, including custom worksheets and Individual Activity 
items. The dialog and the pane both also allow you to close or kill worksheets.

The top portion of the Worksheet List, when sorted by structure rather than 
worksheet name, looks like this:

  

To open a worksheet quickly:

1. Select the worksheet from the Worksheet List (if the Worksheet List is 
hidden, press Ctrl+W to call up the Worksheet List).

2. Double-click on the title of the desired worksheet.
Or highlight the title of the worksheet you want, then press Enter.

The selected worksheet will open on top of the previous worksheet.
Some of these worksheets are also available for selection from the Worksheets 
menu. These include the Batch Input worksheet (for entering tax data in detail 
without using the multi-level worksheet system) and the expanded output 
worksheets (Summary Report and Alternative Capital Gains Tax).
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For a discussion of open, active, and inactive worksheets, see Using the 
Worksheet List on page 161.

NUMERIC DATA ENTRY AND CURSOR MOVEMENT
As you enter a number in a cell, it grows from right to left, with commas inserted 
where appropriate. At any point during numeric entry you can use the 
Backspace key to remove the rightmost digit and the number will shrink 
accordingly.

When you’ve finished entering a number, click on the next cell that you want to 
enter data in or press Enter or the right arrow key to go to the next cell.
If the Display Cents command is selected (through Calculations on the 
Options menu), you may enter a decimal point. The cursor then moves to the 
right, allowing you to enter cents.
The cursor will not move to the next cell until you use one of the Edit menu 
commands, or click on another cell with the mouse, or press a cursor arrow key 
or Enter. This allows you to change what you keyed-in before it is entered into 
the program. You can change an entry subsequently by moving the cursor to 
the cell in question and typing over the old value.

CHANGING INFORMATION ON A WORKSHEET
Information that has been posted automatically from an activated subwork-
sheet can only be changed through the subworksheet, unless the 
subworksheet is made inactive. Any keystroke (other than H (Help), K (Kill), X 
(Summary Report), B (Batch Input), W (Go to Subworksheet), or a cursor 
movement command) on a row with an active worksheet will produce the 
following message:

 

Click OK to close the message and continue. Double-click on a cell or press W 
to call up the subworksheet again; press K to perform the Kill operation. See 
Kill Subworksheet Command on page 122.

You can also use the Zap command to eliminate a custom worksheet and all 
the row descriptions and other data it contains. See Zap Custom Worksheet 
Command on page 123.
For more information on entering data and Edit menu commands, see the Edit 
Menu Commands on page 105.

msgCautionNoEntry.png
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CUSTOM WORKSHEETS
The program allows you to create your own custom worksheets for entering the 
details of any row that does not already have a built-in worksheet. You can 
provide your own row titles for the items that you want to include and enter the 
amounts for each item (positive or negative) in the year and/or case column(s) 
provided. The program will total the entries and post the totals back to the row 
for which the custom worksheet was created. This feature is available from 
both regular worksheets as well as Batch Input worksheets.
Custom worksheets are also easily accessible on the Worksheet List.
When you select a built-in worksheet for printing, all custom worksheets that 
were created from that worksheet will be printed as well, provided that the 
Custom Worksheets option is selected on the Page Setup dialog (see Custom 
worksheets on page 63). 

A sample custom worksheet that was just opened for Other Adjustments is 
shown below. (The Other Adjustments custom worksheet is accessible from 
the “Other Adjustments” row on the Ordinary Income worksheet.)

A custom worksheet has two basic sections: the row title section (the first 
column on the left) and the numeric cell section (the column(s) to the right). The 
row title section has its own Edit menu which is described in Custom 
Worksheet Edit Menu for Row Titles on page 46. 

If you create a custom worksheet for a row on which you’ve already entered 
amounts, instead of creating a blank custom worksheet, the program carries 
that row’s title and amounts to the first row of the custom worksheet, as shown 
above:

CREATING CUSTOM WORKSHEETS
Rows without a worksheet icon (on the left of the row title) do not have built-in 
subworksheets. To create a custom worksheet for one of these rows:
1. Double-click on a row without a built-in subworksheet. A blank custom 

worksheet will open that has a title matching the row you just came from 

wiOtherAdjustments.png

To capture this image, open the 
scenario3.it file from the tutorial, then 
open the Ordinary Income 
worksheet.

Row title section Numeric cell section
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and column headings corresponding to the years and/or cases selected for 
this taxpayer. The cursor will be on the left in the row title section. 

2. Type in your row titles using up to 36 letters or numbers for each. (Depend-
ing upon the width of the selected screen font, the entry may scroll off the 
screen to the left as you type. When you press Enter, the title area will 
expand to display the entire title.) When you press Enter, the cursor moves 
down to the next row title.

Note. You can leave the title and columns for any row blank by simply 
pressing Enter without entering any description.

Note. To erase the row title while leaving the numeric entries intact, click 
the row title to select it, then press and hold the Backspace key down until 
the title is deleted. Now you can enter a new title for the row.

MOVING BETWEEN ROWS
To move up or down the rows, click on the desired cell or row or use the arrow 
keys.

DELETING OR ADDING ROWS
You can delete a row (from a row title cell) by opening the Edit menu and 
selecting Delete Row. To insert a row above a particular row, open the Edit 
menu and select Insert Row. You cannot insert a row into a range of linked 
rows from within the program nor can you delete rows that are linked to a 
remote application as long as these rows are linked.

3. After entering the last row title (up to 49 rows are allowed), move to the 
numeric section of the custom worksheet by clicking the first numeric cell 
in the first row and first column, or by pressing Ctrl+Right Arrow key. Fill in 
the numbers using any of the Edit menu commands available on the built-
in worksheets, such as Auto Copy, Repeat, Clear, Increase, Math, etc. 

4. To move back to the row titles, click on the desired title or press Left Arrow 
key (to move to the title in the same row).

DESIGNATING TITLE ROWS
You may designate a custom worksheet row as a title row. (A title row does not 
allow numeric input.) In the following illustration, the second row has not yet 
been designated as a title row:
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To designate a row as a title row:
1. With the cursor in the row title cell, open the Edit menu.
2. Select the Title Row On/Off command. The message “Title ON” will 

appear. Any existing numbers on the row will be blanked out.

Repeating the Title Row On/Off command while in the row title section of a 
title row converts it back to a normal input row and the message “Title OFF” 
appears. However, numbers that may have been blanked out when the title 
row was created are not restored.

DESIGNATING SUBTOTAL ROWS
Similarly, you may designate a custom worksheet row as a subtotal row. (A 
subtotal row accumulates the entries from the normal input rows above it.)

1. Enter a row title such as “Subtotal”. 
2. Open the Edit menu and select the Subtotal Row On/Off command. The 

message “Sub Total ON” will appear, and the amount in the cells will be the 
sum of those above the subtotal row.

 

As shown above, the Subtotal feature sums the amounts in all rows above up 
to, but not including, the previous subtotal row. The numeric cells in a subtotal 
row are calculated and therefore cannot be edited.
Repeating the Subtotal On/Off command converts the row back to a normal 
input row.

When you leave a subtotal row, the program treats the row as a calculated row 
and the row is dimmed. However, unlike other calculated rows, you can revise 
the title of the subtotal row.

wiOtherAdjustmentsb.png

wiOtherAdjustmentsc.png

Subtotal 
Row
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NESTING CUSTOM WORKSHEETS
The program allows up to 100 custom worksheets. They can all be created off 
the built-in worksheets or they can be “nested,” i.e., created off each other. You 
can have as many worksheets running off another worksheet as there are rows 
available to create them, provided the total number of custom worksheets, 
however created, does not exceed 100.
To create a custom worksheet for a row entered on a custom worksheet, while 
the cursor is in the row title section simply open the Edit menu and select Open 
Custom Worksheet. Or, when the cursor is in the row’s numeric section, 
double-click on the row.

WORKSHEET TOTALS
Each custom worksheet includes a calculated Total row at the bottom of the 
worksheet.

Each custom worksheet automatically posts its totals back to the row from 
which it was created. Positive entries are added and negative entries 
subtracted.
While you can use the Math Calculator command (on the Edit menu) while in 
a numeric cell to compute an entry, formulas cannot be entered and retained.

KILLING CUSTOM WORKSHEETS
The Kill command operates on custom worksheets in the same way as on built-
in worksheets, zeroing out the numeric data but leaving the rest of the 
worksheet intact. When you kill a custom worksheet that is linked to other 
remote applications, the links are not affected and remain active.

To kill a custom worksheet, press K when the cursor is in the numeric section 
of the row from which the worksheet was created. The program will issue a 
message stating that all data on the subworksheet will be cleared, and asking 
for confirmation before deleting the worksheet data.
After killing the data on the subworksheet, the program issues a message to 
tell you that the subworksheet is no longer active.

Note. Both the Kill and Zap commands require that you work from the most 
recently created worksheet back to previously created worksheets. You cannot 
kill or zap a worksheet while other worksheets created from it are still active. 
The only exception is the State Tax – Main Worksheet. You may kill this 
worksheet from the Main Worksheet and all subworksheets created from it will 
be killed also.
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ZAPPING CUSTOM WORKSHEETS
When a custom worksheet is zapped (eliminated), all of its row titles and 
numeric data are deleted and the worksheet itself is deleted from the analysis. 
Additionally, when you zap the custom worksheet any Excel links to or from the 
custom worksheet are deleted.
You can eliminate a custom worksheet in any of three ways:
1. From the worksheet row for which the custom worksheet was created 

— If the cursor is in either the row title or the numeric section of the row, 
open the Edit menu and select Zap Custom Worksheet.
Before deleting the custom worksheet, the program first issues a message 
similar to the following which asks you to confirm your request and then 
eliminates the custom worksheet (including all row titles and numbers).

After completing the task, the program issues a message to tell you that 
the custom worksheet has been zapped.

2. From the custom worksheet itself — Call up the custom worksheet 
(double-click on its access row) and then go to each row title one at a time 
and select Delete Row from the Edit menu. As soon as you close the 
worksheet, it will be removed from the analysis.

3. From any worksheet — using the Erase Worksheets command on the 
File menu to eliminate all custom worksheets, select the Erase Worksheet 
Data and Zap Custom Worksheets option (see Erase Worksheets on 
page 99). 

CREATING OVERLAYS
You can use the custom worksheet feature of the program to create overlays 
(or worksheet templates) for clients with similar fact patterns. To do so:

1. Create the custom worksheets you want.
2. Open the File menu and select the Erase Worksheets command. 
3. Select Erase Worksheet Data from the list and click OK.

4. When prompted to confirm, click OK. All numeric data will be deleted from 
the worksheets, but the custom worksheets (except passive activity and 
PTP custom worksheets) will be left in template form. State specifications 
used by Income Tax Planner with Fifty States are not affected.

msgZapCustomW
orksheet.png
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5. Save the file using the Save Client File or Save Client File As selection 
on the File menu.

Thereafter, when you load in the template file you created, the custom 
worksheets in the file will be available as though they were built into the original 
program.

Note. When you load the template file, you may want to save it under a new 
name immediately to keep from changing the template unintentionally.

CUSTOM WORKSHEET EDIT MENU FOR ROW TITLES
The custom worksheet has a different Edit menu for the row title section, as 
shown below. The numeric cell section uses the same Edit menu as regular 
worksheets. For more information, see Cell Commands on page 106.

 

COPY
The Copy command places the selected text onto the Clipboard.

To use the toolbar to perform this function, click the Copy icon on the 
main program toolbar.

PASTE
The Paste command places the Clipboard’s contents into the current row title 
cell, overwriting the existing contents. This command will only paste to input 
rows that are already active. You cannot use this command on rows that do not 
already have either a row title or amounts in the cells.

To use the toolbar to perform this function, click the Paste icon on the 
main program toolbar.

PASTE LINK
Use the Paste Link command to invoke the link feature and to place data 
copied from Excel onto the custom worksheet, starting at the selected cell. This 
command will only paste to input rows that are already active. You cannot use 

mEditCustomWorksheet.png
Make sure this is taken when the 
cursor is in the title section
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this command on rows that do not already have either a row title or amounts in 
the cells.

Note. You cannot insert rows into a range of custom worksheet rows that are 
paste linked from another application. Nor can you delete rows from a range of 
custom worksheet rows that are paste linked from another application. You 
can, however, add or delete rows at the source — within the remote applica-
tion. However, the program cannot recognize when you add or delete rows in 
the remote application. You must break the links, and then recopy and 
paste-link the new range of rows from the other application into the program.

Or, if you want to add or remove only custom worksheet rows in Income Tax 
Planner and these rows are within a range of linked cells, when you select the 
Insert Row or Delete Row command, the program will issue a message 
asking if you want to delete the links. Select OK to have the program delete the 
links and either delete the selected row or insert a new row. You can then re-
copy and re-paste link the rows from the remote application that you want 
linked.

SELECT ALL
Use the Select All command to select the entire worksheet before using the 
Copy command.

EDIT CELL
Use the Edit Cell command to revise the text of the row title.

DELETE ROW
Use the Delete Row command to delete a row on a custom worksheet. Rows 
that are linked to remote applications cannot be deleted until the link is broken.

INSERT ROW
Use the Insert Row command on a custom worksheet to insert a new row 
above the current row. A row cannot be inserted between rows that are linked 
to a remote application until the link is broken.

TITLE ROW ON/OFF
When executed from the row title section, this command designates a row as 
a title row and issues the message “Title ON.”

SUBTOTAL ROW ON/OFF
When executed from the row title section, this command designates a row as 
a subtotal row and issues the message “Subtotal ON.”
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OPEN CUSTOM WORKSHEET
Use the Open Custom Worksheet command to create a custom subwork-
sheet for a row on a custom worksheet. You can subsequently access the 
subworksheet by double-clicking on the row on the parent custom worksheet to 
which the subworksheet is attached. To open a custom subworksheet while in 
the numeric cell section, double-click the mouse.

KILL SUBWORKSHEET
Use the Kill Subworksheet command to change a custom subworksheet’s 
status from active to inactive and set all items on the subworksheet to zero 
while in the row title section of the subworksheet’s access row. To prevent 
accidental deletions, the program requests verification before killing the 
subworksheet. Killing a subworksheet automatically restores any calculations 
that use the subworksheet data to where they would have been had the 
subworksheet not been used. When you kill a subworksheet, any Excel links to 
or from this worksheet are not affected — the links remain intact, ready for 
when you reactivate the subworksheet.

Note. This command will be dimmed on the Edit menu unless the cursor is on 
a row that has a custom subworksheet.

For more information, see Killing Custom Worksheets on page 44.

ZAP CUSTOM WORKSHEET
Use the Zap Custom Worksheet command to delete a custom subworksheet 
from a row on a custom worksheet. The subworksheet data and the worksheet 
itself will be deleted. Any Excel links to or from the zapped custom worksheet 
will be deleted as well.

Note. This command will be dimmed on the Edit menu unless the cursor is on 
a row that has a custom subworksheet.

For more information, see Zapping Custom Worksheets on page 45.

OVERVIEW OF MENUS
FILE MENU

The File menu lists functions that you can perform on entire client data files, 
client letter templates, reports, or worksheets. You may use the File menu to 
perform the following program functions:

New Client File — Prepares the program for a new client, clearing any 
worksheets and Assumptions 
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Open Client File — Opens an existing client data file 
Merge Client File — Allows you to combine the information saved in a file 
with the information in the currently open analysis. This feature helps you 
to incorporate yearly tax data into a single multi-year historical planning 
file.

Save Client File — Saves the current client data file 
Save Client File As — Saves the current client file under a new name or to 
a new location  
New Client Letter — Erases the current client letter and opens a new blank 
one using the headers or footers in the default letter template

Open Letter Template — Opens an existing client letter template for editing
Save Letter Template As — Saves the current client letter or letter template 
as a client letter template
Page Setup — Allows you to set up the page specifications for the printed 
report 

Print Preview — Allows you to preview reports on-screen before printing 
Print — Allows you to select which reports to print as well as output options 
Send to — Allows you to send the client file as an attachment (PDF or IT 
format) via email.

Erase Worksheets — Erases data from worksheets, while leaving 
Assumptions from the current client file (such as name, years, and cases) 
in place 
Exit — Exits the program 

You can also rename and delete files from the Open Client File and Save 
Client File As dialogs. 

The File menu also lists the names of the last four client data files that were 
opened. 
We describe the File menu functions in detail in Chapter 3. You may also want 
to review Chapter 11 for step-by-step printing instructions.

EDIT MENU
The Edit menu lists functions that you can perform within or between 
worksheet cells or to worksheets themselves. The Edit menu allows you to 
perform the following program functions: 

Undo Last Entry — Cancels the last entry in a cell 
Undo List — Allows you to restore the values in a worksheet row to a 
previous value.
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Copy — Copies a selection to the clipboard 
Paste — Pastes from the clipboard into a cell or range of cells 

Paste Link — Pastes linked data from a Windows application 
Select All — Selects all items on a worksheet
Edit Cell — Edits a cell’s contents (allows you to insert/delete specific 
characters within a cell) 

Auto Copy Within A Case — Automatically copies the contents of the 
current cell to other years within a case or to other cases in a single-year 
analysis. When you use this command (instead of Enter) to terminate an 
Increase command, the same increment, along with the result, is included 
in all remaining columns in the case. 
Auto Copy Same Year — Automatically copies the contents of the current 
cell to the same year for all cases 
Auto Copy All Columns — Automatically copies the contents of the current 
cell to all other years for all other cases 

Clear Or Restore Prior Value — Clears or restores the cell’s previous value 
Increase By Constant Or % — Increases or decreases the value of the 
previous cell by a percentage or dollar amount and enters the new value in 
the current cell 
Kill Subworksheet — Kills the subworksheet accessed from the row the 
cursor is on 

Zap Custom Worksheet — Zaps a custom worksheet accessed from the 
row the cursor is on 
Math Calculator — Calls up the Math Calculator to calculate a value and 
post it into a cell 

Repeat Previous Cell — Repeats the previous cell’s content in the current 
cell 
Spread Annualization — Enters (or spreads) evenly received amounts 
based on your entry. Available on the custom worksheets for income and 
expense items only. Only available for annualization analyses 
Case Titles — Opens the Case Titles dialog, which you can use to enter 
case titles.

Move Case — Opens the Move Case dialog, which allows you to move 
cases.
Hide Columns — Allows you to hide one or more columns on-screen and 
(if you choose) when printing.
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Protect Columns — Protects one or more columns by locking the data in 
these columns 
Link Commands — Allows you to delete, update, and edit links to/from 
Excel 

Note — Lets you create, edit, and delete a note that acts as a footnote for 
any input cell. Can be used to help distinguish between cases 
Go To Batch Input Line Number — (Enabled only when the Batch Input 
worksheet has the focus) Moves the cursor to a specified line on the Batch 
Input worksheet 

We describe these functions in detail in Chapter 4.

Note that the commands on the Edit menu are different when the cursor is in 
the title row of a custom worksheet (see Chapter 6) or when the graph or client 
letter has the focus (see Chapter 7 and Chapter 8).

ASSUMPTIONS DIALOG
The Assumptions dialog allows you to specify basic information about the 
current analysis, including the Client Name, the type of analysis, and the 
year(s) of analysis. The Assumptions dialog also provides buttons for speci-
fying case titles, information for the client letter, and selecting a resident or 
nonresident state for the analysis. The items for each type of analysis are:

Client Name

CASES AND YEARS
Years within Cases
Cases within Years
Adjustment

Taxpayer & Spouse
Difference

Number of Cases in Analysis (Limit 20)
Number of Years in Analysis (Limit 20)
First year of Analysis (2000 or later)

MULTI NONRESIDENT
In Income Tax Planner with Fifty States, the program allows for a Multi 
Nonresident analysis to calculate the state taxes for one resident state and up 
to 18 nonresident states for one year. For more information, see page 139.
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ANNUALIZATION
If the analysis involves estimated tax annualization, the analysis is limited to 
one case and one year, displaying four periods (five for estates and trusts). You 
can specify the:

Year of Analysis (2000 or later)
Filing Status

MINOR CHILD
If the analysis involves the computation of the tax on investment income of a 
minor child, the analysis is limited to one case and one year. You can specify 
the:

Number of Children (Limit 19)
Year of Analysis (2000 or later)

DEFAULTS
When you first start the program after installation, the initial defaults for the 
analysis are: 

You have the option of changing these defaults for future analyses. We 
describe these selections in detail in Chapter 5.

WORKSHEETS MENU
The Worksheets menu allows you to manipulate the tax input and output 
worksheets, both in the data file and as windows on the screen and access the 
following program functions:

Hide/Show Worksheet List 

Worksheet List 
Open Worksheet 
Close Worksheet 

Kill Worksheet 
Zap Custom Worksheet 
Print Worksheet 

Years within Cases on

Number of Cases in Analysis (Limit 20) 2

Number of Years in Analysis (Limit 20) 3

First Year of Analysis (2000 or later) 2020
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Sort Worksheet List 
Help for Worksheet List 

Go to Subworksheet — Brings a specific worksheet to the top
Arrange the worksheets (as windows) in your workspace, using these 
commands:

Cascade 

Tile Horizontal 
Tile Vertical 
Tile Optimal 

Arrange Icons 
Select how worksheets are treated when you press Esc:

Close on Escape 

Minimize on Escape 
Use Same Window — Have the worksheets open directly on top of the 
previous worksheet

Use commands on the Worksheets menu to access special worksheets or 
windows, such as:

Batch Input 
Individual Activities 
Summary Report 

Present Value 
W-4 — provides access to the W-4 worksheet and W-4 form

Alternative Capital Gains Tax 
Security Transaction Analyzer 
Watch Window 

1040–ES/1041–ES payment vouchers 
Close All Subworksheets 
View Worksheets submenu <<Available only with Income Tax Planner 
with Fifty States>> — display worksheets of a selected type:

Federal Worksheets
Resident Worksheets
New York Nonresident Worksheets

Other Nonresident State Worksheets 
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Finally, the Worksheets menu lists the names of the worksheets that are 
currently open. 
We describe the Worksheets menu commands in detail in Chapter 6.

GRAPH
The Graph dialog allows you to set up a graphic representation of the analysis 
which shows various aspects of the case in relation to each other.
You can customize the graph by:

specifying the data items shown on the Graph — select from 11 predefined 
data items and four user-defined worksheet rows (some data items corre-
spond directly to a particular worksheet row; others are calculated from a 
combination of worksheet rows)

specifying the type of graph you want
further defining how the graph will appear — selecting from vertical, 
horizontal, stacked vertical, stacked horizontal, labels, colors or patterns, 
etc.
specifying the titles that appear on the graph

We describe the Graph feature in detail in Chapter 7.

CLIENT LETTER
The Client Letter allows you to write a letter to your client that is a part of the 
file. The letter can pull data from the worksheets; calculated amounts cited in 
the letter are updated automatically as you change data within the analysis. 
You can also create one or more Client Letter Templates to use as standard 
boilerplates for analyses that require the same basic letter. 

You can perform several word processing tasks. For example, you can:
Set tabs, indents and margins;
Add a header and footer;

Insert page numbers, page breaks, and the time and date;
Format your text;
Pull information from the worksheets; and

Find and replace words or linked fields.
You can also use the Client Letter feature to:

Automatically insert the client’s name, address, and a salutation name; or

Link calculated fields from the worksheets.
We discuss the Client Letter in detail in Chapter 8.
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OPTIONS MENU
Selections on the Options menu provide ways to control how the program 
operates or looks. some of the options include:

Auto Backup — As a default, the program will save every five minutes
Calculations

Colors
Default Directory 
Deactivate Workstation <<desktop program edition only>>

Link Options — Provides options used when the client data file is linked to 
Excel. 
Password Protect 
Screen Font 

Resident State Specifications <<Available only with Income Tax Planner 
with Fifty States>> — A gateway to the resident state specifications 
portion of the program.
Nonresident State Specifications <<Available only with Income Tax 
Planner with Fifty States>> — A gateway to the nonresident state speci-
fications portion of the program.

You can toggle the Calculations and Save Desktop features on or off. As a 
default, these options are on.

The Options menu allows you to organize the program window to suit your 
particular preferences by, for example, displaying or hiding the main program 
toolbar, Worksheet List, or worksheet tabs. You can also change where the 
Worksheet List or worksheet tabs are placed within the program window.
We describe the Options menu selections in detail in Chapter 9.

HELP MENU
The selections on the Help menu provide a few different ways to look up help 
topics covering the program. The selections on this menu include:

Contents – Displays the contents of the Income Tax Planner Help system.
Search for Help On – Searches for Help information related to topics that 
you specify.

Help for Current Row – Displays a description of the worksheet row on 
which your cursor is sitting.
Operations Guide – Opens the Operation Guide in your default web 
browser.
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Tax Reference Guide Supplement – Opens the Tax Reference Guide 
Supplement in your default web browser.
View Tutorial – Opens the tutorial web page in your default web browser.

View Merge Conflict Log – Displays the log that details any issues that 
arose during a merge 
Web Update <<desktop program edition only>> – Searches the 
Bloomberg Tax Technology updates Web page for program updates. 
Offers you the option to automatically check for program updates or to 
manually check for update. Also offers you the option to have the most 
recent update downloaded and installed automatically. 
Contact Support Team – Opens your default internet browser and displays 
the Bloomberg Tax Technology Customer Support  Web page, where you 
can search frequently asked questions and find contact information for 
Bloomberg Tax Technology.

About Income Tax Planner – Displays the About dialog, containing infor-
mation about your copy of Income Tax Planner.



57

FI
LE

 M
EN

U
FI

LE
 M

EN
U

FI
LE

 M
EN

U
FI

LE
 M

EN
U

FI
LE

 M
EN

U

::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::

3
3 File Menu

FILE MENU

OVERVIEW
The File menu of the program allows you to manage the program’s data files. 
Through the File menu you can access the following program functions:

Prepare for a new client, open client files to retrieve client data, merge 
information saved in a file with an open analysis, save client files to store 
client data on disk, rename client files, and even delete client files.

Start a new client letter; create, open and save a client letter template.
Customize the format of the printed reports using Page Setup.
Look at the reports before printing using Print Preview.

Print the reports using Print.

Note. Chapter 11 details each step of the print process.

Send a saved client file as a PDF or IT attachment to an email recipient.

mFileMenu.png
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Clear the data from the current analysis’ worksheets using Erase 
Worksheets.
Leave the program and return to Windows using Exit.

NEW CLIENT FILE
To open a new client file and clear any worksheets or assumptions from the 
currently loaded client file:
1. Select New Client File on the File menu. A submenu appears.

2. Select the desired analysis type from the submenu.

Note. If you have not saved your most recent changes to the currently 
loaded client file, the program will issue a message asking if you want to 
save changes to the analysis before closing the client file that is currently 
loaded.

If you select Cases & Years, the Main Worksheet opens, cleared of 
all data, with the default number of years and cases open, just as when 
you first start the program. (Selecting this option does the same thing 
as clicking the New icon  on the program toolbar.) For further 
instructions, see Cases and Years on page 129.

If you select Multi Nonresident, the Choose State Specification 
Assumptions dialog opens. For further instructions, see Multi 
Nonresident Analysis on page 139.
If you select Annualization, the Assumptions dialog opens. For 
further instructions, see Annualization Analysis on page 146.
If you select Minor Child, the Assumptions dialog opens. For further 
instructions, see Minor Child Analysis on page 153.

OPEN CLIENT FILE
Note. This topic applies to the desktop program edition only. If you are using 
the Web program edition and you want to view the related help topic, select 
Open Client File on the File menu and then click the help link on the Open 
Plan dialog.

To retrieve previously saved client data for review or updating, select Open 
Client File from the File menu. The Open Client File dialog looks similar to 
this:
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The Open Client File dialog allows you to specify the file name and location of 
the client file.

Caution! Opening a client file from disk overwrites the worksheet data 
currently in use. If you haven’t saved the analysis or the most recent changes, 
the program issues a message asking if you want to save the analysis or the 
changes. Select Yes to keep the current worksheet data. 

You can also rename or delete an existing client file from the Open Client File 
dialog. Just highlight the name of the client file that you want to rename or 
delete, then click Rename or Delete, respectively.

To use the toolbar to perform this function, click the Open icon on the main 
program toolbar.

CLOSING A CLIENT FILE
You do not need to take any extra steps to close a client file before starting a 
new client file or opening an existing client file. The program automatically 
closes the currently loaded client file when you select New Client File or Open 
Client File from the File menu.

LOADING CLIENT FILES LINKED TO OTHER APPLICATIONS
When you select Open Client File for a file that contains links to Excel, a 
Caution message appears, informing you that the client data contains links and 
prompts you to re-establish links.

Select Yes. The remote application(s) will load the linked file and then the 
focus will return to the program. The links should be re-established. Check to 
be sure that the links are hot.
If you do not want to have the links re-established at this time, select No. The 
message box will close. 

Click column header to 
change the sort of the list to 
that column, or to reverse 
the sort order of the items 
within the column.

Different versions of 
Windows may cause 
these buttons to vary.
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COMMON OPTIONS AND BUTTONS
Many of the File menu’s selections open a dialog that displays a host of 
buttons, icons, check boxes, text boxes, and/or list boxes. The dialogs have 
the same look and work in the same manner as each other and as dialogs in 
other Windows applications. Consequently, you will see the same button or 
item or layout on several dialogs. To avoid repeating the information in several 
places, the Open Client File section covers several items common to client file 
dialogs. These items will, therefore, only be mentioned again if the information 
differs for a particular dialog.
If the dialog contains diagonal hash marks in the lower-right corner, it can be 
resized — click and drag the dialog’s edges to resize the dialog.

Note. Your selections are persistent. The program will retain them the next 
time you access a File dialog.

FILE NAME
The File name field (along with the Look in field) controls which files are 
displayed in the Files list box. Long file names are supported (unless the files 
are stored on a Novell 16-bit network, which requires short (8-character) file 
names).
The portion of the entry before the period (.) specifies the file name, the portion 
after the period (.) specifies the file extension, and “*” denotes “all”. Therefore, 
*.it* will display in the Files list box all files with the extension it, itb, or itl. 
For example, to display all income files that begin with the letter “J”, place the 
insertion point before the “*”, type J, and press Enter. Before you press Enter, 
the File name field will look like this:

When you highlight or select a name from the Files list box, it will appear in 
this text box. If this is the file that you want to select, click the file again.
Rather than selecting a name from the list, you can type the file name directly 
into this box. For instance, to select the Joneses’ client file, type “Jones” and 
press Enter.

Note. Since the program automatically assumes the file extension is “it” when 
you are opening a client file, you need not enter the extension.

SHOW/HIDE PEEK FRAME
The Show/Hide Peek Frame icon opens (or closes) a frame in the dialog that 
contains information about the program file selected in the file list for easy 
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reference, such as date last revised, client name, number of cases and year, 
program version, and type and year of analysis.
Use this feature to help determine whether the selected file is actually the client 
file that you seek before opening it.

LOOK IN/SAVE IN
<<desktop program edition only>> 
This field displays the current drive or the current directory. Use this box to 
specify the directory that you want searched for files. The default directory is 
the directory where the program is installed.
When you first start the program, the default directory is the directory specified 
through the Default Directory command on the Options menu. Throughout 
the remainder of the session, the program defaults to the last accessed 
directory when you invoke the Open or Save As command.

FILES
This list box displays all files meeting the criteria specified by your selections 
for File name, Look in/Save in, and Files of type.
After selecting a file for use, the file name is displayed in the File text box. You 
can then click OK to complete the task.

Note. The list of files has the same right-click functionality as Windows 
Explorer: right-click on a file name to open, copy, delete, rename, etc., a file.

Right-click the list box but not a particular file to switch the View setting within 
this box between Large Icons, Small Icons, List, and Details.
When the View setting (accessed through a right-click on the list box) is set to 
Details, you can click the top of a column in the file list to change the sort of the 
list to that column, or to reverse the sort order of the items within the column. 

FILES OF TYPE/SAVE AS TYPE
<<desktop program edition only>>
As a default, this field contains Client Files (*.it) or the file name of the 
currently loaded file. 

HELP
Select Help to review specific information concerning the items on this dialog.

RIGHT-CLICK SHORTCUT COMMANDS
DELETE Right-click the file name, then select Delete from the shortcut menu to delete a 

selected file from disk.
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RENAME Right-click the file name, then select Rename from the shortcut menu. Type in 
the new file name.

VIEW Right-click within the list box (not on a file name), select View from the shortcut 
menu, then on the submenu, select Large Icons, Small Icons, List, or Details 
to change how the items in the list box are displayed. Your selection is applied 
to all File menu List dialogs and will remain persistent until you change the view 
again.

ARRANGE
ICONS

Right-click within the list box (not on a file name), select Arrange Icons from 
the shortcut menu, then on the submenu, select by Name, by Size, by Date, or 
by Type to change how the items in the list box are sorted. Auto Arrange is 
enabled when viewing Large or Small Icons.

COMPLETING THE TASK
OPEN Select Open when the name of the client file that you want to open (or save as, 

or delete) appears in the File name field. The command’s dialog will close and 
the program will run the command on the specified data file. If you are opening 
a file, you will be taken to the Main Worksheet.

CANCEL Select Cancel to close the command’s dialog without selecting a client file or 
running the command. The window or worksheet that you were in when you 
selected the menu command will reappear.

MERGE CLIENT FILE
Note. Invoking this command opens the Merge Client File dialog (desktop 
program edition) or the Merge Plan dialog (Web program edition). In either 
case, use the dialog to select the client file (plan) to be merged with the open 
file (plan).

The Merge Client File option allows you to combine the information saved in 
a file with the information in the currently open analysis. This feature helps 
bridge users incorporate yearly tax data into a single multi year historical 
planning file.

Note. This section utilizes the following terminology: The analysis open before 
the merge is the open analysis. The file that contains the data you want to 
merge into the open analysis is called the merge file. After the merge, the 
resultant file is the merged analysis. Files are merged in this manner: the 
program combines the open analysis with the merge file to produce the 
merged analysis, the analysis that is open after completing the merge. You 
may want to save the merged analysis with a different name to distinguish it 
from the open analysis.

When utilizing this command, we recommend opening the historical file first, 
then merge the single-year, single-case bridge data into it.
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If the merge file contains a year that is also part of the open analysis, you are 
prompted to either overwrite the overlapping year(s) or add the merge data as 
a new case(s) to the merged analysis.
If the merge file contains a year which is not part of the open analysis, the 
program automatically extends the range of years covered by the merged 
analysis.

The program allows for replicating data from existing cases into any new cases 
as well as replicating existing years into new years. The merge processes all 
worksheet data, including custom worksheets, individual activities and securi-
ties (these are discussed in detail below). Any linked information or state 
specification information is ignored in the merge file. Link information or state 
specification information is retained from the open analysis.

CUSTOM WORKSHEETS
If the open analysis and merge file have custom worksheets, all custom 
worksheet rows from both analyses are incorporated into the merged analysis.
If both the open analysis and merge file have a custom worksheet attached to 
the same row, the custom worksheet in the merged analysis will contain the 
custom worksheet rows from both analyses. The total row at the bottom of the 
custom worksheet in the merged analysis will have the combined total from 
both of the analyses.

If either the open analysis or merge file has a custom worksheet attached to a 
particular worksheet row but the other analysis does not, the custom worksheet 
will be attached to that same row in the merged analysis. However, if the 
analysis which did not have the custom worksheet has data in the row to which 
the custom worksheet is attached (the parent row), the program will create an 
extra row in the custom worksheet of the merged analysis with the row 
description “Merged Amount”.

INDIVIDUAL ACTIVITIES & SECURITIES
Individual Activities from the merge file are “matched” against the Individual 
Activities in the open analysis. Two activities match if their description and 
attributes as specified on the Individual Activities screen agree (i.e. Passive 
or MAPRRA, Active Real Estate etc.). If an activity from the merge file does not 
match an existing activity in the open analysis it is added as a new activity.

Securities from the Security Transaction Analyzer follow the same approach 
as above.

MERGE CONFLICTS & MERGE CONFLICT LOG
Data will not be merged if the worksheet row specified in the merge file has an 
active built-in worksheet from the same row in the open analysis. Data will also 
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not be merged if the row specified in the merge file would activate a worksheet 
in the open file and subsequently overwrite entries on access rows to this 
worksheet. The Merge Conflict Log can be reopened at any time from the 
Help menu and allows copy-and-paste capabilities, to assist you with finalizing 
the merge.
The program produces a Merge Conflict Log (accessible from the Help menu) 
that lists the data from the merge file that could not be merged. Data for the 
most recent merge is listed at the end of the log.

SAVE CLIENT FILE
Use the Save Client File command on the File menu to re-save a previously 
saved client file under the same name and location. The program overwrites 
the old client file.
If you select this command for a file that was not saved previously, the Save 
Client File As dialog (see the following section) opens automatically.

To use the toolbar to perform this function, click the Save icon on the main 
program toolbar.

SAVE VS. AUTO BACKUP

SAVE COMMANDS
When you save the current case data using the Save Client File or Save 
Client File As commands, you make the decisions concerning when to save 
the file, what file name to use, and for users of the desktop program edition 
only, where the file will be saved (the file is saved in a permanent file on disk). 
You would use the Save feature so that you can retrieve the client data in future 
sessions.

AUTO BACKUP COMMAND

Note. For users of the Web program edition, the way in which the backup (itb) 
file is handled is the same as in the desktop program edition but the actual itb 
file will be invisible to you.

When the current case data is saved using the Auto Backup feature on the 
Options menu, the program saves the data in a temporary file on disk, at a set 
time interval. The name and location of this temporary backup file is controlled 
internally by the program. You can change the time interval, or turn the Auto 
Backup feature on or off. The data is saved in a temporary file only if Auto 
Backup is on, or in the rare circumstances when the program encounters an 
unanticipated error condition. Use the Auto Backup feature as a temporary 
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backup to protect your current data against data loss in the event of a system 
failure.
We recommend using both Save and Auto Backup features together for 
maximum protection.

For additional information, see Auto Backup on page 241.

SAVE CLIENT FILE AS
<<desktop program edition only>>

Note. To view the related help topic in the Web program edition, select Save 
Client File As on the File menu and then click the help link on the Save Plan 
As dialog.

To save the current client data on disk for later use, select Save Client File As 
from the File menu. Use this command to:

assign a name and location to newly created client files
save a previously saved file under a new name or in a new location

overwrite the name and location of a previously saved client file with 
changed or new client data

When you select this command, the following dialog opens.
  

The program also opens this dialog if you select Save Client File from the File 
menu while in a previously unsaved client file.
Refer to Open Client File on page 58 for information on specific common 
items on this dialog.

SAVING LINKED CLIENT FILES UNDER A DIFFERENT NAME
You can save a client file containing links to Excel under a new name or to a 
new directory.

Different versions of 
Windows may cause 
these buttons to vary.
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FILE NAME
When saving a file under a new name, type the file name directly into this box. 
The list of file names in the Files: box will show you which names are already 
in use on the selected drive and directory. For instance, to save the client file 
under the name Jones, type “Jones” and press Enter.
The program automatically assigns “.it” as the extension. Additionally, the 
program will add the file name to the list of recently opened client files on the 
File menu, above the Exit command.
If you specify an extension other than “it”, the program will issue a program 
message stating that the extension must be “it” and will return the focus to the 
dialog so that you can revise your entry.

Note. Most Page Setup commands, the Client Letter, all Calculation 
Options and Assumptions are saved with the client file and will be loaded the 
next time you open the file.

If you specify a name that is already in use, the program issues a message 
asking if you want to replace the existing file. Click Yes to overwrite the existing 
data file or click No if you do not want to overwrite the existing file.
The focus will return to the program so that you can specify a different file 
name.

For additional information on the File name, or on the other items within this 
dialog, see Open Client File on page 58.

NEW CLIENT LETTER
To open a new client letter for the file, select New Client Letter from the File 
menu. Use the client letter feature to create a letter for the analysis file or a 
template to store for use with other analyses.

The Client Letter window opens. For more information on creating a new 
client letter, go to Starting a New Client Letter on page 216.

To use the toolbar to perform this function, click the New Client Letter icon on 
the client letter standard toolbar.

OPEN LETTER TEMPLATE
The Open Letter Template command allows you to select a template from the 
list of client letter templates that you saved previously. Invoking this command 
opens the Open Letter Template dialog. 

<<Web program edition only>> Use the template list on the Open Letter 
Template dialog to choose a template to be opened. 
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<<desktop program edition only>> 
Use the Open Letter Template dialog to locate the desired template folder and 
then select the name of the template to be opened. 

You can also rename or delete an existing template from the Open Letter 
Template dialog. Just right-click the name of the template that you want to 
rename or delete, then click Rename or Delete, respectively.
Note that if you save the client file after opening the letter template, the 
template letter replaces any existing client letter previously saved for the client 
file.
Once you select Open Letter Template, the following dialog opens.

If you do not see a template that you need, you can look in another drive or 
folder. Templates use the extension .itl (rather than .it, which is the extension 
for a client file).
In addition to opening a template, you can delete the default template here. 
The default template, ITDefaul.itl, is stored in C:\windows. Right-click the file, 
then select Delete from the shortcut menu to remove the default template.

To use the toolbar to perform this function, click the Open Letter Template 
icon on the client letter toolbar.

SAVE LETTER TEMPLATE AS
Note. Invoking this command opens the Save Letter Template As dialog. A 
few differences in this dialog exist between the desktop and Web program 
editions. These differences are indicated below.

Saves the current template for later use. Use this command to:
assign a name to newly created letter template
specify the location for the newly created letter template <<desktop 
program edition only>>

dOpenLetterTemplate.png

Different versions of 
Windows may cause 
these buttons to vary.
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save a previously saved template under a new name
save a previously saved template in a new location <<desktop program 
edition only>>
overwrite the name of a previously saved template with a changed or new 
letter
overwrite the location of a previously saved template with a changed or 
new letter <<desktop program edition only>>

<<desktop program edition only>> When you select this command, the 
following dialog opens.

<<desktop program edition only>> When saving a template, be sure to use 
an .itl extension. To save a template as the default template, change the path 
to c:\windows. Then enter ITDefaul.itl in the File name box.

<<desktop program edition only>> You can also rename or delete an exist-
ing letter template from the Save Letter Template As dialog. Just right-click 
the name of the template that you want to rename or delete, then click the 
Rename or Delete button, respectively. 

To use the toolbar to perform this function, click the Save Letter Template As 
icon on the client letter toolbar.<<desktop program edition only>> 

DEFAULT LETTER TEMPLATE
<<desktop program edition only>>
You can save an open template as the default template.

To save the currently-open template as the default template, save the file to 
c:\windows\itdefaul.itl. The program uses the default letter template to create 
letters for new client files and those files that do not already include letters.

dSaveLetterTemplateAs.png

Different versions of 
Windows may cause 
these buttons to vary.
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PAGE SETUP
The Page Setup command allows you to set up a report format suitable for 
presenting calculation results to your clients. When you select Page Setup 
from the File menu, the following dialog opens. (This dialog can also be 
accessed from the Print Preview window and the Print dialog.) The illustration 
below shows the initial default settings.

 

Use the Page Setup dialog to set up and/or modify the printed reports’ 
appearance, either for this session or for this and future sessions (when saved 
as the default). Your selections in the Page Setup dialog also control what 
information is included in the printed reports. For step-by-step instructions on 
printing reports, see Chapter 11.

Note. You can use the Print Preview feature to look at the reports before 
deciding whether you want to select any of these features. 

The check box settings on the left — plus the Fonts, Margins, Header/Footer, 
and Style settings — are saved with the client file. They will be loaded with the 
rest of the client data the next time you open the file.
After making your selections, click OK to accept your selections and to return 
to the originating worksheet. When you then print or preview the reports, you 
will see the changes you made reflected on the report pages.

dPageSetup.png
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PRINT
FILENAME Select this option to print the location and file name of the client file in the 

lower-left corner of each page. This makes it easier for you to locate a file when 
changes are required.

UNDERLINES When you select this option, the program puts single and double underlines at 
appropriate rows when printing a report either to a text file or to a printer. 
Reports without underlines look similar to a worksheet on the screen when the 
“underlines” color option is not selected.
For an example of a report that does not use underlining, see page 82. For an 
example of a report that uses underlining, see page 86.

NOTES When you select this option, the program prints the Notes attached to 
worksheet cells. Each Note prints immediately after the worksheet to which it 
applies, if the Note meets the following two conditions:

the worksheet to which it applies is printed, and
the row to which it applies is printed. If the row is blank and you’ve selected 
Don’t print empty rows (see below), the Note will not print.

CUSTOM
WORKSHEETS

When you select this option, the program prints all custom worksheets in the 
analysis that are attached to a built-in worksheet that is selected for printing. 
Each custom worksheet prints immediately after the worksheet to which it 
applies, if the worksheet to which it applies is printed.

TABLE OF
CONTENTS

Select this option to print, in page number order, a list of the worksheets and 
their corresponding page numbers.

This option is only available if the Page Numbers option is selected on the 
Page Style dialog. If you try to select the Table of Contents option without 
selecting the page numbering command, the program automatically selects the 
Page Numbers option on the Page Style dialog for you, after issuing a 
message to inform you of this action.

INDEX Select this option to print an alphabetical list of the worksheets and the 
corresponding page numbers on which they were printed.

This option is only available if the Page Numbers option is selected on the 
Page Style dialog. If you try to select the Index option without selecting the 
page numbering option, the program automatically selects the Page Numbers 
option on the Page Style dialog for you, after issuing a message to inform you 
of this action.

DON’T PRINT
EMPTY ROWS Select this option if you want the program to not print user-input rows which 

contain all zeros. If an input row contains all zeros and this command is 
selected, the program will not print the input row.
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The program will disregard entries in columns that have not been selected for 
printing.
When this option is not selected, the program prints the row whether or not it 
contains all zeros.

EMPTY
WORKSHEETS

When you select this option, the program does not print any selected 
worksheets that are filled with all zeros. The program issues a message stating 
that “Empty worksheets were not printed” after the reports have finished 
printing.
The program will disregard entries in columns that have not been selected for 
printing.
When this option is not selected, the program prints all selected worksheets 
whether or not they contain all zeros.

ONE WORKSHEET PER PAGE
When you select this option, each worksheet begins printing at the top of a new 
page. If you do not select this option, the program prints multiple worksheets on 
a page whenever possible.
Even when this option is not selected, the program will never start printing a 
worksheet in the middle of a page unless the entire worksheet will fit on that 
page.

USE DEFAULT HEADER/FOOTER IF NO OTHER 
HEADER/FOOTER

For bridge files, this option adds the default header/footer to the client file. 
(Bridge files are ASCII files created in a program other than the program, such 
as a tax preparation application, for the purpose of bringing client information 
into Income Tax Planner for analysis.) The default header/footer will print on 
all pages.
If not selected, the program will only print headers/footers for a bridge file if you 
enter them in the Header & Footer Lines dialog.

When selected, the program also adds the default header/footer to all client 
files that you open subsequently if they do not include header/footer 
information.

FONT
This selection allows you to control the appearance of the printed reports by 
choosing the fonts used on the reports.
Your selections in the Font dialog control the appearance of the font used on 
the printed reports. (The illustration on page 82 shows Arial, Regular, 12 point.) 
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The fonts listed will differ for you depending upon what fonts you have loaded 
for your printer.

Note. Your selections in the Font dialog affect only the fonts used on the 
printed reports. Your selections here do not affect the fonts used to display the 
worksheets on-screen. To change the screen fonts, use the Screen Font 
command on the Options menu.

Note. If you will not be printing the reports on your usual printer, you should 
specify the printer using the Print Setup dialog (accessed through the Printer 
command on the Print dialog, see “Printer” on page -97) before you complete 
the Font options. This is because the fonts that are available on one printer 
may not be available on another.

When you select Font, the following dialog opens (the contents of the Font, 
Font style, and other boxes will vary depending on which font types you have 
loaded). 

 

This dialog operates in the same manner as the Font dialogs in other Windows 
applications. See your Windows manual for specific information concerning the 
items in this dialog.

FONT ITEMS
Use the Font, Font style, and Size areas to specify your printer font selection. 
Your selection will be used in all areas of the printed reports.

SIZE You usually specify the size in a number of points. The larger the number of 
points, the larger the font.

dFont.png
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Some fonts accept point sizes in any whole number; some fonts accept point 
sizes only in even numbers. The program only supports whole numbers. If you 
enter a fractional number, the program issues an error message. 

COMPLETING
THE FONT

SETUP

Select OK to accept the selections within this box. The focus will return to the 
Page Setup dialog. The program will save the font selections for this analysis 
until you change the settings. 

SAVE AS
DEFAULT

To save your font selection(s) as the permanent default for future analyses, 
select the Save As Default button on the Page Setup dialog. 

 CANCEL Select Cancel to close the dialog without accepting any changes made during 
the session and to return to the Page Setup dialog.

Note. You can use the Print Preview feature to look at the reports before 
deciding whether you want to use or revise your font selection. You can use the 
Font icon on the Print Preview toolbar to return to the Font dialog and make 
changes. 

MARGINS
When you select this icon, the dialog shown below will appear. (Unless you 
previously adjusted the margins, the fields on this dialog will contain zeros.)

 

Use the Left, Right, Top, and Bottom list boxes to specify the margins for the 
printed reports, graph, and client letter. All items on the printed report, including 
the headers and footers, print in the body of the page bordered by the margins 
— nothing prints in the margin area itself. Use the Letter 1st Page Top list box 
to specify an increased top margin for the first page of the client letter.

Note. The margins you set do not affect the 1040–ES/1041–ES payment 
vouchers.

You can enter your own customized margin setting in inches or to the one-
thousandth of an inch. Or, you can use one of the preset margin selections, 
which range from 0 to 2 inches in 0.25 increments (see the right dialog, above).
Increasing the top margin will move the report down on the page. Increasing 
the bottom margin will move the footer lines up. The margins are taken into 
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account when you print to a text file that will be later loaded into text editing or 
word processing programs.

Note. When you try to print or preview the reports, the program issues an error 
message that asks you to adjust your entries if your margin settings are too 
large relative to the page size. 

CLIENT LETTER
AND GRAPH

Margins define the printable area of the client letter and graph. The client letter 
is further indented by any indent settings that you specify on the letter.

COMPLETING
THE MARGINS

SETUP

Select OK to accept the selections within this box. The focus will return to the 
Page Setup dialog. These selections will be saved for this analysis until you 
change the settings. 
To save your margin selection(s) as the default for future analyses, select the 
Save as Default button on this dialog. The Save as Default button on the 
Page Setup dialog does not save the margin settings. 
When you select Save as Default, the program issues the following message: 

 

The message will close automatically and the focus will return to the Page 
Setup dialog.
Select Cancel to leave this dialog without accepting any changes made during 
the session and to return to the Page Setup dialog.

Note. You can use the Print Preview feature to look at the reports before 
deciding whether you want to use or revise your margin selections. If you 
select Margins from the Print Preview window, you can click and drag margin 
indicators (displayed as black lines) to increase or decrease each margin. For 
more information, see page 85. 

COLUMNS
For a multi-case or multi-year analysis, the program allows you to select which 
columns you wish to print using this dialog. When you select this icon, a dialog 
similar to the one shown below opens:

 

msgInitializationFileSave.png

dPrintColumns.png
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An check mark in the box next to the column heading indicates that the column 
will be printed. As a default, the program selects all columns to print. The box 
is empty for items that have not been selected. The illustration shows that all 
columns for Case 1 and the last column for Case 2 have been selected to print.
See Hide Columns Command on page 119 for additional information about 
hiding and printing columns.

COMPLETING
THE COLUMN

SELECTION

Select OK to accept the selections within this dialog. Or, select Cancel to leave 
this dialog without accepting any changes made during the session. 
The focus will return to the Page Setup dialog.

Note. You can use the Print Preview feature to look at the reports before 
deciding whether you want to use or revise the columns chosen. 

HEADER/FOOTER
Use Header/Footer to customize client reports by including a client’s name 
and additional lines of header text (for example, your firm’s name and 
address). You can also use the Header/Footer dialog to include footer text (for 
example, the assumptions used in the analysis, or a Circular 230 disclaimer).
The header and footer settings are saved with the client file. When you select 
this icon, the following dialog opens:

 

Note. Header and footer lines can contain up to 80 characters, including 
letters, numbers, spaces, and any other characters on the keyboard.

Header and footer text will word-wrap as you enter it. However, the wrapping 
will be different on the actual report, since the page is wider. 
It will also be centered, left to right, on the report. You can separate paragraphs 
by pressing Enter.

The program centers the header at the top of every page, below the top 
margin. The client’s name appears below the last line of the header text, 

dHeader&FooterLines.png
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immediately above the worksheet title. The program centers the footer at the 
bottom, above the bottom margin.
You can save the header and footer lines to be used as defaults on all your 
printed reports. 

ENTERING THE HEADER AND FOOTER TEXT
To specify header and footer lines, take the following steps:
1. Enter the client’s name on the first line, then press Enter. The cursor 

moves to the first Header Line. 

Note. If you entered the client’s name on the Assumptions dialog, the 
Client Name box will contain this entry. Any entry in the Client Name box 
overwrites the Client Name entry in the Assumptions dialog for all 
purposes, including insertion in the client letter.

2. Enter the desired header and footer text in the appropriate boxes.

3. After completing the box, select OK to return to the Page Setup dialog. 
The text that you entered will print out on all client report pages until you 
change it, load a new client file, clear worksheets to begin a new case, or 
quit the program.

DEFAULT HEADERS AND FOOTERS
SAVE AS
DEFAULT

To store the header and footer lines as the program’s default configuration, 
click Save as Default instead of OK after entering the text. You may find it 
convenient to store certain lines of text, such as your firm’s name and address, 
in the default configuration, and add additional lines as needed for individual 
client reports. 

When you select Save as Default, the program issues the message, informing 
you that the headers and footers are saved to the initialization file. The 
message closes automatically and the focus returns to the Page Setup dialog.

RESTORE
DEFAULT

Click Restore Default to return the text in the header and footer lines to the 
most recent default settings. This is a quick way to restore the default 
headers/footers when you no longer want to use the current header/footer 
information.

COMPLETING THE HEADERS AND FOOTERS SETUP
Select OK to accept the selections within this dialog. The focus returns to the 
Page Setup dialog. These selections will be saved for this analysis until you 
change the settings. To save your headers and footers as the default for the 
current analysis and future analyses, select Save as Default on the Header & 
Footer Lines dialog. The focus returns to the Page Setup dialog. The Save as 
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Default button on the Page Setup dialog does not save the headers and 
footers settings for future analyses; it saves the settings with the client file.
Select Cancel to leave this dialog without accepting any changes made during 
the session and to return to the Page Setup dialog. 

STYLE
This selection allows you to select from several style options to customize the 
reports printed for your clients. You can choose from several preset styles or 
select from the various style options to create a default style of your own. (The 
selections made on this dialog are not used for the client letter.) The Style 
settings are saved with the client file. When you select Style, the following 
dialog opens. This illustration shows the initial default settings.

STYLE OPTIONS
Use the style options to specify which worksheet elements you want to 
highlight and how you want them highlighted.

The program displays the current selections in a preview sample worksheet 
area at the bottom of the dialog. The preview is an approximation of the 
selected settings. Your font, header, and footer selections are not reflected in 
the preview.

FRAME
HEADINGS

Select this option to print a frame (border) around the column headings. 

FRAME
CAPTIONS

Select this option to print a frame (border) around the row captions (or row 
titles).

dPageStyle.png

Preview window 
approximates the 
selected style settings
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FRAME CASES Select this option to print a frame (border) around each set of case/year 
columns. (For example, if you have 2 cases for years 2020 and 2021, the 
program adds a border that frames all columns within Case 1 and another 
border that frames the columns for Case 2.)

FRAME KEY
ROWS

Select this option to print a frame (border) around the key rows.

SHADE
HEADINGS

Select this option to print the column headings in a shaded box

SHADE
CAPTIONS

Select this option to print the row captions (row titles) in a shaded box.

SHADE CASES Select this option to print each set of case/year columns in a shaded box. See 
Frame Cases, above.

SHADE KEY
ROWS

Select this option to print the key rows in a shaded box.

BOLD
HEADINGS

Select this option to print column headings in a bold font.

BOLD CALC
ROWS

Select this option to print calculated rows in a bold font.

BOLD TITLES Select this option to print worksheet titles in a bold font.

DOUBLE SIZE
TITLES

Select this option to print the worksheet titles in a font twice the size of the font 
used for the rows and captions. If not selected, the program uses the same font 
size for the worksheet titles as is selected for the worksheet rows. 

LINE UNDER
TITLES

Select this option to print a bold line that separates the worksheet title from the 
rest of the worksheet.

DATE AND TIME Select one or both of these options to print the current date and time on each 
page. If you select both date and time, the information displays in the following 
format: 12–31–02 : 12:10 p.m. Then select where on the page you want the 
date and/or time placed:

Left, Center, Right — Allows you to choose the alignment of the date and time 
on the report page. 
Top, Bottom — Allows you to choose the placement of the date and time on 
the report page. 

PAGE
NUMBERS

Select this option to print page numbers on each page. Then select where on 
the page you want the page numbers placed:
Left, Center, Right — Allows you to choose the alignment of the page 
numbers on the report page. 
Top, Bottom — Allows you to choose the placement of the page numbers on 
the report page. 
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PRESET STYLES
Offers several pre-defined styles from which you can choose that the program 
will use when printing worksheets. These style sets contain style settings for 
each of the Page Style options. The pre-defined style sets provide a fast and 
convenient method of establishing program styles. When you select a preset 
style set, your selection is demonstrated in the preview sample worksheet.

PRESET STYLE
# 1

Places the date and time in the upper-left corner and the page numbers in the 
upper-right corner of the reports.

PRESET STYLE
# 2

Frames and shades the headings and the key rows. Bolds the headings, 
calculated rows, and worksheet titles. Doubles the size of the worksheet titles 
and separates the worksheet title from the worksheet rows with a line. Places 
the date and time in the upper-left corner and the page numbers in the upper-
right corner of the reports.

PRESET STYLE
# 3

Frames and shades the headings, row captions, and the key rows. Also frames 
the case columns. Bolds the headings, calculated rows, and titles. Doubles the 
size of the worksheet titles and separates the worksheet title from the 
worksheet rows with a line. Places the date and time in the upper-left corner 
and the page numbers in the upper-right corner of the reports.

PresetStyle1.png

PresetStyle2.png
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PRESET STYLE
# 4

Frames the headings, row captions, case columns, and the key rows. Bolds 
the headings, calculated rows, and titles. Doubles the size of the worksheet 
titles and separates the worksheet title from the worksheet rows with a line. 
Places the date and time in the upper-left corner and the page numbers in the 
upper-right corner of the reports.

PRESET STYLE
# 5

Frames and shades the headings, row captions, case columns, and the key 
rows. Bolds the headings, calculated rows, and titles. Doubles the size of the 
worksheet titles and separates the worksheet title from the worksheet rows 
with a line. Places the date and time in the upper-left corner and the page 
numbers in the upper-right corner of the reports.

CURRENT
DEFAULTS

Allows you to restore the style settings previously saved as the default settings.

COMPLETING
THE STYLES

SETUP

Select OK to apply your style selections to the current session of the program. 
Your new style selection remains in effect until you quit the program (or until 
you change it, whichever is first) unless you save the selection as the default.

PresetStyle3.png

PresetStyle4.png

PresetStyle5.png
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Note. <<desktop program edition only>> When you install a program 
update, the program uses the default style set from the earlier version as the 
default styles unless you change the default settings.

To save your page style selection(s) as the permanent default for future 
analyses, click the Save as Default button. The Save as Default button on the 
Page Setup dialog does not save the style settings.
Select Cancel to leave this dialog without accepting any changes made during 
the session and return to the Page Setup dialog.

COMPLETING THE PAGE SETUP
 OK Select OK when you’ve finished setting the page specifications. The Page 

Setup dialog will close and your specifications will be saved for this and all 
other new analyses in this work session. The program returns the focus to the 
worksheet that had the focus before you selected Page Setup. Margins, 
printer font, headers and footers, styles, as well as all Page Setup options are 
saved with the client file.

CANCEL Select Cancel to close the Page Setup dialog without saving any of your 
selections. The window or worksheet that had the focus before you selected 
Page Setup will reappear.

 SAVE AS
DEFAULT

To save your Page Setup selections as the default for new analyses, select 
Save As Default on this dialog. The program issues a message stating that the 
page setup was saved in the initialization file. The message closes automati-
cally, the changes are saved in the it.ini file, and the focus returns to the 
window or worksheet that you were in when you selected Page Setup.
The Save as Default button on the Page Setup dialog saves all your selec-
tions in the check boxes on the left, as well as the fonts settings. To give you 
the maximum flexibility when choosing your defaults, the program allows you 
to selectively save the defaults for headers/footers and margins separately. 

ITEMS SAVED
WITH CLIENT

FILE

The check box settings on the left side, plus the Font, Margins, Header/Footer, 
and Style settings, are saved with the client file. They will be loaded with the 
rest of the client data the next time you open the file.

PRINT PREVIEW
Print Preview allows you to review each page of the reports on-screen before 
printing.

Note. If you haven’t already selected at least one worksheet to print (from the 
Print command of the File menu), the program automatically selects all active 
worksheets (including those worksheets automatically activated by the 
program) for previewing.
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The following window illustrates the Zoom Out mode, which is the default 
Zoom mode. 

  

The Print Preview window has a series of icon under the Title Bar. You can 
use these icon:

to display or hide the Worksheet List
to go to the next or previous page of the report
to change the report configuration for the Security Transaction Analyzer 
(if you accessed Print Preview through the Analyzer) 
to zoom in or out

to change the page setup, fonts, and/or margins 
to go to the Print dialog
to print the page displayed in the Print Preview window

to close the Print Preview window 
For step-by-step instructions on printing reports, see Chapter 11.

PrintPreviewS
cenario1.png
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To use the toolbar to perform this function, click the Print Preview icon on the 
toolbar of the main program.

NUMBER OF
REPORT

PAGES

The program displays the first page of the report immediately upon opening the 
Print Preview window. The program counts the number of report pages 
included in the report and displays the current page number and the total 
number of pages at the bottom center of the Print Preview window.

HIDE/SHOW LIST
This option allows you to quickly hide or show the Worksheet List in the Print 
Preview window. If the Worksheet List is displayed, the icon will display the 
hide option. If the Worksheet List is hidden, the icon will display the show 
option.

NEXT
To preview the report page following the current report page, select Next. The 
program will display the next page of the report.
At the bottom center of the Print Preview window is a page status message 
(for example, on the illustration on page 82 this status message was “Page 1 
of 22”, indicating that there are 21 additional report pages that you can review 
using the Next command). 
If this is the last page of the report (following the example, the status line would 
display Page 22 of 22), or if there are no more pages selected, the Next icon 
will be dimmed. 

PREVIOUS
To preview the report page preceding the current report page, select Previous. 
The program will display the previous page.

If this is the first page of the report (e.g., the page status message would 
display Page 1 of ...), the Previous icon will be dimmed. 

ZOOM IN/OUT
There are two zoom modes, Zoom In and Zoom Out. The Zoom Out mode is 
the default mode, illustrated on page 82, and it displays an entire page of the 
report within the Print Preview window. This mode allows you to see the full 
effect of your header, footer, and margins selections. When the mode is Zoom 
Out, the program shrinks the size of the displayed page to fit within the window.
When you click the Zoom In icon, the program enlarges the display of the 
report so that you can read the report text and see the report up close with your 
selected page setup options. Zoom In magnifies the displayed page so that it 
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is larger that the actual printed report. The program will display as much of the 
report as possible within the window.

PRINT
When you select the Print icon from the Print Preview window, the following 
dialog opens:

 

On this dialog you can select which worksheets to print, specify the number of 
copies, choose a different printer, save a custom default print set, and hide or 
show the Worksheet List. You can access Page Setup and Print Preview and 
specify a destination for your printer output as detailed below.

PRINTER To send the selected report(s) to the printer, make sure that the Printer radio 
button is selected, then select Print.

TEXT FILE To send the selected report(s) to a text file for subsequent editing in another 
program, select the Text File radio button and then select Print.

EXCEL FILE To send the selected report(s) to a file for subsequent editing in Excel, select 
the Excel File radio button and then select Print.

LOTUS 1-2-3
FILE

To send the selected report(s) to a file for subsequent editing in Lotus 1-2-3™, 
select the Lotus 1-2-3 File radio button and then select Print.

ADOBE
ACROBAT FILE

To send the selected report(s) to an Adobe® Acrobat® file, select the Adobe 
Acrobat File radio button and then select Print.
For further discussion concerning this dialog and its corresponding options, 
see Print on page 89.

PRINT PAGE
When you select Print Page from the Print Preview window, the page that is 
displayed in the Print Preview window is printed. 

dPrint.png
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SETUP
When you select the Setup icon from the Print Preview window or the Print 
dialog, a dialog similar to the following opens: 

 

Note. This dialog is also called by the Page Setup command on the File menu. 
You would usually only use this dialog from the Print Preview window to adjust 
the settings for a particular report.

After making your selections, choose OK to accept your selections and to 
return to the Print Preview window. The changes you made are immediately 
reflected on the displayed report page in the Print Preview window. See Page 
Setup on page 69.

FONT
When you select the Font icon from the Print Preview window or the Page 
Setup dialog, you will see the Font dialog discussed on page 72. Any font 
selection changes are immediately reflected on the displayed report in the 
Print Preview window. See Font on page 71.

MARGINS
When you select the Margins icon from the Print Preview window, the 
program adds margin handles to the image in the Print Preview window:

dPageSetup.png
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Margin handles are vertical and horizontal bars terminated by solid black 
boxes. You can click on a bar and drag it to increase or decrease a margin. To 
increase the top margin: click and drag the top horizontal margin handle down 
to the desired position (the arrow pointer changes to a double-pointed arrow 
when the cursor is positioned to select the margin handle). A double gray bar 
appears when you select a margin handle to show the margin handle’s position 
as you move it. When you’ve placed the handle where you want it, release the 
mouse button. The following illustration shows the top margin handle being 
moved to increase the current margin setting.

 

When you release the mouse button, the program immediately resizes the 
margin on the displayed page. To see the results of your changes reflected on 
the displayed page without the margin handles, re-select the Margins icon on 
the Print Preview window. The margin handles will disappear.

PrintPreviewScena
rio1b.png

PrintPreviewScenario1c.png

Click and Drag
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Note. You can use margin handles along with the Margins dialog (accessed 
through the Setup icon and discussed on page 73) to first approximate the 
margins’ placement, and then to specify the exact margin widths, by following 
these steps:

 

1. Select Margins from the Print Preview window so that the margin handles 
are visible. Then click and drag the handles to approximately where you 
want the margins.

2. Select Setup from the Print Preview window to open the Page Setup 
dialog.

3. Select Margins from the Page Setup dialog to open the Margins dialog.
4. Change the widths in the drop-down text boxes to refine the settings.
5. To accept your changes and see the new margins displayed in the Print 

Preview window, select OK from the Margins dialog, then select OK from 
the Page Setup dialog. The margin handles will move and the page will be 
refreshed to reflect your changes.

PrintPreviewSce
nario1d.png
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Note. The margins you set do not affect the 1040-ES/1041-ES payment 
vouchers.

For additional information on Margins and the Margins dialog and its options, 
see Margins on page 73.

CLOSE
When you select the Close icon from the Print Preview window, this window 
closes and the focus returns to the previous worksheet.

Your worksheet selections will remain selected for this client file: 
for future sessions of the program if you save the client data before leaving 
the analysis
for the current program session only if you do not save the client data 
before leaving the analysis 

until you erase worksheets (thereby starting a new file)
Your page setup selections, excluding Margins and Headers and Footers, will 
remain selected:

for new analyses only in future sessions of the program if you selected 
Save as Default where available 
for the current and future program sessions (for this analysis only) if you do 
not select Save as Default where available but do save the client file
until you erase worksheets (at which point new analyses will use the 
default settings and retrieved analyses will use either the default settings 
or the settings previously saved with the file)

Your selections for Headers and Footers and Margins will remain selected:
for future sessions of the program if you selected Save as Default where 
available (for new analyses or retrieved analyses using the default 
settings)
for the current and future program sessions (for this analysis only) if you do 
not select Save as Default where available but do save the client file

until you erase worksheets (at which point new analyses will use the 
default settings and retrieved analyses will use either the default settings 
or the settings previously saved with the file)

The reports are not printed when you select Close from the Print Preview 
window. You can print the selected reports by completing the steps discussed 
in Print To on page 92.
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PRINT
The Print dialog allows you to select the worksheet range, to select the type of 
output, and to specify the number of copies to be printed. You can also access 
the Page Setup, Analyzer Setup, Print Setup, and Print Preview dialogs 
from here.
When you select Print from the File menu, the Print dialog opens.

The Setup and Preview commands on this dialog are the same as the ones 
mentioned earlier under Page Setup and Preview. Using the Printer 
command on this dialog, you can specify special print options such as 
landscape paper, paper size, etc. You can also print worksheets to disk for 
subsequent use with word processing or spreadsheet programs.

For step-by-step instructions on printing reports, see Chapter 11.

To use the toolbar to perform this function, click the Print icon on the main 
program toolbar. Or, click the printer icon located to the left of the desired title 
in the Worksheet List.

WORKSHEET RANGE

The commands in this section allow you to select a single worksheet or a range 
of worksheets to print.

dPrint.png

dPrintWorksheetRange.png
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CURRENT WORKSHEET
The Current Worksheet option allows you to quickly print the worksheet that 
has the focus. This worksheet’s name is noted after the option name. The 
program ignores items selected in the Worksheet List when this option is 
selected. To select this option, click this radio button. The worksheet will print 
when you select Print.

ALL ACTIVE WORKSHEETS
The All Active Worksheets option allows you to print any worksheet that is 
active and contains user entries, as well as the output worksheets. You cannot 
change the list of worksheets to be printed while this option is selected. 

HIDE/SHOW WORKSHEET LIST
This option allows you to quickly hide or show the Worksheet List in the 
program window. If the Worksheet List is displayed, the icon will display the 
hide option. If the Worksheet List is hidden, the icon will display the show 
option.

SELECTED WORKSHEETS
Choosing Selected Worksheets (by clicking on the Selected Worksheets 
radio button) tells the program to print worksheets that are selected in 
Worksheet List.

This option is dimmed when you access the Print dialog from the Security 
Transaction Analyzer worksheet.

SELECT ALL
ACTIVE

You can use this option to quickly select all active worksheets to print. When 
this command is selected you can freely add or remove worksheets to be 
printed from the Worksheet List by clicking the printer icon located next to the 
desired worksheet title. The printer icon next to the worksheet title is dimmed 
for worksheets not selected for printing. This option is enabled only if Selected 
Worksheets is selected.

DESELECT ALL The Deselect All command is a quick way to clear the Worksheet List of 
worksheet print selections. When you select this option, all printer icons next to 
the worksheet titles in the Worksheet List are dimmed. If you do not select any 
worksheets and subsequently try to print selected worksheets, the program 
issues a message stating that no worksheets were selected and the focus 
returns to the Print dialog. This option is enabled only if “Selected Worksheets” 
is selected. 

SAVE AS
DEFAULT

When you select Save as Default and items in the Worksheet List have been 
selected, the program saves the current list of worksheets and the current 
settings for the 1040–ES Payment Vouchers, W-4 Worksheet, Client Letter, 
and Graph. If All Active Worksheets has been selected and you select Save 
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as Default, the program saves the All Active Worksheets setting plus the 
current settings for 1040–ES Payment Vouchers, W-4 Worksheet, Client 
Letter, Graph, and resident state specifications. If Select All Active has been 
selected and you select Save as Default, the program saves the current 
selection settings for all worksheets, 1040–ES Payment Vouchers, W-4 
Worksheet, Client Letter, Graph, and resident state specifications. The 
program will use the saved settings whenever you create a new client file or 
open an existing client file that does not contain a list of worksheets to be 
printed. 

RESTORE
DEFAULT

When you select Restore Default, the settings that were last saved by the 
Save as Default command are restored. If no settings have been saved yet, 
then no worksheets are selected by default and a message indicating this is 
issued when you try to print. However, when you close then reopen the Print 
dialog the program selects All Active Worksheets for printing.

PRINTING SUPPORTING DOCUMENTS
Using the Worksheet List, select the supporting document you want printed just 
as you would worksheets. Note that these documents may only be printed or 
(except in the case of the 1040–ES/1041–ES Payment Voucher) saved in an 
Adobe Acrobat file.

Client Letter — The client letter always prints first, before all other pages.
1040–ES/1041–ES Payment Voucher — The 1040–ES Payment Vouch-
ers will not appear in the Worksheet List unless the Withholding, 
Estimated and Penalty worksheet has been added to the analysis and 
the current tax year is included in the analysis. See 1040-ES and 1041-ES 
Payment Vouchers on page 189.

W-4 Worksheet
Graph — When you first select the printer icon, the program will place the 
Graph before the client letter and all worksheets when it is printed. (“Before 
Worksheets” appears in parentheses after Graph.) 

Click the printer icon a second time to have the Graph placed after the 
client letter and worksheets. (“After Worksheets” appears in parentheses 
after Graph.)

COPIES
The program defaults to sending one copy of the reports to the printer. To print 
multiple copies, click the Copies drop down list box and select the desired 
number or click the current number of copies and enter any number from 1 to 
99.
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PRINT TO

The options in this section allow you to send the reports directly to the printer 
or to create a text, spreadsheet, or Adobe Acrobat file containing the text of the 
reports which you can load into your word-processing, spreadsheet, or Acrobat 
Reader program for further editing or review. 

You can click one of the radio buttons in this section to select the output 
method that you want.
Before actually printing the reports, you may want to modify or customize the 
reports’ appearance using the Page Setup dialog (select the Setup icon to go 
directly to Page Setup). For details on the Page Setup dialog, see Page Setup 
on page 69. 

PRINTER
To send the worksheets in report format to a printer, make sure that your printer 
is turned on and is ready to print and that the Printer radio button is selected. 
Then click Print.

CANCELING PRINT
After you select the Print button, a message opens which displays the number 
of the page being printed. The message also contains a Cancel button; click 
this button to cancel printing. The focus returns to the Print dialog so that you 
can change your print selections or select Close.
After printing, the program returns to the worksheet that you were in when you 
selected the Print command.

TEXT FILE
To print the worksheets in report format to a text file, select the Text File option 
by clicking in the radio button. Then click the Print button. As the program 
prints each page to the text file, it indicates in the title bar which page is 
printing.

You can edit this text file later using either a text editor or word processing 
program. The text file will be affected by the margins you specified in the Page 
Setup dialog (that is, the program adds spaces at the beginning of each text 
line in proportion to the selected margins). 
After you select the Print button, the following dialog opens:

dPrintPrintTo.png
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Most items in this box operate in the same manner as their counterparts in the 
Open Client File and Save Client File As dialogs. Refer to these sections for 
general information on the items in this dialog (page 58 and page 65, 
respectively).
The previous illustration shows what you would see if you:

have the Jones client file open and
had selected print to Text File for the Jones’ printed reports
had previously printed reports for Smith to a text file named Smith.itp.

PRINT FILE
NAME

The program automatically places the current file’s file name in the File Name 
box, followed by itp as the extension. The program has placed Jones.itp in the 
File Name box for the client data file named Jones.it.
If this is a new file that has not yet been saved, *.itp will appear in the File 
Name box.
You can use any file extension for the text file except .it and .itb. 

If you specify only a file name and do not specify any extension, the program 
saves the text file under the name you entered, adding the itp extension 
automatically, and returns the focus to the previous worksheet.

OVERWRITING AN EXISTING PRINT FILE
If you enter (or select from the Files list box) a file name that already exists, 
(for example if, in another session with the Jones’ client file, you clicked the 
Save button to select the Jones.itp file name), the program issues a caution-
ary message to remind you that there is already a file using the name you 
selected.

Select OK if you want the program to replace the existing file with the 
current client file’s reports. The program will overwrite the file, close the 
message box, and return the focus to the previous worksheet.

dPrintToTextFileAs.png

Different versions of 
Windows may cause 
these buttons to vary.
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Select Cancel if you want to preserve the existing text in the file. The 
program will close the message box and return the focus to the Print to 
Text File As dialog so that you can specify a new file name.

COMPLETING
THE PRINT TO

TEXT FILE
TASK

After you have specified a valid file name, click Save. The program will place 
the text of the worksheet reports in the specified file and return the focus to the 
previous worksheet. As it creates the text file, the dialog’s title bar displays the 
number of the page being created.

If you do not want to print to a text file at this time, select Cancel. The program 
will return to the Print dialog. 

EXCEL FILE
This command operates in the same manner as the Text File command, 
except that the default file name extension for Excel files is .txt and the 
selected margins have no effect on the output file. For detailed information, see 
Text File on page 92.

LOTUS 1-2-3 FILE
This command operates in the same manner as the Text File command, 
except that the default file name extension for Lotus 1-2-3 files is .prn and the 
selected margins have no effect on the output file. For detailed information, see 
Text File on page 92.

ADOBE ACROBAT FILE
This command operates in the same manner as the Text File command, 
except that the default file name extension for Adobe Acrobat files is .pdf. For 
detailed information, see Text File on page 92.

SETUP
If you select Setup from the Print dialog, the program opens the Page Setup 
dialog. For more information, see Page Setup on page 69. 

ANALYZER SETUP
When you select the Analyzer Setup button from the Print dialog, the program 
opens the Transaction Analyzer Setup dialog. This dialog allows you to 
change the Security Transaction Analyzer worksheet’s printed report config-
uration and set up a report format suitable for presenting security transaction 
results to your clients.
You can also access the Transaction Analyzer Page Setup dialog from the 
Print Preview window (when you access Print Preview from the Security 
Transaction Analyzer’s Print command).
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Use the Transaction Analyzer Page Setup dialog to set up and/or modify the 
printed report’s appearance, either for this session or for this and future 
sessions (when saved as the default). Your selections in the Transaction 
Analyzer Page Setup dialog also control what information is included in the 
printed reports, such as the years.
The items on the program’s Page Setup dialog (such as font, margins, and 
headers and footers) are also used to format the printed Security Transaction 
Analyzer report.

The check box settings on the right side of this dialog are saved with the client 
file. They will be loaded with the rest of the client data the next time you open 
the file. The year selections are not saved with the client file.

Note. You can use the Print Preview command to look at the reports before 
deciding whether you want to select any of these features.

If you select all the options, the printed report will most closely resemble the 
federal Form 1040, Schedule D.

YEARS TO INCLUDE:

FIRST/LAST
From the drop-down list boxes, select the first and last years that you want 
included on the printed report. The program defaults to the first and last years 
of the analysis. Changes to these settings are saved with the client file, but can 
be lost when you change the number of years or starting years in the analysis, 
the defaults to the first and last years of the analysis are restored.

NEW PAGE FOR EACH YEAR
Select this option if you want the program to print all transactions for each year 
sold on a separate page. If this option is not selected, the program prints all 
years together on the report in chronological order by date sold.

SEPARATE SHORT AND LONG
If you select this option, the program prints all short-term transactions on the 
report before printing the long-term transactions.

dTransactionAnalyzerPageSetup.png
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SUPPRESS “OTHER” COLUMNS
The printed report includes the following columns: 

Total Short-Term
Total Long-Term

28% Rate Long-Term
5-Year Gain Purchased Before 2001
Other Long-Term

Select the Suppress “Other” Columns option to exclude the Other Long-Term 
column from the printed report. The Total Long-Term column is the sum of the 
28% Rate Long-Term, 5-Year Gain Purchased Before 2001, and the Other 
Long-Term columns.

SUPPRESS ZERO COLUMNS
The printed report includes the following columns: 

Total Short-Term

Total Long-Term
28% Rate Long-Term
5-Year Gain Purchased Before 2001

Other Long-Term
Select the Suppress Zero Columns option to exclude columns that contain 
only zeros from the printed report. 

CASES This option opens the Print Cases dialog, which allows you to select whether 
transactions are printed depending upon which cases they are included.

When a transaction is not included in any case, the program prints it unless you 
choose to not print at least one case in this dialog. This dialog is not available 
for Annualization analyses. You must choose to print at least one case of the 
analysis.

SAVE AS
DEFAULT

This option saves your Transaction Analyzer Page Setup selections as the 
default for new analyses. This command saves all your selections in the check 
boxes on the right. 

dPrintCases.png
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PREVIEW
When you click the Preview button on the Print dialog, the program opens the 
Print Preview window (illustrated on page 82). When this window is open, you 
can view the selected worksheet report pages one at a time.

To select or deselect worksheets, click the worksheet’s printer icon on the 
Worksheet List (if the Worksheet List is not visible, click Show List).
To print the worksheets after previewing them, click the Print button.

For detailed step-by-step instructions, see Chapter 11.
See Print Preview on page 81 for information about the Print Preview window 
and its available commands.

PRINTER
Use the Printer command on the Print dialog to select or specify the printer to 
which you will send the reports. When you select this button, a Print Setup 
dialog similar to the following opens (the actual printer information will differ 
based on your printer configuration): 

 

ORIENTATION Select Portrait or Landscape orientation. Portrait orientation is taller than it is 
wide. Landscape orientation is wider than it is tall.

Note. Because the Security Transaction Analyzer worksheet reports can be 
quite wide, you may want to print them separately from the other worksheets, 
using Landscape orientation. See the Printing the Security Transaction 
Analyzer on page 290.

This is the same Print Setup dialog as that used for other Windows programs. 
Refer to your Windows documentation for more information. The dialog picks 
up the information from your current Windows printer setup.

dPrintSetup.png
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Note. If you are not printing the reports on your usual printer, you should 
specify the printer using the Print Setup dialog before you complete the other 
Page Setup options. This is because the fonts that are available on one printer 
may not be available on another.

Note. Using the Specific Printer list box to select a different printer changes 
the default printer for the program and for all other Windows programs using 
the Windows default printer.

COMPLETING THE PRINT TASK
PRINT After selecting the worksheet(s) to be printed, the output destination, the page 

setup, and the printer, click the Print button to send the reports to a printer or 
create a file on disk.

CLOSE To leave the Print dialog without printing your selections or creating a file, 
select the Close button. Your worksheet and page setup selections for this 
client file will remain selected:

for future sessions if you save the client data before leaving the analysis
for the current session only if you do not save the client data before leaving 
the analysis 

until you erase worksheets
The reports are not printed when you select Close. You can print the selected 
reports by completing the steps discussed in Print To on page 92.

SEND TO
<<desktop program edition>> This submenu allows you to send an analysis 
as an IT attachment or as a PDF attachment.
<<Web program edition>> This submenu allows you to send an analysis as 
a PDF attachment. (This feature is available only if your Subscription Adminis-
trator has enabled it.) After the email is sent, Income Tax Planner presents a 
dialog asking if you also want to save the PDF file to the client's Documents tab 
in the Web program (on the Manage Client page).

Caution! Email is not a secure method for transmitting data over the Internet. 
Before sending an analysis as a PDF attachment, be sure you are willing to 
accept the security risks associated with sending confidential client data in 
email.

SENDING AN ANALYSIS AS AN IT ATTACHMENT
<<desktop program edition only>>
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The Send as IT Attachment command automatically opens your default email 
program, attaching the file analysis to a new message, ready to be sent.
If you have unsaved data in your analysis, the program offers you the chance 
to save your file.

SENDING AN ANALYSIS AS A PDF ATTACHMENT
The Send as PDF Attachment command opens the Send dialog, allowing you 
to create and save a client analysis as a PDF file. Once the PDF file is saved, 
the program opens your default email program, attaching the PDF file to a new 
message.
When you invoke this command, the process of creating a PDF file begins: 
unless deactivated, the Page Style dialog appears. After selecting a page 
style, click OK. 
Next, the Send dialog appears, where you can select the worksheets and print 
attributes to include in the PDF attachment.

When the Send icon is clicked, the program displays the Attach As Adobe 
Acrobat File As dialog, where you specify the filename of the PDF attach-
ment. When you click the Save button, the program creates the PDF file and 
automatically opens your default email program with the PDF file attached to a 
new message, ready to be sent.
<<Web program edition>> After the email is sent, Income Tax Planner presents 
a dialog asking if you also want to save the PDF file to the client's Documents 
tab in the Web program (on the Edit Client page).
See “Send Dialog Options” in Help.

ERASE WORKSHEETS
Use the Erase command to discard all current tax data in memory so that you 
can enter and calculate new data. The selections on this menu also return all 
system options (such as margins, fonts, screen colors, etc.) to the default 
settings currently in effect for your system. All client assumptions will remain in 
memory until you select New Client File from the File menu.

When you select Erase Worksheets on the File menu, the following command 
box opens. If you have not saved the data since your last change was made, 
the program will first ask if you want to save changes to the current file before 
erasing from memory.
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Note. Using this command discards only the analysis and its tax data that 
reside in memory, effectively opening a new analysis for the client. If you 
previously saved the client file, the file remains on disk, unchanged.

ERASE WORKSHEET DATA
The first command, Erase Worksheet Data, zeroes all the data, and returns 
any options you have set to their default settings. The program will keep the 
text on any custom worksheets you have created (except Passive Activity 
and Publicly Traded Partnership custom worksheets) as part of the program 
structure, but will delete the amount entries on the custom worksheets.

Note. Use this command to begin a new client analysis while retaining the 
custom worksheets from an existing client file as a template for the new 
analysis. If the line items on the custom worksheets are substantially the same, 
this command can be a real time saver.

To select this command, make sure it is highlighted then click OK.
The state specifications associated with the current client data remain in effect. 
To avoid inadvertently erasing data, the program will first ask you to confirm 
your request by issuing the following message (if you do not have Income Tax 
Planner with Fifty States, you will see a slightly different message):

 

If you select OK, the program clears the worksheets and returns the focus to 
the Main Worksheet.
If you select Cancel, the program returns the focus to the Erase command box 
where you can then either select Cancel to return to the previous worksheet or 
re-select an Erase command.

dErase.png

msgCautionZeroAl
lWorksheets.png
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ERASE WORKSHEET DATA AND ZAP CUSTOM 
WORKSHEETS

The second command, Erase Worksheet Data and Zap Custom 
Worksheets, will zero out the data from the built-in worksheets and also 
eliminate any custom worksheets from the program structure. This command 
works in the same way as the Erase Worksheet Data command.
Select Yes to save the analysis before leaving the program. If you have saved 
the file previously, the program will close after saving the analysis and the 
focus will return to Windows. If you have never saved the analysis, you will be 
taken to the Save Client File As dialog where you can specify a file name 
before exiting to Windows.

Select No to exit to Windows without saving the last changes made to the 
analysis. Select Cancel to return to the program without exiting.

PREVIOUSLY LOADED CLIENT FILES
Above the Exit command on the File menu, the program lists the four most 
recently opened client files, as illustrated below:

 

The file names are numbered and listed in reverse chronological order, 
showing the most recently opened (or saved) file on top as 1 and so on.

Note. When you open the File menu, you can open a listed file by clicking 
directly on the file name, or by pressing a key that corresponds to the file 
name’s number. For example, to open the Scenario1 file, click the 
C:\ITWIN\SCENARIO1.it line or press 3.

mFileRecentlyOpenedFiles.png
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EXIT
There are several methods you can use to close and leave the program. If the 
File menu is open, you can click Exit. If the File menu is closed, you can click 
the Close icon  on the program’s Title Bar or you can press Alt+F4. As a 
safeguard, if you have not saved the last changes you made to the analysis, 
the program will prompt you to save your changes prior to exiting.
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4
4 Edit Menu

EDIT MENU

OVERVIEW
The program’s Edit menu lists functions that you can perform within or between 
worksheet cells (or groups of cells) or to worksheets. The Edit menu also 

mEditMenu.png
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includes commands used to dynamically exchange data with Excel. The Edit 
menu allows you to perform the following program functions:

Undo Last Entry – Cancels the last entry in a cell 

Undo List – Opens the Undo List dialog, where you can restore to a prior 
value to a worksheet row
Copy – Copies a selection to the Clipboard. Copy is also used to establish 
an Excel link, as well as copy pages of Form 1040-ES and Graph to the 
clipboard. This command is also available on the shortcut menu that 
appears when you right-click a cell in a worksheet.
Paste – Pastes a selection from the Clipboard into a cell or range of cells. 
This command is also available on the shortcut menu that appears when 
you right-click a cell in a worksheet.

Paste Link – Pastes linked data and establishes a link from Excel. This 
command is also available on the shortcut menu that appears when you 
right-click a cell in a worksheet.
Select All – Selects everything on a worksheet or client letter
Edit Cell – Edits a cell’s contents (allow you to insert or delete specific 
characters within a cell) 

Auto Copy Within A Case – Automatically copies the contents of the 
current cell to other years within a case or to other cases within a single-
year analysis 
Auto Copy Same Year – Automatically copies the contents of the current 
cell to the same year for all cases 
Auto Copy All Columns – Automatically copies the contents of the current 
cell into all colums, across all cases, in plans with multiple cases and years 

Clear or Restore Prior Value – Clears or restores the cell’s previous value 
Increase By Constant or %– Increases or decreases the value of the 
previous cell and enter the new value in the current cell 

Kill Subworksheet – Kills the subworksheet from the row the is on 
Zap Custom Worksheet – Zaps the custom worksheet accessed from the 
row the cursor is on  
Math Calculator – Opens the Math Calculator to calculate a value and 
post it into a cell

Repeat Previous Cell – Repeats the previous cell’s content in the current 
cell 
Spread Annualization – Enters (or spreads) evenly received amounts 
based on your entry. Available on the custom worksheets for income and 
expense items only. Only available for Annualization analyses. 
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Case Titles – Opens the Case Titles dialog, where you can enter and edit 
case titles. This command is also available on the shortcut menu that 
appears when you right-click a cell in a worksheet.
Move Case – Opens the Move Case dialog, where you can move a case. 
This command is also available on the shortcut menu that appears when 
you right-click a cell in a worksheet.

Hide Columns – Opens the Hide Columns dialog, where you can hide one 
or more columns
Protect Columns – Opens the Protect Columns dialog, where you can 
protect one or more columns by locking the data in these columns
Create Link – Opens the Create Link with Excel dialog, where you can 
create a link to/from Excel. This command is also available on the shortcut 
menu that appears when you right-click a cell in a worksheet.

Delete / View Link – Opens the Link To/From Income Tax Planner dialog, 
where you can view or delete the selected link. This command is also 
available on the shortcut menu that appears when you right-click a cell in 
a worksheet.
Dynamic Link – Opens the Dynamic Links With Excel dialog, where you 
can view details about the selected link, and delete, update, or expand the 
selected link.
Go To Excel Link – Highlights (makes active) the linked cell in Excel. If the 
Excel file containing the link is closed, it will open automatically. This 
command is also available on the shortcut menu that appears when you 
right-click a cell in a worksheet.

Note – Opens the Note dialog, where you can create, edit, and delete 
notes attached to worksheet input cells. This command is also available on 
the shortcut menu that appears when you right-click a cell in a worksheet.

Note. Custom Worksheets have their own separate Edit menu, as does the 
individual activities worksheets (discussed in Chapter 6), the security transac-
tion analyzer (Chapter 6), the graph (Chapter 7), and the client letter 
(Chapter 8). In addition, when the focus is on the Batch Input worksheet, 
there’s an additional command, Go To Batch Input Line Number, that allows 
you to change the focus to a particular line in the worksheet.

Each one of these program functions will be discussed in detail within this 
chapter.

EDIT MENU COMMANDS
Some of the commands on the Edit menu operate at the cell level, some 
operate at the worksheet level, some operate on columns, and others operate 
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between applications. One group, comprising commands used on custom 
worksheet title text, is discussed in the section Custom Worksheet Edit Menu 
for Row Titles on page 46. Another group, comprising commands used on 
graphic representations of data, is discussed in the section Graph Edit Menu 
for Row Titles on page 206. A final group, comprising commands used on the 
client letter, is discussed in the section Using the Edit Menu for the Client 
Letter on page 231.
All commands apply to both the worksheet and batch data entry modes. 
Shortcut keys are listed on the Edit menu. This chapter will refer to the 
commands and shortcut keys interchangeably.

The Edit menu is context-specific and only contains commands that operate on 
the current screen. Depending on the row the cursor is on when you open the 
menu, some commands may be “dimmed” i.e., they are disabled on that row. 
For example, in the following illustration of a single-year, single-case analysis, 
the Auto Copy Same Year and Auto Copy All Columns commands are 
dimmed because they only operate on multi-year and/or multi-case analyses. 
Similarly, the Kill Subworksheet and Zap Custom Subworksheet 
commands are dimmed because the row where the cursor is located has no 
active subworksheet and no custom worksheets.
The following sections detail the Edit menu commands.

CELL COMMANDS

UNDO LAST ENTRY COMMAND
The Undo Last Entry command restores the contents of all cells that were 
changed by the previous entry.

If you used an Auto Copy command for the last entry, for example, A, to copy 
a value into more than one cell, all cells that were affected by the command will 
be restored to their prior values.
When you use the Undo Last Entry command on a data entry cell, the 
program issues a message informing you that the prior entry is restored for the 
affected worksheet.

Click OK to close the message box. The program will finish restoring the 
previous entry (or entries).

To use the toolbar to perform this function, click the Undo icon on the main 
program toolbar.

Note. You can use the Undo Last Entry command with data entry cells.
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UNDO LIST COMMAND
The Undo List command opens the Undo List dialog, which allows you to 
restore the values in a worksheet row to a previous value. In this dialog the 
program lists the prior values of the worksheet rows edited since you opened 
the analysis. Up to 100 prior values are included in the Undo List.
Double-click any row (or press Enter) to restore its value to the worksheet row. 
After restoring the row’s prior value(s), the program issues a message stating 
which row’s values were restored. Click OK to close the message and 
continue. The program then adds the values that you’ve just replaced to the 
Undo List. 
Similar to a worksheet, the Undo List dialog stays open until you click the 
Close icon. However, unlike a worksheet, pressing the Esc key will change the 
focus to the Main Worksheet.
When you kill a worksheet or zap a custom worksheet, the values for rows on 
that worksheet are removed from the Undo List. When you activate a 
worksheet, the values for the access row to that worksheet are removed from 
the Undo List.
Once you close the analysis or change assumptions, the Undo List is cleared.

COPY COMMAND
The Copy command allows you to copy the contents of a cell or range of cells 
(also called a block of cells) to another cell or range of cells, or to a linked 
application. Using a combination of the Copy and Paste commands, you can 
copy the contents of the selected cells to another location within the same 
worksheet, to a different worksheet, or to another Windows application.

To use the toolbar to perform this function, click the Copy icon on the main 
program toolbar.
The process of selecting and copying cells to the Clipboard does not change 
the original cells.
The first time you use the Copy command before saving the analysis, the 
program issues a message to remind you that to link data to a remote applica-
tion, you must first save the analysis.

The Copy command places the contents of all selected or highlighted cells 
onto the Clipboard. When you copy cells using a Windows application, the 
application temporarily stores the contents of the cells or the data onto the 
Clipboard. You can then paste the Clipboard’s contents to another location 
within or outside the source Windows application.
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Note. Data copied to the Clipboard remains on the Clipboard until you replace 
it by performing another Copy command (or another Cut command in a 
different Windows application).

TO SELECT
AND COPY A

SINGLE CELL

1. Highlight a data entry or calculated cell to be copied by clicking the cell.
2. Now select the Copy command from the Edit menu or press  on the 

toolbar. The program will copy the cell’s contents onto the Clipboard.

TO COPY A
GROUP OF

CELLS

1. Place the pointer on a cell.
2. Click and hold down the left mouse button.
3. Continue to hold the mouse button down while you drag horizontally, 

vertically, or diagonally across the desired cells.

Note. The upper left cell in the selected range controls the placement of 
the cells’ contents when pasted. For more details, see Paste Command 
on page 109.

The following illustration shows a group of cells that were selected by 
clicking first in the upper leftmost cell and then dragging diagonally right 
and down. The cell initially clicked on is highlighted by a border. In this 
illustration, the mouse has not yet been released.

 

4. When the block or range you want to copy is highlighted, release the 
mouse button.

5. Now select the Copy command from the Edit menu. The program will copy 
the contents of the selected cells onto the Clipboard. 

Note. Try to select only the cells that you want to copy. Also take care that 
the destination location has active cells available for you to paste over. The 
program will only paste to active input cells. If you’ve copied more cells 
to the Clipboard than you have active at the insertion point, when you 
invoke the Paste command, the program will first issue an error message 
and then paste as much as possible into the available active cells. See 
Coping to an Inadequate Area on page 111.

Caution! You can only use the Paste command on input data. Although the 
program can copy title text data to the Clipboard, the program cannot paste 
non-numeric, title text data to a numeric data entry cell. 

wiOtherOrdinaryIncome
Chapter4.png
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Note. If you are copying cells that you want to paste into a linked application, 
you must first save the Income Tax Planner analysis. The file name should be 
the same for both the Income Tax Planner analysis and the other application; 
only the file extensions should differ. 

COPYING THE GRAPH
You can copy the contents of the graph to the Clipboard using the Copy 
command. Using a combination of the Copy command and the Paste 
command in another application, you can copy the entire graph image to 
another Windows application.

Note. The graph image copied to the other application is not dynamically-
linked to Income Tax Planner. It is an image (or picture) of the graph, not the 
graph itself. If you change the analysis, re-copy and paste the graph image to 
the destination application.

COPYING 1040–ES PAYMENT VOUCHERS
You can copy the current page of the 1040–ES (or 1041–ES for estates and 
trusts) payment voucher to the Clipboard using the Copy command. Using a 
combination of the Copy and Paste commands in another application, you can 
copy the entire image in the 1040–ES window to another Windows application.

Note. The 1040–ES image copied to the other application is not dynamically-
linked to Income Tax Planner. It is an image (or picture) of the IRS form, not 
the form itself. If you change the analysis, re-copy and paste the form image to 
the destination application.

COPYING W-4 FORM
You can copy the current page of the W-4 Form to the Clipboard using the 
Copy command. Using a combination of the Copy command and the Paste 
command in another application, you can copy the entire image in the W-4 
window to another Windows application.

Note. The 1040-ES image copied to the other application is not dynamically-
linked to Income Tax Planner. It is an image (or picture) file of the IRS form, it 
isn't the form itself. If you make changes to the analysis that in turn changes the 
estimated payment amounts on the vouchers, you should re-copy and paste 
the form image to the destination application.

PASTE COMMAND
The Paste command allows you to paste the contents of the Clipboard to a cell 
or a range (or block) of cells. Using a combination of the Copy and Paste 
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commands, you can paste the Clipboard’s contents to another location within 
the same worksheet or to a different worksheet or to another Windows 
application.

To use the toolbar to perform this function, click the Paste icon on the toolbar.
The process of copying to and pasting from the Clipboard does not change the 
original cells in any way.

The Paste command places the contents of the Clipboard onto the worksheet 
beginning at the insertion point. When you paste the data onto a worksheet, the 
program automatically updates the worksheet’s calculated rows to account for 
the new data.

TO PASTE TO A
SINGLE CELL

1. Highlight the cell to be pasted over by clicking the cell.

2. Select Paste from the Edit menu or click  on the toolbar. The program 
will copy the Clipboard’s contents into the selected cell.

Note. The upper left cell in the selected paste range controls the placement of 
the cells’ contents when actually pasted. The program pastes the contents of 
the upper left copied cell into the upper left selected cell within the paste range. 
The program then pastes the remaining copied cells into the selected cells 
within the paste range to the right and down from the upper left cell relative to 
their position in the copied range.

TO PASTE TO A
GROUP OF

CELLS

The following illustration shows a group of cells that were selected starting in 
the upper leftmost cell and copied to the Clipboard. The cell initially clicked on 
is highlighted. This cell is coincidentally the upper left cell described in the 
Note, above. The selected range illustrated below displays the contents of the 
Clipboard used in the following discussion on how to paste a group of cells.

 

1. After copying the cells to the Clipboard, position the pointer on a cell, then 
click and hold down the left mouse button. Continue to hold the mouse 
button down while you drag horizontally, vertically, or diagonally across the 
range of cells into which you want to place the Clipboard’s contents. Then 
release the mouse button. The selected range will look like this:

wiOtherOrdinaryIncome
Chapter4.png
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Or, select the cell that corresponds to the upper left cell in the group of cells 
into which you want the Clipboard’s contents placed: 

 

2. Click Paste on the Edit menu.

The program will copy the contents of the Clipboard into the range of cells 
as shown below: 

 

COPING TO AN
INADEQUATE

AREA

The program will allow you to paste to active cells only — cells that contain 
data. If you try to copy a group of cells to a location where there are insufficient 
columns or rows, as shown here...

 

...then, the program will issue an error message and then paste the contents of 
as many of the copied cells as possible into the available cells.

wiOtherOrdinaryIncome
Chapter4b.png
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The contents of the cells at the upper left of the copied block were pasted onto 
the worksheet, beginning in the upper left of the selected paste range. The 
amounts in the rightmost column were not pasted.

Caution! You can only use the Paste command in active input areas. You can 
copy title text data to the Clipboard, but you cannot paste non-numeric Title text 
data to a numeric data entry cell. Also, you can copy and paste the entire 
contents of a Title text cell into another Title text cell. However, you cannot copy 
or paste a portion of a text cell.

SELECT ALL COMMAND
The Select All command lets you select an entire worksheet or client letter 
before copying and pasting the data elsewhere or, in the client letter, applying 
a format (such as a new font) to the selection.

After clicking the Select All command on the Edit menu, choose Copy to place 
the document onto the Clipboard. You can then paste the Clipboard’s contents 
to another location. To paste the Clipboard’s contents to a location in the 
program, click on the destination document, then select Paste on the Edit 
menu.

EDIT CELL COMMAND
The Edit Cell command allows you to change (rather than replace) the cell’s 
current contents by inserting numbers at the insertion point.

When you invoke the Edit Cell command, the border around the current cell 
and any commas within the number will disappear but the current cell’s value 
will remain intact. The number will move to the left of cell.
The Edit Cell command lets you add numbers to the left of the insertion point.

USING THE
INSERT

FEATURE

When you use the Insert feature of the Edit Cell command, the insertion point 
appears as a flashing vertical bar at the end of the number. Use the mouse or 
the left and right arrow keys to place your insertion point. When you move the 
insertion point, it will rest between the number’s digits as shown below:

 

Again, when in Insert mode the program adds your entries to the left of the 
insertion point.
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Caution! If you are editing a number that already has the maximum number of 
digits (as specified in the Calculation Options dialog under the Calculations 
command of the Options menu), you cannot use the Insert feature to change 
the number. To increase the number of digits when at the current maximum, 
you must first increase the number of digits using Calculations on the Options 
menu. (The program issues an error message if you try to insert more than the 
maximum number of digits.)

COMPLETING
THE EDIT

After completing your changes, press Enter to leave the cell. The program 
automatically re-inserts the commas within the number and advances the 
active cell to the next column or to the first column in the next data entry row.  

AUTO COPY WITHIN A CASE COMMAND
The Auto Copy Within a Case command copies the current cell’s contents 
into all remaining columns of the row and advances the active cell to the first 
column of the next row.

AUTO COPY
AND INCREASE

COMMANDS

If you use the shortcut key A instead of Enter to complete an I (Increase) 
command entry, the program will apply the same increment to all remaining 
columns in the row for that case or year. See Increase By Constant or % 
Command on page 114.

AUTO COPY SAME YEAR COMMAND
The Auto Copy Same Year command automatically copies the contents of the 
current cell into the same column of all other cases in the analysis.

EXAMPLE 1 If you are running a three-year, two-case analysis with Joint as the default 
filing status and you want to enter Single as the filing status for the first year in 
both cases, select Single in the first column of the first case and then select the 
Auto Copy Same Year command. The window should look like this:

 

The first column for both cases now shows Single as the filing status.

Note. In multiple years within cases analyses, the Auto Copy Within a Case 
command copies only into the remaining columns in the same case and 
advances the active cell to the first column of the next case.

AUTO COPY ALL COLUMNS COMMAND
The Auto Copy All Columns command automatically copies the contents of 
the current cell into all columns, across all cases.

wiMainWorksheetChapt
er4a.png
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EXAMPLE 2 If you are running the three-year, two-case analysis described in Example 1, 
above, and you want to enter Single as the filing status for all years in both 
cases, select Single in the first column of the first case and then select the 
Auto Copy All Columns command. The window should look like this:

 

All columns for both cases now show Single as the filing status.

CLEAR OR RESTORE PRIOR VALUE COMMAND
If you keyed a new value into a cell by mistake, you can use the Clear or 
Restore Prior Value command to restore the cell’s previous contents if you 
invoke the command before pressing Enter.
If you enter the shortcut key C as the first keystroke in a numeric cell that 
already contains a value, the program will clear the cell by deleting the original 
number and replacing the number with a zero. 

Note. To restore the cell’s original contents after pressing Enter but before 
making any other entries, use the Undo Last Entry command. See Undo Last 
Entry Command on page 106.

Note. If you used any of the Auto Copy commands for the last entry, for 
example, A, to copy a value into more than one cell, you can clear all cells that 
were affected by the command. First, move the cursor back to the cell where 
you originally used the Auto Copy command, then press C followed immedi-
ately by the same Auto Copy command. The program will replace the cells’ 
contents with zero.

INCREASE BY CONSTANT OR % COMMAND
The Increase By Constant or % command takes the value of the previous 
cell, increases or decreases the value by a specified amount or percentage, 
and then enters the new value into the current cell.

To use the toolbar to perform the Increase by Percent function, click the 
Increase by Percentage icon on the toolbar.

To use the toolbar to perform the Increase by Constant function, click the 
Increase by Dollar Amount icon on the toolbar.

Note. Using the Increase command in the first column enters the value in the 
cell if you enter a constant and enters a zero if you enter a percentage. 

wiMainWorksheetChapt
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When you invoke the Increase command, “I=” appears in the cell. As you key 
in the amount of the increment, the number grows from left to right. If you enter 
P or % after the number, the program treats the increment as a percentage. 
Otherwise, the increment is treated as a dollar amount. Enter a minus sign 
before or after the number to indicate a decrement. Press Enter to enter the 
incremented or decremented value into the current cell. The active cell then 
advances to the next column.

USING
INCREASE

WITH AUTO
COPY

If you use the Auto Copy Within a Case command (A) instead of Enter to 
complete an Increase by Percent command entry (I), the program will apply 
the same increment to all remaining columns in the row for that case or year. 
In multiple years within cases analyses, the program applies the increase to all 
remaining columns in the same case.

Using the Increase by Constant command adds the value entered after the 
“I=” to the amount in the previous cell and enters the result in the current cell. 
If you press A instead of Enter to complete the entry, the value will be 
incremented by an equal amount in all remaining columns in the row for that 
year or case.
For example, in the following illustration, I=1000A was entered in the second 
column of row 3 “Medical Expense”, yielding the amounts shown in the remain-
ing columns:

 

MATH CALCULATOR COMMAND
The Math Calculator command provides a calculator function for any numeric 
cell.

To use the toolbar to perform this function, click the Calculator icon on the 
main program toolbar.

Note. The program does not retain the formula after you leave the calculator 
function. To perform the math function on a cell again you must enter a new 
formula.

When you click Math Calculator on the Edit menu, the Calculator dialog 
opens. If the cell already contains a value, that number will appear in the 
Calculator amount window instead of zero.

ENTERING THE
FORMULA

You can then enter the numbers you want to add, subtract, multiply, or divide 
by clicking the number buttons or by pressing the appropriate number keys on 
the keyboard.

wiMainWorksheetChapt
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You can use any of the operators shown in the Calculator window within the 
formula by positioning the arrow cursor above the operator button and then 
clicking the left mouse button or by pressing the corresponding key on the 
keyboard.

CHANGING THE
AMOUNT

DISPLAYED

If the current cell contains an amount when you invoke the Math Calculator 
command, that value will appear in the Calculator’s amount window. You can 
then use that value in your formula to calculate the desired amount. Or you can 
change it directly by using the mouse or the Backspace and left and right arrow 
keys to place the insertion point, and the keyboard’s number pad and Delete 
key to revise the entry. 

REVIEWING
AND POSTING
THE RESULTS

After completing your formula or entering the last number, you can click on or 
press = to display the result in the Calculator amount window. If you are 
satisfied with the result, click the Enter button or press Enter to post the result 
directly to the worksheet in the current cell. The program rounds entries posted 
to the worksheet to the nearest dollar (or nearest cent if you selected the 
Display Cents option on the Calculation Options dialog).
If the calculated result is too large for the computer to display within the current 
cell on the worksheet, the program issues an error message. 

Posts the results to the current cell and closes the Calculator

Results are displayed here

Cancels the entire operation; restores the cell’s original value

Numeric keypad. Click these buttons or press the keys on 
your keyboard’s numeric keypad.

Basic mathematical operators

Shifts the result between positive and negative

Clears the calculation or the displayed number

Displays the calculated results

Clears the value stored in memory

Displays the value stored in memory

Stores the displayed value in memory

Adds the displayed value to any value already in memory
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When you click OK, the program will return to the Calculator window and 
display the calculated result. You may modify the displayed amount or cancel 
out of the Math Calculator function:

To modify the amount, use the mouse or the Backspace key to place the 
insertion point and then change the amount. Select Enter when finished.
Or click the C button to clear the calculation and re-enter the formula. 
Select Enter when finished.

To cancel the Math Calculator function, click the Cancel button or press 
Esc. The Calculator window will close and the focus will return to the 
previous worksheet with the current cell’s original value intact. At this point 
you could increase the number of digits allowed in the cell using the 
Calculations command on the Options menu and then return to the Math 
Calculator function to re-enter the formula or value.

CANCELLING
THE MATH
FUNCTION

You can click Cancel or press Esc at any time to cancel the Math Calculator 
operation without posting calculated results to the worksheet.

MOVING THE
CALCULATOR

WINDOW

If the Calculator window is covering numbers on the screen that you wish to 
see as you enter the formula, you can move the box around the screen by 
clicking the Title Bar, dragging the window to where you want it, and then 
releasing the mouse button. In this way you can use the Math Calculator 
function to compare results. You must be in a worksheet cell to use the Math 
Calculator function, but you can avoid putting the result into the cell by using 
= and then clicking the Cancel button or pressing Esc.  

REPEAT PREVIOUS CELL COMMAND
The Repeat Previous Cell command enters the previous cell’s value into the 
current cell and advances the active cell to the next column.

Note. The Repeat Previous Cell command only works between years within 
the same case. This command does not copy the amount between cases in a 
multiple-case analysis.

SPREAD ANNUALIZATION
The Spread Annualization command allows the program to enter (or spread) 
evenly received amounts based on your entry. This command is available on 
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the custom worksheets for income and expense items only and is only avail-
able for annualization analyses.

SPREADING AN
AMOUNT IN A

PERIOD OTHER
THAN THE

FULL YEAR

If you make an entry in any period except the full year and use the Spread 
Annualization command, the program automatically enters a grossed-up 
amount in the subsequent columns. Thus, if you are in the second period and 
enter 25,000 and use the Spread Annualization command, the program will 
enter 40,000 in the third period and 60,000 in the full year. The first period will 
remain unchanged.

SPREADING AN
AMOUNT IN

THE FULL
YEAR COLUMN

If you make an entry in the full year column and use the Spread Annualization 
command, the program allocates the amount back to all the earlier periods. 
Thus, if you are in the full year column and enter 90,000 and use the Spread 
Annualization command, the program will enter 22,500 in the first period, 
37,500 in the second period, and 60,000 in the third period.

CHANGING THE
AMOUNTS

If you do not wish to use the automatically entered amounts, simply type a 
corrected amount over the entered number.

CASE TITLES
If you are running a multiple case analysis, you can enter a different case title 
for each case in the analysis. The title you enter will appear at the top of the 
specified column(s) on all worksheets and printed reports.

If you are running a minor child analysis, you can enter the names of the parent 
and children. The names you enter will appear at the top of the specified 
columns on all worksheets and printed reports.

This dialog can also be accessed from the Case Titles option on Edit menu by 
the shortcut key Ctrl+E or by right-clicking with the mouse on the actual case 
heading on one of the open worksheets and choosing the Case Titles popup 
submenu item.

MOVE CASE
The first field on the Move Cases dialog indicates which case you want to 
move. The second field indicates the case you want to move the case next to. 
The Before and After buttons allow you to specify if you want to move the case 
before or after the case it is moved next to.
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This dialog can be accessed from the Move Case option on the Edit menu by 
the shortcut key Ctrl+M, or by right-clicking with the mouse on the actual case 
heading on one of the open worksheets and choosing the Move Case popup 
submenu item.

HIDE COLUMNS COMMAND
The Hide Columns command allows you to hide selected columns both on-
screen and when printing. When you invoke the Hide Columns command, a 
dialog similar to the following opens:

The items listed in the Hide Columns dialog will be customized to match the 
facts of the current analysis. Click a check box to select a column to be hidden. 
Click again to remove the hidden attribute.

After selecting the cases that you want hidden, click OK. The Printed 
Columns dialog appears, asking you whether you want to hide the same 
column(s) when printing. Click Yes or No. If you click Yes, a message informs 
you that the specified column(s) will be suppressed on the reports, and that you 
can change the columns specified for printing from the Columns dialog 
accessed from the Page Setup dialog (see page 74). Click OK. The focus 
returns to the worksheet that was open when you invoked the command. 
The program hides the selected column(s) on all worksheets and places a 
“Hidden Columns” note in the upper left corner of each affected on-screen 
worksheet.

To use the toolbar to perform this function, click the Hide Columns icon on the 
main program toolbar to open the Hide Columns dialog.

dHideColumns.png



120

::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::

PROTECT COLUMNS COMMAND
The Protect Columns command allows you to lock the data in selected 
columns and protect these columns from changes.
When you invoke the Protect Columns command, a dialog similar to the 
following opens:

The items listed in the Protect Columns dialog will be customized to match 
the facts of the current analysis. Click a check box to select a column to be 
protected. Click again to remove the protection.
After you select OK, the focus returns to the worksheet that you were on when 
you invoked the command. The program changes the color of the cells of the 
selected column(s) on all worksheets to the colors selected for calculated cells.

To use the toolbar to perform this function, click the Protect Columns icon on 
the main program toolbar to protect one or more highlighted columns.

Click the Unprotect Columns icon on the main program toolbar to unprotect 
one or more highlighted columns.
The program will still change the data in a protected column if you activate an 
underlying worksheet.

CREATE LINK COMMAND
Opens the Create Link with Excel dialog, where you can create a link to/from 
Excel. This command is also available on the shortcut menu that appears 
when you right-click a cell in a worksheet.

DELETE / VIEW LINK COMMAND
Opens the Link To/From Income Tax Planner dialog, where you can view or 
delete the selected link. This command is also available on the shortcut menu 
that appears when you right-click a cell in a worksheet.

DYNAMIC LINKS COMMAND
Opens the Dynamic Links With Excel dialog, where you can view details 
about the selected link, and delete, update, or expand the selected link.

dProtectColumns.png
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GO TO EXCEL LINK COMMAND
This command highlights (makes active) the linked cell in Excel. If the Excel file 
containing the link is closed, it will open automatically. This command is also 
available on the shortcut menu that appears when you right-click a cell in a 
worksheet.

NOTE COMMAND
The Note command allows you to create or edit a note that acts as a footnote 
for a worksheet input cell. This feature allows you to provide additional expla-
nation to distinguish the cases within the analysis.

To use the toolbar to perform this function, click the Note icon on the main 
program toolbar.
To quickly create a new note or open an existing note, right-click the input cell.
When you invoke the Note command, a dialog similar to the following opens:

There is no practical limit on the size of the note — each can contain approxi-
mately 32,000 characters.
A musical note symbol  appears to the right of the amount in cells for which 
you’ve created a note. (The color of the note symbol depends on the color 
scheme you select on the Color Options dialog, accessible from the Options 
menu.) From the Note dialog, you can also delete a note.
Notes print immediately after the worksheet to which they apply, if:

you’ve selected the Notes option on the Page Setup dialog, 
the worksheet to which the note applies is printed, and

the row to which the note applies is printed. (If you chose not to print empty 
rows on the Page Setup dialog, the program may automatically suppress 
the row when the worksheet is printed.)

Note. You cannot attach a note to a calculated or output cell.

dNote.png
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ENTERING/EDITING THE NOTE TEXT
Enter the note text in the Note text box. When a line is filled, the text wraps to 
the next line.
Press Enter to start a new line of text.
To include a list within a note, enter the description, press Tab, then enter the 
amount, as illustrated below:

Explanation of amount Tab 1000
Explanation of amount Tab 2000

To copy text within the note, first highlight the text that you want to copy, then 
press Ctrl+C to place it on the Clipboard.

To cut text within the note, first highlight the text that you want to cut, then press 
Ctrl+X. In addition to deleting the text, the text is placed on the Clipboard.
To paste text from the clipboard into the note, first place the insertion point 
where you want the text placed, then press Ctrl+V.

GO TO BATCH INPUT LINE NUMBER COMMAND
The Go to Batch Input Line Number command moves the cursor to the 
specified line of the Batch Input worksheet. When the Go to Batch Input Line 
Number dialog opens, enter the line number that you want to go to, then click 
OK.

This command is only available when the focus is on the Batch Input 
worksheet.

WORKSHEET COMMANDS
The next two sections in this chapter cover the commands that operate at the 
worksheet level. These commands clear a worksheet’s data and delete a 
custom worksheet.

KILL SUBWORKSHEET COMMAND
The Kill Subworksheet command changes a subworksheet’s (or custom 
worksheet’s) status from active to inactive and sets all items on the subwork-
sheet to zero.
When invoked on a row with a custom worksheet, the Kill command erases all 
numeric data from the custom subworksheet, but leaves the custom 
worksheet’s row titles intact. This command can only be used from the numeric 
section of the current row.
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When invoked on a row for a subworksheet that has Excel links, the Kill 
command issues a message and deletes the links before killing the subwork-
sheet and clearing the data.
If you invoke this command while on a row with an active worksheet, the 
program issues a message stating that all data on the worksheet will be 
cleared for the item. 

After you kill a subworksheet, it will no longer be active. Now you can change 
the row items directly on the displayed worksheet. Killing a subworksheet 
automatically restores any calculations that use the subworksheet data to 
where they would have been had the subworksheet not been used.
When you invoke the Kill command while on a row with an active subwork-
sheet that also has active subworksheets, the program issues a message 
stating that there are active subworksheets that must be killed first.
Click OK. Then you can call up the subworksheet (by double-clicking the row) 
and kill its subworksheets before killing the first subworksheet.

ZAP CUSTOM WORKSHEET COMMAND
The Zap Custom Worksheet command eliminates the custom worksheet, 
including all row titles and their corresponding numbers.
When invoked on a row for a custom worksheet that has Excel links, the Zap 
command issues a message and deletes the links before zapping the custom 
worksheet and deleting the data.
If you invoke this command while on a row with a custom worksheet, the 
program issues a message stating that this will remove the worksheet itself, 
including all row descriptions and data. 

Click OK. (The program will issue a message stating that the worksheet has 
been zapped and returns the focus to the worksheet.) Once the Zap operation 
has been performed, the worksheet will no longer exist. Now you can change 
the row items directly on the displayed worksheet. Zapping a custom 
worksheet automatically restores any calculations that use the custom 
worksheet data to where they would have been had the custom worksheet not 
been created.
When you invoke the Zap command while on a row with an active subwork-
sheet that also has active subworksheets, the program issues a message 
stating that there are active subworksheets that must be killed first.

Click OK. Then you can call up the subworksheet (by double-clicking the row) 
and zap its subworksheets before zapping the first subworksheet.
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CUSTOM WORKSHEET COMMANDS
The custom worksheets have an additional set of Edit menu commands for use 
on the title text rows. For details on these edit commands, see Chapter 2.

GRAPH COMMANDS
The Graph has a different set of Edit menu commands. For details on these 
commands, see Chapter 7.

CLIENT LETTER COMMANDS
The Client Letter has a different set of Edit menu commands. For details on 
these commands, see Chapter 8.

COPY COMMAND
Before you can copy and link data between the Income Tax Planner and 
another application such as Word or Excel, you must first make sure that the 
files to be linked have been saved and are open in both programs. To make it 
easier for you to keep track of these files, they should have the same file name 
(except for extension) in both programs. The Copy command is used in the 
first step of establishing links.
To define the data to be copied and linked to another application:
1. In Income Tax Planner, select the cell by moving the cursor to it or select 

the range of cells by clicking the left mouse button and dragging the mouse 
until all cells to be linked are highlighted.

Caution! Be careful to select only those cells that you want linked. If you 
want to add rows or to delete rows from a custom worksheet in Income 
Tax Planner or change a row’s caption in the other application, and these 
areas are linked, you will have to break the link before you can make these 
changes.

2. Select Copy from the Edit menu or click  on the program toolbar. The 
program will copy the data to the Clipboard where it will be held until you 
paste-link it into another application or you copy other data over it.

For more information on the Copy command, see Copy Command on page 
107. 

PASTE LINK COMMAND
The Paste Link command allows you to paste data from a linked cell or cells 
in an Excel file into the selected worksheet cell or cells in Income Tax Planner.
The source Excel file must be running to use the Paste Link command.
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Caution! Both the current Planner analysis and the file from which you are 
copying data (in the other application) must be saved (preferably under the 
same file name) before you can use the Paste Link command.

The Paste Link command places the cells that you have already selected and 
copied in the linked source application file onto a Planner worksheet beginning 
at the insertion point (in the same way that the Paste command operates). The 
program automatically updates the worksheet’s calculated rows to account for 
the new data.
When you change the data in a linked cell of the source application, the cell’s 
data changes simultaneously on the Income Tax Planner worksheet, provided 
that both applications are open.

NOTE COMMAND (EDIT MENU)
Allows you to create or edit a note that acts as a footnote for a worksheet cell. 
This feature allows you to provide additional explanation to distinguish the 
cases within the analysis. A musical note symbol appears to the right of the 
amount in cells for which you’ve created a Note. From the Note dialog, you can 
also delete a Note.
Notes print immediately after the worksheet to which they apply, if:

you’ve selected the Notes option on the Page Setup dialog, 
the worksheet to which the note applies is printed, and
the row to which the note applies is printed. (If you chose not to print empty 
rows on the Page Setup dialog, the program may automatically suppress 
the row when the worksheet is printed.)

To quickly create a new note or open an existing note, click the Note icon  or 
right-click the input cell.
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5
5 Assumptions

ASSUMPTIONS

OVERVIEW
The Assumptions dialog allows you to specify some basic information about 
the current analysis, including client name, the first year of the analysis, client 
letter information, and case titles. You may also choose a resident state 

dAddumptions.png
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specifications file other than your default state or a nonresident state specifica-
tions file using a button on this dialog.
To open the Assumptions dialog, click Assumptions on the menu bar.

If the analysis does not involve a minor child or estimated tax annualization 
analysis, you can define the analysis within the Assumptions dialog using the 
following items: 

Number of Cases in Analysis (and Case Titles) 
Number of Years in Analysis 

Years within Cases 
Cases within Years 
Adjustment 

Taxpayer & Spouse 
Difference 

Note. If the analysis involves a multi nonresident, minor child or annualization, 
the analysis is limited to one case and one year.

ANNUALIZATION ANALYSIS
For an estimated tax annualization analysis, you can specify the following 
items within the Assumptions dialog:

Year of Analysis  
Filing Status 

While the estimated tax annualization analysis covers only one year, it will 
show each of the four periods separately (five periods for Estates and Trusts).

MINOR CHILD ANALYSIS
For a minor child analysis, you can define the analysis within the Assump-
tions dialog using the following items: 

Number of Children 
Name of each child
Name of the parent

Year of Analysis 

MULTI NONRESIDENT ANALYSIS
In Income Tax Planner with Fifty States, the program allows for a Multi 
Nonresident analysis to calculate the state taxes for one resident state and up 
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to 18 nonresident states for one year. For a Multi Nonresident analysis, you can 
define the analysis within the Assumptions dialog using the following item:

Year of Analysis

INITIAL PROGRAM ASSUMPTION DEFAULTS
When you first start the program after installation, the initial defaults for the 
analysis are:

You have the option of changing these defaults for future analyses.
Each one of the above items will be discussed in detail within this chapter.

Note. If the client file contains cells linked to a remote location and you delete 
a year or a case that has links or if you change the type of analysis to an 
Annualization analysis or Minor Child analysis, the program deletes the 
Excel links (after issuing a message stating that the links will be deleted). After 
making this change in Income Tax Planner, switch to the other application and 
delete the corresponding links.

ASSUMPTIONS ITEMS
CLIENT NAME

In the Client Name field, you can enter the client name using uppercase, 
lowercase, or a combination of upper and lowercase letters. The Client Name 
you enter appears in the program’s Title Bar, and also appears on all printed 
reports (unless you erase it through the Header & Footer command of the 
Page Setup dialog (accessed through the File menu)). You can also use the 
Insert feature of the client letter to include the name on the letter or template.

If you enter client name on the Header & Footer dialog, that entry overwrites 
the entry on the Assumptions dialog.
You can enter up to 80 characters in this text box. After completing your entry, 
click on the next item you want to change.

CASES AND YEARS
The program allows you to specify any combination of years and cases; 
however, the analysis is limited to a maximum of twenty (20) columns. (A 

Years within Cases on

Number of Cases 2

Number of Years 3

First Year of Analysis 2020
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column consists of a year within a case or a case within a year, depending 
upon whether the analysis has multiple years or multiple cases or both.)

REPLICATION FEATURE
A special replication feature (described under Replication Feature on page 
134) carries over data from an earlier calculation for use in the new calculation. 
This feature is useful for extending the number of cases used in an earlier 
calculation for the same taxpayer. You can also use this feature to extend the 
number of years used.

YEARS WITHIN CASES ANALYSIS
The Years within Cases analysis allows you to specify one or more cases 
each with one or more years. When there are multiple cases and multiple years 
in an analysis the case titles are given priority and appear above the year 
column headings. It is possible to change this priority when you select the 
Cases within Years analysis (see below).

CASES WITHIN YEARS ANALYSIS 
In order to select a Cases within Years analysis there must be two or more 
cases specified in the Number of Cases in Analysis box. When there are 
multiple cases and multiple years in the analysis the years under analysis are 
given priority and appear above the case column headings. It is possible to 
change this priority when you select the Years within Cases analysis (see 
above).

ADJUSTMENT ANALYSIS
The Adjustment analysis allows you to see the effect of adjustments to any 
row item in the program. The column headings for each year are “Original,” 
“Adjustment,” and “Adjusted.”

Entries may be made only in the Original column and the Adjustment column. 
Numeric entries in the Adjustment column are added to those in the Original 
column and appear automatically in the Adjusted column. Nonnumeric entries 
are copied from the Adjustment column to the Adjusted column. Tax calcula-
tions are performed only on the Original and Adjusted columns, not on the 
Adjustment column. However, calculated rows, e.g., “Taxable Income”, and 
active worksheet rows are computed in the Adjustment column as the differ-
ence between the Original column and the Adjusted column. The Adjustment 

wiMainWorksheet
Chapter5a.png
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column serves to allow input of adjustments and to show the results of those 
adjustments.

Note. Carryovers in the Original column and the Adjusted column are 
computed on the basis of the amounts in the corresponding column of the 
previous year.

When an existing analysis is changed to an Adjustment analysis, one case is 
used for the Original case and another is used for the Adjusted case. The 
adjustment column is initially computed as the difference between the two 
columns. When there is only one existing case the program uses that case for 
both the Original and Adjusted cases, with the adjustment column starting out 
with zeros.

The Adjustment analysis is a companion analysis to the Difference analysis. 
The Adjustment case will be equal to the Difference case when you switch 
from the Adjustment analysis to the Difference analysis and retain the Origi-
nal and Adjusted cases in the Difference analysis.

TAXPAYER AND SPOUSE ANALYSIS
The Taxpayer and Spouse analysis allows you to see the effects of a married 
couple filing separately as well as jointly. It is also useful in analyzing the tax 
effects of a divorce. Under a taxpayer and spouse analysis, the column 
headings are “Taxpayer,” “Spouse,” and “Combined.”

Numerical entries may be made only in the Taxpayer column and the Spouse 
column. Amounts in the Combined column are computed as the sum of the 
other two columns. Nonnumeric row entries, such as filing status may be made 
in any column. Tax calculations are performed independently on all three 
columns. The calculated amounts in the Combined column, therefore, repre-
sent the results of the tax calculations in that column and are not simply the 
sum of the other two columns. Similarly, carryovers in each column are 
computed on the basis of the amounts in the corresponding column in the 
previous year.
The filing status for the taxpayer and the spouse start out as separate for each 
and joint for the combined column. These can be changed on the Main 
Worksheet or on the Filing Status worksheet.

When an existing analysis is changed to Taxpayer and Spouse, one case is 
used for the taxpayer and another for the spouse. When there is only one 

wiMainWorksheet
Chapter5c.png
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existing case, the program uses the same case for both the Taxpayer and 
Spouse cases and transfers any data entered in the spouse categories within 
the worksheets into the Spouse’s case automatically. The Taxpayer and 
Spouse cases can then be edited independently to calculate the Combined 
case automatically. 
When running a Taxpayer and Spouse analysis you should enter the 
taxpayer’s amounts on the taxpayer rows and the spouse’s amounts on the 
spouse’s rows on those worksheets that have rows for both taxpayer and 
spouse. These worksheets include:

Wages 
Self-employment Income 
IRA Deductions 

Credit for Elective Deferrals and IRAs 
Dependent Care Exclusion and Credit 
Adoption Exclusion and Credit 

Similarly for individual activities, the taxpayer’s amounts should be entered as 
the taxpayer’s and the spouse’s amounts as the spouse’s so that the program 
can properly combine the amounts in the Combined column. If you were to 
enter both the taxpayer’s and spouse’s amounts on the taxpayer rows, the 
combined self-employment income, for example, would not produce the 
correct self-employment tax in the Combined column. For other types of 
analysis you should enter the taxpayer’s amounts on the taxpayer rows and the 
spouse’s amounts (for joint filing status) on the spouse’s rows.

Note. When entering transactions on the Security Transactions Analyzer 
worksheet, you can specify (in the Owner column) whether the security is 
owned by the taxpayer, the spouse, or both.

NOTE ON CARRYOVERS
When running any analysis, carryovers are computed on the basis of the 
corresponding column in the previous year. For example:

TAXPAYER
AND SPOUSE

The Taxpayer’s carryovers in a subsequent year are computed on the basis of 
the amounts in the Taxpayer column in the previous year, the Spouse’s 
carryovers are computed on the basis of the amounts in the Spouse column in 
the previous year, and the carryovers in the Combined column are computed 
on the basis of the amounts in the Combined column in the previous year. The 
carryovers in the Combined column, therefore, do not represent the sum of 
the carryovers in the Taxpayer and Spouse columns.

DIFFERENCE
AND

ADJUSTMENT

The Original column carryovers in a subsequent year are computed on the 
basis of the amounts in the Original column in the previous year, and the 
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Adjusted column carryovers in a subsequent year are computed on the basis 
of the Adjusted column amounts in the previous year. The Difference or 
Adjustment column represents the difference between the Original and 
Adjusted columns in each year.

DIFFERENCE ANALYSIS
The Difference analysis allows you to see the difference between two cases 
on a year-by-year basis. The column headings for each year are “Original,” 
“Adjusted,” and “Difference.”

Entries may be made only in the Original column and the Adjusted column. 
Entries in the Difference column are computed as the difference between the 
Original column and the Adjusted column. This is true for both entered and 
computed amounts. Tax calculations are performed only on the Original and 
Adjusted columns, not on the Difference column. (See the Note below for 
carryover situations.)
When an existing analysis is changed to a Difference analysis, one case is 
used for the Original case and another is used for the Adjusted case. When 
there is only one existing case, the program uses that case for both the 
Original and Adjusted cases. The Difference analysis is a companion analy-
sis to the Adjustment analysis. The Difference case will be equal to the 
Adjustment case when you switch from the Difference analysis to the Adjust-
ment analysis and retain the Original and Adjusted cases in the Adjustment 
analysis.

NUMBER OF CASES/YEARS IN ANALYSIS (LIMIT 20)
The program calculates up to twenty alternative tax plans (also called cases 
within this manual) for years beginning after 1986, or calculates the tax liability 
for up to twenty years for any individual or fiduciary taxpayer. You can use 
multiple cases to compare different courses of action for one or several 
taxpayers. Use these boxes to specify the number of cases and years in the 
analysis.

Note. For analyses using multiple years within multiple cases, the number of 
cases times the number of years cannot exceed 20.

wiMainWorksheet
Chapter5b.png
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VIEWING COLUMNS ON-SCREEN
The number of columns that you can view on-screen at once depends upon:

the width of the window opened for the worksheet
the number of digits selected for display

the selection of cents or dollars only for display and
the type and size of the selected screen font

You can manipulate any and all of these factors to increase or decrease the 
number of visible columns. Or use the worksheet’s scroll bar to display hidden 
columns.

COLUMN HEADINGS
If your analysis includes multiple years and multiple cases, the column 
headings appear on the worksheet as shown below. Cases will be numbered 1 
through the number selected or, if you wish, you can click Case Titles to enter 
titles of your own. Case Titles on page 138. 

 

If you enter a case title for a single case, the program will display your entry 
above the year heading(s). However, the program does not display a default 
case heading for single-case analyses. Instead, as a default, the columns are 
headed by the years selected:

 

If you select multiple cases and a single year, the columns will be headed by 
the case title (or number) and each column will apply the same year, which is 
displayed in the upper left corner of the worksheet, above the row titles:

 

REPLICATION FEATURE
CASES If you are increasing the number of cases covered by the analysis, the program 

issues the following message:
 

Respond as follows:

CaseTitles1.png

CaseTitles2.png

CaseTitles3.png

msgCasesIncrease.png
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Yes — A message informs you that the number of cases has been 
increased. Click OK. If you already have more than one case, the Choose 
Replicate Case dialog appears:

In the Replicate box, select the case you want to replicate from the drop-
down list, then click OK. The worksheet expands to include the new 
number of cases selected and copies the selected case’s data into all 
newly added columns of the new case. (Subworksheet data is also 
copied.) Click Cancel to return focus to the Assumptions dialog.
No — Expands the worksheet to include the number of cases selected in 
the box. All additional columns of the new analysis are filled with zeros. 
You can then use the worksheets to change selected data.

Cancel — Returns focus to the Assumptions dialog to revise your 
changes.

YEARS If you are increasing the number of years covered by the analysis, the program 
issues a message similar to the following:

Respond as follows:

Yes — Expands the worksheet to include the new number of years 
selected and copies the last column’s data into all newly added columns of 
the new year. (Subworksheet data is also copied.
Thus, if the previous calculation was for two years and you expand the 
analysis to four years, the same input data will appear in each of the new 
columns of the new calculation.

No — Expands the worksheet to include the number of years selected in 
the box but does not replicate the last column. All additional columns of the 
new analysis are filled with zeros. You can then use the worksheets to 
change selected data.
Cancel — Returns focus to the Assumptions dialog to revise your 
changes.

dChooseReplicateCase.png

dReplicate.png
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DELETING CASES
You can delete individual cases from a multiple case analysis as desired. 
Simply change the number of cases entered in the Number of Cases in 
Analysis field. The program issues a message asking you to enter the 
numbers of the cases you wish to delete. After clicking OK on the message, the 
program then opens a dialog so that you can select the case(s) to discard:

You can select as many cases as you want. Click OK after you’ve finished 
selecting cases. The program issues a message similar to the following:

Click OK to complete the task. The program returns focus to the previous 
worksheet; the designated cases will no longer be included on the worksheet. 
The program automatically relabels the remaining column heads with the 
appropriate case titles.
If you realize that you’d selected the wrong case(s), select Cancel. The 
program will return focus to the Assumptions dialog to revise your changes.

DELETING A
CASE WITH

LINKS

If you delete a case linked to Excel (or rearrange columns that have links), the 
program will delete the links in the Income Tax Planner analysis after issuing 
a message stating that the links will be deleted.
If you delete a case that has cells linked to the client letter (or rearrange 
columns that have links), the program will delete the links in the Income Tax 
Planner analysis after issuing a message stating that the links will be deleted. 
Whenever possible, you are given a chance to retain the links.

FIRST YEAR IN ANALYSIS (2000 OR LATER)
The first year can be 2000 or later. A default year is provided. To start with a 
different year, use the mouse to select a year from the list or type in the desired 
year.

dDeleteCase.png

msgCautionDe
leteCase.png
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CHANGING THE BEGINNING YEAR
MOVING THE

BEGINNING
YEAR

FORWARD

When you advance the beginning year of a multiple-year calculation, say from 
2020 to 2021, the program issues the following message:

To accept the change, click OK. The program will proceed into the Replication 
Feature. See Replication Feature on page 134.
To reject the change and restore the original assumptions, click Cancel. The 
focus will return to the Assumptions dialog where you can revise your 
changes.

MOVING THE
BEGINNING
YEAR BACK

Retaining the same number of years

When you move back the beginning year, say from 2021 to 2020 in a 3-year 
analysis, the following message will appear:

 

To accept the change, click OK. The program will proceed into the Replication 
Feature. See Replication Feature on page 134.
Increasing the number of years
If you wish to include both the new beginning year and all the years in the 
earlier analysis, select Cancel, and when the focus returns to the Assump-
tions dialog, increase the number of years from 5 to 6. Since you are now 
including years that were not in the earlier analysis, the program will ask how 
you wish these years to be handled (For information on how the program 
handles an extended analysis, see Replication Feature on page 134). Note 
that when you move the beginning year back, the program replicates the first 
column of data into the new year(s), rather than the last.

To reject the change and return to the Assumptions dialog so that you can 
restore the original assumptions, click Cancel.

Note. Changing the first year of analysis may cause the program to delete the 
links to the client letter.

msgReplicateFirstYear
Increase.png

msgReplicate2.png
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CASE TITLES
If you are running a multiple case analysis, you can enter a different case title 
for each case in the analysis. Up to twenty titles can be entered (depending on 
the number of cases you specified).
Each case title can be up to 80 characters (fewer than 80 may be displayed or 
printed, depending of the type of analysis, number of dollar digits selected, and 
the type and size of the selected screen font). Titles can be typed in uppercase, 
lowercase, or a combination of upper and lowercase letters.
The title you enter will appear at the top of the specified column(s) on all 
worksheets and printed reports. To see samples of how case titles appear on 
the worksheets, turn to page 134.

Note. Case titles will only be available if you select Years within Cases or 
Cases within Years. If you select Minor Child for your analysis, the label on 
the Case Titles button will change to Child Names and allow you to enter the 
names of the parent and up to nineteen children. 

To enter case titles, click the Case Titles button. The Case Titles dialog 
opens:

 

Type in the case title, then click on the next title line. To save the titles and 
leave the dialog, click OK. To leave the dialog without saving your title entries, 
click Cancel. The focus will return to the Assumptions dialog.
You can only enter titles for as many cases as you have specified in the 
Assumptions dialog.

CLIENT ADDRESS
If you plan to include a client letter with the analysis, you can enter the client 
letter address and a salutation for the letter here. If you create a client letter or 
template that uses the Client Address or Salutation variable, the program will 
pull the address and salutation name from this dialog and place them in the 
places you designated in the letter or template. See Chapter 8, for more 
information.

To enter information for the letter, click the Client Address button. The Client 
Letter Address and Salutation Name dialog opens. 

dCaseTitles.png
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Once you type the client’s address in this dialog, it is available for use in a client 
letter. The address can be easily added to your letter using the client letter’s 
Insert tool.
The Salutation Name field allows you to store a greeting or salutation name, 
which you can also automatically insert in the client letter. For example, you 
can use “Mr. and Mrs. Jones:” as the salutation name.

MULTI NONRESIDENT ANALYSIS

GENERAL
The Multi Nonresident analysis allows for the analysis of one resident state 
and up to eighteen nonresident states in a single year.
On the Assumptions dialog, check the box for Multi Nonresident analysis 
and select the year of analysis. Click on either the Resident State or the 
Nonresident States button to access the Choose State Specification 
Assumptions dialog.
On the Choose State Specification Assumptions dialog, you may select one 
resident state and up to 18 nonresident states. You can use this dialog to move 
them left or right. Because some states in some circumstances allow the credit 
for taxes paid to another state to be claimed on the nonresident return, the 
program will automatically reorder such states to the right of the other nonres-
ident states in order to correctly compute the credit for taxes paid to another 
state.

MAIN WORKSHEET
The analysis consists of one column for the federal and resident state, a 
column for each nonresident state, and a totals column.
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In the first column, enter the federal and resident state data. For all federal 
worksheets except the Main Worksheet and Summary Report worksheet 
only the first column will be visible. On the Main Worksheet and Summary 
Report worksheet the federal amounts in all the columns will be equal.
On the Main Worksheet, in the first column, all the rows below the “Resident 
State Estimated and Withholding” row will be unavailable (grayed out). In the 
nonresident columns, the federal and resident state total rows will be unavail-
able. These columns only relate to the nonresident taxes. The Totals column 
will contain all the final amounts. The “Resident State Tax” row will typically 
have a lower amount in the Totals column than in the first column, because in 
the Totals column the Resident State Tax is computed after any credit given 
by the resident state for the nonresident taxes. The Summary Report 
worksheet follows the pattern of the Main Worksheet.

Total other 
nonresident 
taxes

Total New York

Resident tax 
after credit for 
nonresident 
taxes

Rows 1-19 
in columns 
2-Total are 
repeats of 
column 1

Resident tax 
before credit for 
nonresident tax

Total federal 
& state taxes

Oregon 
nonresident

Illinois 
nonresident

New Jersey 
nonresident

New York 
nonresident

California 
nonresident

Grayed out to isolate 
nonresident amounts

Federal & 
resident state 
column
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STATE TAX MAIN WORKSHEET
The State worksheets, including the nonresident state worksheets, are 
accessed by double-clicking on the corresponding rows of the Main 
Worksheet.

The State Tax – Main Worksheet will contain all the columns. However, the 
amounts in the first (Resident) column will not contain any nonresident data. In 
the nonresident columns, the resident state data will be repeats of the first 
column, except for the rows relating to the credit for other state taxes. The 
“Total Resident State Taxes” row will be grayed out in the nonresident columns. 
In the Totals column, Total Resident State Taxes will represent the resident tax 
after taking into account the credit allowed by the resident state for nonresident 
taxes. Thus, the Total Resident State Taxes amount in the first column will not 
usually agree with the amount in the first column because of this credit. The 
“Total Sate Taxes” row (the last row) in the Totals column will represent the 
resident and nonresident taxes after taking into account the credit given by the 
resident state for the nonresident tax and in certain states (like Arizona) the 
credit given by the nonresident state for the resident tax.

Total state taxes 
before withholding

Rows 1-19 
in columns 
2-Total are 
repeats of 
column 1

Oregon 
nonresident

Illinois 
nonresident

New Jersey 
nonresident

New York 
nonresident

California 
nonresident

Grayed out to isolate 
nonresident amounts

Resident tax 
before credit for 
nonresident tax

Total other 
nonresident 
states before 
withholding

Total NY
before 
withholding

Resident 
credit for 
nonresident 
taxes

Resident tax 
after credit for 
nonresident 
taxes
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The nonresident state worksheets are accessed by double-clicking on the 
nonresident tax rows at the bottom of the State Tax – Main Worksheet. The 
columns on the nonresident worksheets are unavailable for nonresident states 
that do not use the calculations on that worksheet. New York has its own 
worksheet for computation of its nonresident tax and all the nonresident 
columns for other states will be unavailable. Correspondingly, the New York 
column on the Nonresident State Tax – Main Worksheet will be unavailable. 

CREDIT FOR OTHER STATE TAX WORKSHEETS
The “Compute Credit” row in the nonresident columns on the Credit for Other 
State Tax worksheet defaults to "Yes". In a Multi Nonresident analysis, the 
Credit for New York Nonresident Tax worksheet will not be active; instead, 
such credit will be computed in the New York column of the Credit for Other 
State Tax worksheet. Most resident states calculate the credit for other state 
tax paid to another state separately, so there will be a separate computation of 
the credit on the Credit for Other State Tax worksheet in each nonresident 
column.
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Some states (like Ohio) calculate the credit for taxes paid to another state by 
aggregating the nonresident income and taxes. For such resident states the 
credit for taxes paid to another state will be calculated solely in the Totals 
column of the Credit for Other State Tax worksheet.

ESTIMATED AND WITHHOLDING WORKSHEETS
In order to calculate the correct federal itemized deduction for state taxes paid, 
in the column for the federal and resident state data (the first column) on the 
Other Nonresident State Estimated and Withholding Payments worksheet 
and on the New York Nonresident State Estimated and Withholding 
Payments worksheet, rows 16-31 will equal the sum of the nonresident state 
data in the succeeding columns for the following rows, all of which relate to the 
federal deduction:
In the second and subsequent columns (except Totals), enter data for the 
nonresident states. Where meaningful, the Totals column will equal the sum of 
the nonresident columns.
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RESTRICTIONS
The Security Transaction Analyzer worksheet allows for only one case. 
Case Titles may not be edited in the Assumptions dialog.

Cells that are not meaningful will be N/A or unavailable.  
Columns may not be selected from the Page Setup dialog.
The Hide Columns button on the toolbar is disabled.

The following rows on the Resident State Estimated and Withholding 
Payments, Other Nonresident State Estimated and Withholdings 
Payments, and New York Nonresident State Estimated and Withhold-
ings Payments worksheets are disabled: 

Auto Prepay the Current Year Tax
Auto Prepay the Prior Year Tax
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Auto Deduct the Current Year Tax
Auto Deduct the Prior Year Tax 

The following rows on the Wages worksheet are disabled:
Taxpayer's NY Nonresident Withholding 
Taxpayer's Other Nonresident Withholding 

Spouse's NY Nonresident Withholding 
Spouse's Other Nonresident Withholding

Tip. For the best printing results, choose an 8-point printer font size to prevent 
the column headings from wrapping. See Screen Font on page 261.

CHOOSE CASE FOR MULTI NONRESIDENT DIALOG
When you change a multi-case analysis into a Multi Nonresident analysis, the 
program offers you a choice of which case to use for the Multi Nonresident 
case. All other cases will be deleted from the analysis.

Caution! Once you've selected the case to use for Multi Nonresident Analysis, 
the prior analysis and the other cases are deleted. If you change back from the 
Multi Nonresident analysis to a multi-case analysis you will not be able to 
recover the data in the deleted cases. Therefore, you should only continue if 
you have saved the prior analysis or if you want to discard the prior analysis.

1. On the Assumptions dialog, select the Multi Nonresident Analysis.
The program issues a message informing you that you must specify which 
case you wish to use for the Multi Nonresident Analysis. Click OK to close 
the message.

2. The program opens a dialog so that you can select the case. Select a 
single case, then select OK.

The program issues messages asking you to verify the cases selected for 
deletion and alerting you to the deletion of the data in all other years other 
than the year of analysis.

3. Select OK to complete the task.

Click to select case from drop-down list
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The program will return the focus to the previous worksheet; the selected 
case will become the Multi Nonresident case, and the other cases will no 
longer be included on the worksheet. The program automatically re-labels 
the remaining column heads with the appropriate column headings for the 
number of states selected.

4. Or, If you realize that you'd selected the wrong case(s), select Cancel.
The program will return the focus to the previous worksheet.

ANNUALIZATION ANALYSIS
The program applies the annualized income installments method to calculate 
the periodic estimated tax payments and underpayment penalty for taxpayers 
whose income and deductions are not evenly spread throughout the year. Only 
one year may be annualized at a time.

CUSTOM WORKSHEETS
The custom worksheets for income and deduction items are specially designed 
to handle the amounts that are not spread evenly throughout the year. When 
you enter the cumulative amounts for each period through the custom 
worksheet, the program automatically applies the appropriate annualization 
factor to compute the annualized amount for the period. It is not necessary to 
use the custom worksheets for items that are spread evenly throughout the 
year; they can be entered in the columns for the appropriate periods on the 
regular worksheets.

SELECTING ANNUALIZATION
When you select an Annualization analysis, four columns appear at the top of 
all worksheets for the designated year. These columns, labeled 1/1-3/31, 1/1-
5/31, 1/1 8/31, and Full Year, represent the periods for which income and 
deductions are computed to determine the payment for each period. (For 
Trusts and Estates, five columns appear, labeled 1/1-2/28, 1/1-4/30, 1/1-7/31, 
1/1-11/30, and Full Year.) The "Full Year" column represents the actual 
required periodic payments based on a comparison of the full year with 
payments for each period.
You can use this analysis in two principal ways:

1. First create a full year analysis (using cases and years), save this analysis, 
then switch to Annualization.

2. Or, first create an Annualization analysis from the start and then switch to 
the regular cases/years analysis.

The Annualization analysis is significant only for computations on the 
Withholding, Estimated and Penalty worksheet, accessed from the Credits 
worksheet.
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CHANGING FROM A MULTI-YEAR OR MULTI-CASE ANALYSIS TO 
AN ANNUALIZATION ANALYSIS

Before you change an Annualization analysis to a multi-year or multi-case 
analysis, you should save the file containing the periodic amounts. The 
program does not retain the results of the annualization analysis when you 
switch from an Annualization analysis. Therefore, you should note the penalty 
amounts before making the switch so that you can adjust the program's 
computed penalty amounts accordingly. Excel links and links to the client letter 
may be deleted.

ANNUALIZATION OVERVIEW
When you select Annualization on the Assumptions dialog, the program uses 
the annualized income installments method to calculate the quarterly 
estimated tax payments and underpayment penalty for taxpayers whose 
income and deductions are not evenly spread throughout the year.

Caution! It should be noted that the computations involving annualization are 
not clearly defined by either statute or regulation and there are many 
unanswered questions regarding the details. Further, the regulations are in 
many respects out of date. Special care should be taken in examining the 
computations performed by the program in conjunction with the discussion on 
the following pages. You should rely on our interpretations only to the extent 
you agree with them.

WHERE ARE ITEMS ENTERED?
Four columns will appear for the designated year (only one year at a time may 
be analyzed). These columns, labeled 1/1-3/31, 1/1-5/31, 1/1 8/31, and Full 
Year, represent the periods for which income and deductions are computed to 
determine each period's payment. (For Trusts and Estates, five columns 
appear labeled 1/1-2/28, 1/1-4/30, 1/1-7/31, 1/1-11/30, and Full Year.) 
On the Main Worksheet and the regular subworksheets for income and deduc-
tion items these columns are headed Annualized Amounts. On custom 
worksheets for income and deductions they are headed Cumulative Periodic 
Amounts.

USING CUSTOM WORKSHEETS TO ANNUALIZE 
AUTOMATICALLY

Annualized amounts for income and deduction items are posted to these 
columns from the custom worksheets, which are specially designed to 
automatically annualize the cumulative amounts entered for each period. 
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(Amounts earned evenly throughout the year can be entered directly on the 
regular worksheets, rather than on custom worksheets. In such cases, enter 
the same (annualized) amount in each cumulative period, reflecting the 
assumption that the amount is received (or paid) evenly throughout the year.)
When custom worksheets are used, the annualization computation is 
performed on two additional rows at the bottom of the custom worksheets for 
income and deduction items.

These rows are: the Annualization Factor row and the Annualized Amounts 
row. The Annualization Factor amounts for individuals are: 4, 2.4, 1.5, and 1; 
the factors for Trust or Estate are 6, 3, 1.71429, 1.09091, and 1. 
The Annualized Amount row is the amount on the Total row multiplied by the 
amount on the Annualization Factor row.

USING THE SECURITY TRANSACTION ANALYZER TO 
ANNUALIZE AUTOMATICALLY

Transactions entered on the security transaction analyzer are automatically 
annualized by accumulating the gains and losses in each period and applying 
the annualization factors described above.

WHERE DO REQUIRED PAYMENTS AND PENALTY APPEAR?
Once the annualized amounts are entered, the program calculates (on the 
Withholding, Estimated & Penalty worksheet) the required payments for each 
period and the underpayment penalty for the year. 
The required payment for each period appears in that period based on the 
annualized income and deductions for that period, taking into account the 
required payments for prior periods, also based on annualized income and 
deductions for such periods. 

In other words, the required payments appearing in the first three columns (four 
for estates and trusts) are based solely on the entries in those columns and do 
not take into account the full year amounts. 
The full year column shows the actual required periodic payments based on a 
comparison of the full year amounts with the periodic amounts. 

Of course, at the end of each period, but before the end of the year, you may 
not know the full year amounts, and will have to rely on the periodic amounts.

Caution! The annualization analysis is significant only for purposes of compu-
tations on the Withholding, Estimated and Penalty worksheet. Annualization 
amounts appearing on other worksheets should not be used for any other 
purpose.
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RUNNING THE ANNUALIZATION ANALYSIS
You can use this analysis in two principal ways:

Switch to the Annualization analysis after creating and saving a full year 
analysis (using cases/years); or
Create an Annualization analysis from the start.

Caution! Before you change an Annualization analysis to a multi-year or multi-
case analysis, you should save the file containing the quarterly amounts. The 
program does not retain the results of the annualization analysis when you 
switch from an Annualization analysis. Therefore, you should note the penalty 
amounts before making the switch so that you can adjust the program's 
computed penalty amounts accordingly. In general, we suggest that you do not 
simply change the Annualization analysis to a multiple-year analysis, but 
instead keep a separate file with the full year amounts. In particular, you should 
not switch back and forth between Annualization and full year analysis when 
you have created custom worksheets for carryovers.

SWITCHING FROM A SAVED FILE
When you switch to the Annualization analysis, the program will "de-annualize" 
each item's amount on an income or deduction custom worksheet. 
Therefore, if you have 100,000 entered on a custom worksheet for a taxpayer's 
1999 FICA Wages and you select annualization, the program will enter 25000 
in the first period (1/1-3/31), 41,667 in the second period (1/1-5/31), and 
66,667 in the third period (1/1-8/31), and 100,000 in the fourth period (Full 
Year). 

Then the program will annualize each amount so that the amounts appear the 
same in each worksheet column. You may then adjust the amounts on the 
custom worksheets to reflect the amounts actually received in the period and 
the program will annualize your entries. In this way, the program initially 
assumes that all amounts are earned evenly throughout the year.
For income or deduction amounts entered directly, i.e., not posted from custom 
worksheets, the program puts the same amount into each cumulative period 
reflecting the assumption that the amount is received (or paid) evenly through-
out the year. 
You may overcome this assumption either by entering the annualized amount 
for each period directly on the income or deduction row or by entering the 
unannualized cumulative period's amount on a custom worksheet (which the 
custom worksheet will then annualize).
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CREATING AN ANNUALIZATION ANALYSIS FROM THE 
START
For income and deduction amounts earned evenly throughout the year, you 
can simply enter the full annual amount in each worksheet column without 
using the custom worksheets (by pressing A after the entry in the first column). 
Then use the custom worksheets to enter amounts earned unevenly through-
out the year. 

SPREAD KEY S
When running an annualization analysis, an additional shortcut key is available 
on the custom worksheets for income and deduction items. By using the S key 
instead of the Enter key to terminate an entry, you can easily enter evenly 
received amounts. 
If you make an entry in any period except the full year and press S, the 
program will automatically enter a grossed-up amount in the subsequent 
columns.
If you make an entry in the full year column and press S, the program will 
allocate the amount back to all the earlier periods.

Thus, in the example above, you could have entered the income from XYZ 
Corp either by entering 12,000 in the first period and pressing S or by entering 
48,000 in the Full Year column and pressing S.
If you do not wish to use the automatically entered amounts, simply type a 
corrected amount over the entered number.

ITEMS NOT ANNUALIZED
For certain items, annualization is not appropriate and the custom worksheets 
for such items do not automatically annualize. These items are as follows:

CREDITS AND OTHER TAXES
The program does not annualize amounts on credit or other taxes rows 
although the program allocates these amounts to each cumulative period both 
on the custom worksheet and on the regular worksheets. 
This reflects the assumption that these amounts accrue or are paid evenly 
throughout the year, but are not to be annualized when calculating the period's 
tax. Note, however, that you may enter annualized amounts for credits and 
other taxes when appropriate. See Form 2210, Pub. 505, and Treas. Reg. § 
1.6654.

An exception to this rule is the credit from prior years on Minimum Tax Credit 
worksheet. This amount is not annualized but the full amount of the credit 
appears in all four periods.



151

A
SS

U
M

PT
IO

N
S

A
SS

U
M

PT
IO

N
S

A
SS

U
M

PT
IO

N
S

A
SS

U
M

PT
IO

N
S

A
SS

U
M

PT
IO

N
S

::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::

You may change the amount if you do not agree with this assumption. A 
second exception to this rule is for the prior year and carryover items on the 
Adoption Exclusion & Credit worksheet, the Dependent Care Exclusion and 
Credit worksheet, the DC Homebuyer Credit worksheet, the Residential 
Energy Efficient Property Credit worksheet, and the Nonbusiness Energy 
Property Credit worksheet.
These amounts are also not annualized with the full amount appearing in all 
four periods. A third exception to this rule is for domestic employment taxes on 
the Self-Employment & Other Taxes worksheet See Sec. 3510(b)(3) of the 
Social Security Domestic Employment Reform Act of 1994 (HR 4278), 
suggesting that regulations will be forthcoming prescribing annualization of this 
tax. The tax enters into the computation of estimated taxes for years after 1997.

Finally, certain credits depend on items of income and expense. These items 
are annualized by the program and, therefore, the credit effectively is annual-
ized as well. Included in this category are the earned income credit, the 
adoption credit, and the dependent care credit. 
HOPE and Lifetime learning expenses are not annualized by the program, 
unless they are being used for a deduction instead of a credit, nor is the 
purchase price of the residence for purposes of the D.C. Homebuyer Credit. 
See the instructions to Form 2210. The amounts entered on the Nonbusiness 
Energy Property Credit and Residential Energy Efficient Property Credit 
worksheets are not annualized.

WITHHOLDING
Enter withholding on the Wages worksheet and on row 13 of the Withholding, 
Estimated & Penalty worksheet spread by quarters instead of in proportion to 
the months in each cumulative period. 

Therefore, if the taxpayer paid $100,000 in withholding for the year and you 
wish to apply the statutory presumption of even quarterly withholding, you 
should enter $25,000 in the first cumulative period, $50,000 in the second, 
$75,000 in the third, and $100,000 in the fourth (when you switch from a full 
year to annualization, the program allocates the annual amount this way 
automatically).
The amount applied by the program to the first installment will be the withhold-
ing entered in the first period. The amount applied to each subsequent 
installment will be the difference between the withholding entered in the 
column for that installment and the withholding entered in the preceding install-
ment's column.

If you wish to overcome the statutory presumption, you may enter the cumula-
tive withholding paid prior to each required payment date. In this way, you can 
group the withholding for each period and have it applied to the payment for 
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that period. The program, however, does not support taking into account the 
actual date of payment of each of the withholding amounts. See IRC § 6654(g).

LUMP SUM
For lump sum distribution amounts, the program initially puts the full year 
amount into each period, thus assuming that the distribution was received in 
the first period. You may adjust the entries either on the Lump Sum Distribu-
tions worksheet or its custom worksheets to reflect the actual period(s) of 
receipt. 

Rows that involve elections such as lump sum Yes/No rows are also treated 
this way.

OTHER ITEMS NOT ANNUALIZED
Personal exemptions, self-employment and other taxes, and withholding are 
not annualized. The Local Additional Sales Tax Rate rows on the State and 
Local Sales Taxes worksheet are not annualized. Also, the prior year amounts 
on the Farm Income Averaging Tax worksheet are not annualized. 
With respect to all the non-annualizing items listed above, you may enter 
annualized amounts and thus override the program's assumptions.

PRINCIPLES OF ANNUALIZATION

AGI AND ITEMIZED DEDUCTIONS
In general, the program uses annualized amounts for each item that goes into 
adjusted gross income and itemized deductions rather than annualizing AGI 
and total itemized. This methodology raises certain issues which are discussed 
below.

LIMITATIONS
Limitations that depend on AGI (such as the social security income inclusion or 
the medical expense deduction) are computed on the basis of annualized AGI 
rather than actual AGI for the period. They are then applied to the annualized 
amounts for the period. In addition, the program applies limitations that are 
defined in terms of fixed annual amounts in each period after the income and 
expense amounts have been annualized. The program does not annualize 
these limitations. For example, the passive rental real estate allowance of 
$25,000 is applied in each period after the real estate losses for the period 
have been annualized. This seems consistent with the treatment of other fixed 
dollar amounts such as personal exemptions, the standard deduction, and the 
self-employment tax OASDI limitation (see Form 2210).
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CARRYOVERS
The program treats income and expense carryover rows the same way as 
other income and expense rows. The custom worksheets for these rows 
automatically annualize their entries. When switching from a full year analysis 
to annualization, entries on these custom worksheets are allocated to their 
respective periods. There is conflicting authority on whether the full amount of 
a carryover should be annualized in each period. Compare Rev. Rul 67-93, 
1967-1 CB 366, which suggests that the entire amount of a net operating loss 
carryover should be deducted from the income for the appropriate period prior 
to annualization of the income for such period, with Treas. Reg. § 1.6655-2T, 
which suggests the opposite. The program takes no position on this issue. To 
have the program apply the position of Rev. Rul 67-93, enter the full amount of 
the carryover in all periods on the custom worksheet. To have the program 
apply the position of Treas. Reg. § 1.6655-2T, enter the proportionate amounts 
on the custom worksheet or don't use the custom worksheet and enter the full 
amount on the regular worksheets in all periods.

STATE TAX PAYMENTS AND REFUNDS
When running annualization, special attention should be given to the entries on 
the State Estimated & Withholding worksheets. The auto prepay (or deduct) 
current year tax options on the Resident, New York Nonresident and Other 
Nonresident State Estimated & W/H Payments worksheets should not be used 
unless the proportionate part of the tax computed by the program in each 
period will in fact be paid in that period. When switching from a full year 
analysis to annualization, the payment and refund rows on these worksheets 
should be carefully examined, since it is unlikely that these amounts are paid 
or received evenly throughout the year. Finally, certain rows require annualiza-
tion on these worksheets solely because they are being used in conjunction 
with other amounts that are annualized, and therefore must be "grossed up" to 
yield the proper result. These rows include row 20 (Total Prior Year State 
Credit) on the Resident, New York Nonresident and Other Nonresident State 
Estimated & W/H Payments worksheets as well as row 18 (Tax Benefit Reduc-
tion) on the State Estimated and Withholding worksheet.

SUBPART F & SEC. 936 INCOME
The program does not handle the prior year safe harbor for Subpart F and Sec. 
936 income provided by IRC § 6654(d)(2)(D)(ii).

MINOR CHILD ANALYSIS
The program allows for a Minor Child analysis to calculate the taxes on the 
unearned income of up to nineteen minor children. The tax applies for all 
children under 18 and for certain children under age 24. The program automat-
ically computes the amount of the standard deduction allowable and applies 
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the parent's marginal rates to the child's unearned income. When you select 
this option, the program by default, sets the “Must Itemized Supported” row to 
Yes for all children on the Filing Status worksheet. However, in some cases 
the child may have sufficient earned and unearned income to be self-support-
ing yet still be subject to the Minor Child tax due to lack of sufficient earned 
income. See IRC § 1(g)(A)(ii). You should, therefore, check the Filing Status 
worksheet for the proper setting of this option, which affects both the child's 
standard deduction and his or her eligibility for a personal exemption. For the 
years 2018-2019, the program will compute the children's tax according to 
IRC § 1(j)(4).

ENTERING DATA
The program treats a minor child analysis in a manner similar to a multiple case 
selection, except the first column is for the parent’s tax data and the other 
columns are for each child with income. The label on the Case Titles button 
will change to Child Names and allow you to enter the names of the parent and 
up to nineteen children.

The following illustrates the column headings and first few rows of the Main 
Worksheet for a Minor Child analysis with two children:

 

Enter the parent’s data in column one, labeled Parent, and each child’s tax 
data in the succeeding columns.

Note. When you change a multi-case analysis to a Minor Child analysis, the 
program allows you to specify which case to use for the Parent. Once you 
have selected the case to use for Parent, the prior analysis and the other 
cases are gone. If you change back from the Minor Child analysis to a multi-
case analysis you will not be able to recover the data in the deleted cases. 
Therefore, you should only continue if you have saved the prior analysis or if 
you want to discard the prior analysis.

Note. If you switch an analysis that has Excel links to a Minor Child analysis, 
the program will delete any links in the Income Tax Planner file after issuing a 
message stating that the links will be deleted. You should then switch to the 
other application and delete the corresponding links.

MINOR CHILD ANALYSIS
To select a minor child analysis, this check box must be selected.

wiMainWorksheetChapter5e.png
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NUMBER OF CHILDREN (LIMIT 19)
The program handles up to nineteen children for the Minor Child calculations. 
The default is one. You can enter the number of children or select a number 
from the list box. This line will be dimmed until you select the Minor Child 
Analysis check box.

REPLICATION
FEATURE

If you are increasing the number of children’s cases covered by the analysis, 
the program issues the following message:

 

Respond as follows:

Yes — A message informs you that the number of cases has been 
increased and you must select the child or parent to replicate. Click OK. 
The Choose Replicate Case dialog appears:

In the Replicate box, select the case you want to replicate from the drop-
down list, then click OK. The worksheet expands to include the new 
number of children specified and copies the selected case’s data into all 
newly added columns. (Subworksheet data is also copied.) Click Cancel to 
return focus to the Assumptions dialog.

No — Expands the worksheet to include the number of children’s cases 
selected. All additional columns of the new analysis are filled with zeros. 
You can then use the worksheets to change selected data.
Cancel — Returns focus to the Assumptions dialog to revise your 
changes.

If you increase the number of children in your analysis, the program asks 
whether you want to replicate an existing child’s data into the new minor child’s 
(children’s) column(s). If you click Yes, you may replicate the parent’s or any 
existing child’s data into the new child’s column. If you click No, the program 
expands the worksheet to include the number of children selected in the box 
and does not include data from other columns.

msgReplicate3.png

dChooseReplicateCase2.png
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YEAR OF ANALYSIS (2000 OR LATER)
The analysis year can be 2000 or later. A default year is provided. To use a 
different year, select a year from the list box or type in the desired year. This 
line will be dimmed until you select the Minor Child Analysis check box.
<<Desktop program edition>> Changes to default assumptions are saved in 
the IT.INI file in the following folder:

[drive letter]:\Users\[user name]\AppData\Local\Bloomberg Tax Technol-
ogy\Income Tax Planner

CHILD NAMES
When you click the Child Names button on the Assumptions dialog, the 
following dialog appears:

On the Child Names dialog you can enter the names of up to nineteen children 
and the name of the parent. Procedures for entering, changing, and deleting 
names on this dialog are the same as for the Case Titles dialog discussed 
earlier in this chapter.

RESIDENT STATE
If you have Income Tax Planner with Fifty States, you can select a different 
resident state specifications file for this analysis by clicking the Resident State 
button. The Choose New Resident State Spec dialog will open.

dChildNames.png

dChooseNewResidentStateSpec.png
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NONRESIDENT STATE
If you have Income Tax Planner with Fifty States, you can select a nonresi-
dent state specifications file for this analysis by clicking the Nonresident State 
button. The Choose Nonresident State Spec dialog will open. 

COMPLETING THE TASK
OK After completing your changes, click OK to accept your changes. The program 

returns focus to the previous worksheet after making your changes.
CANCEL To leave this dialog without accepting any changes made since you opened the 

dialog, select Cancel. The program will issue the Cancel Assumptions 
Change message.

HELP Select Help to review specific information concerning the items on this dialog.

SAVE AS
DEFAULT

To save your selection(s) as the default for future analyses, select Save as 
Default on the Assumptions dialog. The program saves your selection for 
every item (except Client Name and Case Titles) for the default.
When you select Save as Default, a message appears informing you that the 
program has saved your assumptions to the initialization file. The message will 
close and the focus will return to the previous worksheet.

dChooseNonresidentStateSpec.png



158

::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::

This page is intentionally left blank.



159

W
O

R
K

SH
EE

TS
 

M
EN

U
W

O
R

K
SH

EE
TS

 
M

EN
U

W
O

R
K

SH
EE

TS
 

M
EN

U
W

O
R

K
SH

EE
TS

 
M

EN
U

W
O

R
K

SH
EE

TS
 

M
EN

U

::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::

6
6 Worksheets Menu

WORKSHEETS MENU

MENU COMMANDS
The Worksheets menu allows you to manipulate the tax input and output 
worksheets, both in the data file and as windows on the screen. Through the 
Worksheets menu you can access the following program functions: 

Show or Hide the Worksheet List.

mWorksheetsMenu.png

Before capturing image, open the Withholding Estimated & 
Penalty worksheet, and click a row containing a subworksheet.
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Open, close, kill, zap a custom worksheet, or print a worksheet highlighted 
in the Worksheet List using the Worksheet List submenu commands. (You 
can also sort the items in the Worksheet List.)
You can also close all subworksheets using the Close All Subworksheets 
command or open and bring a specific worksheet into focus using the Go 
to Subworksheet command.
Arrange the worksheets (as windows) in your workspace, using the 
Cascade, Tile Horizontally, Tile Vertically, Tile Optimally, and Arrange 
Icons commands. You can also have the worksheets open directly on top 
of the previous worksheet, using the Use Same Window command.  
Select how worksheets are treated when you press the Esc key: closed, 
minimized, or left open.

You can also use commands on the Worksheets menu to access special 
worksheets, such as: 

Batch Input 
Individual Activities 
Summary Report 
Present Value 
W-4
Alternative Capital Gains Tax 
Security Transaction Analyzer 
Watch Window 
4868 Extension
1040–ES Payment Vouchers 

If you have Income Tax Planner with Fifty States, you can use the 
commands on the View Worksheets submenu to restore the worksheets of a 
selected type (federal, resident state, New York nonresident, or other nonresi-
dent state) and minimize all other types of worksheets.

The Worksheets menu also lists the names of the worksheets that are currently 
open. Each of the above items will be discussed in detail within this chapter.

SHOW/HIDE WORKSHEET LIST
These commands allow you to display or hide the Worksheet List in the main 
program window. By initial default, the Worksheet List is shown. The command 
displayed on the Worksheets menu toggles between Show Worksheet List 
and Hide Worksheet List, depending upon whether the Worksheet List is 
currently displayed or not. If you have Income Tax Planner with Fifty States, 
this Show/Hide setting is also applied to the Spec Worksheet List panes.
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When you exit the program, the Show/Hide Worksheet List setting is retained 
as the default for the next time you start the program.

To use the toolbar to perform this function, click the Show/Hide Worksheet 
List icon on the main program toolbar.

USING THE WORKSHEET LIST
The Worksheet List lists all worksheets and indicates the status of each built-in 
worksheet, custom worksheet, and Individual Activity item. The Worksheet List 
also includes the Client Letter, Graph, Security Transaction Analyzer, and (if 
applicable) 1040–ES/1041–ES Payment Vouchers. 

Note. If you have Income Tax Planner with Fifty States, you can also access 
the Resident State Specifications or Nonresident State Specifications 
menus and worksheets from the Worksheet List.

To the left of each item’s name is a set of color-coded symbols represented by 
a printer and by a file folder. The following table describes each item’s status 
condition, its corresponding symbol, and the meaning of each status condition.

The method used to select (or open) a worksheet is discussed under Select-
ing a Worksheet on page 161. 

You will find a description of program worksheets in Chapter 1 of the Tax 
Reference Guide. Use the descriptions to determine which subworksheets 
you may need to use. See also the discussion of Specialized Worksheets on 
page 169. For a discussion of basic worksheet structure and operation, see 
Overview of Worksheets on page 35.

SELECTING A
WORKSHEET

You can use either the mouse or the keyboard to scroll through the Worksheet 
List, then locate and select an item in the List. After selecting a worksheet in the 
List, you can open, close, kill, print, or (for custom worksheets) zap it.

OPEN
WORKSHEETS

An open worksheet is a worksheet that you have called up, either by double-
clicking or pressing W while on its access row, or by selecting Open Worksheet 

Status Symbol Description Definition
Full Color Print Worksheets selected for printing

Dark Gray Do not Print Worksheets selected for printing but will not be printed 
because of the settings for Print Custom Worksheets 
or Don’t Print Empty worksheets on the Page Setup 
dialog

Light Gray Do not Print Worksheets not selected for printing

Blue Active Active worksheets

Yellow Inactive Inactive worksheets

Blue & Red Custom Custom worksheets



162

::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::

on the Worksheet List submenu, or by double-clicking the worksheet name in 
the Worksheet List. (The Main Worksheet is an exception — it is opened 
automatically when you start the program and cannot be closed.) An open 
worksheet exists either in a window or as a minimized icon within the program 
workspace. Since open worksheets are always active, the program can post 
amounts to them.

CLOSED
WORKSHEETS

A closed worksheet is a worksheet that does not exist in a window or as an 
icon within the program workspace. You can close an open worksheet by 
clicking on its Close  icon or by pressing Ctrl+F4 while in the worksheet. You 
can also close an open worksheet by selecting Close Worksheet on the 
Worksheet List submenu, or by right-clicking the worksheet name in the 
Worksheet List, then selecting Close. Closed worksheets can be active or 
inactive. If a closed worksheet is active, the program can still post amounts to 
it.

ACTIVE
WORKSHEETS

The program can post amounts to the calculated rows of an active worksheet. 
An active worksheet can be open or closed.

INACTIVE
WORKSHEETS

An inactive worksheet is one that you either have not opened or have killed. 
The program cannot post amounts to inactive worksheets. Inactive worksheets 
are always closed.

KILLED
WORKSHEETS

A killed worksheet was open at one time. Killing a worksheet clears all data 
from the worksheet.

If you try to kill a worksheet that has active subworksheets, you will receive a 
message telling you to kill the active subworksheets before killing the selected 
worksheet. Select OK to continue, then kill all active subworksheets pertaining 
to that worksheet before killing the worksheet.

WORKSHEET LIST COMMANDS
This submenu of Worksheet List commands is active only when the Worksheet 
List is displayed (on the Options menu, select View Worksheet List Left or 
View Worksheet List Right). The following commands are available from the 
Worksheet List submenu (accessed from the Worksheets menu) and from the 
shortcut menu (accessed by right-clicking in the Worksheet List).

OPEN WORKSHEET 
The Open Worksheet command opens the active or inactive worksheet 
selected in the Worksheet List. You can also open a worksheet from the 
Worksheet List by right-clicking the worksheet name and selecting Open.



163

W
O

R
K

SH
EE

TS
 

M
EN

U
W

O
R

K
SH

EE
TS

 
M

EN
U

W
O

R
K

SH
EE

TS
 

M
EN

U
W

O
R

K
SH

EE
TS

 
M

EN
U

W
O

R
K

SH
EE

TS
 

M
EN

U

::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::

CLOSE WORKSHEET 
The Close Worksheet command closes the open and active worksheet having 
the focus. You can also close a worksheet from the Worksheet List by right-
clicking the worksheet name and selecting Close.

KILL WORKSHEET 
The Kill Worksheet command kills the worksheet having the focus, unless it is 
a worksheet that must remain active. Killing a worksheet also clears all data on 
the worksheet. You can also kill a worksheet from the Worksheet List by right-
clicking the worksheet name and selecting Kill.

ZAP CUSTOM WORKSHEET
The Zap Custom Worksheet command deletes a custom subworksheet from 
a row on a custom worksheet. The subworksheet data and the worksheet itself 
will be deleted. Any Excel links to or from the zapped custom worksheet will be 
deleted as well. You can also zap a worksheet from the Worksheet List by right-
clicking the worksheet name and selecting Zap.

PRINT WORKSHEET 
The Print Worksheet command prints the worksheet selected in the 
Worksheet List. If the worksheet is not open and active, using this command 
opens and brings the focus to the selected worksheet. If the selected 
worksheet has any notes and/or custom worksheets and the Notes and/or 
Custom Worksheets option(s) is selected in the Page Setup dialog, these 
items also print along with the selected worksheet. You can also print a 
worksheet from the Worksheet List by right-clicking the worksheet name and 
selecting Print.

SORT WORKSHEET LIST
The Sort List command displays the Sort Worksheet List dialog that allows 
you to sort the worksheets listed in the Worksheet List by structure or by name. 
The dialog can also be displayed by right-clicking anywhere on the Worksheet 
List and selecting Sort.

 

If you want to sort the Worksheet List according to the program’s worksheet 
structure, select Structure. If you want to display an alphabetical list of 
worksheet names, select Name.

dSortWorksheetList.png
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To activate your choice, click OK. To discard any changes, click Cancel.

Note. You can use the Worksheet List to jump quickly to a known worksheet 
title, even if you don’t know its place in the worksheet structure. Press the initial 
letter of the worksheet title to go to the first worksheet beginning with that letter. 
For example, press I and (if you clicked in the beginning of the List) you will 
jump to the Individual Activities worksheet. Then, if you want the Interest 
and Dividends worksheet, click on this worksheet title or press I again. 

(If the worksheets are sorted by structure, the “first” worksheet will be the 
closest one beginning with the letter you type.)

HELP FOR LIST 
The Help For List command displays help for the Worksheet List. To display 
the Help, right-click the Worksheet List then select Help for the selected 
worksheet.

GO TO SUBWORKSHEET
Use this command either to call up (or open) a built-in worksheet or to create a 
custom worksheet. See Custom Worksheets on page 41.

To access a row’s subworksheet while in a cell of the row:
Select Go to Subworksheet on the Worksheets menu
Or, double-click on the custom worksheet’s title in the Worksheet List
Or, double-click on a cell in the row
Or, press W

The program will open either the built-in subworksheet or the custom 
worksheet, as applicable.

ARRANGING THE PROGRAM WORKSPACE
The program workspace is that area under the menu bar where the worksheets 
and dialogs appear. The commands in this section of the Worksheets menu 
allow you to have the program quickly place the open worksheets in a specified 
arrangement so that you can see at least part of each open worksheet. These 
commands are divided into three groups: Cascade, Tile, and Arrange Icons.

THE DEFAULT WORKSHEET ARRANGEMENT
When you start the program, the Main Worksheet is open and located in the 
upper left corner of the workspace. Each additional worksheet that you open is 
placed on top of the previously opened worksheet, slightly lower and to the 
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right of the upper edge of the previous worksheet. As shown below, the Filing 
Status worksheet is on top of the Main Worksheet:

 

With this arrangement, the worksheet on top is the one with the focus. The 
color of this worksheet’s Title Bar is different from the color of the worksheets 
beneath it. In this case, the Title Bar of the worksheet with the focus is a darker 
gray than the other worksheets. (The color of the Title Bar is controlled by the 
Appearance tab on the Display dialog accessed from the Control Panel in 
Windows.)

When you press Esc, the worksheet on top (as a default) remains open but 
moves behind the now current worksheet; generally part of the worksheet 
remains visible. As the number of open worksheets in the workspace 
increases, the workspace may become crowded and it can become increas-
ingly difficult to visually identify each worksheet so that you can just click on the 
one you want. For example, the following illustration shows, from bottom to top, 
the Main Worksheet, the Minimum Tax Credit worksheet, the Ordinary 
Income worksheet, and the Filing Status worksheet.

 

Were you to press Esc from the Wages worksheet, it would be nearly obscured 
by the larger Ordinary Income worksheet that would be brought into focus. 

BNAIncomeTaxPlan
nerWindow2.png

BNAIncomeTaxPl
annerWindow3.p
ng
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CASCADE
The Cascade command arranges the worksheets so that each newly opened 
worksheet overlaps the previous worksheet, but the previous worksheet’s Title 
Bar is visible.
The following shows the results of selecting the Cascade command on the 
previous example: 

 

To bring a worksheet to the top and give it the focus, you can click on its Title 
Bar. Or, you can press Ctrl+Tab to bring each worksheet to the top in turn.

Note. The Cascade command operates on worksheets that are currently 
opened. As you open new ones, they are arranged according to the default 
arrangement. Re-select Cascade to re-order the worksheets.

TILE HORIZONTALLY
The Tile Horizontally command displays all open worksheets so that as much 
of each worksheet as possible is visible horizontally. One such arrangement is 
shown below:

 

BNAIncomeTax
PlannerWindo
w4.png

BNAIncome
TaxPlanner
Window5.pn
g
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TILE VERTICALLY
The Tile Vertically command displays all open worksheets so that as much of 
each worksheet as possible is visible vertically. Here is the previous example 
tiled vertically:

TILE OPTIMALLY
The Tile Optimally command displays all open worksheets so that as much of 
each worksheet as possible is visible both horizontally and vertically.

ARRANGE ICONS
Use the Arrange Icons command to place the minimized worksheet icons 
across the bottom of the workspace, starting from the left corner, as shown 
below:

 

BNAIncomeTaxPl
annerWindow6.p
ng

Minimized worksheets

BNAIncomeTaxP
lannerWindow7.
png

Restore icon Maximize icon Close icon
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The worksheet’s name is displayed on the worksheet icon. If the worksheet 
name is truncated, ellipses will appear in the worksheet title. Notice that the 
Ordinary Income worksheet icon is currently selected.
To expand the minimized worksheet and restore it to its previous position in the 
workspace, click the Restore icon.

To maximize the minimized worksheet, click the Maximize icon on the 
worksheet icon.
If the icons are covered by a worksheet on the screen, select Arrange Icons 
to bring the icons into view, and overlay the worksheet.

ESCAPE COMMANDS
Pressing the Esc key moves the focus from the current worksheet into another 
worksheet. The Escape commands allow you to choose how the worksheet 
you leave behind is handled.

LEAVE OPEN ON ESCAPE — DEFAULT
As a default, when you press Esc the current worksheet remains open but 
moves behind the other worksheets. When using this command, neither the 
Close On Escape nor the Minimize On Escape commands on the 
Worksheets menu will have a check mark next to them. To change this 
handling, select one of the following commands from the Worksheets menu.

CLOSE ON ESCAPE
When you select the Close On Escape command, the program will close the 
worksheet that had the focus when you pressed Esc. The worksheet will 
remain active so that amounts can still be posted to it. When this command is 
selected, you will see a check mark next to Close On Escape on the 
Worksheets menu.

MINIMIZE ON ESCAPE
When you select the Minimize On Escape command, the program will 
minimize the worksheet that had the focus when you pressed Esc. The 
worksheet will remain active so that amounts can still be posted to it. When this 
command is selected, you will see a check mark next to Minimize On Escape 
on the Worksheets menu.
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USE SAME WINDOW
When you select the Use Same Window command, the program places 
worksheets opened thereafter directly over the worksheet that currently has 
the focus.
This command allows you to open a worksheet and the graph, tile the two 
windows so that both are visible, then have the program open other 
worksheets on top of the worksheet while the graph is visible so that you can 
see the graph update dynamically as you make changes. When this command 
is selected, you will see a check mark next to Use Same Window on the 
Worksheets menu.

SPECIALIZED WORKSHEETS
In addition to the Main Worksheet and subworksheets, the program provides 
several specialized worksheets: Batch Input Worksheet, Individual Activi-
ties, Summary Report, and Alternative Capital Gains Tax. You can also 
access the 1040–ES Payment Vouchers, Watch Window, 4868 Extension, 
and Securities Transaction Analyzer from the Worksheets menu. In the 
following sections we describe each of these types of worksheets, their 
purposes, and how to use them.

BATCH INPUT
The Batch Input Worksheet is a worksheet containing all the program’s detail-
level input rows, sequentially numbered and grouped under each worksheet 
title. This worksheet is provided as an alternative to entering data on the 
subworksheets.

 

As shown above, input rows are numbered on the Batch Input Worksheet. 
Additional unnumbered rows are worksheet titles and are displayed in the 
same manner as calculated rows.

wiBatc
hInput
Worksh
eet.png

Column 
headers

Worksheet 
title

Numbered 
input row

Calculated 
row
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Note. If you call up the Batch Input Worksheet before entering any data, 
Joint filing status is entered for all years (except for Minor Child computa-
tions), default answers are entered for all Yes/No questions, and all numeric 
cells contain zeros.

SELECTING BATCH INPUT
You may find it faster and more convenient to use the Batch Input Worksheet 
to enter the data for some items, while using the regular worksheets for other 
items.
To open the Batch Input Worksheet, select Batch Input from the Worksheets 
menu or, press B when on another worksheet. You can also select it from the 
Worksheet List.

ENTERING DATA ON THE BATCH INPUT WORKSHEET
You enter numbers on the Batch Input Worksheet the same way you enter 
numbers on any other worksheet.
Use this worksheet just as you would use the program’s regular worksheets. 
Data is posted automatically to the appropriate worksheets for calculation and 
display. Calculations are performed automatically during batch input if you 
select Calculations On from the Options menu.

On the Batch Input Worksheet, you can only enter data into the program’s 
lowest level rows. For example, there is no row for “Interest and Dividends” on 
the Batch Input Worksheet. Instead, there are many rows where the detailed 
interest and dividends data can be entered (e.g., “U.S. Gov't Interest”, “Private 
Activity Bond Int”, etc.).
The Edit commands described in Chapter 4 can be used on both regular 
worksheets and the Batch Input Worksheet.

INDIVIDUAL ACTIVITIES (PASSIVE AND NONPASSIVE 
ITEMS)

Several of the program’s worksheets provide access to the Individual Activity 
worksheets, which handle items from K–1s and 1099s on an activity-by-activity 
basis. Individual Activities worksheets are available only for rows that are 
followed by a row labeled “Individual Activities.” As illustrated below, you can 
access an Individual Activities worksheet for the “Other Lg-term Investmt 
Gain/Loss” row but not for the “5-Year Invst Gain Purch Post-2000” row:
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The Individual Activity worksheets accommodate up to 300 different, individ-
ual activities. For each activity, you can designate the characteristics of the 
activity, e.g., passive or nonpassive, active participation rental real estate, etc., 
and enter the items of income and loss for the activity. All data entered is 
automatically posted back to the rows labeled “Individual Activities” on other 
worksheets in the program, e.g., Interest and Dividends, Capital Gains and 
Losses, etc. 

Note. To open the Individual Activities worksheet while the Worksheets 
menu is open, you can click on the Individual Activities command. If you 
have the Worksheet List open, you can also select Individual Activities from 
there (it will be at the top of the List if you have the worksheet titles sorted by 
structure).

You can have up to 500 passive or nonpassive activities overall, distributed 
among the activities. 

ENTERING DATA ON AN INDIVIDUAL ACTIVITIES WORKSHEET
When you first open an Individual Activities worksheet, you will see an 
“Individual Activities” screen where you enter the name of the activity and its 
characteristics, i.e., passive or MAPRRA, active real estate, PTP information, 
etc. All activities, passive and nonpassive, are entered on this one screen.

 

Note. After you select Print, a message may appear. See Acknowledging the 
Income and Loss Data Message on page 172.

Note. The Individual Activities worksheet has its own menu bar and 
commands. The commands on the regular Edit menu are not available to you 
when entering data on the Individual Activities worksheet.

As you enter the information in the various columns, you can either click on the 
next column you want to change or you can press Enter or the right arrow key 
to move to the next column. When you complete the last column for an 

wiCapitalGainsAn
dLosses.png

wiIndividualA
ctivities.png
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individual activity, either the Passive Activity Items worksheet or the Nonpas-
sive Items worksheet will appear, depending on whether you answered Yes or 
No in the Passive or MAPRRA column. See Passive Activity Items 
Worksheet on page 174 and Nonpassive Items Worksheet on page 175.
For details on each column of this worksheet and how to use it, in the Tax 
Reference Guide, see the Individual Activities worksheet.

Note. You cannot toggle between this worksheet and other worksheets as you 
complete the Individual Activities worksheet. You must complete the 
worksheet and close it to access other worksheets.

ACKNOWLEDG-
ING THE

INCOME AND
LOSS DATA

MESSAGE

Unless you previously suppressed it, a message appears after you open the 
Individual Activities worksheet. This message, shown here, tells you to 
complete entries on the worksheet and then press W or double-click to enter 
income or loss data for the activity. The message also allows you to suppress 
the message or to simply continue.

You will continue to see this message until you select one of the following 
options:

Don’t repeat this message during this session — Selecting this option 
prevents the message from appearing again during your current session.
Don’t repeat this message during any session — Selecting this option 
prevents the message from appearing again during this or any other 
session.

1. Select one or neither of these options before proceeding.
2. Click OK to access the Individual Activities worksheet. See Entering 

Data on an Individual Activities Worksheet on page 171.

EDIT MENU
The commands on the Individual Activities worksheet Edit menu act on 
activities on the worksheet. They are: 

 

msgIncomeAn
dLossData.pn
g

mEditMenuIndividualActivities.png
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COMBINE
The Combine command allows you to combine the data for a passive activity 
with that of a nonpassive activity. You can combine up to two activities at a 
time.
The program will open a dialog that asks for the numbers of the activities you 
wish to combine and, after execution, will issue a message that confirms the 
status of the new combined activity. The newly combined activity will take the 
description of the passive activity.

Note. You cannot combine two passive activities or two nonpassive activities. 
Not can you combine a nonpassive activity with a passive activity that already 
has nonpassive items.

INSERT
The Insert command allows you to insert a new activity above the current 
activity after you have finished entering the information for the current activity.

You can also add an activity after all other Individual Activities by clicking on the 
next row.

KILL
The Kill command allows you to delete an individual activity and its data. The 
program will display a caution message that tells you that all passive and 
nonpassive data for the activity will be deleted and asks you for confirmation. 
The program deletes the activity after you click OK to confirm that you want the 
activity killed.

To kill an activity when the Edit menu is open, first make sure that the cursor is 
resting on the activity you want deleted. Then select the Kill command on the 
Edit menu.

ACTIVITIES MENU
The Go to Activity command on the Individual Activities worksheet Activi-
ties menu accesses the subworksheet for the Individual Activities. 

 

GO TO ACTIVITY
Use the Go to Activity command to jump to the current activity’s Passive 
Activity Items worksheet or Nonpassive Items worksheet.
To jump to an activity’s subworksheet when the Activities menu is open, while 
the cursor is in a cell other than the row description cell, select the Go to 
Activity command on the Activities menu. 

mActivities.png
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CLOSE COMMAND
This command closes the Individual Activities worksheet and returns you to 
the previous worksheet.

PASSIVE ACTIVITY ITEMS WORKSHEET
When you complete the last data field on the Individual Activities worksheet 
row for a passive activity, the Passive Activity Items worksheet appears such 
as this one shown in part:

 

For details on each row of this worksheet and how to use it, in the Tax 
Reference Guide, see the Individual Activity (Passive/MAPRRA Items) 
worksheet.

The Passive Activity worksheet also contains a row to access the Nonpas-
sive Items worksheet.
The Edit menu for the Passive Activity worksheet contains two additional 
commands, Insert item and Kill item.

 

INSERT ITEM (EDIT MENU)
The Insert command inserts a new passive activity item above the current item 
while in a cell of the passive activity worksheet.

KILL ITEM (EDIT MENU)
The Kill command deletes an item from a passive activity worksheet. All data 
for the item and the item itself will be removed from the worksheet.
To prevent an item from being accidentally deleted, the program issues a 
cautionary message requesting confirmation before killing the item.

wiRentalHouseActiveRealEstateS
cenario3c.png

mEditMenuIndividualActivities.png
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NONPASSIVE ITEMS WORKSHEET
If the activity is nonpassive, when you complete the last data field of an 
Individual Activity worksheet row the program skips the Passive Activity 
Items worksheet and goes directly to the Nonpassive Items worksheet, 
partially shown below: 

 

For details on each row of this worksheet and how to use it, see Individual 
Activity (Nonpassive Items) worksheet in the Tax Reference Guide.

COMPLETING THE INDIVIDUAL ACTIVITY WORKSHEETS
When you have completed the worksheets for an activity, click the Close icon 
or press Esc to return to the Individual Activities worksheet, where you can 
start a new activity. 

When you have completed all the activities, the program takes you back the 
way you came in.

SUMMARY
WORKSHEET

FOR NONPAS-
SIVE

ACTIVITIES

If you accessed an activity through a nonpassive “Individual Activities” row, the 
program will summarize all the items posted back to that row from the individ-
ual activity Nonpassive Items worksheets. The following is a summary 
worksheet for Other Interest taken from the George Winchester analysis 
covered in Scenario 3 of the Tutorial, accessible on the program Help menu.

 

Thereafter, when you open a worksheet on any nonpassive “Individual Activi-
ties” row, the program will take you to the summary worksheet for that item. If 
you move to a particular activity on the summary worksheet and double-click 

wiXYZMutualFund.png

woOtherInterestIndividualActivities.png
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on a cell in the row, the program takes you directly to that activity on the 
Individual Activities worksheet.

SUMMARY REPORT
The Summary Report shows the details behind the analysis’ worksheet calcu-
lations. All rows on this report are calculated rows. A small portion of the 
Summary Report is shown below:

 

For a row-by-row explanation of the items on this worksheet, see Summary 
Report worksheet in the Tax Reference Guide.
To easily access the Summary Report, press X or click the Summary Report 
icon on the toolbar.

PRESENT VALUE
The Present Value worksheet contains computations of present value of total 
taxes to be paid over multiple year periods together with cash flows to be 
generated by the transactions under analysis. This worksheet is normally 
accessed and used after data has been entered in the other worksheets.

woSummaryReportScenario1c.png
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For a row-by-row explanation of the items on this worksheet, see Present 
Value worksheet in the Tax Reference Guide.

W-4
The W-4 command on the Worksheets menu allows you to choose either the 
W-4 Worksheet or the W-4 Form.

W-4 WORKSHEET
The W-4 Worksheet computes income withholding needed for the remainder 
of the year. The worksheet may be accessed from the worksheet list. A small 
portion of the worksheet is shown below.

For a row-by-row explanation of the items on this worksheet, see W-4 
Worksheet in the Tax Reference Guide.

W-4 FORM
Opens a window containing the W-4 Form. You can only access this form only 
if the W-4 Worksheet has been activated. Otherwise this command will be 

wiPresentValueScenario2c.png
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dimmed. Data entered on to the forms will be saved in the data file with other 
taxpayer data.

<<Web Program edition only>>  The Taxpayer's SSN and the Spouse's SSN 
and the Employer's EIN are not saved with the plan.

The W-4 Form includes the following:

MENU ITEMS
Next Page – Move to the second W-4 year.
Previous Page – Move to the first W-4 year.
Print – Print the form.
Help – Access this help page.
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Copy Taxpayer to Spouse – Transfers the information in box 1, the 
exemption, employer’s name and address, and first date of employment 
boxes to the second job Form W-4.
Copy from the First Year to the Second Year – Transfers the information 
in box 1, the exemption, employer's name and address, and first date of 
employment boxes to the second year Form W-4.
Case 1 - 20 – Select case 1-20 in the analysis.
Quarter (Annualization Only) – Select the quarter for the W-4 Form.
Parent / Child 1-9 (Minor Child Analysis Only) – Select the Parent or a 
Child for the W-4.

W-4 FORM FIELDS
Box 1a: Enter the taxpayers name and address directly in the four boxes 
provided on the form. 
Box 1b: Enter the social security number in the format xxx-xx-xxxx.
Box 1c: The program checks the box for the filing statuses of married, 
married separate, head of household, or single.
Step 2c: The program checks this box if entries are made on both rows 5 
and 13 of the W-4 worksheet.
Step 3: The program does not use Step 3 of the form.
Step 4a: The program does not use Step 4a of the form.
Step 4b: Line 30 or 43 of the W-4 worksheet.
Step 4c: Line 33 or 46 of the W-4 worksheet.
Exempt box: Type the word "Exempt" if the employee is exempt from 
withholding.
Employer's Name and Address Box: Enter the employer's name and 
address.
First Date of Employment Box: Enter the employee's first date of 
employment.
Employer Identification Number (EIN): Enter the employer identification 
number in the format xx-xxxxxxx.

Note. Box 1a, the Exempt box, the Employer’s Name and Address box, the 
First Date of Employment box, and the Employer Identification Number 
(EIN) will be the same for all cases.
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ALTERNATIVE CAPITAL GAINS TAX
If Alternative Capital Gains tax does not apply for a particular year or case, the 
fields for that column will be filled with N/A:

 

For a row-by-row explanation of the items on this worksheet, see Alternative 
Capital Gains Tax worksheet in the Tax Reference Guide.

SECURITY TRANSACTION ANALYZER WORKSHEET
The Security Transaction Analyzer handles most capital gains and losses 
from the sale of stocks and bonds. It automatically allocates the gain or loss 
from each transaction to the appropriate year and category without further user 
adjustment, and produces detailed reports. It is especially useful in years such 
as 2003, when there are different treatments of gain or loss depending on 
whether the transaction occurs before or on or after a specific date.

Note. The program assumes that all transactions entered on the Security 
Transaction Analyzer worksheet are capital asset investment transactions 
(as opposed to trade or business, personal, or ordinary income and loss 
transactions). The Analyzer worksheet should not be used for Section 1231 
transactions or sale of personal assets (such as a residence). Nor should it be 
used for transactions of security dealers. It also should not be used for 
unrecaptured section 1250 gain, for sales of Section 1202 (small business) 
stock, or losses on Section 1244 stock. It may be used for investment collect-
ibles gain or loss, provided the holding period override is used to select 28% 
Rate for these gains and losses.

wiAlternativeCa
pitalGainsTaxb.
png

wiAlternativeC
apitalGainsTax
a.png
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As you enter transactions, the program calculates the total for each year at the 
bottom of the worksheet. Once you close the Security Transaction Analyzer 
worksheet, the program automatically posts all data on the worksheet back to 
the Capital Gains and Losses worksheet, 2003 Post 5/5 Capital Gains and 
Losses worksheet, and the 28% Rate Capital Gains and Losses worksheet, 
as appropriate. The gains and losses are distributed, as required under the Tax 
Relief Act of 1997 as amended by the Internal Revenue Service Restructuring 
and Reform Act of 1998, and as further amended by the Jobs and Growth Tax 
Relief Reconciliation Act of 2003 among the following holding period catego-
ries of gain or loss: 

2003 post 5/5 short-term
other short-term
2003 post 5/5 long-term
28% rate long-term
5-year gain purchased before 2001
other long-term

Note. To open the Security Transaction Analyzer for a row while the 
Worksheets menu is open, you can click the Security Transaction Analyzer 
command. If you have the Worksheet List open, you can also select Security 
Transactions from there (it will be at the top of the List if you have the 
worksheet titles sorted by structure).

Note. To open the Security Transaction Analyzer without opening the 
Worksheets menu, move to the desired “Security Transaction Analyzer” row 
and double-click in the row. 

ENTERING DATA ON THE SECURITY TRANSACTION ANALYZER
When you first open the Security Transaction Analyzer, you will see a 
Security Transaction Analyzer screen (shown below) where you enter a 
description of the property and the details of the transaction.
There is no limitation in the program for the number of security transaction 
items you can have on the Security Transaction Analyzer worksheet. 
However, the number of items may be limited, depending upon the amount of 
available memory in your computer. We strongly suggest that you have the 
Auto Backup feature turned on to minimize data loss in case an out-of-memory 
situation arises.
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Note. The Security Transaction Analyzer has its own menu bar and 
commands. The commands on the regular Edit menu are not available to you 
when entering data on the Security Transaction Analyzer.

For details on each column of this worksheet, see the Tax Reference Guide.

MOVING
WITHIN THE

WORKSHEET

As you enter the information in the various columns, you can either click on the 
next column you want to change or you can press Enter or the right arrow key 
to move to the next column. You must provide information for every column of 
the transaction. When you complete the last column (Cost or Other Basis) for 
a security transaction, the cursor will move to a new transaction row to allow 
you to enter the next security transaction.

Note. You can scroll the worksheet to the right using Ctrl+Right Arrow key. To 
scroll the worksheet to the left, use Ctrl+Left Arrow key.

CHANGING
SECURITY

TRANSACTION
DETAILS

You can edit cells directly on the Analyzer worksheet, using the F2 edit key for 
dates and numbers. You can also use the commands on the Analyzer’s Edit 
menu to insert a transaction above the active transaction row (where the cursor 
rests), delete the selected transaction, or view transaction details. See Edit 
menu on page 185.

MOVING
BETWEEN

WORKSHEETS

Note. You cannot toggle between the Analyzer and other worksheets as you 
enter transactions on the Analyzer. You must complete and close the 
Analyzer to access the other worksheets.

SECURITY INFORMATION DIALOG
The Analyzer lets you override the holding period computation for a transac-
tion by using the dialog shown below.
This dialog is important for transactions such as puts and calls, short sales, 
collectibles gains or losses, and other special transactions.

wiSecurityTransa
ctionAnalyzerSce
nario1b.png
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To access the Security Information dialog, double-click in the Security 
Number column for a particular security or select View from the Analyzer’s 
Edit menu. (The dialog automatically appears whenever the program detects 
an acquisition date that comes after the sales date for a transaction, since this 
usually indicates a short sale.) For any transaction for which you have overrid-
den the holding period, an active icon replaces the inactive icon next to the 
Security Number.
In addition to letting you override the holding period computation, the Security 
Information dialog also provides an alternate way for you to enter the original 
transaction data or correct the other information related to the sale.

DESCRIPTION
OF PROPERTY

In this text box enter a description of the security. Up to 35 characters are 
permitted. This item is mandatory.

INCLUDE IN
CASE

Select from the drop-down list the appropriate item to reflect whether the 
program will include the transaction in all, none, or one or more particular 
cases.

OWNER Enter a description of the security’s ownership, either “Taxpayer,” “Spouse,” or 
“Joint.” Applies only to Taxpayer/Spouse analyses.

DATE
ACQUIRED

Enter a full 8-digit date acquired here (MM/DD/YYYY). You must enter a full, 4-
digit year. This item is mandatory.

COST OR
OTHER BASIS

Enter the cost or other basis of the property. This item is mandatory.

DATE SOLD Enter a full 8-digit date sold here (MM/DD/YYYY). You must enter a full, 4-digit 
year. If you enter a date sold that is earlier than the date acquired, you must 
override the holding period below. This item is mandatory.

SALES PRICE Enter the amount received from the sale of the security. This item is mandatory.

dSecurity#1.png
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HOLDING
PERIOD

OVERRIDE

The program automatically determines the holding period of the transaction 
using your entries in the two date boxes above, provided the date sold is after 
the date acquired. If the date acquired is after the date sold (such as for short 
sales), you must override the holding period by clicking in this check box and 
selecting one of the holding periods below. When you override the holding 
period, the inactive icon in the Sec. # column of the Security Transaction 
Analyzer worksheet changes to an active icon.

THE REMAIN-
ING COLUMNS

The program determines the holding period of the transaction and places the 
calculated gain or loss in the appropriate columns, listed below. For each 
transaction, there will be an amount in one of the Total columns (either Total 
Short-Term or Total Long-Term) and in one of the breakdown columns (either 
2003 Post 5/5 Short-term, Other Short-term, 2003 Post 5/5 Long-term, 
28% Rate Long-Term, 5-Year Gain Purchased Before 2001, or Other Long-
Term). 

Total Short-Term 
2003 Post 5/5 Short-Term — applies only to transactions in 2003.
Other Short-Term 
Total Long-Term 
28% Rate Long-Term 
2003 Post 5/5 Long-Term – Applies only to transactions in 2003.
28% Rate Long-Term 
5-year Gain Purchased Before 2001 — Includes transactions resulting in a 
capital gain (strictly gains) that were held for more than 60 months, 
acquired before 12/31/200 and sold after 12/31/2000 and before 5/6/03, 
and after 12/31/2012. See “Annualization Analyses,” Note 2, below.
Other Long-Term 

MULTIPLE CASE SCENARIOS
The Security Transaction Analyzer posts its results into all cases in the 
analysis. It is, therefore, not suitable for testing hypothetical sales in multiple 
case scenarios. Enter only actual sales on the Security Transaction Analyzer 
worksheet. Enter hypothetical sales directly on the other worksheets in the 
program, in the appropriate cases, after entering the actual sales on the 
Security Transaction Analyzer.

ANNUALIZATION ANALYSES
The Security Transaction Analyzer worksheet works with Annualization for 
estimated tax purposes when the Annualization analysis is selected. For 
Annualization analyses, the program automatically sorts the transactions on 
the Security Transaction Analyzer worksheet into the proper quarters and 
applies the annualization factor to the totals.
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Note. For assets purchased on the last day of a month, the program follows the 
rule of Rev. Rul. 66-7, 1996-1 C.B. 188, to the effect that, to qualify for the 
favorable holding period, the asset must be held until the first day of the next 
month at the end of the holding period. For example, an asset purchased on 
February 28, 1999, must be held until March 1, 2000, to qualify as being held 
more than one year. If it is sold on February 29, 2000, the holding period is not 
more than one year and the gain or loss is short-term. 

Note. The program includes the gain or loss in the year indicated in the Date 
Sold column or the Date Purchased column for sales that occur before 
purchases (short-sales). There is no provision in the program for computing 
the holding period and the year of inclusion in inconsistent ways. See Rev. Rul. 
93-84, 1993-2 C.B. 225.

EDIT MENU
The commands on the Security Transaction Analyzer worksheet’s Edit menu 
act on the items on the worksheet. These commands are:

INSERT
Allows you to insert a row for a new security transaction above the current row, 
but only after you've finished entering the information for the current transac-
tion. You can also add an item below all other securities by clicking on the next 
row.

DELETE
Allows you to delete a selected security and its data.

VIEW
Opens the Security Information dialog for the current row, allowing you to 
view or change the data for the security. You can also override the holding 
period for the transaction by clicking the Holding Period Override check box, 
then selecting the desired holding period.

MATH CALCULATOR
Opens the Math dialog, providing a calculator function for numeric cells. See 
Math Calculator Command on page 115.

mEditSecurityTransactionAnalyzer.png
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PRINT COMMAND
This command allows you to print the Security Transaction Analyzer 
worksheet. You can also set up the print conditions for the Analyzer and 
preview the worksheet before printing it. 
For more information on printing the Security Transaction Analyzer, see 
Printing the Security Transaction Analyzer on page 290 and Customizing 
the Security Transaction Analyzer Results on page 306.

CLOSE COMMAND
This command closes the Security Transaction Analyzer and returns the 
focus to the previous worksheet.

WATCH WINDOW
The Watch Window displays calculated or active worksheet rows that you 
specify in a window docked at the bottom of the main program window. This 
feature allows viewing of key rows at all times. The following icons are 
displayed in the watch window toolbar:

WATCH Opens the Edit Watch Window dialog where you specify the rows to be 
displayed in the watch window.

MOVE UP The Move Up icon moves the row for the currently selected caption in the 
watch window up.

MOVE DOWN The Move Down icon moves the row for the currently selected caption in the 
watch window down.

SAVE Saves the current rows specified in the watch window so that the list will 
reappear the next time the program is started and the watch window is opened. 
This feature is useful if you like to watch the same set of rows each time you 
use the program.

CLOSE Closes the watch window.
HELP Opens this help topic.

EDIT WATCH WINDOW DIALOG
The Edit Watch Window dialog displays a list of all currently active 
worksheets. For each worksheet the calculated and active worksheet rows are 
displayed when the worksheet title is expanded by clicking the + sign to the left 
of the title or pressing the right arrow key when the title is selected. When a row 
is selected in the dialog it is automatically added to the watch window. When a 
row is deselected in the dialog it is automatically removed from the watch 
window. The following icons are displayed at the bottom of the dialog:

OK – Closes the edit watch window dialog
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Cancel – Restores the watch window to the rows that were displayed 
when the edit watch window was opened and then closes the dialog
Clear – Removes all rows from the Watch Window
Help – Opens this help topic.

NOTES
The watch window can display a maximum of 10 rows at a time
When a worksheet becomes inactive any rows that are in the watch 
window for that worksheet are automatically removed.
When a worksheet becomes active any rows that were previously saved 
for that worksheet are automatically added to the watch window.

4868 EXTENSION

APPLICATION FOR AUTOMATIC EXTENSION OF TIME TO FILE 
U.S. INDIVIDUAL INCOME TAX RETURN

Opens a window containing the 4868 form. You can only access this form only 
if the Withholding, Estimated, and Penalty worksheet has been activated. 
Otherwise, this command will be dimmed. Data entered on to the forms will be 
saved in the data file with other taxpayer data.

<Web Program edition only>> The Taxpayer's SSN and the Spouse's SSN  
are not saved with the plan.

The 4868 form includes the following:
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MENU ITEMS
Print - Print the form.
Help - Access this help page.
Case Selection Box - Select case 1-20 in the analysis. In a Minor Child 
Analysis select either the parent or one of the children. In an Annualization 
Analysis the program only displays the Full Year case.
Add 1st Quarter 2017 Estimate - Check the box to add the first quarter 
estimate to the amount of the estimated total tax liability, line 4.

Caution! When this box is checked, do not make an entry on the “Payment 
with Extension” row of the Credits worksheet for the 4868 year, and select 
Yes for the “Apply Refund to Estimated” row on the Withholding, 
Estimated, and Penalty worksheet for the subsequent year.

Use Required Payment - Select the radio button to add the amount on the 
Net Current Year 1st Payment Due row from the Withholding, Estimated, 
and Penalty Worksheet to Line 4, Estimate of total tax liability.
Use Payment Made - Select the radio button to add the amount on the 
Current Year 1st Payment Made row from the Withholding, Estimated, and 
Penalty Worksheet to Line 4, Estimate of total tax liability.
Override Balance Due (Line 6) - Check the box to enter an amount for 
line 6 into the box. Line 4 will then equal the amount in line 6 less the 
amount on line 5.
Zoom Buttons and Slider - Use the slider to zoom in or out on the form. 
Use the buttons with the diagonal directional and horizontal arrows to fit 
the form to the visible and horizontal areas respectively.

4868 FORM FIELDS
Box 1: Enter the taxpayers name and address directly in the four boxes 
provided on the form. 
Box 2: Enter the social security number..
Box 3: Enter the spouse's social security number.

Box 4: The amount on the Net Federal Tax row less the amount on the 
Federal, Withholding and Estimated row of the Main Worksheet.
If the option to add the first quarter payment has been chosen, the box will 
instead include the sum of 

the greater of:

The “Total Payments” row less the “Payments with Extension” row of 
the Credits worksheet, or
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The “Net Federal Tax” row less the “Federal Withholding and 
Estimated” row on the Main Worksheet.

and the greater of:

If use required payment is chosen, the “Net Current Year 1st Payment 
Due” row from the subsequent year of the Withholding, Estimated, 
and Penalty worksheet, or 
If Use Payment Made is chosen, the “Current Year 1st Payment Made” 
row from the subsequent year of the Withholding, Estimated, and 
Penalty worksheet.

Notwithstanding the instructions for the 4848 form the program will include the 
amount of any estimated tax penalty calculated by the program on this row.

Caution! When this box is checked, do not make an entry on the “Payment 
with Extension” row of the Credits worksheet for the 4868 year, and select Yes 
for the “Apply Refund to Estimated” row on the Withholding, Estimated, and 
Penalty worksheet for the subsequent year.

Box 5: The amount on the Total Payments row less the amount on the 
Payment with Extension row of the Credits Worksheet.
Box 6: The amount on Box 4 less the amount on line 5, but not less than zero.

Box 7: Enter the amount of payment made.
Box 8: Check the box for "out of the country".
Box 9: Check the box for "1040NR" or "1040NR-EZ".

1040-ES AND 1041-ES PAYMENT VOUCHERS
Opens a window containing the 1040-ES Payment Vouchers form window. 
You can only access this command if the Withholding, Estimated & Penalty 
worksheet is active and the analysis includes the current year. Otherwise this 
command will be dimmed. For estates and trusts, this command appears as 
1041-ES Payment Vouchers, and opens the 1041-ES Payment Vouchers 
form window.
The 1040-ES Payment Vouchers form window shows the results of the 
analysis’ worksheet calculations for the “Required Payment” or “Payment 
Made” rows on the Withholding, Estimated & Penalty worksheet. Directly 
enter data on to the form. For estates and trusts, the 1041-ES Payment 
Vouchers form opens in this window.
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<<Web Program edition only>> The Taxpayer's SSN and the Spouse's SSN 
are not saved with the plan.

The 1040-ES or 1041-ES form windows include the following options:

MENU ITEMS
Next Page – Move to the third and fourth quarter vouchers
Previous Page – Move to the first and second quarter vouchers
Print – Print the form.
Help – Access this Help page.
Use Required Payment – Select this option if you want the 1040-ES 
Payment Vouchers prepared using the “Required Payment” rows of the 
Withholding, Estimated & Penalty worksheet. The program will apply 
any withholding to the amounts.
Apply Previous Period Under(Over)payment – If you select this box 
along with Use Required Payment, the required payment for each quarter 
after the first is computed cumulatively adding in prior quarters' required 
payments and subtracting out the payments made for those quarters. If no 
payments are entered, the required payment increases each quarter. 
Therefore, you should only use this option on a per-quarter basis and not 
to prepare all the vouchers for the year.
Use Payment Made – Select this option if you want the 1040-ES Payment 
Vouchers prepared using the “Payment Made” rows of the Withholding, 
Estimated & Penalty worksheet.



191

W
O

R
K

SH
EE

TS
 

M
EN

U
W

O
R

K
SH

EE
TS

 
M

EN
U

W
O

R
K

SH
EE

TS
 

M
EN

U
W

O
R

K
SH

EE
TS

 
M

EN
U

W
O

R
K

SH
EE

TS
 

M
EN

U

::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::

Case 1-20 – Select the case you want Income Tax Planner to use when 
preparing the 1040-ES Payment Vouchers. This option is not available 
when running an Annualization or Minor Child analysis.
Quarterly (Annualization Analysis Only) – If you select Quarterly, the 
payment on the last quarter's voucher is a computed amount that does not 
appear on the Withholding, Estimated & Penalty worksheet. This 
amount is computed as:

If Apply Previous Period Under(Over)payment was selected, the required 
payments are computed as described but each quarter's payment, after 
the first, is computed cumulatively adding in the required payments for the 
prior quarters and subtracting out the payments made for those quarters.

Full Year (Annualization Analysis Only) – If you select Full Year, the 
amounts on the vouchers for all quarters appear on the Withholding, 
Estimated & Penalty worksheet in the Full Year column.
Parent / Child 1-9 (MInor Child Analysis Only) – Select Parent or the 
child that you want Income Tax Planner to use when preparing the 1040-
ES Payment Vouchers. This option is only available when running a Minor 
Child analysis. When selecting a child, use the child's information to 
complete the client items above.

1040-ES FORM FIELDS
Client's first name and initial – Enter the taxpayer's first name and 
middle initial.
Client's last name – Enter the taxpayer's last name.
Client's SSN – Enter the taxpayer's social security number.
Spouse's first name and initial – Enter the spouse's first name and 
middle initial, if applicable.
Spouse's last name – Enter the spouse's last name, if applicable.
Spouse's SSN – Enter the spouse's social security number, if applicable.
Address (number, street, apt. number) – Enter the street address of the 
client.
City, state, ZIP code – Enter the city, state, and ZIP code portion of the 
client's address.

Required Annual Payment (for the Full Year)
less Current Year 1st Req'd Pmt (for the first period)

less Current Year 2nd Req'd Pmt (for the second period)

less Current Year 3rd Req'd Pmt (for the third period)
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Foreign country name – The name of the foreign country, as entered on 
the 1040-ES Data dialog.
Foreign province/county – The name of the foreign province or county, 
as entered on the 1040-ES Data dialog.
Foreign postal code – The foreign postal code, as entered on the 1040-
ES Data dialog.

1041-ES FORM FIELDS
Employer Identification Number – Enter the taxpayer's employer identi-
fication number.
Name of Estate or Trust – Enter the name of the estate or trust.
Name and title of fiduciary – Enter the name and title of the fiduciary.
Address of Fiduciary – Enter the address of the fiduciary.

Note. The above form fields will be the same for all cases. 

CLOSE ALL SUBWORKSHEETS
Use this command to close all subworksheets in the current analysis. Only the 
Main Worksheet, Graph, and 1040-ES Payment Vouchers will remain open 
after you invoke this command.

To use the toolbar to perform this function, click the Close All Worksheets 
icon on the main program toolbar.

VIEW WORKSHEETS

If you have Income Tax Planner with Fifty States, use this submenu to 
display the open federal, resident state, New York nonresident, or other 
nonresident worksheets, while minimizing other worksheets. 

FEDERAL WORKSHEETS
Use this command to quickly display windows for all open federal worksheets. 
All other worksheets will be minimized.

To use the toolbar to perform this function, click the View Federal Worksheets 
icon on the main program toolbar.

mViewWorksheets.png
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RESIDENT STATE WORKSHEETS
Use this command to quickly display windows for all open resident state 
worksheets. All other worksheets will be minimized. If none are open, displays 
the resident State Tax–Main Worksheet.

To use the toolbar to perform this function, click the View Resident State 
Worksheets icon on the main program toolbar.

NEW YORK NONRESIDENT WORKSHEETS
Use this command to quickly display windows for all open New York Nonres-
ident worksheets. All other worksheets will be minimized. If none are open, 
displays the New York Nonresident Tax worksheet.

To use the toolbar to perform this function, click the View New York Nonresi-
dent State Worksheets icon on the main program toolbar.

OTHER NONRESIDENT STATE WORKSHEETS
Use this command to quickly display windows for all open nonresident 
worksheets (other than New York). All other worksheets will be minimized. If 
none are open, displays the Nonresident State Tax – Main worksheet.

To use the toolbar to perform this function, click the View Other Nonresident 
State Worksheets icon on the main program toolbar.

LIST OF OPEN WORKSHEETS
At the bottom of the Worksheets menu is a numbered list of open worksheets, 
for example:

 

You can use this list to bring a particular open worksheet to the top by clicking 
on the worksheet title or by pressing the key matching the worksheet’s corre-
sponding list number. The worksheet that currently has the focus has a check 
mark next to it on the list.

mWorksheetsMenu2.png

Check mark indicates the worksheet with the focus
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7
7 Graph

GRAPH
OVERVIEW

The Graph feature allows you to set up a graphic representation which shows 
various aspects of the case as they relate to each other.
You can customize the graph to best suit your needs. You can:

Specify which data types or worksheet rows to include on the Graph

Specify the type of graph you want
Define the graph’s appearance
Specify the graph titles

Each of these items will be described in detail within this chapter.

GRAPH ITEMS
GRAPH WINDOW

The Graph window below illustrates the parts of a 3D bar graph, stacked 
vertical.
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The Graph window opens when you select Graph from the menu bar. It 
displays a graphic representation of the client’s current data according to 
selections you make for Data, Type, and Titles. The graph is shown against a 
grid background to make it easier to relate a graph element to an amount.
The selections you make for the graph are saved with the client file so that you 
don’t have to redefine the graph every time you call it up.

Note. You can make this window larger or smaller by dragging the window’s 
borders. The width and height of the graph change proportionally with the 
window’s dimensions.

CASE AXIS
All cases and years in the client file are presented in the graph, in the same 
order as on a worksheet. The program identifies each column in the following 
format: Case Title:Year, at the base (or Case axis) of the graph. The graph’s 
Case axis is at the bottom of the graph for vertical graphs and on the left for 
horizontal graphs.

Note. Long case titles may run together when printed, although they may look 
fine on-screen. When this happens, you may want to shorten the case title 
(select Case Titles on the Assumptions dialog).

For multi-year, single-case analyses, the case title prints as the bottom graph 
title rather than at the base of the Case axis, preceding any graph title that you 
may have specified.

AMOUNT OR PERCENT AXIS
The Amount or Percent axis is divided evenly into several segments at the 
axis-points. At each axis-point along this axis a number appears which shows 

Case Axis

GraphSc
enario2a.
png

Amount/
Percent Axis

Graph Title

Left Title
Graph 
Data 
Items

Toolbar
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the percent or amount at that axis co-ordinate. The Amount axis is on the left 
for vertical graphs and at the bottom for horizontal graphs.
The program displays the amount that each axis-point represents to the left or 
below each axis-point.

DATA ITEMS
To help you identify each data item on the graph, on the right side of the graph 
the program lists each data item selected for the graph (when there is more 
than one item selected). Each item is shown in a different color, the same color 
that the program uses on the graph for the item.
Next to each data item is a line or a multi-sided symbol (for line graphs) or a 
small rectangle (for other graph types). The lines or rectangles display a 
pattern in addition to the color if you select Patterns in the Graph Type dialog. 
Otherwise, they are solid.
When you’ve selected only a single data item, the description for the data item 
prints in the top graph title, next to any title you may have specified in the 
Graph Titles dialog.

TOOLBAR
You can customize the graph for the client using the Data, Type, and Title 
icons.

Data — Opens the Graph Data dialog which allows you to select which 
data types or worksheet rows you want represented on the graph (the data 
items consist of one worksheet row or a combination of worksheet rows)
Type — Opens the Graph Type dialog which allows you to customize the 
appearance of the data on the graph

Titles — Opens the Graph Titles dialog which allows you to enter the titles 
that you want to appear on the graph
Help — Opens the help topic for the Graph window

You can set new defaults for the Graph Data, Graph Type, and Graph Titles 
on their respective dialogs, or you can restore the original defaults.

FONTS
The font used for the graph is the same as the screen font used for the 
worksheets. You can change the font by selecting Screen Font from the 
Options menu.
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Caution! Case Titles may overlap when a non-True Type font is selected. You 
may want to select a True Type font, such as Arial, for better display and 
printing. (The default program screen font, MS San Serif, is not a True Type 
font and may not give satisfactory results in the graph.)

GRAPH DATA DIALOG

The Graph Data dialog allows you to specify which worksheet data types you 
want represented on the graph. You can select from eleven predefined data 
types and four user-defined worksheet rows. Your selections are called data 
items for the purposes of this documentation. You can access this dialog from 
the Graph window by selecting the Data icon.

To save your selections for other cases, click Save as Default. To return to the 
initial default selections, click Restore Default.

PREDEFINED DATA SELECTIONS
The Predefined Data Selections at the top of the dialog include:

AGI — from the Adjusted Gross Income row of the Main Worksheet
Adjusted AGI — 

dGraphData.png

AGI (as defined above)

plus The capital gain and ordinary income amounts on the Lump Sum Distribution 
worksheet, i.e., Taxpayer’s and Spouse’s Distributions, Capital Gain and Ordi-
nary Inc rows

minus Lump Sum long-term capital gain included on the Long-term Gain - Lump Sum 
row of the Capital Gains and Losses worksheet

minus Post ’99 Lump Sum Distrib row of the Other Ordinary Income worksheet
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Disposable AGI — Adjusted AGI (as defined above) less Total Federal & 
State Income & S/E Taxes (as defined below), less Itemized Deductions 
(as defined below) if selected, plus the “Self-employment Tax Deduction” 
row of the Ordinary Income worksheet. less Employee FICA Tax on 
Wages (as defined below) if selected

Itemized Deductions — total itemized deductions computed without 
regard to any AGI floor or state income taxes (if state income taxes was 
selected for the graph)
Taxable Income — from the “Taxable Income” row of the Main Worksheet
Alternative Minimum Taxable Income — from the “Alternative Minimum 
Taxable Income” row of the Alternative Minimum Tax worksheet

Total Federal Income & S/E Taxes — the sum of the federal regular tax, 
net alternative minimum tax, and total other taxes from the Self-Employ-
ment & Other Taxes worksheet, minus total nonrefundable credits, the 
refundable child, the health insurance, the Earned Income Credit and the 
refundable Minimum Tax credit. The amount is limited to not less than zero.
Total State Taxes — from the “State Tax” row of the Main Worksheet
Total Federal & State Income & S/E Taxes — the sum of the Total 
Federal Income & S/E Taxes and Total State Taxes (as described above)
Employee FICA Tax on Wages — computed as the FICA percentage 
applied to Taxpayer and Spouses’ FICA wages on the Wages worksheet 
plus statutory employee wages on the Self-employment Income and 
Loss worksheet. The FICA percentage is composed of the OASDI 
percentage and the HI percentage.
For all years after 1990, except 2011 and 2012, the OASDI percentage, 
which is applied to FICA wages (including statutory employee wages), is 

minus Social Security Benefits Exclusion row of the Other Ordinary Income work-
sheeta

minus EE Bond Interest Exclusion row of the Educational Interest Income & Ex-
pense worksheeta

plus The Tax Exempt Interest rows of the Interest and Dividends worksheet

minus Taxpayer and Spouses’ Dependent Care Inclusion rows on the Wages work-
sheet

plus Taxpayer and Spouses’ Employer Provided Benefit rows on the Dependent 
Care Exclusion & Credit worksheet

minus Taxpayer and Spouses’ Adoption Assistance Exclusion rows on the Wages 
worksheeta

plus The Domestic Production Deduction row on the Ordinary Income worksheet
a These exclusions are presented as negative numbers on their respective worksheets

and, therefore, are subtracted to increase AGI.
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6.2%. For 2011 and 2012 the OASDI percentage is 4.2%. The HI percent-
age, which is applied to FICA and HI Only wages, is 1.45%. The amount to 
which the OASDI percentage is applied is limited to the maximum OASDI 
contribution base which increases each year. See the Self-employment 
Income and Loss worksheet for further details.
If the Wages worksheet is not active, then the program uses the amount 
entered as Wages on the Ordinary Income worksheet, and assumes it is 
the FICA wages of the taxpayer alone (as opposed to both the taxpayer’s 
and spouse’s wages).

If you select this data item, the program uses it to decrease the disposable 
AGI amount. Although Employee FICA Tax on Wages does not appear 
elsewhere in the program, it is provided here to allow you to present a 
more complete graphic picture of all federal taxes based on income and 
the corresponding reduction in disposable AGI.
Employer FICA Tax on Wages — computed as an amount equal to the 
amount of Employee FICA Tax on Wages. See the description above. If 
you select this data item, the program does not use it to decrease the 
amount of disposable AGI, since disposable AGI does not initially include 
the employer FICA tax.

As an initial default, Disposable AGI, Itemized Deductions, Total Federal 
Income & S/E Taxes, and Total State Taxes are selected.

USER DEFINED DATA SELECTIONS
At the bottom of this dialog you can define and select up to four worksheet rows 
to be included on the graph. You can predefine selections, then not check the 
box — they will remain predefined for future selection.

1st, 2nd, 3rd, 4th — Click the check box to include a user defined row on 
the graph.

Worksheet — Select a worksheet from the list.
Row — The rows on the selected worksheet are included on the list. Select 
the row that you want from the list.

GRAPH SELECTION CONSIDERATIONS
When selecting type and properties for a graph, keep in mind which data items 
you’ll be selecting and the information that you want to convey. Not all data 
item combinations are appropriate for all types of graphs or graph properties.

For instance, when you select a graph type that shows each data item as a 
discrete item, it may be appropriate to select related data items, that is, items 
that are included as a component in another selected data item. An example of 
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related data items are Total Federal Income & S/E Taxes, Total State Taxes, 
and Total Federal & State Income & S/E Taxes.
On the other hand, when you select a graph type that shows data items as 
components of a total (such as a stacked bar graph or a percent area graph), 
selecting related data items is generally not appropriate because these items 
will double components of the total and skew the results.

Note. When you select predefined data items for stacked bar or percent area 
graphs, the program checks to see if your selections are related and issues an 
error message when the selections duplicate amounts. However, the program 
cannot check user defined data item selections for duplications.

Also, if you are selecting an item that has a negative value in the case, only the 
line graphs and the following properties of the bar graphs can represent this 
item in a meaningful manner:

Vertical
Horizontal

TYPE

The Graph Type dialog allows you to customize the appearance of the data 
represented on the graph. You can select from four basic types of graphs, then 
you can select from a list of graph properties. The 3D Bar, Stacked Vertical 
graph is the initial default graph type. You can access the Graph Type dialog 
by selecting the Type icon on the Graph window.
To save your selections for other cases, click the Save as Default button. To 
return to the initial default selections, click the Restore Default button.

dGraphType.png
This image is also in the 
Tutorial.
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GRAPH TYPES
You can choose from four graph types:

2D Bar — two-dimensional horizontal bars or vertical columns represent 
the value of the selected data items
3D Bar — three-dimensional horizontal bars or vertical columns represent 
the value of the selected data items

Line — points on the grid background represent the value of the selected 
data items. Best used when showing a trend. At your option, these points 
may be connected by a line and/or represented by a multi-sided symbol.
Area — each data item across all cases is represented by a two-dimen-
sional area on the graph. Best used when displaying the relative 
significance or importance of items over time.

You can apply different properties to each graph type. Not all properties apply 
to each graph type.

GRAPH PROPERTIES
The graph properties govern how the graph type you selected is displayed and 
how the information about each case is conveyed. 

PROPERTIES FOR ALL GRAPH TYPES
Labels — toggles the display of the data item value on and off at or next to 
the graph co-ordinate for the item. Select Labels when it’s important to 
display exact amounts. This property does not display well with the 
Symbols property. 
Patterns — toggles the display between a solid color and a pattern of lines 
(for bar and area graphs), or a dotted or dashed line pattern (for line 
graphs).

Note. This property is best used when printing to a black and white printer.

PROPERTIES FOR BAR GRAPHS
You can select any one of these properties for 2D and 3D graphs. 

Vertical — displays a single, discrete, columnar bar for each selected data 
item. All items within a single case are grouped together, side-by-side.

Horizontal — displays a single, discrete, horizontal bar for each selected 
data item. All items within a single case are grouped together, one on top 
of the other.
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Stacked Vertical — displays a single, discrete, columnar bar for all data 
items in a case, each item stacked on top of the other. The Amount axis is 
the vertical axis. Shows the relative importance of items within a case.
Stacked Horizontal — displays a single, discrete, horizontal bar for all 
data items in a case, each item stacked side-by-side. The Amount axis is 
the horizontal axis. Shows the relative importance of items within a case.

% Stacked Vertical — displays a single, discrete, columnar bar for all data 
items in a case, each item stacked on top of the other. The Percent axis is 
the vertical axis. Shows the relative importance of items within a case.
% Stacked Horizontal — displays a single, discrete, horizontal bar for all 
data items in a case, each item stacked side-by-side. The Percent axis is 
the horizontal axis. Shows the relative importance of items within a case.

Note.  For Stacked properties, the program issues a message if you select 
related data items, because these items contain duplicate amounts which will 
skew the graph results.

PROPERTIES FOR LINE GRAPHS
Symbols — displays a multi-sided symbol at the co-ordinate of the graph 
for the data item. Each symbol has a different shape, color, and pattern. 
Does not display well with Labels. 
Lines — displays a line which connects the co-ordinates of each data item 
across the cases. Best used when showing historical trends or projections.

PROPERTIES FOR AREA GRAPHS
Stacked — displays the areas for the data items stacked one on top of the 
other. The Amount axis is the vertical axis. Shows the relative importance 
of items within a case across time. Best selected when unrelated data 
items are selected.

Absolute — displays the areas for the data items in terms of the absolute 
value of the amount. The area for each item starts at the Case axis (which 
is zero). The Amount axis is the vertical axis. Some items will be hidden 
behind the others when their amounts are smaller for a particular case. 
Best selected when unrelated data items are selected. 
For example, since Total Federal Income & S/E Taxes is smaller than Total 
Federal and State Income & S/E Taxes, it is “hidden” behind Total Federal 
and State Income & S/E Taxes. The same holds for Total State Taxes.
Percent — displays the areas for the data items stacked one on top of the 
other. The Amount axis is the vertical axis. Shows the relative importance 
of items within a case as a percentage of the sum of the selected items. 
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Best selected when unrelated data items are selected; selecting related 
items will skew the graph and show misleading results.

TITLES

The Graph Titles dialog allows you to enter the titles that you want to appear 
on the graph. You can specify up to four titles. You can access this dialog from 
the Graph window by selecting Titles.
To save your selections for other cases, click Save as Default. To return to the 
initial default selections, click Restore Default.

GRAPH The Graph title prints across the top of the graph in large letters. Income 
Distribution is the initial default Graph title in most circumstances. However, 
if you select only a single data item, the Row title for this item appears as the 
Graph title, following any Graph title you may have specified in this dialog.

LEFT The Left title appears to the left of the vertical axis. “Amount” is the initial 
default Left title.

RIGHT The Right title appears to the right of the graph, to the left of the data item 
descriptions. There is no initial default Right title.

BOTTOM The Bottom title appears under the graph, below the Case titles. There is no 
initial default Bottom title for multi-case analyses. For multi-year, single-case 
analyses, however, the case title prints as the Bottom title rather than at the 
base of the Case axis, preceding any Bottom title that you may have specified 
in this dialog (e.g., Case Title First: Bottom Graph Title).

GRAPH OPERATIONS
PRINTING GRAPHS

To print the graph when it has the focus:
1. Select Print on the File menu. The graph will be listed as the Current 

Worksheet.

dGraphTitles.png
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Note. If you wish to print the graph in Landscape mode, click Printer on 
the Print dialog and change the orientation from Portrait to Landscape. 
Since this is a Windows dialog, this will change the print orientation for all 
applications. When you are finished printing graphs, remember to change 
the print orientation back to Portrait before printing client worksheets or 
printing from other applications.

2. Select either Printer or Adobe Acrobat File in the Print To box (other 
Print To options are dimmed). If you select Printer, your graph will be 
printed to your printer; if you choose Adobe Acrobat File, your file will be 
printed in Adobe Acrobat format.

3. Select the Print button.

4. If you chose to create an Adobe Acrobat File, you are prompted to select a 
file name in the Print To Adobe Acrobat File As dialog. Click Save after 
selecting a name.

To print with the other worksheets:
1. Display the Worksheet List, if hidden.

2. Click the printer icon for the Graph once to collate the graph before the 
printed worksheets. The graph will print after the client letter, if the letter is 
selected.

3. Click the printer icon for the Graph again to collate the graph after the 
printed worksheets but before the Table of Contents and Index.

4. Select either Printer or Adobe Acrobat File in the Print To box. If you 
select Printer, your graph will be printed to your printer; if you select 
Adobe Acrobat File, your file will be printed in Adobe Acrobat format.

5. Click the Print icon on the toolbar.
6. If you chose to create an Adobe Acrobat File, you are prompted to select a 

file name in the Print To Adobe Acrobat File As dialog. Click Save after 
selecting a name.

PRINTING HINTS
Unless you are printing the graph to a color printer, you may want to select 
Patterns (accessed from Type on the Graph toolbar) instead of colors. When 
using a black and white printer, the colors on the graph sometimes print as very 
dark shades of grey. Also, if choosing between a 2-D and a 3-D bar graph, you 
may find that the 2-D bar graph produces more satisfactory results when 
printing to a black and white printer.
When printing the graph with Patterns, under certain conditions the lines used 
in the patterns can print so closely together that the patterns are hard to 
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discern. Changing the printer’s Windows printer options can help with the 
patterns.
1. Select Print from the File menu.

2. Select Printer.
3. Select Options.

The Options dialog is a Windows dialog, not a program dialog, and it 
varies depending upon what printer you are printing to, what printer driver 
you are using, and what version of Windows you are running under. 

Your results may improve if you select a lower DPI setting (change from 
600 to 300 or from 300 to 150). 
If the Options dialog does not offer a DPI setting, change the Graphics 
Quality from High to Medium or Low. 
Try changing the Graphics Mode from Raster to another choice. 

A combination of these suggestions might work best for your printer 
configuration. 
In some cases, these suggestions can also improve your results when 
using colors instead of patterns.

Also, if choosing between a 2-D and a 3-D bar graph, you may find that the 2-
D bar graph produces more satisfactory results when printing to a black and 
white printer.

COPYING GRAPHS
You can copy a graph to the clipboard to be pasted later into another 
application.
1. With the graph in focus, select Copy from the Edit menu. This places the 

graph on the Window’s clipboard.

2. Switch to the destination application and click on the Paste icon or select 
Paste from the appropriate menu. The graph will be pasted as a picture 
into the application. This image will not be dynamically updated; when you 
change the graph, it must be re-pasted into the destination application.

GRAPH EDIT MENU FOR ROW TITLES
The graph has a different Edit menu, as shown below. 

 

mEditGraph.png
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COPY
The Copy command places the graph onto the Clipboard.

To use the toolbar to perform this function, click the Copy icon on the main 
program toolbar.

DATA
The Data command opens the Graph Data dialog, where you can specify the 
worksheet data types you want represented on the graph. See Graph Data 
Dialog on page 198.

TYPE
The Type command opens the Graph Type dialog, where you customize the 
appearance of the graph. See Type on page 201.

TITLES
The Titles command opens the Graph Titles dialog, where you specify the 
titles used on the graph. See Titles on page 204.
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8
8 Client Letter

CLIENT LETTER
OVERVIEW

The Client Letter feature provides a handy word processor within the Income 
Tax program that allows you to write a letter to your client concerning the 
client’s analysis. When you save the analysis, the letter is saved as part of the 
client program (.it) file. Using the Client Letter feature, you can:

Pull information from the analysis that is updated automatically with the 
analysis. You can bring over the information contained in an entire 
worksheet, one or more rows, or a single cell.
Insert the current date, client name and address, and salutation name from 
the Assumptions dialog.

Save a letter as a template that can be used to build a letter in other 
analyses.
Specify a template as a default template <<desktop program edition 
only>>.

Use standard word-processing capabilities, such as paragraph alignment, 
indents, find and replace, etc.
Specify the font for any portion of a letter or the entire letter.
Set up a letterhead for the first page of the letter using the Headers and 
Footers command. You can set up a separate header for subsequent 
pages of the letter. You can also set up a footer for the first page or 
subsequent pages.

Each of these capabilities will be described in detail within this chapter. In the 
third scenario of the Chapter 2 tutorial, you will find a step-by-step lesson on 
creating a letter.
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CLIENT LETTERS: TYPES AND USES
You can create a client letter that is tailored to a specific client analysis. It can 
have special paragraphs that suit the unique situations of your client’s special 
case. It can pull data from the analysis — one cell at a time or blocks of data, 
whichever you choose. When you save the client file, the program saves the 
letter as part of the client (*.it) file.
You can also create a more generic letter. You may find that the generic letter 
could serve as the basis for several analyses or for different clients. You would 
then save this letter as a template.

TEMPLATES
A template is simply a client letter that you’ve saved as a separate file outside 
of the client files. Think of a template as a “form letter.” When brought into a 
client file, it pulls data from the same source worksheet in each analysis (e.g., 
“Net Federal Tax” on the Main Worksheet, column 1) and places it in the same 
location in the letter (e.g., within a paragraph or on a line by itself).

<<desktop program edition only>> Templates are not stored with the client 
file, but in separate .itl files. You can open any template any time the program 
is running, regardless of which client file is open. If you know that most of your 
letters will be written in the same manner and contain the same basic 
message, you can create a default template that will be loaded each time you 
open the program.
<<desktop program edition only>> A sample letter template is included with 
the program so that you can better understand how templates help you: just 
open the sample.itl template (in a client file that doesn’t already include a 
letter) to see how an automated “form” letter can appear customized to a 
particular analysis. (If the client file already has a letter, when you open the 
sample template, the program replaces the existing letter in memory. Further-
more, it replaces the letter in the file on disk if you save the client file.)

TOOLS
Like a word processing program, the Client Letter window contains toolbars 
with word-processing tools. The toolbars also include special link tools. In 
addition to the toolbars, you can use commands from the main program menu 
bar (such as Cut and Paste from the Edit menu) and buttons on the main 
program toolbar (such as Print, Copy, and Paste).
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CLIENT LETTER ITEMS
CLIENT LETTER WINDOW

When you write a client letter, you work in the Client Letter window. This 
window contains your letter, a specialized ruler — similar to rulers in word 
processing software — and a pair of unique toolbars. To open the Client Letter 
window, click Client Letter on the main program menu bar.

TOOLBARS
The client letter has two unique toolbars with icons that allow you to perform 
activities special to the client letter. These icons do not affect your worksheets.

You will, however, still be able to use several icons on the program’s main 
toolbar while you are in the Client Letter window. Every item on the client letter 
toolbar corresponds to a menu command. See Using the Edit Menu for the 
Client Letter on page 231.

Tab 
controls

Indent level 
indicators

Click here to 
open the 
Client Letter 
window

Workspace

Standar
d toolbar
Formatting 
toolbar

Ruler

ClientLetter.
png

ToolbarClient
Letter.png

Standard 
toolbar

Formatting 
toolbar

Purpose or Function
Equivalent
Menu Command

New Client Letter – Opens an new Client Letter window, 
applying the headers and footers in the default letter tem-
plate, if any. Erases any letter currently in the client file. 

File menu, New Client 
Letter command

Open Letter Template – Opens the Open Letter Tem-
plate dialog, allowing you to select a template file that the 
program will open in the Client Letter window for viewing, 
editing, or adding to the client file.

File menu, Open Letter 
Template command
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Save Letter Template As – Opens the Save Letter Tem-
plate As dialog, where you can save the letter in the Client 
Letter window as a template for the first time, or replace 
the contents of an existing letter template, or <<desktop 
program edition only>> specify the open letter as the 
default letter template.

File menu, Save Letter 
Template As command

Cut – Cuts any highlighted information in the client letter. Edit menu, Cut com-
mand

Insert – Opens the Insert submenu, displaying insert op-
tions: Page Number, Date, Time, Client Name, Client Ad-
dress, Salutation Name, and Page Break.

Edit menu, Insert sub-
menu

Show/Hide Headers & Footers – Opens (or hides) the 
Header and Footer dialog, where you can edit headers 
and footers for the first page or subsequent pages.

Edit menu, Headers & 
Footers command

Margins – Opens the Margins dialog, where you can set 
margins for the top and bottom, and right and left sides of 
the page; set a different margin for the first letter page. 

Edit menu, Margins 
command

Show/Hide Paragraph Symbols – Displays (or hides) 
paragraph symbols in the client letter.

Edit menu, Show ¶ com-
mand

Find – Opens Find dialog, where you can search forwards 
and backwards for text.

Edit menu, Find com-
mand

Find & Replace – Opens the Find and Replace dialog, 
which finds text and replaces it with new text.

Edit menu, Find & Re-
place command

Paste Link – Allows you to paste a link in the client letter 
from selected information in the worksheets. 

Edit menu, Paste Link 
command

Show Links – Shows origins of linked information in the 
client letter. Toggles to Hide Links.

Edit menu, Show Links 
command

Edit Links – Opens the Client Letter Links dialog, allow-
ing you to review or edit the source of the links.

Edit menu, Client Letter 
Links command

Help – Allows you to access Help for the client letter.

Bold – Changes selected text to bold. If no text is selected, 
toggles this attribute on or off for newly entered text.

Edit menu, Font sub-
menu, Bold

Italic – Italicizes selected text. If no text is selected, toggles 
this attribute on or off for newly entered text.

Edit menu, Font sub-
menu, Italic

Underline – Underlines selected text. If no text is selected, 
toggles this attribute on or off for newly entered text.

Edit menu, Font sub-
menu, Underline

Align Left – Aligns the current or selected paragraph and 
any newly entered text thereafter to the left.

Edit menu, Alignment 
command, Align Left 
option

Align Right – Aligns the current or selected paragraph and 
any newly entered text thereafter to the right.

Edit menu, Alignment 
command, Align Right 
option

Purpose or Function
Equivalent
Menu Command
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RULER
The ruler in the Client Letter window allows you to set the indentations and 
tabs for your text. It does not set the margins. Rather, these indents are in 
addition to the margins set through the Margins command. You can choose to 
show or hide the ruler from the Edit menu.

For specifics on paragraph alignment, indent, tab stops, etc., see the 
Paragraph Alignment dialog, accessed from the Edit menu (covered on page 
233). For more information on formatting, see Text Alignment and Layout on 
page 222.

SAMPLE CLIENT LETTER
The program comes with a sample client letter template. To see the template 
as shown below, in a new client file select Open Letter Template from the File 
menu. When the Open Letter Template dialog opens, click Sample.itl. (By 

Center – Centers the current or selected paragraph and 
any newly entered text thereafter.

Edit menu, Alignment 
command, Center op-
tion 

Justify – Fully justifies the current or selected paragraph 
and any newly entered text thereafter. 

Edit menu, Alignment 
command, Justify op-
tion

Decrease Left Indent – Decreases left indent for the 
current or selected paragraph and for any newly entered 
text thereafter.

Edit menu, Alignment 
command, Decrease 
Left Indent option

Increase Left Indent – Increases the left indent for the 
current or selected paragraph and for any newly entered 
text thereafter.

Edit menu, Alignment 
command, Increase 
Left Indent option

Decrease Right Indent – Decreases the right indent for 
the current or selected paragraph and for any newly en-
tered text thereafter.

Edit menu, Alignment 
command, Decrease 
Right Indent option

Increase Right Indent – Increases the right indent for the 
current or selected paragraph and for any newly entered 
text thereafter.

Edit menu, Alignment 
command, Increase 
Right Indent option

Paragraph Alignment – Opens the Paragraph Align-
ment dialog, where you can specify several alignment 
options.

Edit menu, Alignment 
command

Align Data – Returns linked data to the default alignment. Edit menu, Align Data 
command

Purpose or Function
Equivalent
Menu Command

Ruler.png

Indicates Right Indent is 
1 inch from right margin.

Indicates a block format — 
left indent of 1 inch from 
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default, the Sample.itl file is in C:\ITWIN.) Click OK on the Caution message 
to accept keeping links with columns. The following window opens:

There are defined fields that tell you what information will be added to the letter 
as you make changes in the analysis. These fields are linked to worksheets 
and other data in the analysis. To see this, place your pointer on the line that 
reads, “[Client Name from Assumptions Dialog].” The pointer becomes a circle, 
or link. Once you complete the Assumptions dialog, the client name on the 
letter will be filled in because it is linked. Other fields are also links, including 
the calculated amounts. Again, when you place your pointer over the calcula-
tions you will see the link pointer.

Links to the 
analysis

ClientLetterTem
platea.png



215

C
LI

EN
T 

LE
TT

ER
C

LI
EN

T 
LE

TT
ER

C
LI

EN
T 

LE
TT

ER
C

LI
EN

T 
LE

TT
ER

C
LI

EN
T 

LE
TT

ER

::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::

To learn more about the link tools, see Pasting and Linking Worksheet Data 
into a Letter on page 218 and Displaying Links in a Letter on page 219.

USING A CLIENT LETTER AS A TEMPLATE
CLIENT

LETTERS
Within this chapter, “client letter” refers to a letter that relates to one particular 
client analysis. A client letter can contain personal information, such as the 
client’s name and address or a personal greeting. You can overwrite an 
existing letter, which allows you to replace it while keeping formatting. In client 
letters, you can:

add headers and footers;
select from a variety of fonts;

insert the page numbers, date, and time;
link information from the worksheets;
set tabs, indents, and margins; and

cut and paste information from the worksheets.
A client letter is contained within a specific client analysis file. Each client file 
can only have one client letter. If you create a second letter for a client file, it 
replaces the first letter when you save the client file. You cannot have both a 
template and the client letter open at the same time. (When you open an 
analysis, any client letter previously saved with it is activated.)
When you open a client file, its letter (if any) is loaded into the program at the 
same time and is opened by clicking Client Letter on the main program 
toolbar. (It opens automatically if the Client Letter window was not closed 
when you last saved the file.)

LETTER
TEMPLATES

A letter template is a client letter that you’ve saved as a template. Letter 
templates, unlike client letters, exist in separate files outside of client files. 
(<<desktop program edition only>> Templates use the extension .itl.) 
You would save a letter as a template when you find you’ve written a letter that 
you could use repeatedly with several client files, like a form letter. Like any 
other client letter, the template would have standard text and the above listed 
features entirely preset. You can create several letter templates.

<<desktop program edition only>> If you specify a template as the default 
template, when you start a new client analysis or load an old analysis that does 
not already include a client letter, the letter is activated automatically (although 
it remains closed until you call it up from the main program menu bar).
To open a template, select Open Letter Template from the File menu.
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STARTING A NEW CLIENT LETTER
CLIENT FILE DOES NOT HAVE A LETTER

Use the following procedure to create a letter for a client file that does not 
already have a client letter.
You can adjust the default indents of the letter from the Client Letter window. 
If you would like to change the default side margins or spacing above the 
header and footer, select Margins from the Edit menu.

1. Open the client file for which you want to create a letter.
2. From the main program menu bar, select Client Letter.

A blank Client Letter window appears. 
3. Enter the information you want to appear in the letter. For information 

about using the client letter features when creating the letter, see Working 
Within the Client Letter on page 217.

CLIENT FILE CONTAINS A LETTER
Use the following procedure to entirely replace an existing letter with a new 
blank letter. This procedure overwrites the existing letter unless you first save 
the letter as a template or save the client file under a new name. (See Saving 
a Letter as a Template on page 226.)

1. Open the client file for which you want to create a letter.
2. Click New Client Letter from the File menu or click New Client Letter  

on the client letter standard toolbar. 
A blank Client Letter window appears.

<<desktop program edition only>> If there are headers and footers 
included in the default template, these will be included in this letter. 

SAVING A CLIENT LETTER
To save a client letter with a client file:

1. Select Save Client File on the File menu or click Save  on the main 
program toolbar.

2. The Save Client File dialog appears. Save the file as you normally would. 
Because the client letter is like another worksheet for the file, it is not saved 
with a new name. It is simply saved with the file. 

MenuBar.png
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Note. Close the Client Letter window to open the client file more quickly 
the next time you retrieve it.

To save a letter as a template, see Saving a Letter as a Template on page 
226.

WORKING WITHIN THE CLIENT LETTER
The client letter feature offers several word-processing capabilities that allow 
you to make the letter look exactly the way you want it to. You can also pull data 
from the client file that is automatically updated as you change the analysis. 
These capabilities, discussed in the following sections, include:

bringing information in from the client file,
paragraph formatting,

setting tabs,
specifying indents,
setting up headers and footers, and

specifying the font and its attributes for text.

BRINGING DATA FROM THE CLIENT FILE INTO A LETTER
An important and time-saving feature of the client letter feature is the ability to 
easily bring data into the client letter from elsewhere in the client file. You can 
bring this data into the letter in three ways: insert, paste, or paste link. 

If you paste link data, the data in the letter is automatically updated 
whenever the source data in the worksheet changes. 
If you paste data, it is not updated when the source changes. 

PULLING CLIENT INFORMATION FROM ASSUMPTIONS
The Client Letter allows you to easily insert the client address and salutation 
name from the Assumptions dialog. If no information exists for an insertion 
(for example, if you haven’t completed the Salutation Name dialog), fields are 
still inserted. The letter will display a description of the field as a placeholder.

1. Click in the letter where you want to insert the information.
2. Select Insert from the Edit menu or click Insert . The Insert submenu 

opens.
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3. Select the client name, salutation name, or client address.
a. When you select Client Name, the Client Name from the Assump-

tions dialog is inserted.
The Client Name is different from Salutation Name. For example, use 
“Mr. and Mrs. Wilson” as the Salutation Name in your letter, but use 
the Client Name “Jack and Barbara Wilson” in other areas, such as 
the name and address area.

b. Select Salutation Name to automatically insert the salutation name in 
the letter. You create the salutation name in the Salutation Name field 
of the Client Address & Salutation Name dialog, accessed from the 
Assumptions dialog.

c. Select Client Address to automatically insert this item into your letter 
from the Address field in the above dialog.

PASTING AND LINKING WORKSHEET DATA INTO A LETTER
1. Go to the worksheet that contains the data you want to include in the letter.

2. Select the cell(s) you want to use.
To copy the cells, move the cursor to a specific cell and click to highlight it; 
or, select a range of cells by clicking and dragging over the cells.

3. Select Copy from the Edit menu or click Copy  on the main program 
toolbar.

4. Click in your letter where you would like to place the cells.
5. If you don’t want the data to be updated dynamically as its source changes 

in the worksheets, select Paste from the Edit menu or click Paste  on 
the main program toolbar. The information from the cells is pasted into your 
letter. You may now edit the information. 

Otherwise, to have the data in the letter updated dynamically as its source 
changes, select Paste Link from the Edit menu or click Paste Link  on 
the client letter standard toolbar. The information from the cells is 
paste-linked into your letter.

Note. You cannot edit paste linked data but you can edit the link by 
changing the cells to which the link is connected. See Editing Links in a 
Letter on page 219.

mClientLetterInsert.png
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DISPLAYING LINKS IN A LETTER
1. Open the letter that has the links.

The Show Links button  toggles to Hide Links  in the client letter 
toolbar when selected. By default, the letter hides the links. This is the 
same as when you select  on the client letter standard toolbar. The 
example below shows linked data.

2. Select Show Links on the Edit menu or click  on the client letter 
standard toolbar. The links change to display the worksheet, row and 
columns of the source data:

 

EDITING LINKS IN A LETTER
1. To edit a link in a letter, click .

2. When the Client Letter Link dialog opens, select which link to edit. 
You may have linked information from several worksheets. The program 
numbers the links as they appear in the letter and orders them accordingly.

3. To drop a link from the letter, click Delete. The information is still on the 
worksheet, just not in the letter.

4. To change the columns to which the link is connected, click Edit on the 
Client Letter Links dialog. Then, make the changes in the Edit Letter 
Link Columns dialog.

ClientLetterLinkedDat
a.png

ClientLetterShowLinks.
png

dClientLetter
Links.png
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ADDING HEADERS AND FOOTERS
You can create headers and footers in the letter. You can have different 
headers and footers for the first and subsequent pages.
1. To create or edit a header or footer, select Headers & Footers on the Edit 

menu or click Show Headers and Footers  on the client letter standard 
toolbar. This button toggles between show and hide headers and footers. 
The Headers and Footers dialog opens.

2. Type in text, such as your company name and address, in the fields for the 
places in the letter where you want the information to appear. Use the 
Insert tool to add any other information, such as the date or client name. 
You can use any of the formatting tools, such as font and alignment.

3. Click Headers and Footers , whose ToolTip now reads Hide Headers 
and Footers, to return focus to the Client Letter window.

ADDING DATE, TIME, AND PAGE NUMBER
The Client Letter allows you to easily insert basic information pulled from the 
computer. You can add the time and date from your computer’s clock or 
calendar, as well as insert page numbers in the letter.
1. Click in the letter where you want to insert the date, time, or page number.

2. Select Insert on the Edit menu or click Insert  to open the Insert 
submenu.

3. Select Date, Time, or Page Break.

Note. The Page Number option is only available when the Headers & 
Footers window is open.

ClientLetterHeaders&F
ooters.png



221

C
LI

EN
T 

LE
TT

ER
C

LI
EN

T 
LE

TT
ER

C
LI

EN
T 

LE
TT

ER
C

LI
EN

T 
LE

TT
ER

C
LI

EN
T 

LE
TT

ER

::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::

When you select Date, you can choose to set a date based on today’s 
date (No) or have the date updated using your computer’s calendar 
whenever you open the letter (Yes). The date appears in letter at the 
insertion point.
Because you are writing client correspondence, you will probably want 
to keep the original date. Next, save the client file so that if you open it 
in the future, the date does not change automatically.

When you select Time, the following message appears.

To have the time automatically updated from your computer’s clock, 
click Yes. If you want the letter to keep its original time, click No.

To print a page number in the letter, you must first open the Headers 
& Footers window (see page 220) before opening the Insert submenu. 
With the insertion point in the appropriate header or footer field, select 
Page Number on the Insert submenu.

FORCING A PAGE BREAK
1. Page Break is only available when the Headers & Footers window is 

closed. Click in the letter where you want to force a new page to start.
2. Select Insert from the Edit menu or click Insert  to open the Insert 

submenu.

3. Select Page Break. On the screen, a red line marks where you placed the 
page breaks.

DELETING TEXT OR FIELDS
There are three ways to erase text that you’ve typed into your letter: the 
keyboard keys Backspace and Delete, and the Edit command/toolbar button 
Cut. To use Cut, first select the text or fields you want deleted. Then, click 
Cut  on the client letter standard toolbar. The text is placed on the Clipboard.
When you try to delete an inserted field, a Caution message appears. Click 
Yes to close the message and continue erasing.

DELETING A CASE WITH A LINK TO A CLIENT LETTER
When you have links between the analysis and the client letter, the program 
keeps track of the years, cases, and rows that are the source of the linked data. 

msgUpdateTime.png
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When you delete or rearrange the source of the data (by, for example, deleting 
a case, changing the first year of the analysis, or changing the type of analysis) 
the program doesn’t know whether the link can be transferred to another 
column or if it still applies to a particular year/case that had been deleted. 
Whenever possible, the program allows you to specify whether the link belongs 
to a column or to a year and case. Otherwise, the program deletes the link.

TEXT ALIGNMENT AND LAYOUT
There are several ways to set the layout of your letter. You can use several 
buttons on the toolbar to change the alignment, margins, and indents. You can 
also open the general formatting dialog, the Paragraph Alignment dialog, by 
clicking  on the toolbar.

The Paragraph Alignment dialog displays the settings for the selected text 
and allows you to change several formatting aspects at once. Other tools are 
available for making specific formatting changes more quickly and are 
discussed in the following pages. There are several sections to the Paragraph 
Alignment dialog. These include: 

Indentation,

Alignment, 
Spacing, and 
Tab Stops. 

You can use this dialog to set up the letter’s layout before writing the text. Or 
you can select text and apply the settings to that text. 

Note. If you have several paragraphs with different formats selected when you 
open this dialog, the fields that differ will be blank.

dParagraphAlign
ment.png
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ADDING SPACE BETWEEN LINES
Use the Spacing section of the Paragraph Alignment dialog to add space 
between paragraphs and to change the spacing between the lines of 
paragraphs. 
To create spaces between paragraphs, use the Before and After fields to 
select an increment. Each increment is in points. You can overwrite any setting 
by typing a number in the field.
To change the spacing between lines of a paragraph, select Single, 1.5 Lines, 
Double, Multiple, or At Least in the Line field. When you select Multiple or At 
Least, this field is used with the At field, below.

ALIGNING TEXT
To align a particular paragraph(s), click in the paragraph or select the 
paragraphs you want to align. 

ALIGN TEXT TO
THE LEFT

To align the text so that it is straight on the left and ragged on the right, click  
or, in the Paragraph Alignment dialog, select Left in the Alignment section.

ALIGN TEXT TO
THE RIGHT

To align the text so that it is straight on the right and ragged on the left, click  
or, on the Paragraph Alignment dialog, select Right in the Alignment 
section.

JUSTIFY TEXT To align the text so that it is straight on both the right and the left, click  or, on 
the Paragraph Alignment dialog, select Justify in the Alignment section.

CENTER TEXT To center the text so that both the left and right sides are ragged, click  or, on 
the Paragraph Alignment dialog, select Center in the Alignment section.

ALIGNING LINKED DATA
As you write and format a letter, the alignment for ranges of linked cells that 
you’ve paste-linked into the letter can get skewed. Use the Align Data tool to 
restore the default alignment and tab settings to selected linked data. The 
Align Data tool is useful if you add new information or change the layout of 
your letter. 
Below is an example of a draft of a letter with several linked calculations that 
are not aligned.

Select the data you want aligned, then click Align Data  on the client letter 
formatting toolbar or select Align Data on the Edit menu. The program resets 
the linked data to the default columnar format, as shown below.

ClientLettDataEx.png
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SETTING THE MARGINS AND INDENTS OF THE LETTER

MARGINS
As with other worksheets, you can adjust the margins of the letter through Print 
Preview by clicking and dragging the margin lines or by using the Margins 
dialog. When you change the margins for the letter, the margins for the printed 
reports change as well. See Margins on page 73.

You can also increase the top margin for the first page of the letter.
1. Click Margins  on the client letter standard toolbar.
2. The Margins dialog appears.

Enter the increase in the Letter 1st Page Top field. This field must be at 
least as much as entry in the Top field.

INDENTS
You can click and drag the indent markers on the ruler to further indent the 
letter text from the left or right margins. (Or you can change the indent settings 
on the Paragraph Align dialog discussed above.)

If you’ve entered text into the letter, when you change the indents, the changes 
are applied to the paragraph containing your cursor or to the selected 
paragraphs. If you want to change the indents for several paragraphs or the 
whole document, highlight the paragraphs you want to change before you 
change the indent settings.

ClientLettDataEx2.png
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You can indent the header or footer separately in the header and footer 
worksheet. Click Show Headers & Footers  to see the content of your 
headers and footers.
You can also set-up your text so that only the first line of a paragraph is 
indented. 

INDENT
MARKERS ON

THE RULER

When you first open a client letter, the margins are set to default to 1 inch on 
the left and 7 1/8 inches on the right, as shown by the small triangular markers 
in the ruler.

To change the right indent, click and drag on the triangle on the far right side of 
the ruler. 
The marker for the left margin consists of two triangles with a square under-
neath. You can use these markers as follows:

To move the left indent, click and drag the square at the bottom of the 
marker. This moves both triangles and the square as a unit.

When the two triangles are aligned, the text is left aligned. 
When the triangles are not aligned, the text has a first line indent or a 
hanging indent.

Click and drag on the top left triangle to indent the first line of text to the 
right or the left.

INDENT
BUTTONS IN

THE TOOLBAR

The four indent buttons  on the client letter formatting toolbar allow 
you to increase or decrease indents towards the right or left. Use the tab 
buttons at the left end of the ruler to establish the indent increment.
Click the line of text that you want to indent in the Client Letter.

To decrease the left indent, click .

To increase the left indent, click .
To decrease the right indent, click .

ClientLetter
Scenario3b.
png

First line indent



226

::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::

To increase the right indent, click .
CHANGING THE

TAB SIZE
You can set the tab size using the three small buttons at the end of the ruler. 
The small gray line in the ruler marks the current settings for evenly spaced 
tabs.

To set the alignment of the tab stops — left, right or center — click on the 
large middle button.
To decrease the tab settings in 1/16 decrements, click the small bar above 
the middle button.
To increase the tab settings in 1/16 increments, click the small bar below 
the middle button.

When you click on an indent button in the toolbar, the indents use these tab 
increments or decrements.

SHOWING PARAGRAPH MARKERS
You might want to see paragraph markers while writing your client letter. 
Paragraph markers help you to see where you pressed Enter at the end of a 
line. For example, below you can see there are two lines between the address 
and the salutation of the letter. When Show ¶ (Show Paragraph Markers) is 
selected, Undo Last Entry on the Edit menu is disabled.

To see your paragraph markers, click Show Paragraph Markers  on the 
toolbar.

SAVING A LETTER AS A TEMPLATE
Use the following procedure to save an existing letter as a template. (You can 
also create a template from another template. See Editing a Letter Template 
on page 228.)
1. Open the client letter you want to use to create a template.
2. Make any changes necessary to the letter, especially deleting items that 

are too client-specific.

Tab step decrement

Tab step increment

Select a tab Tab setting

ClientLetterTabRule.png
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3. When you are done, click Save Letter Template As  on the client letter 
standard toolbar to open the Save Letter Template As dialog.
<<desktop program edition only>> The default location for templates is 
your program folder. In the File name field, enter the name of the file. Be 
sure to keep the itl extension in the Save as type field.

<<Web program edition only>> Enter the plan name in the Name field.
For more information about the other options available on the Save Letter 
Template As dialog, see Save Letter Template As on page 67.

4. Click Save.

<<desktop program edition only>> For information on specifying a default 
template, see Saving a Template as the Default, below.

SAVING A TEMPLATE AS THE DEFAULT
<<desktop program edition only>>
You can save a template as the default template that will be loaded automati-
cally when you open a new client file or when you open an analysis that does 
not already contain a client letter. The default template is named itdefaul.itl 
and for Windows 7 resides in the following folder: 
C:\Users\[User Name]\AppData\Local\Bloomberg Tax Technol-
ogy\Income Tax Planner. 
When using the program on a network, each workstation can have its own 
default template.
To save a template as the default:

1. Open the client letter that you want to be the default template.
2. Click Save Letter Template As  in the client letter standard toolbar. The 

Save Letter Template As dialog opens.

3. In the Save in field, select 
C:\Users\[User Name]\AppData\Local\Bloomberg Tax Technol-

dSaveLetterTemplate
As.png
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ogy\Income Tax Planner as the drive and path, then enter Itdefaul.itl in 
the File name field. Default templates can only be saved to this location on 
your hard drive.

4. Click Save. The file is saved as the default template.

To delete the default template, in the Save Letter Template As dialog, right-
click C:\Users\[User Name]\AppData\Local\Bloomberg Tax Technol-
ogy\Income Tax Planner\itdefaul.itl in the list, then select Delete from the 
shortcut menu.

OPENING AN EXISTING CLIENT LETTER
1. Open the client file whose letter you want to edit.

2. Click Client Letter in the main program menu bar. The Client Letter 
window opens, displaying the last letter saved with the file or, <<desktop 
program edition only>> if no client letter has been saved with the file, a 
letter based on the default template, if any, will appear.

OPENING AN EXISTING LETTER TEMPLATE
1. Select Open Letter Template from the File menu or, on the client letter 

toolbar, click  to specify the template you want. The Open Letter 
Template dialog appears.

2. Select the template you want from the list, then click Open. The template 
opens in the Client Letter window.

3. After you make any changes, you can save the template as a new template 
(click Save Letter Template As  and assign a new name) or you can 
simply save the client file to add the letter as part of the client file.

EDITING A LETTER TEMPLATE
You can modify an existing template. This will affect all future letters created 
with this template; however, it will not affect existing letters that were created 

dOpenLetterTemplate
.png
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with this template. When you save the edited template, you can save it with the 
same name or save it with a new name. Saving it with a new name creates a 
new template.
1. On the File menu, select Open Letter Template (or, if the Client Letter 

window is open, on the client letter toolbar, click  to specify the template 
you want to edit). The Open Letter Template dialog appears.

2. Select the template you want from the list, then click Open. The template 
opens in the Client Letter window.

3. Make whatever changes are needed to the template’s contents.
4. When finished, click Save Letter Template As . The Save Letter 

Template As dialog appears.

5. Double-click the name of the template in the list or enter a new name in the 
File name field. When prompted about overwriting the existing file, click 
Yes.
The program saves the template and returns the focus to the Client Letter 
window.

For more information, see Open Letter Template on page 66.

ADDING A LETTER TO A CLIENT FILE FROM A TEMPLATE
The following procedure assumes that you have the client file open to which 
you want to add a letter.
1. Open the template you want to use as your source. (See Opening an 

Existing Letter Template on page 228.) 
2. Make any changes needed to the letter’s contents.

3. From the File menu, select Save Client File or click Save  on the 
program toolbar. Save the client file as you normally would.

The client letter, based on the specified template, is now part of the open client 
file.

DELETING A CLIENT LETTER
To completely remove a letter from an analysis without replacing it with another 
letter:
1. Open the Client Letter window.
2. Select all text in the letter (in the Edit menu, click Select All).

3. Click Cut  on the client letter standard toolbar (this places the text on the 
Clipboard) or select Clear on the Edit menu (this does not place the text on 
the Clipboard). If there are links in the letter, the program issues a 
message concerning the links being removed. Click Yes.
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4. Click Headers & Footers  on the client letter standard toolbar.
5. For each field, repeat steps 2 and 3, above.

6. Close the Client Letter window.
Note that although the client letter is removed from the analysis, the client letter 
still exists as an .itl file if it was previously saved as a template.

PRINTING A CLIENT LETTER 
To print the client letter when it has the focus:
1. Click Print  in the program toolbar or select Print on the File menu. The 

client letter will be listed as the Current Worksheet.
2. The Print dialog opens. In the Worksheet Range area, Current 

Worksheet: Client Letter is pre-selected. 

In the Print To box, select either Printer or Adobe Acrobat File (other 
Print To options are dimmed). If you select Printer, your client letter will be 
printed to your printer; if you choose Adobe Acrobat File, your file will be 
printed in Adobe Acrobat format.

3. Click Print.
You can also print and preview the letter with the other worksheets — just click 
the Selected Worksheets radio button. Then on the Worksheet List make 
sure the printer icon next to Client Letter is selected (it should be in color, not 
dimmed). Click Print or Preview.

dPrint.png
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USING THE EDIT MENU FOR THE CLIENT 
LETTER

The client letter has a different Edit menu, as shown below.

While in the Client Letter window, you can access most functions from the Edit 
menu. Most of these functions have a corresponding button on either the main 
program toolbar or one of the client letter toolbars. See Toolbar on page 16 
and Toolbars on page 211 for details on the main program toolbar and the 
client letter toolbars, respectively.

UNDO LAST ENTRY
Reverses certain commands or deletes the last entry you typed. This 
command is disabled whenever the program cannot reverse an action. It is 
also disabled when Show ¶ is selected.

CUT
The Cut command allows you to remove selected text from the letter and place 
it on the Clipboard.

COPY
The Copy command allows you to copy the selected text to the Clipboard so 
that it can be pasted to another location.

PASTE
The Paste command allows you to paste the contents of the Clipboard into the 
letter at the insertion point. Unlike Paste Link (which pastes data into the letter 

mEditClientLetter.
png
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while retaining a link to its source), when you paste data with the Paste 
command, the pasted data will not change as its source is changed in the other 
worksheets.

PASTE LINK
The Paste Link command allows you to paste data from a program worksheet 
into the letter beginning at the insertion point.

The Paste Link command places the cells that you have already selected and 
copied in the program worksheet into the client letter beginning at the insertion 
point (in the same way that the Paste command operates). You can paste link 
a single cell, blocks of cells, entire rows, or an entire worksheet.
When you change the data at the source of the link, the data changes simulta-
neously in the client letter.

SELECT ALL
Use the Select All command to select the entire letter (except the headers and 
footers). You can perform a variety of actions on the selected text, such as 
copy it, delete it, or change its font.

CLEAR
Similar to Cut, the Clear command deletes the selected text, but does not 
place it on the Clipboard.

FIND
Displays the Find dialog. 
You can search for a letter, word, or string of words in your client letter. You can 
search both “up” (Backward) and “down” (Forward) the letter from the insertion 
point. Select Match Case to look for text that exactly matches the capitalization 
of the specified text.

FIND NEXT
Use this command to find the next occurrence of the most recently searched 
for item.

FIND PREVIOUS
Use this command to find the previous occurrence of the most recently 
searched for item.

FIND & REPLACE
Displays the Find & Replace dialog.
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On this dialog, you can enter the letter, word, or string to search for and its 
replacement. Select Match Case to look for text that exactly matches the 
capitalization of the specified text.
To find the text, after entering the text you want to find in the Find what field, 
click Find Next.
To replace the found text with the text in the Replace with field one occurrence 
at a time, click Replace. The program will replace the found text and move to 
the next occurrence of the text being replaced.
To replace all occurrences of the found text in the letter without confirmation, 
click Replace All.

TOOLBARS SUBMENU

Allows you to show or hide each of the client letter toolbars: the Standard 
toolbar and the Formatting toolbar. See Toolbars on page 211.

RULER
Toggles the display of the ruler (located at the top of the client letter) on or off. 
See Ruler on page 213.

FONT SUBMENU

The items on the Font submenu allow you to change the appearance of the text 
in your letter. The selected command changes the appearance of the selected 
text, if any. If no text is selected, the commands act as a toggle, turning on or 
off the font attribute for text you enter from the insertion point on. The 
commands available on the Font submenu are:

Name command — Displays the Font dialog, where you can select the 
desired font name, style, and size. The Font dialog is covered in detail 
under See Screen Font on page 261.
Bold command — Bolds the text. 

Italic command — Italicizes the text. 
Underline command — Underlines the text.

ALIGNMENT
Displays the Paragraph Alignment dialog. 

mToolbarSubmenu.png

mFontSubmenu.png
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Use the Paragraph Alignment dialog to set up the layout of your letter and 
determine the indentation and alignment of your text and linked data. You can 
make several rows of linked cells easier to read by changing the spacing above 
or below lines. Or, choose to change the overall line spacing. You can change 
how far the paragraph or the first line of the paragraph is indented, as well as 
the alignment of the paragraph(s) to the left, centered, right, or fully justified. (In 
justified text, the text is spaced so the left and right margins are straight, not 
ragged.) You can also set the tab stops for the paragraph(s).
The program applies the changes you make in this dialog to the selected text. 
If no text is selected, your changes affect the current paragraph — wherever 
the insertion point is — and toggles on the alignment selection(s) for new text 
added from that point to the next paragraph in the letter. When text is selected, 
the settings affect all selected paragraphs.

INDENTATION Specify how much you want the left or right sides of the text indented, in 
quarter-inch increments. You can select settings between 0 and 2 inches or 
type in precise margin settings. Use the Special and by fields to create special 
indentation settings for a hanging indent or first-line indent.

dParagraphAlignment.png
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ALIGNMENT Lets you choose the alignment orientation — to the left, right, centered, or 
justified.

SPACING Use the Before and After fields to change the spacing before (above) or after 
(below) the selected paragraph(s). Use the Lines and At fields to specify the 
amount of vertical spacing between the lines of the selected paragraph. If no 
text is selected, the spacing selections are toggled on for new text. Amounts of 
spacing are measured in point increments.

TAB STOPS Allows you to set or clear tab stops, including default tab stop selections. 
Choose a tab stop from the drop-down list or type in a precise tab stop in 
points. Choose the tab stop alignment — left, right, or center.

For step-by-step instructions on formatting paragraphs, see Text Alignment 
and Layout on page 222.

ALIGN DATA
Use the Align Data command to restore the default alignment (including tab 
settings) of selected linked data. This is especially useful when you’ve paste 
linked several worksheet rows into the letter or made changes to the alignment 
that you don’t want to keep.

INSERT SUBMENU

The items on the Insert submenu allow you to insert information into your client 
letter that is updated automatically with changes to the letter or within the client 
file. The item is placed in the letter at the insertion point. The items on this 
submenu are:

Page Number — Allows you to insert the number of the page in a header 
or footer of the letter. This selection is disabled outside of the Header & 
Footer window.
Date — Allows you to insert either today’s date or an updated “system” 
date into the letter. The system date uses your computer’s calendar to set 
the date and is updated whenever you print the letter.

Time — Allows you to insert either the current time or an updated “system” 
time into the letter. The system time uses your computer’s clock to set the 
time and is updated whenever you print the letter.
Client Name — Allows you to insert the client’s name in the letter. The 
Client Name is pulled from the Assumptions dialog.

mEditClientLetterInsert.png
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Salutation Name — Allows you to insert the Salutation Name in the letter. 
The Salutation Name is pulled from the Client Address & Salutation 
Name dialog, accessed from Assumptions.
Client Address — Allows you to insert the client’s address in the letter. 
The Client Address is pulled from the Client Address & Salutation 
Name dialog, accessed from Assumptions.

Page Break — Allows you to force the letter to start a new page at the 
insertion point. This selection is disabled within the Header & Footer 
window. A red line across the letter marks the place that the page break 
was inserted.

HEADERS & FOOTERS
Displays the Headers and Footers window, which contains the header and 
footer fields. You can use all font and formatting features in these fields. These 
fields are:

Header first page — The text entered in this field appears at the top of the 
first page only, within the specified top margin. You can specify a separate 
top margin for this item. See Margins, below. You may want to enter a 
letterhead here. 

Footer first page — The text entered here appears at the bottom of the 
first page only, within the specified bottom margin.
Header subsequent pages — The text entered here appears at the top of 
every page in the letter, except the first page.
Footer subsequent pages — The text entered here appears at the 
bottom of every page in the letter, except the first page.

MARGINS
Displays the Margins dialog, which allows you to specify the top, bottom, right, 
and left margins for the client letter, as well as the printed worksheets and 
graph. Depending upon whether you had previously selected margin widths, 
there may be numbers rather than zeros in the boxes. 

dMargins.png
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You can also specify a different margin for the top of the letter’s first page. For 
more details on margins, see page 73.

SHOW/HIDE ¶
Use this command to turn the paragraph (¶) symbols on and off in your letter. 
Turning them on helps you see the formatting (indents, blank lines, etc.) in your 
letter. When paragraph symbols are shown, the Undo command is disabled.

SHOW/HIDE LINKS
When you select this command, the program changes the appearance of the 
linked data within your letter to show the linked data’s source. For example, if 
you inserted a cell from the Main Worksheet into a letter, you would normally 
see the amount from that cell. When you select Show Links, you see the string 
that includes the worksheet name, the row caption, and the column heading 
enclosed in curly brackets, for example {Main Worksheet: Total Net Tax Liabil-
ity: Sell #2}.
If you used the Insert menu commands to insert information that does not 
come from a worksheet (such as a client’s name or address), the link will look 
like this: {Client Name}.

CLIENT LETTER LINKS
Displays the Client Letter Links dialog. 

The Client Letter Links dialog allows you to review, edit, or delete links from 
the worksheets that are paste linked into the letter. This dialog also explains the 
arrangement and origin of the links as they are presented in the client letter. 

LINK # When you link data from a worksheet to the letter, the program assigns a 
number in sequence to each link. To review a link’s source information, select 
the link’s number in this list box. The source information will appear to the right 
of the Link # box.

WORKSHEET Indicates the source worksheet of the link.

TOP ROW Indicates the first row included in the link.
BOTTOM ROW Indicates the last row included in the link.

dClientLetterLinks
.png
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LEFT COLUMN Indicates the leftmost column included in the link. If the row description is 
included, the Left Column is “Caption.”

RIGHT COLUMN Indicates the rightmost column included in the link.
This dialog lists the source information about each link and lets you edit the 
details of the link or delete the link.

EDIT LETTER LINK COLUMNS DIALOG
The Edit Letter Link Columns dialog, accessed from the Client Letter Links 
dialog when you click the Edit button, allows you to change the selection of 
what is linked in the worksheets to the letter.

The appearance of the dialog varies, depending upon the column titles in the 
analysis. The two dialogs above, for example, are for links in letters created for 
two scenarios in the Tutorial (accessible on the Help menu).
The dialog on the left shows a single box is checked — this indicates that the 
link is to a single cell in a worksheet. 
The dialog on the right shows two boxes checked — this indicates that a range 
of cells are included in the link. The first box selected (in this case, Captions) 
indicates the leftmost cell in the range. The second box selected indicates the 
rightmost cell in the range.

You can change the cells included in the link by selecting a different box. 
CAPTIONS The first check box, Captions, gives you the option of simply showing calcula-

tions or keeping the link labels alongside the data in the letter. Captions 
describe the data and indicate where you can find the link on the worksheet.

COLUMN
HEADINGS

The remaining check boxes correspond to the column titles or headings, for 
example, Keep Both or Stock Sale 2012:2013. Select the column(s) you want 
included in the letter at the link.

dEdtiLetterLinkC
olumns.png

For a single-cell link For a multi-cell link (range of cells)

Right-most 
cell in range

Left-most cell 
in range

dEdtiLetterLink
Columnsb.png
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9
9 Options Menu

OPTIONS MENU
OVERVIEW

Selections on the Options menu provide ways to control how the program 
operates or looks. Some of the options include:

Auto Backup – Sets the length of time between auto backups and allows 
you to turn Auto Backup feature on or off
Calculations – Allows you to change the size of the number displayed 
within a column through display cents and number of dollar digits displayed 
commands. You may also enter information that is used to handle limita-
tions used in the Keogh and SEP calculations; also allows you to enter 
items of information affecting calculations that were not available at the 
time the program was released (inflation adjustment percentage, under-
payment penalty rate, etc., for future years).

Colors – Allows you to set the colors used on the screen display
Default Directory – Allows you to specify the initial default directory or 
choose to use the last accessed directory as the initial default directory

Network Administrative Options – <<desktop program edition only, 
and available only when running the program in Admin Mode in a 
network environment>> Opens the Network Administrative Options 
dialog, where network administrators can specify the end users’ activation 
experience when they open Income Tax Planner for the first time.
Link Options – Allows you to select change the length of time Income Tax 
Planner will wait for linked information from Excel, or choose to have 
linked files saved to the same folder as Income Tax Planner’s client file 
(when the client file is being moved using the Save As command)
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Deactivate Workstation – <<not available when running the program 
in Admin Mode>> Allows you to deactivate a workstation and free up a 
license.
Password Protect – Allows you to specify a password that will be required 
to reopen a saved client file.

Screen Font – Allows you to select the screen font used to display the 
worksheets
Resident State Specifications – If you have Income Tax Planner with 
Fifty States, this menu is also the gateway to the resident state specifica-
tions portion of the program.
Nonresident State Specifications – If you have Income Tax Planner 
with Fifty States, this menu is also the gateway to the nonresident state 
specifications portion of the program.

Calculations On – Allows you to toggle the calculation feature on or off. 
As a default, these items are on.
Save Desktop – Allows you to choose to have the size and position of the 
open worksheets saved when you save the client file and restored when 
the client file is reopened
View Filename – Allows you to view the name of the opened file in the 
program title bar.

View Toolbar – Allows you to display or turn off the Toolbar at the top of 
the screen.
View Tabs – Allows you to display the tabs at the top or bottom of the 
program workspace or hide the Tabs altogether.
View Worksheet List – Allows you to display the Worksheet List at the left 
or right of the program workspace or hide the Worksheet List altogether.

View Worksheet Row Numbers – Allows you to display on each built-in 
worksheet the corresponding row numbers for each row title.

Each of these items are described in detail in the following sections.

SAVE AS DEFAULT
Some of the commands on the Options menu can be saved as defaults for 
future analyses, including Auto Backup, Calculations, Colors.
When you select Save as Default, the program issues a message stating that 
the calculation options were saved to the initialization file. In a few moments 
the box closes and the focus returns to the previous worksheet.
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AUTO BACKUP
Note. For users of the Web program edition, the way in which the backup (itb) 
file is handled is the same as in the desktop program edition, but the actual itb 
file will be invisible to you.

WHAT IS AUTO BACKUP?
The Auto Backup feature, if on, causes the program to automatically save the 
current case data in a temporary file on disk every few minutes. Using this 
command you can specify the number of minutes between auto backups or 
turn the Auto Backup feature off. 
This temporary backup file, it.itb, will disappear as soon as you exit from the 
program by the proper exit mechanism (after saving any needed data via the 
Save/Save As features). Whenever Auto Backup processes, an hourglass 
momentarily appears on the screen. 

The data is saved in a temporary file only if Auto Backup is on, or in the rare 
circumstances when the program encounters an unanticipated error condition. 
Use the Auto Backup feature as a temporary backup to protect your current 
data against data loss in the event of a system failure. The Save/Save As and 
Auto Backup features should be used together for maximum protection.
If Auto Backup is off, current data will not be saved automatically in a backup 
file.

SAVE OR AUTO BACKUP?
Using the Auto Backup command is not the same as saving client data to 
retrieve at a later date. 
For additional discussion on this topic, see Save vs. Auto Backup on page 64.

HOW THE AUTO BACKUP FILE IS USED
If the program encounters an unanticipated error condition, it tries to save all 
current data to the it.itb file, regardless of whether Auto Backup was on or not. 
The program also displays a message with an error code number and instruc-
tions to call the toll-free Customer Support number. The program then 
automatically presents the it.itb file for loading the next time you run the 
program. The it.itb file will disappear as soon as you exit the program properly.
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Note. <<desktop program edition only>> If you choose to not load the it.itb 
file, the program renames and saves it on disk so that you can retrieve it at a 
later time. The new name is an 8-digit number reflecting the day, hour, minute, 
and second that the file was created plus the extension .itb. For example, an 
analysis created on the 4th day of the month at 1:30 p.m. would be 
04133000.itb.

If the program fails as a result of external circumstances (i.e., the power goes 
out, the computer is turned off before exiting the program properly, an error 
occurs in the operating system, etc.), the current data will only be saved 
automatically to the backup file if Auto Backup was on. The data would be 
current up to the time of the last Auto Backup time interval.

CHANGING THE AUTO BACKUP INTERVAL
The Auto Backup interval is the length of time between auto backups. The 
default interval is five minutes. To change the interval, select Auto Backup 
from the Options menu. The following dialog opens:

Using the list box, you can select an interval between 1 and 15 minutes.
If you type in a number, the next interval setting beginning with that number will 
pop up. For instance, if the current setting is 5 and you type 1, 10’ will appear 
in the list box. The program treats each digit entered as a separate entry, so if 
you type 14 when the setting is 5, first 10’ and then 4’ will appear in the list box.

TURNING AUTO BACKUP ON AND OFF
When the backup interval is set to a number, Auto Backup is on. To turn Auto 
Backup off, select Auto Backup from the Options menu. Then scroll up the 
items in the list (if necessary) and select Off from the top of the list.

dBackupInterval.png
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Then select OK. You can turn Auto Backup on again whenever you wish, just 
by re-opening this dialog and selecting a backup interval.

CALCULATION OPTIONS DIALOG
The Calculation Options dialog allows you to change the size of the number 
displayed within a column through Display Cents and Number of Dollar 
Digits commands. You may also enter information that is used to handle 
limitations used in the Keogh and SEP calculations. You can enter items of 
information affecting calculations that were not available at the time the 
program was released (inflation adjustment percentage, underpayment 
penalty rate, etc. for future years). 

Using the items on this dialog you can adjust various factors that affect the 
calculations, such as the inflation percentage. You can also change the width 

dBackupIntervalb.png

dCalculationOptions.png
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of the amount displayed in the worksheet columns using the Display Cents 
and Number of Dollar Digits items.
Some of the items on this dialog are available at the time of program publica-
tion and are incorporated into the program. The amount used will be displayed 
in the cell for information purposes only. The available items vary, depending 
on the time of year that the program is released.

All amounts you enter on this dialog can be saved into the program’s default 
configuration by selecting Save as Default while the Calculation Options 
dialog is open.
<<desktop program edition only>> For the network version of the program, 
some items can be changed only by the network administrator using admin 
mode.
<<Web program edition only>> Changes you make to the calculation options 
in the Web program edition will override the entries on the Calculation 
Options dialog in the income tax planning analysis module.

To leave this dialog without saving your changes, select Cancel. You will 
receive message informing you that the original calculation option settings 
have been restored.

DISPLAY CENTS
When you select Display Cents, the program expands each entered and 
calculated dollar amount to include a decimal point and two decimal places. 
This allows you to enter cents in the worksheet by first pressing “.” and then 
entering the digits. The program automatically assigns a decimal point and two 
zeros for any whole number entered.

Note. When cents are displayed, the column width increases. Depending upon 
this factor (and the number of case/year columns, the number of dollar digits, 
the size of the screen font, and the width of the worksheet window), you may 
not be able to view all of the columns at one time on the screen.

If you do not select Display Cents, only whole dollar amounts are displayed.

NUMBER OF DOLLAR DIGITS (7–10)
Use the Number of Dollar Digits item to specify the maximum number of 
dollar digits that you want the program to display within a column.
This list box allows you to select a number between 7 and 10. You can use the 
keyboard to enter a number. Press 1 to enter “10”.
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Note. The greater the number of digits displayed, the wider the column width. 
Depending upon this factor as well as whether cents are displayed, the number 
of case or year columns, the size of the screen font, and the width of the 
worksheet window, you may not be able to view all of the columns at one time 
on the screen.

If a calculated amount exceeds the number of dollar digits specified, the 
program displays a message similar to the following:

 

If this happens during program operation, select OK to return to the worksheet. 
Then open the Options menu, select the Calculations option, change the 
setting for the Number of Dollar Digits, and finally return to where you were 
in the program.

INFLATION PERCENT (2021 AND AFTER)
The estimated inflation percent for the year shown. (The year shown is 
updated with the fall version of the program.) The Inflation Percent can be any 
positive whole number from 1 to 99. The program adjusts the following items 
for the year shown and subsequent years by the percentage that you specify, 
in accordance with IRC § 1(f):

tax rate schedules

personal exemption amounts
standard deduction amounts
itemized deductions floor threshold amounts

personal exemption phaseout threshold amounts
earned income credit limits
educational bond interest limits

self-employment tax limits
the exemption amount for the excess business loss limitation
the limit for which service businesses may generate qualified business 
income

the limit for which business do not have to pay W-2 wages to generate 
qualified business income

msgCautionCal
culationResultT
ooLarge.png



246

::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::

If an amount is entered or displayed in the Consumer Price Index Adjust-
ment field (below), the year on this row will be the year following the CPI 
Adjustment year and the percent entered here will be used for all adjustments 
in the year shown and subsequent years.
This list box allows you to select a number between 0 and 9 by clicking on your 
desired selection. Or, you can use the keyboard to enter a single- or double-
digit number.

2020 CONSUMER PRICE INDEX ADJUSTMENT
The Consumer Price Index Adjustment for the year shown. (The year shown 
is updated with the fall version of the program.) If the CPI Adjustment amount 
for the year shown was available at the time of program publication, the 
amount is incorporated into the program and used in the program’s calcula-
tions. The amount will be displayed in the cell.

Note. In some program versions, an unofficial CPI Adjustment amount is 
displayed. The unofficial amount is used by the program, but can be changed.

If the CPI Adjustment amount for the year shown was not available at the time 
of program publication, you can enter any positive number from 1.000000000 
to 99.99999999 as the adjustment amount. The number entered must be the 
one supplied by Bloomberg Tax Technology in order to have accurate results.

The program uses the Consumer Price Index Adjustment to compute the:
tax rate schedules
personal exemption amounts

standard deduction amounts
itemized deductions floor threshold amounts
personal exemption phaseout threshold amounts

earned income credit limits
educational bond interest limits

If an amount is entered or displayed in the Consumer Price Index Adjust-
ment field, the year in the Inflation Percent field (above) will be the year 
following the CPI Adjustment year and the inflation percent will be applied to all 
years following the CPI adjustment year.

Note. For the network version of the program, this item can be changed only 
by the network administrator using admin mode.
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2020 MAXIMUM OASDI CONTRIBUTION BASE
In computing the self-employment tax, the program uses the amount entered 
or displayed here as the maximum amount on which the social security old age 
tax (12.4%, half paid by employer, half by employee) is withheld from wages in 
the year shown. (The year shown is updated with the fall version of the 
program.)
If the maximum OASDI contribution base amount for the year shown was 
available at the time of program publication, the amount is incorporated into the 
program and used in the program’s calculations. The amount will be displayed 
in the cell.
If the contribution base amount for the year shown was not available at the time 
of program publication, you can enter any positive whole number from 1 to 
999999 as the Maximum OASDI Contribution Base. If no amount is entered, 
the program uses the 2019 limit inflated for years after 2019 by the Inflation 
Percent above.

Note. For the network version of the program, this item can be changed only 
by the network administrator using admin mode.

2020 RETIREMENT PLAN COMPENSATION LIMIT
The limit specified in IRC § 404(l) on compensation that may be taken into 
account in computing the deduction limits of IRC § 404 for contributions to 
employer plans. The limit is 200,000 adjusted for inflation each year. The 
program uses the amount entered here in computing the Keogh and SEP 
deductions allowed to the taxpayer and his/her spouse, on the Keogh and SEP 
deductions worksheets. (The year shown is updated with the fall version of the 
program.)
If the retirement plan compensation limit for the year shown was available at 
the time of program publication, the amount is incorporated into the program 
and used in the program’s calculations. The amount will be displayed in the 
cell.

If the retirement plan compensation limit for the year shown was not available 
at the time of program publication, you can enter any positive whole number 
from 200000 to 999999 as the retirement plan compensation limit.
The program uses the amount entered here for the year indicated and for all 
subsequent years inflated by the Inflation Percent above. If no amount is 
entered, the program uses the 2019 limit inflated for years after 2019 by 
Inflation Percent above.

Note. For the network version of the program, this item can be changed only 
by the network administrator using admin mode.



248

::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::

2020 RETIREMENT PLAN DEDUCTION LIMIT
The limit specified in IRC § 415(c)(1)(A) on contributions that may be made to 
a participant’s account in an employer plan. See IRC § 404(j). The limit is 
40,000 adjusted for inflation each year. The program uses the amount entered 
here in computing the Keogh and SEP deductions allowed to the taxpayer and 
his/her spouse, on the Keogh and SEP deductions worksheets. (The year 
shown is updated with the fall version of the program.)
If the retirement plan deduction limit for the year shown was available at the 
time of program publication, the amount is incorporated into the program and 
used in the program’s calculations. The amount will be displayed in the cell.
If the retirement plan deduction limit for the year shown was not available at 
the time of program publication, you can enter any positive whole number from 
40000 to 999999 as the retirement plan deduction limit.

The program uses the amount entered here for the year indicated and for all 
subsequent years inflated by the Inflation Percent above. If no amount is 
entered, the program uses the 2019 limit inflated for years after 2019 by the 
Inflation Percent above.

Note. For the network version of the program, this item can be changed only 
by the network administrator using admin mode.

2020 401(K) LIMIT
The limit specified in IRC § 402(g)(1) on elective deferrals that may be made to 
a participant’s account in an employer plan. For years after 2006, the limit is 
15,000 adjusted for inflation each year. The program uses the amount entered 
here in computing the Keogh and SEP deductions allowed to the taxpayer and 
his/her spouse, on the Keogh and SEP deductions worksheets. (The year 
shown is updated with the fall version of the program.)

If the 401(k) limit for the year shown was available at the time of program 
publication, the amount is incorporated into the program and used in the 
program’s calculations. The amount will be displayed in the cell.
If the 401(k) limit for the year shown was not available at the time of program 
publication, you can enter any positive whole number from 15000 to 999999 as 
the 401(k) limit.
The program uses the amount entered here for the year indicated and for all 
subsequent years inflated by the Inflation Percent above. If no amount is 
entered, the program uses the 2019 limit inflated for years after 2019 by the 
Inflation Percent above.

Note. For the network version of the program, this item can be changed only 
by the network administrator using admin mode.
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2020 401(K) CATCH-UP LIMIT
The dollar limitation under § 414(v)(2)(B)(i) for catch-up contributions to an 
applicable employer plan other than a plan described in § 401(k)(11) or 408(p) 
for individuals aged 50 or over. For years after 2006, the limit is 5,000 adjusted 
for inflation each year. The program uses the amount entered here in comput-
ing the Keogh and SEP deductions allowed to the taxpayer and his/her spouse, 
on the Keogh and SEP deductions worksheets. (The year shown is updated 
with the fall version of the program.)
If the catch-up limit for the year shown was available at the time of program 
publication, the amount is incorporated into the program and used in the 
program’s calculations. The amount will be displayed in the cell.
If the catch-up limit for the year shown was not available at the time of program 
publication, you can enter any positive whole number from 5000 to 99999 as 
the catch-up limit.

The program uses the amount entered here for the year indicated and for all 
subsequent years inflated by the Inflation Percent above. If no amount is 
entered, the program uses the 2019 limit inflated for years after 2019 by the 
Inflation Percent above.

Note. For the network version of the program, this item can be changed only 
by the network administrator using admin mode.

2020 SECOND QUARTER UNDERPAYMENT PENALTY RATE
The program uses the number displayed here as the interest/penalty rate 
applicable to the second quarter of the year shown for purposes of the IRC § 
6654 (Form 2210) underpayment penalty. (The year shown is updated with the 
spring version of the program.)

This amount is for information purposes only and will always be dimmed.

2020 THIRD QUARTER UNDERPAYMENT PENALTY RATE
The program uses the number entered or displayed here as the inter-
est/penalty rate applicable to the third quarter of the year shown for purposes 
of the IRC § 6654 (Form 2210) underpayment penalty. If the amount for the 
year shown was available at the time of program publication, the amount is 
incorporated into the program and used in the program’s calculations. The 
amount will be displayed in the cell and the item will be dimmed. (The year 
shown is updated with the spring version of the program.)
If the amount for the year shown was not available at the time of program 
publication, use the list box to select a number between 0 or 5 and 14. The 
Third Quarter Underpayment Penalty Rate can be any positive whole number 
from 1 to 99.
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If the item is not dimmed and no number or zero is entered here, the program 
uses the rate from the most recent quarter it has.

Note. For the network version of the program, this item can be changed only 
by the network administrator using admin mode.

2020 FOURTH QUARTER UNDERPAYMENT PENALTY RATE
The program uses the number entered or displayed here as the inter-
est/penalty rate applicable to the fourth quarter of the year shown for purposes 
of the IRC § 6654 (Form 2210) underpayment penalty. If the amount for the 
year shown was available at the time of program publication, the amount is 
incorporated into the program and used in the program’s calculations. The 
amount will be displayed in the cell and the item will be dimmed. (The year 
shown is updated with the spring version of the program.)

If the amount for the year shown was not available at the time of program 
publication, use the list box to select a number between 0 or 5 and 14. The 
Fourth Quarter Underpayment Penalty Rate can be any positive whole 
number from 1 to 99.
If the item is not dimmed and no number or zero is entered here, the program 
uses the rate from the most recent quarter it has.

Note. For the network version of the program, this item can be changed only 
by the network administrator using admin mode.

2021 FIRST QUARTER UNDERPAYMENT PENALTY RATE
The program uses the number entered here as the interest/penalty rate appli-
cable to the first quarter of the year shown for purposes of the IRC § 6654 
(Form 2210) underpayment penalty. (The year shown is updated with the 
spring version of the program.)
The First Quarter Underpayment Penalty Rate can be any positive whole 
number from 1 to 99.
From the list box, select a number between 0 or 5 and 14.

If no number or zero is entered here, the program uses the rate from the most 
recent quarter it has.

Note. For the network version of the program, this item can be changed only 
by the network administrator using admin mode.

Note. <<Desktop program edition only>> Changes to the default calculation 
options are saved in the “it.ini” file in the following folder:
[drive letter]:\Users\[user name]\AppData\Local\Bloomberg Tax Technol-
ogy\Income Tax Planner
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INFLATION ADJUSTMENTS
Certain items used in the computations are subject to annual adjustments for 
inflation. These items include:

tax rate schedules

personal exemption amounts
standard deduction amounts
itemized deductions floor threshold amounts

personal exemption phaseout threshold amounts
earned income credit limits
educational bond interest limits

self-employment tax limits
The exemption from the excess business loss limitation
The limit for which service businesses may generate qualified business 
income for purposes of the qualified business income deduction

The limit for which business do not factor in wages paid for purposes of 
computing the qualified business income deduction

The amounts for all years prior to 2021, including inflation adjustments 
published by the Treasury Department, are incorporated into the program.
For 2021 and subsequent years, the program uses the statuary amounts 
inflated by the Inflation Percent.
All inflation adjustments are made on a compound basis. Each year the 
Inflation Percent is reapplied to the prior year amount.

COLORS
If you are using a color/graphics or enhanced graphics adapter, you can select 
from several pre-defined color sets for displaying the program worksheets on 
the screen using the Colors command on the Options menu. Alternatively, you 
can create color sets of your own by specifying the display colors the program 
will use in 18 different areas of the program worksheets.
To open the Color Options dialog, select Colors from the Options menu. The 
following dialog will appear: 
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WORKSHEET AREA
The following illustration relates the items listed under Worksheet Area to their 
position on a worksheet. 

 

You may use any of the 18 items on the Worksheet Area list to build your own 
custom color set or customize a preset color set.

Input Cell Back — Contrasting background color used for input cells
Input Cell Text — Color used for amounts entered into the input cells
Input Cell Linked to Income Tax Planner — Color used for amounts in 
Income Tax Planner input cells linked from Excel

Input Cell Linked from Income Tax Planner — Color used for amounts 
in Income Tax Planner input cells linked to Excel
Calculated/Protected Cell Back — Contrasting background color used 
for the cells in calculated rows and protected columns

Calculated/Protected Cell Text — Color used for the amounts in the 
calculated rows’ cells and protected columns
Calculated Cell Linked from Income Tax Planner — Color used for 
amounts in Income Tax Planner calculated cells linked to Excel

dColorOptionsb.pngTitle Grid Lines

Input Title

Calculated Title

Active Cell Cell Grid Lines

Calculated and Protected Cell

Input Cell

Cell Underlines

Input Cell Linked
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Cell Grid Lines — Color of the line delineating the cells within the 
worksheet
Cell Underlines — Color of the cell underline(s) within the worksheet 
indicating subtotals and totals

Active Cell Back — Color of the background of the worksheet cell in which 
you are entering data (the active cell is the location of the cursor) 
Active Cell Text — Color of the letters or numbers that you are entering 
into the active worksheet cell
Input Title Back — Contrasting background color used for input cell and 
column heading titles

Input Title Text — Color used for the titles that appear at the left of the 
input cells and at the top of the columns as column headings
Calculated Title Back — Contrasting background color used for the 
calculated row titles
Calculated Title Text — Color the program will use for the calculated rows 
titles to the left of the cells

Title Grid Lines — Color of the lines between the row titles and between 
the column headings
Remote Cell Linked to Income Tax Planner — Color used for amounts 
in Excel linked to Income Tax Planner
Remote Cell Linked from Income Tax Planner — Color used for 
amounts in Excel linked from Income Tax Planner

To change the color used for an item on the list: 
1. Select the item (click on it or press the arrow keys to browse through the 

list).

2. Then select a color from the Color Palette (click on it or press the arrow 
keys to browse through the list).

As you select or browse through colors for the Worksheet Area item, your 
change is reflected in the sample worksheet at the bottom of the dialog. Unless 
you save your changes as the default (click Save as Default), after you select 
OK your changes will only remain in effect until you quit the program.

Note. You cannot change the Worksheet Title area in an application program. 
To change this item, select Settings/Control Panel/Display from the Start 
menu. Then select the Appearance tab on the Display Properties dialog.
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PRESET COLORS
The Preset Colors list box offers several pre-defined color sets for the 
program’s display of worksheets from which you can choose. These color sets 
contain color settings for each of the items listed in the Worksheet Area list. 
The pre-defined color sets provide a fast and convenient method of establish-
ing program colors.
The components of a color set are the foreground (or text) color and the 
background color. In the pre-defined color sets, the foreground color listed 
below is the color for all text on a worksheet except the text of the calculated 
rows. The background color is the color for all background except that of the 
active cell.
The pre-defined color sets are:

When you select a preset color set (click on the selection or press the up or 
down arrow key to browse through the list), your selection is demonstrated in 
the worksheet sample at the bottom of the dialog.

Select OK to apply your color selection to the current session of the program. 
Your new color selection will remain in effect until you quit the program (or until 
you change it, whichever is first) unless you save the selection as the default.
The Prior Default color set allows you to restore the color settings previously 
saved as the default colors.

Note. When you install a program update, the program will use default colors 
from the earlier version as the default colors unless you change the default 
colors.

Text Background
Black Gray

White Navy

Black White

Black Silver

Black Teal

Silver Black

White Green

White Purple

White Gray

Black Aqua
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UNDERLINES
When the Underlines check box is selected, the program displays on the 
worksheets the underlines for the subtotal and total cells and dims the cell grid 
lines so that the on-screen worksheets more closely resemble the printed 
reports. This option is selected by default when you select a Preset Color. 

Note. The first time you open the program after installation, the Underlines 
option is selected.

When the Underlines check box is not selected, the underlines for the subtotal 
and total cells are not displayed and the cell grid lines are highlighted.
The Underlines check box is disabled when the Custom Colors are used. To 
display or change the color of the underlines when using Custom Colors, 
select Cell Underlines on the Worksheet Area list, then select the desired 
color from the Color Palette.

GRADIENT BACKGROUND
When the Gradient Back check box is selected the background for row titles 
is graded from dark to light. Also, the indicator for a subworksheet is a small 
worksheet icon.

ROW HEIGHT
To change the row height hold the left mouse button while sliding the indicator. 
Alternatively you may click on the arrows at the ends of the bar.

COLOR PALETTE
The Color Palette consists of two rows of color patches in the middle of the 
dialog. Each patch displays one of the different colors that are available. A 
square border around a color patch marks the current color selection.

 

To change the color of a selected Worksheet Area item, click the desired color. 
As you change the selected color, you can see the corresponding color change 
on the sample worksheet at the bottom of the dialog.

You can use the Color Palette along with selections on the Worksheet Area list 
box to build a customized color set or to alter a preset color set. However, 
unless you save your new color selections as the color default, the settings 

dColorOptionsc.png
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remain in effect only until you quit the program. See Creating a Custom Color 
Set on page 256 for step-by-step instructions.
To restore the color settings to those previously saved as the default colors, 
select Prior Default in the Preset Colors list box.

SAMPLE WORKSHEET
When you first open the Color Options dialog, the sample worksheet at the 
top of the dialog illustrates the current color setting for the worksheets. The 
colors on the sample worksheet change to reflect the selections you make on 
this dialog.

APPLYING CHANGES
When the sample worksheet illustrates the color settings that you want, select 
OK to return to the worksheet and apply the settings you selected.

Note. <<Desktop program edition only>> Changes to the default color 
options are saved in the “it.ini” file in the following folder:
[drive letter]:\Users\[user name]\AppData\Local\Bloomberg Tax Technol-
ogy\Income Tax Planner

CREATING A CUSTOM COLOR SET
The Color Options dialog allows you to build your own custom color set by 
adjusting the color for each worksheet area desired. The steps below detail the 
procedure.

Note. Before creating a custom color set, you may want to select a preset color 
setting as the base of your custom color set and alter some of the pre-defined 
settings.

1. Select the Worksheet Area item that you want to change by clicking on the 
item. You can use the arrow keys to move the cursor to the item you wish 
to change (such as the Input Title Text).

2. Select a color from the Color Palette by clicking the color then using the 
arrow keys to move the border to the color want. As you change the color 
selection, you can see the color of the selected Worksheet Area item 
change on the sample worksheet at the bottom of the dialog.

If you want to cancel your changes and restore the colors you started with, 
select Cancel.

3. Repeat steps 1 and 2 for each item on the list that you want to change. 
When the sample worksheet is the way you want it, click Save as Default 
to save the changes as a default and to return to the worksheet. The colors 
you select will remain in effect until you change them.
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Note. You can return to the worksheets without saving the changes perma-
nently by clicking OK. The new colors then remain in effect only until you 
exit the program. 

DEFAULT DIRECTORY
<<desktop program edition only>>
The Default Directory command on the Options menu allows you to specify 
the directory that is offered the first time you open or save a data file, or print 
the data to a text, Excel, Lotus 1-2-3, or Adobe Acrobat file. The program also 
provides the option to use the most recently-accessed directory as the default 
directory for the next time you start up the program.
Network workstations may select the default data folder selected by the 
network administrator.
When you select the Default Directory command, the Default Client Files 
Directory dialog opens.

USER SPECIFIED
When this option is selected the program will use the folder designated by the 
user.

USE THE LAST ACCESSED DIRECTORY AS THE DEFAULT
When this option is selected, the initial default directory changes whenever you 
access a different directory using one of Income Tax Planner’s file operations 
(Open Client File, Save Client File As command, or when you print the client 
file to a file on disk). When you exit the program, the “last accessed directory” 
is retained as the default directory for the next time you start Income Tax 
Planner.

NETWORK SERVER
When this option is selected the program will use the folder selected by the 
network administrator for the program. For details, see Inheritance of 
Network Settings in help.

dDefaultClientFil
esDirectory.png
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NETWORK ADMINISTRATIVE OPTIONS
<<desktop program edition only>>

Note. When the network server component of Income Tax Planner was 
initially set up, the network administrator specified the workstation activation 
method, that is, the end users’ activation experience when they open Income 
Tax Planner for the first time on their workstations.

The Network Administrative Options command on the Options menu is 
available to network administrators only when running the program in Admin 
Mode. This command opens the Network Administrative Options dialog, 
where you can change the workstation activation method.

There are three workstation activation methods:
Silent – The program opens immediately and activates silently. The 
program never shows the Confirm Activation panel.
Confirmed – The program always shows the Confirm Activation panel to 
all users.

Confirmed if All Licenses Used – The program shows the Confirm 
Activation panel only to users who activate the program after all 
purchased licenses have already been activated.

If you choose the second or third option, users will still be able to activate the 
program, but they will be given the option to cancel (and not activate the 
program). The information you enter in the lower portion of this dialog – the 
Administrator’s Contact Information – will appear on the Confirm Activa-
tion panel, informing users who to contact if they have questions about 
activation or licensing. If the fields are left blank, only the contact information 
for Customer Support will appear on the Confirm Activation panel.

With all three options, if no internet connection is detected, the Activation 
wizard opens, allowing users to use the Activate by Phone option.

DEACTIVATE WORKSTATION
Allows you to deactivate a workstation and free up a license. This option is not 
available when running the program in Admin Mode.

LINK OPTIONS
The Link Options command provides options used when the client data file is 
linked to Excel. When you select Link Options on the Options menu, the 
following dialog opens: 
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Save linked file to same directory as IT file.

<<desktop program edition only>> Allows you to save to the same directory 
the Income Tax Planner client data file and the file to which it is linked to Excel. 
This option is useful when you move Income Tax Planner client data file using 
the Save As command. To allow easy transfer of the files to another computer, 
a thumb drive, or other media, the program saves the file to which the Planner 
file is linked to the same folder as the Planner file. The program will not save 
an Excel file not directly linked to the Income Tax Planner file to the same 
directory.
<<desktop program and web version>> The Deactivate Links option turns 
off the automatic updating of Excel links during the calculation process.

TIMEOUT
Allows you to set the amount of time (in seconds) that the program waits for 
linked information from Excel. Use this command when you have problems re-
establishing links with a remote application due to timeout problems. 

The default is five seconds. You can change this to any number of seconds 
from 5 to 15 using the list box, or you can key in a number from 1 to 99 directly.
Select OK after making your selection. Income Tax Planner uses the link 
timeout interval you specified until you leave the analysis. You can change the 
interval again whenever you wish, just by re-opening this dialog and specifying 
a different link timeout interval.

Select Cancel to reject your changes and return to the previous worksheet.
Select Save as Default to save your selection as a default for future analyses.

SAVE LINKED FILE TO SAME DIRECTORY AS IT FILE
<<desktop program edition only>>
Allows you to save to the same directory the program client data file and the file 
to which it is linked to Excel. This option is useful when you move the client 
data file using the Save As command. To allow easy transfer of the files to 
another computer, a floppy, or other media, the program saves the file to which 
the Income Tax Planner file is linked to the same folder as the Income Tax 
Planner file.

dLinkOptions.png
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PASSWORD PROTECT
<<desktop program edition only>>
Allows you to specify a password and confirm the password that will be 
required to reopen the file once it is saved.

For an added level of security, password protected files are also encrypted to 
prevent viewing of their content. Therefore, be sure to record the filename and 
password for each password protected file. When you attempt to open a file 
that is password protected, the program prompts you for a password before 
allowing access to the program.
When you select the Password Protect command, the Password Protect 
dialog opens.

ENABLE PASSWORD PROTECTION WHEN SAVING CLIENT FILES
This option allows you to specify a password when saving client files. If this 
option is checked a password check box and two text boxes for the password 
will be displayed at the bottom of the Save Client File As dialog. 

To save a file with password protection, from the Save Client File As dialog:
1. Specify a filename.
2. Check the Password check box at the bottom of the dialog.

3. Type in a password. Passwords are case sensitive, i.e., capital letters are 
not equivalent to lower case letters.

4. Retype the password in the confirm text box.
5. Click Save to save the file.

You may also use a default password for all files by selecting Use Default 
Password described below.

USE DEFAULT PASSWORD WHEN SAVING CLIENT FILES 
This option is only available when the Enable Password Protection option 
above is checked when saving client files.

dPasswordProtect.png
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If this option is checked, the Password specified and confirmed on this dialog 
will be automatically specified on the Save Client File As dialog when you 
select the Password check box on the Save Client File As dialog. 
This option can be used to streamline the password-protection process and 
provide the same password for all saved client files.

Note. For an added level of security, password-protected files are also 
encrypted to prevent unauthorized viewing of their content. We suggest that 
you record the filename and password used each time a password-protected 
file is saved. When you attempt to open a file that is password-protected, the 
program prompts you for the password before opening the file. If you do not 
provide it, the file cannot be opened.

SCREEN FONT
This command allows you to control the appearance of the worksheets on-
screen by choosing a screen font from the Font dialog. The selections for the 
sample illustration on page 15, for example, are Arial, regular, 8 point. The 
fonts listed in the list box will differ for you depending upon which fonts you 
have loaded.

Note. Your selections in the Font dialog affect only the font used to display the 
worksheets on-screen. Your selections here do not affect the font used to print 
the reports. To change the print fonts, use the Font command (accessed from 
Page Setup on the File menu).

When you select the Screen Font command, the following dialog will open (the 
contents of the Font, Font style, and other fields will vary depending on which 
font types you have loaded).
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FONT ITEMS Use the Font, Font style and Size areas to specify your screen font selection. 
Your selection will be used in all areas of the on-screen worksheets.
You usually specify the size in a number of points. The larger the number of 
points, the larger the font. Some fonts accept point sizes in any whole number; 
some fonts accept point sizes only in even numbers. The program only 
supports whole numbers. If you enter a fractional number, the program issues 
an error message. 

RESIDENT STATE SPECIFICATIONS
If you have Income Tax Planner with Fifty States, you can access the resident 
states portion of the program using the Resident States Specifications 
command. For additional information, see the program’s online help.

NONRESIDENT STATE SPECIFICATIONS
If you have Income Tax Planner with Fifty States, you can access the 
nonresident states portion of the program using the Nonresident States 
Specifications command. For additional information, see the program’s online 
help.

dFont.png
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CALCULATIONS ON
The program automatically computes the calculated rows and posts amounts 
from the subworksheets to the worksheets when you select the Calculations 
On command. This command is selected by default.
When the Calculations On command is on, a check mark appears next to the 
command on the Options menu.

When the Calculations On command is off, you can make entries without the 
delay associated with running complicated situations on slower computers.
When you deselect Calculations On, the next time you select Calculations 
On, the program will perform the calculations and post the results to the 
calculated rows.

SAVE DESKTOP
For all open windows, this command saves their size and position in the 
program workspace when you save the client file and then restores these 
windows to the last size and position when you re-open the file. By initial 
default, this command is not selected.
When the Save Desktop command is on, a check mark appears next to the 
command on the Options menu.

VIEW FILENAME
When selected, this option allows you to display the name of the open file 
(desktop program edition) or open client plan (Web program edition) in the title 
bar of the program. When not selected, the client’s name appears in the title 
bar.
<<desktop program edition only>> When selected, the location of the open 
file is also displayed in the title bar.

VIEW TOOLBAR
This command allows you to display or hide the main program toolbar. By initial 
default, this command is selected and the toolbar is visible. When this 
command is on, a check mark appears next to the command on the Options 
menu.

VIEW TABS TOP/BOTTOM
The View Tabs Top command allows you to display — immediately beneath 
the toolbar — a tab for each open worksheet and subworksheet associated 
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with a client file. The View Tabs Bottom command allows you to display these 
tabs immediately beneath the workspace. 
You can click a worksheet tab to bring focus to that worksheet. This allows you 
to quickly move from one open worksheet to another. The tabs appear in the 
order the worksheets are added.

You can right-click a worksheet title to access a pop-up menu of commands, 
such as Open, Close, etc. For more information, see Worksheet List 
Commands on page 162.
By initial default, the View Tabs Top command is on. When one of these 
commands is on, a check mark appears next to the command on the Options 
menu. To hide the tabs, click the command to remove the check mark. 

VIEW WORKSHEET LIST LEFT/RIGHT
The View Worksheet List Left command allows you to display — at the left 
side of the program window — the Worksheet List, which is a comprehensive 
list of the worksheets and subworksheets available for the analysis. The View 
Worksheet List Right command allows you to display the Worksheet List at 
the right side of the program window.
You can double-click on a worksheet title in the list to add it to the current 
analysis or right-click a worksheet title to access a pop-up menu of commands, 
such as Open, Close, etc. For more information, see Worksheet List 
Commands on page 162.
By initial default, the View Worksheet List Left command is on. When one of 
these commands is on, a check mark appears next to the command on the 
Options menu. To hide the Worksheet List, click the command to remove the 
check mark.

VIEW WORKSHEET ROW NUMBERS
This command allows you to display the row numbers that correspond to each 
row title on each built-in worksheet. This feature helps you when reading the 
help file descriptions of certain worksheet rows that cite row numbers in the 
description.

When the View Worksheet Row Numbers command is on, a check mark 
appears next to the command on the Options menu. When you exit the 
program, the View Worksheet Row Numbers setting is retained as the 
default.
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10
10 Help Menu

HELP MENU
OVERVIEW

Selections on the Help menu provide access to the following help system 
commands:

Contents — opens a table of contents to the Help system, offering help 
selections for Menu Commands, Client Data Worksheets (including State 
Specifications worksheets), Troubleshooting, Customer Support, How to 
Use Help, What’s New, and Bloomberg Tax Technology License 
Agreement.
Search For Help On — opens the standard Windows Help Search dialog, 
which allows you to search for a specific topic using keywords and 
phrases.

Help For Current Row — accesses a context-sensitive help topic. When 
the cursor is on a worksheet cell, this command will retrieve a help topic 
that pertains to that specific row.
Operations Guide — opens the Operations Guide in your default web 
browser. The Operations Guide contains information about the user inter-
face for the program, and it provides instructions on using the program.

Tax Reference Guide — opens the Tax Reference Guide in your default 
web browser. The guide contains information about the program’s tax 
calculations.
Tutorial — opens the tutorial web page in your default web browser
Merge Conflict Log — Displays the log that details any issues that arose 
during a merge.

Web Update <<desktop program edition only>> — automatically looks 
on the Bloomberg Tax Technology Updates Web site for program updates. 



266

::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::

Offers you to the option to automatically check for program updates or to 
manually check for update. Also offers you the option to have the most 
recent updates downloaded and installed automatically.
Contact Support Team — Opens your default Internet browser and 
displays the Bloomberg Tax Technology Customer Support Web page, 
where you search frequently asked questions and find contact information 
for Bloomberg Tax Technology.

About Income Tax Planner — displays information specific to the 
program and your setup, including the program version, copyright, and 
license information, as well as system information such as whether a math 
co-processor is present on your PC and the amount of free memory.

USING THE HELP SYSTEM
The program’s help system uses the same methodology as the help system of 
other Microsoft Windows programs. You can search for a help topic using a 
variety of methods: either the context-sensitive Help command or the 
Contents command or the Search For Help On command.

USING THE HELP COMMANDS

CONTENTS AND SEARCH COMMANDS
These commands operate in the same manner as the same commands in 
other Windows’ help systems.
To access the help system’s table of contents, select the Contents command 
from the Help menu.
To use the help system’s search feature, select the Search For Help On 
command from the Help menu.

For additional information, see your Windows documentation.

HELP FOR CURRENT ROW COMMAND
The Help For Current Row command allows you to access context-sensitive 
help. That is, when you select this command from the Help menu or press F1, 
the help window will open and a help topic that addresses that row will be 
displayed.

TAX REFERENCE GUIDE COMMAND
The Tax Reference Guide command opens the latest version of the Tax 
Reference Guide in your default web browser. The guide contains information 
about the program’s tax calculations.
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OPERATIONS GUIDE COMMAND
The Operations Guide command opens the latest version of the Operations 
Guide in your default web browser. The guide contains information about the 
user interface for the program, and it provides instructions on using the 
program.

TUTORIAL COMMAND 
The Tutorial command opens your default web browser and displays the 
Income Tax Planner Tutorials page on the Bloomberg Tax Technology 
website. On that page, you have access to several tutorials aimed at helping 
you get familiar with the program and creating client analyses.

MERGE CONFLICT LOG COMMAND
The program produces a Merge Conflict Log when data from two files cannot 
be cleanly Merged. Data for the most recent merge is listed at the end of the 
log.

Data will not be merged if the worksheet row specified in the merge file has an 
active built-in worksheet from the same row in the open analysis. Data will also 
not be merged if the row specified in the merge file would activate a worksheet 
in the open file and subsequently overwrite entries on access rows to this 
worksheet. The Merge Conflict Log can be reopened at any time from the Help 
menu and allows copy-and-paste capabilities, to assist you with finalizing the 
merge.
See “Merge Client File” for more information about merging files.

WEB UPDATE COMMAND
<<desktop program edition only>>
The Web Update command automatically locates and installs updates to the 
program via the Internet. The command allows you to have the program look 
for program updates at a frequency of your choosing (upon program startup, 
every day, every week, every month, or never). You also have the ability to 
check for a program update immediately.

Note. This feature requires that Microsoft Internet Explorer 3.0 or later be 
installed (which should be the case on most Windows systems) and that an 
active Internet connection be available.

When you invoke this command, the program connects to Bloomberg Tax 
Technology’s Web Update site and checks to see if an update to the program 
is available.
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If an update is available, the program displays a message that includes the 
size of the update, some information about the update, and offers you the 
option to download the update.
If you elect to download the update, the program downloads the file, shuts 
down, installs the update, then automatically restarts. (The update installation 
is installed in the same manner as a normal program installation — when 
prompted, click Yes at the License Agreement panel or the update installation 
will terminate.) If you have a client file open when you elect the download, the 
program offers you a chance to save the file.

This dialog also contains information about the last time the program searched 
for an update and the original program version.

Note. <<Network versions only>> Only the network administrator running 
the program in admin mode can download and install the update. The program 
informs client users that invoke this command if there is an update available 
and instructs them to have the network administrator download and install it.

CONTACT SUPPORT TEAM COMMAND
The Contact Support Team command opens your default Internet browser 
and displays the Bloomberg Tax Technology Customer Support Web page, 
where you search frequently asked questions and find contact information for 
Bloomberg Tax Technology.

ABOUT INCOME TAX PLANNER COMMAND
Opens a dialog that displays the current version of the program, your access 
code, and copyright information. The dialog also contains a button that allows 
you to see your system information.

ACCESSING CONTEXT-SENSITIVE HELP
To access context-sensitive help, while the cursor is on the item for which you 
want help, select the Help For Current Row command from the Help menu 
(for worksheet rows only), or press F1, or click the Help button (for dialogs 
only).
When accessing help for a worksheet row, the help topic that appears contains 
the help topics for all input rows on the worksheet; the topic for the row where 
your cursor currently rests will be at the top of the window. Use the scroll bar or 
the arrow keys to browse through the topics for the other rows of the 
worksheet.

When accessing help for a menu, a command, or a dialog, the help topic that 
appears contains a help topic addressing that item. The topic frequently 
contains underlined keywords that allow you to jump to other related topics.
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A SAMPLE SEARCH FOR HELP
This section describes a sample help topic search session. When you first 
invoke the Search command, the following Help Topics dialog opens to the 
Search tab:

Click the Index tab. Begin to type the word “alternative.” As you type, the list 
beneath the text box (which contains keywords) jumps to the next keyword that 
matches the string of letters you’ve typed:

dHelpIndex.p
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If there are no keywords matching your entry, the keyword list will highlight the 
keyword text that most closely matches your entry.
When you type the letter “i”, the “Alternative capital gains calculation, in 
general” keyword will be highlighted. You can also use the mouse, the arrow 
keys, and the scroll bar to review the keywords. When you find the keyword 
that you’re searching for, highlight it and click the Display button. Or you can 
double-click the keyword to bring topic titles up in the Topics Found dialog.

For this example, select alternative minimum tax and then click the Display 
button. The help system then displays in the Topics Found dialog all topic 
titles that are indexed to your keyword selection. 

 

dHelpIndexb.png

dHelpIndexc.p
ng
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Note. All the topics listed for tax-related keywords or subjects (that is, all topics 
that discuss non-operational issues) are worksheet titles. The Topics Found 
dialog will list a worksheet title more than once if the same keyword is assigned 
to different rows on a worksheet (and therefore to different areas in a help 
topic). To see all the areas on a worksheet topic to which a particular search 
keyword relates, select each occurrence of that worksheet title in the Topics 
Found dialog.

To select a help topic from the Topics Found list, double-click the topic title or 
highlight it and then select the Display button. Now select Investment Inter-
est — Alt Min Worksheet and click Display.
A help topic similar to the following will appear:

 

As the illustration shows, the topic for the keyword that you specified is at the 
top of the help window, immediately beneath the non-scrolling worksheet title 
area. The scroll bar illustrates that there are additional row topics available for 
your review above and below the current row’s topic. The underlined text 
indicates that you can click this area to jump to a related help topic.
For help topics dealing with worksheets, you will find green jump text in the 
yellow nonscrolling area at the top of the help window. When you click the jump 
(you can click the button or the text) on the left, a help topic that gives a general 
description of the worksheet will appear. When you click the jump on the right, 
the help system will close and the client data worksheet addressed in that help 
topic will open in the program window.

HelpTopic.pn

Click this text to jump 
to a related topic

Click here to jump to a general 
description of this worksheet

Click here to close Help 
and open the worksheet
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HELP MENU BAR AND COMMANDS
The program’s help system offers many of the standard Windows Help system 
buttons allowing you to access many of the standard features for moving 
through the help topics, including:

Hide/Show — toggles between Hide and Show. You can click Hide to 
hide the Contents/Index/Search tabs in the Help window. You can click 
Show to show the Contents/Index/Search tabs in the Help window. 
Back — returns the focus to the help topic that you accessed before the 
currently open help topic. The Back button returns the focus to the previ-
ous topic(s) in the order they were viewed.

Print — Opens the Print Topics dialog, allowing you to print the selected 
topic or print the selected heading and all subtopics.
Options — contains commands that allow you to customize the appear-
ance of the Help window, navigate through the help topics, print a topic, 
and turn Search Highlight on or off.

For additional information on these buttons and their features, refer to your 
Windows documentation or use the How to Use Help command on the Help 
menu’s Contents command.
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11
11 Printing

PRINTING
OVERVIEW

This chapter details the steps needed to handle all tasks related to printing 
within the program. We cover how to print your tax calculations in a report 
format and how to print client letters and graphs. You can send the results to a 
printer or a text, spreadsheet, or Adobe Acrobat file for later editing or viewing 
in a word-processing, spreadsheet, or Acrobat Reader program. You will learn 
how to preview your report before printing, set up page specifications, custom-
ize the look of the reports, and actually print your reports.
For additional information concerning each of the commands and options 
described below and available in Income Tax Planner, please refer to 
Chapter 3 or access the Help system.

HOW TO PREVIEW REPORTS
USING THE FILE MENU’S PRINT PREVIEW COMMAND

To review an analysis’ reports before printing, use the Print Preview feature as 
follows:

Select Print Preview on the File menu.

Or, click the Print Preview button  on the main program toolbar.
Or, select the Preview button on the Print dialog (accessed from the File 
menu).

Unless you previously suppressed it, a message appears informing you that 
there is a new Page Style feature. (See Changing the Page Style on page 
294 for details.) Click the Style button. To use the existing styles, click Cancel 
on the Page Style dialog.
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 A Print Preview window similar to the following will open.

If you have not previously selected worksheets to be printed, all active 
worksheets (including those automatically generated), plus the output 
Summary Report, will be included in the preview selection.
From here you can browse through the report pages (click Next or Previous), 
change the contents of the report, customize the report’s appearance, or print 
the report.

USING THE PRINT DIALOG’S PREVIEW BUTTON
You can also access Print Preview though the Print dialog. To open the Print 
dialog:

1. From other worksheets, select the Print command on the File menu.

PrintPreview
SummaryRe
port.png
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Or click the Print button  on the main program toolbar, or, if the 
Worksheet List is open, right-click on a worksheet title, then select Print.
Or, from the Security Transaction Analyzer, select the Print command 
on the Analyzer’s menu bar.

The Print dialog appears:

2. Click the Preview button. The Print Preview window opens.

SELECTING WORKSHEETS TO PREVIEW
To specify the worksheets you want to preview or print from the Print dialog:
In the Worksheet Range box, there are three separate radio buttons to choose 
from: Current Worksheet, All Active Worksheets, and Selected 
Worksheets. See Worksheet Range on page 89 for detailed information 
about the three selections.
If you choose All Active Worksheets or Selected Worksheets, you can 
change the icons on the Worksheet List.

If the Worksheet List is not visible, click the Show Worksheet List button to 
the right of the Selected Worksheets radio button. (If the Worksheet List is 
already visible, this button is called Hide Worksheet List.) Not only does this 
display the Worksheet List, it also change your Worksheet Range selection to 
Selected Worksheets.

Note. The Selected Worksheets button is replaced by the Analyzer Setup 
button when you access the Print Preview window through the Security 
Transaction Analyzer.

Print

dPrint.png
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The printer icon to the left of each worksheet title is full-color, dark gray, or light 
gray. Click a printer icon next to a worksheet, graph, form, or client letter to 
change the item’s printing status. Only the items with full-color icons will print. 
See the table included in Using the Worksheet List on page 161. 

The ability to easily select or de-select an item for printing can be immensely 
helpful. For instance:

To include a worksheet in the preview group, click the worksheet’s printer 
icon.
To select the client letter, click the printer icon to the left of the Client Letter.

To select a custom worksheet or empty worksheet, click the worksheet’s 
printer icon. If custom worksheets or empty worksheets are not selected for 
printing, the program informs you of this and asks if you’d like to print the 
selected type of worksheets.
To select the 1040-ES voucher, click the printer icon to the left of the 1040-
ES Payment Voucher’s name.

To print the graph before the worksheets, click its printer icon once. To print 
it after the worksheets, click it a second time (the graph’s printing location 
changes in response to your clicks).
Remember that you can select all active worksheets by clicking either the 
Select All Active button or the All Active Worksheets radio button.
To remove a worksheet from the preview group, click the worksheet’s 
printer icon.

To always print the worksheets selected in the list and save the other selected 
settings, click the Save as Default button on the Print dialog. Likewise, to 
restore a previous default setting, click the Restore Default button.
After completing your selections, click Preview on the Print dialog. The Print 
Preview window appears.

WorksheetsToPrint.png

Full color 
icon

Dark gray 
icon

Light gray 
icon

To get image:
1. Open the Sample.it file.
2. Click the Print button.
3. On the Print dialog, click Setup.
4. Deselect Custom Worksheets.
Image is also under the heading Selected 
Worksheets on page 286.
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Note. The selections you make when previewing worksheets are the same as 
those selected for printing the report. Therefore, if you make changes to the 
selected worksheets for print purposes, the worksheets selected for preview 
purposes in the Worksheet List also change. Likewise, when the Print Preview 
window is open, you may print the worksheets by clicking Print on the toolbar.

For additional information on the Worksheet List, see Using the Worksheet 
List on page 161.

BROWSING THROUGH THE PREVIEW REPORTS
To preview the analysis’ reports:

Click Next to go to the next page in the report.
Click Previous to go to the previous page in the report.

The program displays the current page number and the total number of pages 
in the report at the bottom of the Print Preview window.

TAKING A CLOSER LOOK: ZOOM IN/OUT
When you first open the Print Preview window, you will find that the entire first 
page of the report is displayed in the workspace. Depending upon the size and 
style of the printer font, you may only be able to get a general idea of the 
report’s appearance and may not be able to actually read the items on the 
report.
To take a close-up view of a portion of a page, click the Zoom In button. Two 
things happen: the report increases in size and should be legible and the 
Zoom In  button toggles to Zoom Out .

If the program window is maximized (that is, it takes up the full screen), then 
the entire width of the report should be visible, but you will not be able to see 
the bottom of the page.
If you re-sized the program window and it takes up less than the full screen, 
only the top center portion of the report will be visible. To return to the smaller 
image, click the Zoom Out button.

LEAVING THE PREVIEW WINDOW
After previewing the reports, you can return to the analysis, change the 
contents of the reports, revise the reports’ appearance, or print the reports.

To leave Print Preview and return to the analysis, select Close. 
To change the contents:

If the Worksheet List is not visible, click the Show List button to 
display the Worksheet List. Click printer icons to the left of worksheets 
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to instantly add or delete them from the Print Preview window. See 
Selecting Worksheets to Preview on page 275.
Or, click Setup to add or delete the table of contents or an index. See 
Including a Table or Index with the Printed Reports on page 302.

Or, for the Security Transaction Analyzer, click the Analyzer Setup 
button to specify the years included on the report, as well as other 
changes. See Customizing the Security Transaction Analyzer 
Results on page 306.

To revise the report’s appearance, select Setup, then select Filename or 
Underlines in the Print box, or click the Font, Margins, Columns, 
Header & Footer, or Style button. See How to Customize the Printed 
Reports on page 291.
To print the reports, select the Print button. The Print dialog opens. See 
How to Send Reports to a Printer on page 278.

HOW TO SEND REPORTS TO A PRINTER
To send reports to a printer for printing:

Verify that your printer is online.

If you have multiple printers, verify that you are connected to the correct 
printer. For more information, see Selecting a Different Printer on page 
280.

Note. Before proceeding, you may want to preview the reports to ensure 
that the settings for the font, margins, headers, footers, and other page 
setup options are satisfactory. See How to Preview Reports on page 273 
and How to Customize the Printed Reports on page 291.

ACCESSING THE PRINT DIALOG
Printing is done from the Print dialog, accessed in the following ways:

Click the Print button  on the main program toolbar.
Select Print on the File menu.
In the Worksheet List, right-click on a worksheet title. Select Print on the 
shortcut menu.

Select Print on the Print Preview window (accessed from the File menu).
Select Print on the Security Transaction Analyzer’s menu bar. 

1. Open the Print dialog using one of the methods listed above.
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2. Choose one of the three Worksheet Range options described below.

Note. When you select an option and then execute the Print command, 
the option remains selected for this client file until you select a different 
option.

To print only the current worksheet:
1. Select the Current Worksheet radio button. (This is the default setting.)
2. Click Print and the worksheet will print.

Note. If you selected Custom Worksheets on the Page Setup dialog, any 
custom worksheets associated with the current worksheet will also print.

To print only the active worksheets:
1. Select the All Active Worksheets radio button. (This option is disabled 

when you access the Print dialog from the Security Transaction 
Analyzer.)

2. Click Print and the worksheets will print. 

Note. If you selected Custom Worksheets on the Page Setup dialog, any 
custom worksheets associated with the current worksheet will also print.

To print several different worksheets:
1. Select the Selected Worksheets radio button. (This option is disabled 

when you access the Print dialog from the Security Transaction 
Analyzer.)

2. If you have not yet selected worksheets to print (using either the Print 
Preview or the Print commands), ensure that the Worksheet List is open. 
If it is not visible, click the Show Worksheet List button. (This button 
toggles to Hide Worksheet List when the Worksheet List is visible).

dPrint.png
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3. On the Worksheet List, worksheets that are selected for printing have a full 
color printer icon to the left of the worksheet title. Instructions concerning 
selecting worksheets in this pane are detailed in Selecting Worksheets to 
Preview on page 275.

4. After selecting the worksheet(s) you want to print, click the Print button. 
The program sends your selected worksheets to the printer.

While the report is printing, a message appears displaying the number of the 
pages currently being printed as well as a Cancel button, which you can use to 
stop sending pages to the printer.

SELECTING MULTIPLE COPIES
The program defaults to printing one copy of the reports when you send the 
reports to the printer.

To print multiple copies:
1. From the Print dialog, click the Copies list box.

2. Specify the number of copies to print:
a. Select any number from 1 to 10 from the list, or
b. Enter any number from 1 to 99.

Note. The number of copies is reset to 1 after you print the reports.

SELECTING A DIFFERENT PRINTER
The program sends the reports to the default printer (selected through 
Windows’ Print Manager or other print management program) for printing.
If you want to print the reports on a different printer:
1. Select the Printer button on the Print dialog. (For instructions on opening 

this dialog, see Accessing the Print Dialog on page 278.) A dialog similar 
to the following will appear (the actual printer information will differ, based 
on your printer configuration):

dPrintCopies.png
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This is the same Print Setup dialog used for other Windows programs.

2. In the Printer Name field, select a printer from the list box.
3. If desired, you may change paper orientation, paper size and source, or 

other printer options at this time.
4. Click OK.

Changing the printer selection for the program will change your default printer 
for all Windows programs that use this Printer Setup dialog. Conversely, 
changing your default printer selection in another Windows program may reset 
the default printer for Income Tax Planner. Refer to your Windows documen-
tation for more information.

HOW TO CREATE OUTPUT FILES FROM 
REPORT DATA

You can send the output from the analysis to an editable file rather than to a 
printer. The program can create four different types of output files:

Text (ASCII) file
Excel file
Lotus 1-2-3 file

Adobe Acrobat file

CREATING A TEXT FILE THAT YOU CAN EDIT
To send your report to a text file for later editing and/or printing through a text-
editing or word-processing program:
1. Click the Text File radio button on the Print dialog. Then click Print. The 

Print To Text File As dialog appears:

dPrintSetup.png
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2. As a default, in the File name field the program will display the name of the 
file currently loaded and will assign the default extension .itp (e.g., 
jones.itp).

You can change this default name and use any extension you choose 
(except .it, .itl, and .itb). If you specify the name of a file that already 
exists, as a precaution the program issues a message asking whether you 
want to overwrite the existing file.
When the File name field contains the name you want, click Save. As it 
prints to the file, the program displays the page number of the page being 
printed in the title bar.

When finished, the Print dialog closes, returning the focus to the previous 
worksheet.

CREATING AN EXCEL FILE
To send your report to an Excel file for later editing and/or printing through 
Excel:
1. Click the Excel File radio button on the Print dialog. Then click Print. The 

Print To Excel File As dialog appears:

dPrintToTextFileAs.png

Different versions of 
Windows may cause 
these buttons to vary.

dPrintToExcelFileA
s.png

Different versions of 
Windows may cause 
these buttons to vary.
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2. As a default, in the File name field the program will display the name of the 
file currently loaded and will assign the default extension .txt (e.g., 
jones2.txt).
You can change this default name and use any extension you choose 
(except .it, .itl, and .itb). If you specify the name of a file that already 
exists, as a precaution the program issues a message asking whether you 
want to overwrite the existing file.

When the File name field contains the name you want, click Save. As it 
prints to the file, the program displays the page number of the page being 
printed in the title bar.

When finished, the Print dialog closes, returning the focus to the previous 
worksheet.

LOADING FILES INTO EXCEL
To load the resulting file into an Excel spreadsheet, place the cursor on your 
Excel spreadsheet where you want the Income Tax Planner data to appear. 
(These instructions are based on Excel 97 and Excel 2000.) Select Open on 
the File menu, change the Files of type to Text Files, select the file, then click 
Open. The Text Import Wizard appears. Specify Delimited for the Original 
Data Type, as well as the row on which you want the import to start. Click Next. 
Specify Tab as the Delimiters, then click Next. Specify General for the 
Column Data Format, then click Finish. Income Tax Planner data will appear 
in their respective cells. Select the entire worksheet. Then select Column, then 
AutoFit Selection on the Format menu to reset the column width of the 
columns to allow room for the row captions. Existing data in the Excel 
worksheet may be overwritten, so be sure to leave room for as many 
worksheets as you printed to the text data file.

CREATING A LOTUS 1-2-3 FILE
To send your report to a Lotus 1-2-3 file for later editing and/or printing through 
Lotus 1-2-3:
1. Click the Lotus 1-2-3 File radio button on the Print dialog. Then, click 

Print. The Print To Lotus 1-2-3 File As dialog appears:
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2. As a default, in the File name field the program will display the name of the 
file currently loaded and will assign the default extension .prn (e.g., 
jones2.prn). You can change this default name and use any extension you 
choose (except .it, .itl, and .itb). If you specify the name of a file that 
already exists, the program issues a message asking whether you want to 
overwrite the existing file.

When the File name field contains the name you want, click Save. As it 
prints to the file, the program displays in the title bar the page number 
being printed.

When finished, the Print dialog closes, returning the focus to the previous 
worksheet. 

LOADING FILES INTO LOTUS 1-2-3
To load the resulting file into a Lotus 1-2-3 (Windows) worksheet, place the 
cursor on your Lotus spreadsheet where you want Income Tax Planner data 
to appear. Select Open on the File menu, select the file, then click OK. Income 
Tax Planner data will appear in their respective cells. Then select Column 
Width on the Style menu to reset the column width of the first column (which 
is based on the number of characters) to allow room for the row captions. Key 
in the appropriate value and click OK. Existing data in the Lotus worksheet may 
be overwritten, so be sure to leave room for as many worksheets as you 
printed to the text data file.

CREATING AN ADOBE ACROBAT FILE
To send your report to an Adobe Acrobat file for easy e-mailing, or later viewing 
or printing through Adobe Acrobat Reader:
1. Click the Adobe Acrobat File radio button on the Print dialog, then click 

Print. The Print To Adobe Acrobat File As dialog appears:

dPrintToLotus123
FileAs.png

Different versions of 
Windows may cause 
these buttons to vary.
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2. As a default, in the File name field the program will display the name of the 
file currently loaded and will assign the default extension .pdf (e.g., 
jones2.pdf). You can change this default name and use any extension you 
choose (except .it, .itl, and .itb). If you specify the name of a file that 
already exists, the program issues a message asking whether you want to 
overwrite the existing file.

When the File name field contains the name you want, click Save. As it 
prints to the file, the program displays in the title bar the page number 
being printed.

When finished, the Print dialog closes, returning the focus to the previous 
worksheet.

SELECTING WHAT TO PRINT
PRINTING SPECIFIC REPORTS

Use the Worksheet Range section of the Print dialog to choose your 
worksheet selections. For details on opening this dialog, see Accessing the 
Print Dialog on page 278. For more detailed information about these selec-
tions, see Worksheet Range on page 89.

CURRENT WORKSHEET
When you first enter the Print dialog for a new analysis, the current worksheet 
is selected for printing. To print this worksheet, click the Print button.

dPrintToAdobeAcr
obatFileAs.png

Different versions of 
Windows may cause 
these buttons to vary.

dPrintWorksheetRange.png
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ALL ACTIVE WORKSHEETS
To print all active worksheets, click the Print button.

SELECTED WORKSHEETS
Click the Selected Worksheets radio button to print selected worksheets. This 
selection activates the Select All Active and Deselect All buttons. These 
worksheets are all active worksheets or worksheets selected for printing.
To change the worksheet selection, the Worksheet List should be open. If it is 
not, click the Show Worksheet List button on the Print dialog. (If the 
Worksheet List is already visible, this button is the Hide Worksheet List.) Not 
only does this display the Worksheet List, it also changes your Worksheet 
Range selection to Selected Worksheets.

Note. The Selected Worksheets button is replaced by the Analyzer Setup 
button when you access the Print Preview window through the Security 
Transaction Analyzer.

The printer icon to the left of each worksheet title is full-color, dark gray, or light 
gray. A full-color printer indicates that a worksheet is selected for printing. A 
light or dark gray printer indicates that a worksheet is not selected for printing. 
See the table included in Using the Worksheet List on page 161. Click a 
printer icon next to a worksheet, graph, form, or client letter to change the 
item’s printing status. Only full-color icons are selected to print. If the 
Worksheet List is open, you can easily select or deselect worksheets for 
printing by clicking the printer icon to the left of a worksheet’s title.
Click the printer icons next to the names of all the worksheets that you want 
printed in the report. The program highlights the worksheets you select.

WORKSHEET SELECTION BUTTONS
Buttons on the Print dialog allow you to make fast changes to the worksheets 
selected for printing:

WorksheetsToPrint.png

Full color 
icon

Dark gray 
icon

Light gray 
icon

To get image:
1. Open the Sample.it file.
2. Click the Print button.
3. On the Print dialog, click Setup.
4. Deselect Custom Worksheets.
Image is also under the heading Selecting 
Worksheets to Preview on page 275.
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To quickly select all active worksheets, click the Select All Active button on the 
Print dialog. (This button is active only when Selected Worksheets is active.) 
You can add or remove worksheets selected for printing by clicking on a 
worksheet’s printer icon on the Worksheet List.
To quickly deselect all worksheets, click the Deselect All button on the Print 
dialog. (This button is active only when Selected Worksheets is active.) You 
can add or remove worksheets selected for printing by clicking on a 
worksheet’s printer icon on the Worksheet List.

To always print the worksheets selected in the list and save the other selected 
settings, click the Save as Default button on the Print dialog. (This button is 
not active when Current Worksheet is the print selection.)
Likewise, to restore a previous default setting, click the Restore Default 
button. (This button is not active when Current Worksheet is the print 
selection.)
For additional information about these option, see Selected Worksheets on 
page 90.

After completing your selections, either select or deselect additional 
worksheets for printing (by clicking on worksheets’ printer icons on the 
Worksheet List) or click the Print button on the Print dialog. Depending on the 
output selection you chose in the Print To field on the Print dialog, either the 
report prints or you are prompted to save the report in a particular format. For 
more information, see How to Send Reports to a Printer on page 278.

Note. The program will “remember” the worksheets you select to print, so that 
the next time you print or preview the reports, these worksheets will be “pre-
selected.” When you save the client file, the program saves the current 
worksheet selections with the file. 

Note. The selections you make when printing worksheets are the same as 
those selected for previewing the report. Therefore, if you make changes to the 
selected worksheets for preview purposes, the worksheets selected for print 
purposes in the Worksheet List also change. Likewise, when the Print dialog is 
open, you may preview the worksheets by clicking Preview on the dialog.

PRINTING SPECIFIC COLUMNS OF THE ANALYSIS
As a default, the program automatically prints all columns of the analysis. You 
have the option to exclude certain columns from the printed report. This feature 
can be accessed from the Page Setup dialog.

ACCESSING THE PAGE SETUP DIALOG 
You can open the Page Setup dialog in any of three ways:
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Select Page Setup on the File menu.
Click Setup on the Print Preview window toolbar.

Click Setup on the Print dialog (accessed from the File menu or the 
Print button on the main toolbar).

The Page Setup dialog appears:

To select specific columns for the printed report:
1. Click the Columns button. The Print Columns dialog opens.

The first time you open this dialog, the program pre-selects for printing all 
columns present in the analysis (selected columns have a check mark in 
the check box). 

2. To exclude a column from the printed reports, click the column. (When the 
cursor is on the column, the column item has a box around it. See “Case 1” 
in the above illustration.) The program will clear the check box.

3. To include a column in the analysis that had been excluded from print, click 
the column item. The program will place a check mark in the check box.

4. When only the columns you want to print are selected, click OK. The Print 
Columns dialog closes, returning the focus to the Page Setup dialog.

dPageSetup.png

dPrintColumns.png
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To cancel all changes made since you entered the Print Columns dialog 
and return to the Page Setup dialog, click Cancel.

To print the reports, click the Print button on the Print dialog. See How to 
Send Reports to a Printer on page 278.

Note. For information about hiding columns during an analysis and printing, 
see Hide Columns Command on page 119.

Note. If you hid columns and saved your file, the program retains your selec-
tions in the Print Columns dialog. The next time you open the client file, all 
columns will again be hidden.

PRINTING ALL COLUMNS WITHIN THE ANALYSIS
As a default, the program prints all columns within an analysis. Every time you 
open a client file, the program resets the column selection so that all columns 
are selected.
If you had previously excluded columns from printing and now want to print all 
columns:

1. Open the Page Setup dialog. For more information, see Printing Specific 
Columns of the Analysis on page 287.

2. Click the Columns button. The Print Columns dialog opens.
3. Click on each column item that has an empty check box. The program 

places a checkmark in the check box.

4. Click OK. The focus returns to the Page Setup dialog.
To print the reports, click the Print button in the Print dialog. For more 
information, see How to Send Reports to a Printer on page 278.

PRINTING OR PREVIEWING THE CLIENT LETTER AND 
GRAPH

The client letter and graph can be selected in a similar manner as program 
worksheets. When the Worksheet List is visible, check the printer icon to the 
left of the item’s name to determine whether the item is selected for printing or 
previewing. If the item is active, you may select or deselect it for printing or 
previewing. See Selecting Worksheets to Preview on page 275 and Select-
ing What to Print on page 285 for additional information.
The client letter and graph can be previewed and printed. They can also be 
saved in Adobe Acrobat format, but not in Lotus 1-2-3 or Microsoft Excel. For 
specific information about printing each of these items, please see Printing a 
Client Letter on page 230 and Printing Graphs on page 204
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PRINTING 1040–ES/1041–ES PAYMENT VOUCHERS
To print the 1040–ES/1041–ES Payment Vouchers, you must first have 
completed items on the 1040-ES Data dialog (accessed from the Worksheets 
menu). See 1040-ES and 1041-ES Payment Vouchers on page 189 for 
information about completing the dialog. Once you have supplied the informa-
tion needed to prepare the vouchers, you can print the vouchers.
To print the 1040–ES Payment Vouchers with other worksheets, make sure its 
printer icon is active (full color) on the Worksheet List. It cannot be saved in 
text, Adobe Acrobat, Lotus 1-2-3, or Excel file formats.
To print the 1040–ES Payment Vouchers when they have the focus:

1. Select Print from the File menu or click the print button on the program 
toolbar. The Print dialog appears:
The 1040–ES Payment Vouchers are selected as the Current 
Worksheet in the Worksheet Range box.

2. In the Print To box, select either Printer (the default) or Adobe Acrobat 
File. Click Print to send the 1040–ES payment vouchers to the printer or 
open the Print To Adobe Acrobat File As dialog (see Creating an Adobe 
Acrobat File on page 284).

For more information on the 1040–ES Payment Vouchers feature, see 
Chapter 7.

PRINTING THE SECURITY TRANSACTION ANALYZER
To print the Security Transaction Analyzer, you must first have completed 
items on the Security Transaction Analyzer worksheet (accessed from the 
Worksheets menu). See Security Transaction Analyzer Worksheet on page 
180 for information about completing the worksheet. Once you have supplied 
the information needed, you can print the worksheet.

To print the Security Transaction Analyzer with other worksheets, make sure 
its printer icon is active (full color) on the Worksheet List (next to Security 
Transactions). It can be printed or saved in text, Lotus 1-2-3, Excel, or Adobe 
Acrobat format with other worksheets and items.
To print the Security Transaction Analyzer when its window has the focus:
1. Select Print from the menu bar. The following Print dialog appears:

The Security Transaction Analyzer is selected as the Current 
Worksheet in the Worksheet Range box.

2. Select the output format in the Print To box. If you select a file format, see 
How to Create Output Files from Report Data on page 281.
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3. Click Print. The Security Transaction Analyzer will print or the appropri-
ate Save To dialog will open.

Note. The report may not fit properly in portrait mode. You may want to 
change the page orientation in your printer setup to landscape before 
printing the Security Transaction Analyzer report. If the orientation is 
portrait and not all of the columns will fit on a page, the program will print 
the remaining columns on a new page.

For more information on the Security Transaction Analyzer feature, see 
Chapter 7.

HOW TO CUSTOMIZE THE PRINTED REPORTS
As the initial default, the program automatically includes the following items on 
the printed reports:

Client Name

Current Date and Time
Page Number

Underlines
Notes
Multiple Worksheets per Page

All Columns in the Analysis
The program automatically excludes empty rows and worksheets from the 
printed reports. The program also prepares a Table of Contents and an Index 
as references to worksheets within the printed reports.
You can change these defaults for a particular analysis or for all new analyses 
as detailed below. You can also add or change the following items to further 
customize your printed reports:

Add the filename
Change the font
Change the margins

Exclude columns
Add or edit the header and/or footer
Shade and/or add a frame (or border) around column headings, row 
captions, case/year columns, and/or key rows

Bold column headings, calculated rows, and /or worksheet titles
Increase (or change) the size of the worksheet titles
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Add a bold line that separates worksheet titles from worksheet column 
headings and rows

INCLUDING THE CLIENT’S NAME ON THE REPORT
The program automatically prints the Client Name entered on the Assump-
tions dialog or the Header & Footer Lines dialog. Entering the client name in 
one of these dialogs changes the entry on the other dialog.

Note. Enter the name exactly as you want it printed. For example, if you want 
the name printed in all capital letters on the reports you must enter the name 
using all uppercase letters in the text box. 

To enter the Client Name from the Assumptions dialog:
1. Click Assumptions in the menu bar. The Assumptions dialog opens.
2. Enter the desired name in the Client Name field.

3. Select OK to accept your entry. The focus returns to the previous 
worksheet.

To enter the Client Name on the Header & Footer Lines dialog:

1. Click Page Setup on the File menu. The Page Setup dialog opens.
2. Click the Header & Footer button. The Header & Footer Lines dialog 

opens.
3. Enter the desired name in the Client Name field.

4. Click OK to accept your entry. The focus returns to the Page Setup dialog.
5. Click OK. The focus returns to the previous worksheet.
The client name will print above any header lines.

INCLUDING HEADERS OR FOOTERS
To include headers and/or footers on the printed report, you must enter them in 
the Header & Footer Lines dialog. The program will print up to three lines (80 
characters each) of header and footer text. While you can save default header 
and footer text to be used on all new analyses, until you do so, the default 
headers and footers are blank.

ACCESSING THE HEADER & FOOTER LINES DIALOG
There are three ways to access the Header & Footer Lines dialog:

Click Page Setup on the File menu. Then, click the Header/Footer button 
on the Page Setup dialog. Or,
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Click Print Preview on the File menu. Click Setup in the Print Preview 
button bar. Then, on the Page Setup dialog, click the Header/Footer 
button. Or,
Click Print on the File menu. Click the Setup button in the Print dialog. 
Click the Header/Footer button.

The Header & Footer dialog opens and the cursor will be in the Client Name 
field:

To enter the Header or Footer Lines:
1. Press Enter, Tab, or the down arrow key to bypass the client’s name on the 

first line and move the cursor to the first Header Line.
2. Enter up to three lines of header text and three lines of footer text. At the 

end of each line of text, press Enter, Tab, or the down arrow key to move 
to the next line. (To leave a line blank, simply click the next line you want to 
change.)

Note. To jump quickly to the beginning of the text line, press Home. To 
jump quickly to the end of the line, press End.

3. After entering the headers and footers, click OK to return to the Page 
Setup dialog.

The Header and Footer settings are saved with the client file.

Note. The Headers and Footers text that you entered will print on all report 
pages for the client until you change it, load a new client data file, clear 
worksheets to begin a new case, or quit the program.

For information on saving default headers and footers, see Headers and 
Footers on page 309.

dHeaders&Foote
rLines.png
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ADDING THE DEFAULT HEADERS/FOOTERS TO BRIDGE 
FILES

For analyses created within the program, headers and footers are saved and 
stored with the client file. Bridge files (ASCII files created using a program 
other than Income Tax Planner, such as a tax preparation program, for the 
purpose of bringing information into Income Tax Planner for analysis) do not 
contain the headers/footers when loaded into Income Tax Planner.
The Use default header/footer if no other header/footer option on the Page 
Setup dialog adds the default header/footer to the client file. When this option 
is selected, the default header/footer will print on all pages.

To select the Use default header/footer option:
1. Open the Page Setup dialog (from the File menu, the Print Preview 

window or the Print dialog).
2. Click Use default header/footer if no other header/footer.
3. To save the current Page Setup settings for future analyses, click Save as 

Default. The Page Setup dialog closes. 
Or, click OK to accept your changes and close the Page Setup dialog.

When this option is selected, the program adds the default header/footer to all 
client files that you open subsequently if they do not include header/footer 
information.

If this option is not selected, the program will only print headers and footers for 
a bridge file if you enter them in the Header & Footer Lines dialog.

CHANGING THE PAGE STYLE
As an initial default, the program includes no special formatting in the printed 
reports, that is, all text on the report page use the same plain font (see 
Selecting a Font for the Printed Reports on page 304 for changing the report 
font). You can change this default for a particular analysis or for all new 
analyses using page style settings as described below. You can choose from 
five preset styles or customize your own style and save it as your default.

ACCESSING THE PAGE STYLE DIALOG
To access the Page Style dialog:
1. Select Page Setup from the File menu. The Page Setup dialog appears.
2. Click the Style button. The Page Style dialog opens:
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The Page Style dialog allows you to specify the style (appearance) of the 
reports. This dialog contains a preview sample worksheet where you can see 
the effects of your style choices as you make them. 

ADDING BORDERS AND SHADING TO THE REPORT
As an initial default, the program include neither frames (borders) nor shading 
on the report. You can shade and/or add a frame around the following compo-
nents on a report:

Headings
Captions
Cases

Rows
To shade or add a frame to any of these components on the report:

1. Open the Page Setup dialog. See Accessing the Page Setup dialog on 
page 287.

2. Click the Style button to access the Page Style dialog.
3. Place a check mark in the box next to the Frame and/or Shade item(s), as 

desired, by clicking the item(s).

dPageStyle.png
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4. To save the change(s) as a revised default for new analyses, click the 
Save as Default button on the Page Style dialog.
Otherwise, click OK to accept your changes and close the dialog.

MAKING PARTS OF THE REPORT BOLD
As an initial default, none of the report components are bold. You can change 
the following components on a report to bold:

Headings
Calc Rows

Titles
To change any of these components on the report to bold:
1. Open the Page Setup dialog. See Accessing the Page Setup dialog on 

page 287.

2. Click the Style button to access the Page Style dialog.
3. Place a check mark in the box next to the Frame item(s), as desired, by 

clicking the item(s).

4. To save the change(s) as a revised default for new analyses, click the 
Save as Default button on the Page Style dialog.
Otherwise, click OK to accept your changes and close the dialog.

MAKING THE WORKSHEET TITLES STAND OUT
As an initial default, the worksheet titles have no special style; that is, the titles 
are not underlined, are not bold, and are normal size font. You can make the 
worksheet title stand out by selecting one of the following options on the Page 
Style dialog:

Bold Titles

StyleOptions.png

Select from 
these items

StyleOptions.
png

Select from these items
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Double Size Titles
Line Under Titles

To make the worksheet title stand out:
1. Open the Page Setup dialog. See Accessing the Page Setup dialog on 

page 287.
2. Click the Style button to access the Page Style dialog.

3. Place a check mark in the box next to the item(s) illustrated below, as 
desired, by clicking the item(s).

4. To save the change(s) as a revised default for new analyses, click the 
Save as Default button on the Page Style dialog.

Otherwise, click OK to accept your changes and close the dialog.

INCLUDING THE CURRENT DATE & TIME ON THE REPORT
If you select one of the preset styles on the Page Style dialog, the program 
includes the current date and time in the upper-left corner of each report page 
(except the client letter and 1040-ES payment vouchers), as shown below.

You can change this default for new analyses, or simply change the default to 
print:

the date and time in a different location on the reports, 

either the date or the time for a particular analysis, or
neither the date nor the time for a particular analysis.

To change the current handling of the Date and Time on the reports:

StyleOptions.pn
g

Select from 
these items

SummaryRep
ortPresetStyle.
png
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1. Open the Page Setup dialog. See Accessing the Page Setup dialog on 
page 287.

2. Click the Style button to access the Page Style dialog.

3. Change the Date and Time settings:
Click the Date or Time item to remove the check mark from a check 
box or to place a check mark in a check box.
If the Date or Time items are checked, you can click the Left, Center, 
or Right radio button, and the Top or Bottom radio button to specify 
the location of the date and time on the report.

4. To save the change(s) as a revised default for new analyses, click the 
Save as Default button on the Page Style dialog.
Otherwise, click OK to accept your changes and close this dialog.

PRINTING PAGE NUMBERS
As an initial default, the program includes the page number in the upper-right 
corner of each page (except the client letter and 1040–ES payment vouchers). 
You can change this default to not print the page numbers for a particular report 
or change the default for new analyses.

Note. Page Numbers must be selected if you want a Table of Contents or an 
Index printed with the report. See Including a Table or Index with the Printed 
Reports on page 302.

To change the current handling of the page numbering on the reports:
1. Open the Page Setup dialog. See Accessing the Page Setup dialog on 

page 287.

2. Click the Style button to access the Page Style dialog.
3. Change the Page Number settings:

Click the Page Numbers item to remove the check mark from the 
check box or to place a check mark in the check box.

If the Page Numbers item is checked, you can click the Left, Center, 
or Right radio button, and the Top or Bottom radio button to specify 
the location of the page numbers on the report.

4. To save the change(s) as a revised default for new analyses, click the 
Save as Default button on the Page Style dialog.

Date&Time.png

PageNumbers.png
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Otherwise, click OK to accept your changes and close this dialog.

CHANGING THE REPORT MARGINS
The program applies the margin settings to all printed worksheets, the graph, 
and the client letter. (The indent on the client letter is in addition to the 
margins.) The program provides a few methods to change the margins of the 
printed reports. You can:

specify the depth of the margins in the Margins dialog.
change the margins using margin handles in the Print Preview window.
use a combination of these two methods.

Note. Although the list boxes in the Margins dialog allow you to enter zero for 
a margin, the program will never allow the margin’s width to be less than what 
your selected printer allows. For instance, if your printer requires a minimum 
0.25 inch margin (that is, it won’t print in the first or last quarter-inch across the 
width and length of the page) while the margin settings may be 0, the actual 
margin would be 0.25 inch.

All items on the report, including the headers and footers, print in the page 
body bordered by the margins — nothing prints in the margin area itself.
Increasing the top margin will move the report down on the page. Conversely, 
increasing the bottom margin will move the footer lines up. The margins are 
taken into account when you print to a text file that may be later loaded into text 
editing or word processing programs.

USING THE MARGINS DIALOG TO SET MARGINS
To change the margins using the Margins dialog:
1. Select Margins on the Page Setup dialog (accessed from the File menu). 

The Margins dialog opens:

2. Click in a text box. The current entry will be highlighted. Then enter the 
desired margin setting in inches. (You can enter up to 5 digits in the box.)

dMargins.png
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Or, click the drop-down arrow button to open the list box and select one of 
the pre-set margin selections, which range from 0 to 2 inches in.25 
increments.
To increase the top margin of the first page of the client letter, enter the 
additional margin measurement in the Letter 1st Page Top field. You 
cannot enter a number less than the Top margin, above.

3. When the text boxes contain the settings that you want, click OK to accept 
your changes and close this dialog.

Note. If the settings you specify are too large in combination with the selected 
font, when you try to print or preview the reports the program will issue an error 
message stating that it cannot print with the current settings and asks that you 
adjust them.

USING MARGIN HANDLES TO SET MARGINS
Margin handles are vertical and horizontal bars terminated by solid black 
boxes. You can click on a bar and drag it across the report image to increase 
or decrease a margin.

To change the margins using margin handles:
1. Click Print Preview on the File menu. The Print Preview window opens.
2. Click the Margins button on the button bar. The image in the Print 

Preview window will change — margin handles are added to the report 
page:

3. Adjust the margins as desired:
a. To increase the top margin, click and drag the top horizontal margin 

handle down to the desired position (the arrow pointer changes to a 
double-pointed arrow when the cursor is positioned to select the 
margin handle). When you’ve placed the handle where you want it, 
release the left mouse button. The top margin will be re-sized 
immediately.

b. To increase the bottom margin, click and drag the bottom horizontal 
margin handle up to the desired position. When you’ve placed the 

Double-pointed 
cursor arrow
PrintPrewiewMarg
ins.png

Margin handle
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handle where you want it, release the left mouse button. The bottom 
margin will be re-sized immediately.

c. To increase the left or right margin, click and drag the left or right 
vertical margin handle toward the middle of the page image to the 
desired position. When you’ve placed the handle where you want it, 
release the left mouse button. The side margin will be re-sized 
immediately.

The following illustration shows margin handles on a page image, while the 
top margin handle is being dragged to increase the current top margin 
setting.

4. To see the results of your changes reflected on the displayed page without 
the handles, click the Margins button on the Print Preview window’s 
button bar. The margin handles will disappear.

METHODS FOR REVISING MARGINS
To revise the margins again:

Click the Margins button to bring up the margin handles.
a. Click and drag the margin handles as needed.
b. Click the Margins button to accept your changes.

Or,
Click the Setup button to open the Page Setup dialog.
a. Then click the Margins button to open the Margins dialog.

b. Adjust the numbers in the text boxes as needed.
c. Click OK to accept your changes.

Or,

Click the Margins button to bring up the margin handles.
a. Click and drag the margin handles to their approximate positions.

b. Click the Setup button to open the Page Setup dialog. The text boxes 
will reflect the latest changes to the margins.

c. Revise the numbers in the text boxes as needed. 

Double-pointed 
cursor arrow
PrintPrewiewMarg
ins.png

Margin handle
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d. Click OK to close the dialog.
e. When the focus returns to the Print Preview window, click the 

Margins button to clear the margin handles.

PRINTING THE FILE NAME ON THE REPORT
For the program to print the analysis’s file name and location (path) in the 
lower-left corner of the printed reports:
1. Open the Page Setup dialog. See Accessing the Page Setup dialog on 

page 287.
2. Click the Filename item. The program inserts a check mark in the check 

box.

3. To save the change as a revised default for new analyses, click the Save 
as Default button in the Page Setup dialog.
Otherwise, click OK to accept your changes and close the dialog.

INCLUDING A TABLE OR INDEX WITH THE PRINTED 
REPORTS

As an initial default, the program includes the Table of Contents and Index in 
the printed report. You can change this default for new analyses, or simply 
change the default to print:

the Table of Contents only,
the Index only, or

neither the Table of Contents nor the Index for a particular analysis.
To change the current Table of Contents and Index selections:

1. Open the Page Setup dialog. See Accessing the Page Setup dialog on 
page 287.

2. Click the Table of Contents item and/or the Index item to remove the 
check mark from the check box or to place a check mark in the check box.

3. To save the change(s) as a revised default for new analyses, click the 
Save as Default button in the Page Setup dialog.

Otherwise, click OK to accept your changes and close this dialog. 

Note. Page Numbers must be selected in order to enable the Index and Table 
of Contents. If the page numbering feature is not selected when you select 
Index or Table of Contents, the program issues a message informing you that 
Page Numbers will be automatically selected. See Printing Page Numbers 
on page 298.
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INCLUDING NOTES WITH PRINTED REPORTS
As an initial default, the program includes each Note immediately after the 
worksheet to which it applies, if the note meets the following two conditions:

the worksheet to which it applies is printed, and
the row to which it applies is printed. (If the row is blank and you’ve 
selected “Don’t print empty rows” (see below), the note will not print.)

You can change this default to not print the notes for a particular analysis or 
change the default for new analyses.
To change the current handling of the note printing on the reports:
1. Open the Page Setup dialog. See Accessing the Page Setup dialog on 

page 287.

2. Click the Notes item to remove the check mark from the check box or to 
place a check mark in the check box.

3. To save the change as a revised default for new analyses, click the Save 
as Default in the Page Setup dialog.
Otherwise, click OK to accept your changes and close this dialog.

EXCLUDING EMPTY ROWS OR WORKSHEETS FROM 
REPORTS

As an initial default, the program excludes empty rows (those containing only 
zeros) and empty worksheets (e.g., active worksheets that do not contain client 
data) from printed reports. This results in a smaller printed report. However, 
items that may pertain to the client data but are currently empty will not be 
shown.
You can change the default for new analyses, or simply change this default to 
exclude:

empty rows only,
empty worksheets only,

or neither empty rows nor empty worksheets for a particular analysis.
To change the current handling of empty rows and worksheets:
1. Open the Page Setup dialog. See Accessing the Page Setup dialog on 

page 287.

2. In the Don’t Print area, click the Empty rows item to remove the check 
mark from the check box or to place a check mark in the check box.
Or, click the Empty worksheets check box to remove the check mark from 
the check box or to place a check mark in the check box.
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3. To save the change(s) as a revised default for new analyses, click the 
Save as Default button in the Page Setup dialog.
Otherwise, click OK to accept your changes and close this dialog.

Note. Clicking on an item in the Don’t Print section toggles the selection on 
and off. If a check box in the Don’t Print section has a check mark in it, the 
program excludes its corresponding item from the reports.

SELECTING A FONT FOR THE PRINTED REPORTS
You can use any font loaded for your printer to print the reports. Your font 
selection controls the appearance of the printed reports including the labels on 
the graph. The font used for printing the reports does not need to be the same 
as the font used to view the worksheets on-screen while you enter client data 
into the analysis. The selected font, including point size and style, is used for 
the entire printed report (excluding the client letter).

Note. If you will not be printing the reports on your usual printer, you should 
specify the printer using the Print Setup dialog (accessed through the 
Printer command on the Print dialog) before you complete the Font 
options. This is because the fonts that are available on one printer may not 
be available on another.

ACCESSING THE FONT DIALOG 
Specify the Font selection in the Font dialog:

1. Access the Font dialog in one of the following ways:
a. Select Page Setup from the File menu, then click the Font button.
b. Select Font from the Print Preview window, or

c. Select Setup from the Print dialog, then click the Font button.
The Font dialog will open. (This dialog operates in the same manner as the 
Font dialogs in other Windows applications. See your Windows manual for 
information concerning specific items in this dialog.)
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2. Scroll through the items in the Font list box. Click a font name to select the 
font. (The fonts listed in this box will vary depending upon what fonts you 
have loaded for your printer.) A sample of the font will display in the 
Sample area of the dialog.

3. Click the desired font style and/or size to change these selections. 

4. Click OK to accept your changes or Cancel to reject any changes. The 
Font dialog closes.

INCLUDING TOTAL AND SUBTOTAL LINES ON THE 
REPORTS

As an initial default, the program includes single and double underlines for 
totals, subtotals, and sections on the printed reports. You can change this 
default to not print the underlines for a particular print run or change the default 
for new analyses.
To change the current handling of underlining on the reports:
1. Open the Page Setup dialog. See Accessing the Page Setup dialog on 

page 287.

2. Click the Underlines item to remove the check mark from the check box or 
to place a check mark in the check box.

3. To save the change as a revised default for new analyses, click the Save 
as Default button in the Page Setup dialog.
Otherwise, click OK to accept your changes and close this dialog.

dFont.png
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PRINTING MULTIPLE REPORTS OR ONE REPORT PER PAGE
As an initial default, the program places multiple worksheets on each page of 
the printed reports whenever possible. You can change this default to print one 
report on each page using a command on the Page Setup dialog.
To change the handling of the number of reports per printed page:
1. Open the Page Setup dialog. See Accessing the Page Setup dialog on 

page 287.

2. Click the One worksheet per page item to remove the check mark from 
the check box or to place a check mark in the check box.

3. To save the change as a revised default for new analyses, click the Save 
as Default button in the Page Setup dialog.
Otherwise, click OK to accept your changes and close this dialog.

Note. Even when this command is not selected, the program will never start 
printing a worksheet in the middle of a page unless the entire worksheet will fit 
on that page.

INCLUDING CENTS OR PRINTING DOLLAR-ROUNDED 
AMOUNTS

As an initial default, the program displays dollar-rounded amounts on-screen. 
The program prints the amounts on the reports according to whether you have 
the cents displayed on-screen or not.

To display and print cents in the amounts on the reports:
1. Select Calculations on the Options menu. The Calculation Options 

dialog appears.
2. Click the Display Cents item to place a check mark in the check box.

When this check box contains a check mark, cents will be included in the 
amounts. When the check box is empty, the amounts will be dollar-rounded.

CUSTOMIZING THE SECURITY TRANSACTION ANALYZER 
RESULTS

Using the Transaction Analyzer Page Setup dialog, you can set up a report 
format suitable for presenting security transaction results to your clients. You 
can set up and/or change the printed report’s appearance for a single session 
or save the settings as the default for future sessions.
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Note. The items on the program’s Page Setup dialog, such as font, margins, 
and headers and footers, are also used to format the printed Security Trans-
action Analyzer report. 

To access the Transaction Analyzer Page Setup dialog:
Open the Print dialog. (If the Security Transaction Analyzer window is 
open, select the Print command on the menu bar. Otherwise, select Print 
on the File menu.) Then click the Analyzer Setup button.

Or, from the Print Preview window, click the Analyzer Setup button on the 
button bar.

The Transaction Analyzer Page Setup dialog appears:

CHANGING THE YEARS INCLUDED ON THE ANALYZER REPORT
From the list boxes, select the first and last year(s) that you want included on 
the printed report. The printed report will include all years within this range. The 
program defaults to the first and last years of the analysis.

SORTING TRANSACTIONS BY YEAR SOLD
As an initial default, the program includes the transactions from all years 
together on the printed report. You can choose to have the transactions sorted 
by year sold, starting a new page for each year.

To change the current handling of years on the report, click the New Page for 
Each Year item.
If you select this option, the program will print all transactions for each year 
sold on a separate page. If you do not select this option, the program will print 
all years together on the report in chronological order by date sold.

SORTING TRANSACTIONS BY HOLDING PERIOD
As an initial default, the program includes the transactions from all holding 
periods together on the printed report, sorted by date sold. You can choose to 
have the transactions sorted by holding period, printing the short- and long-
term transactions separately.

dTransactionAnalyzerPageSetup.png
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To change the current handling of the holding period sort on the report, click the 
Separate Short and Long item.
If you select this option, the program prints all short-term transactions on the 
report before printing the long-term transactions.

SELECTING THE COLUMNS INCLUDED ON THE REPORT
As an initial default, the printed report includes the following gain/loss columns: 

Total Short-Term
Total Long-Term

28% Rate Long-Term
5-Year Gain Purchased Before 2001
Other Long-Term

Select the Suppress “Other” Column item to exclude the Other Long-Term 
column from the printed report. The Total Long-Term column is the sum of the 
28% Rate Long-Term, 5-Year Gain Purchased Before 2001, and the Other 
Long-Term columns.

MODIFYING THE REPORT TO RESEMBLE SCHEDULE D
If you select all the options listed below, the printed report will most closely 
resemble the federal Form 1040, Schedule D:

New Page for Each Year 

Separate Short and Long for Each Year
Suppress “Other” Column

REMOVING NONESSENTIAL COLUMNS FROM THE REPORT
As an initial default, the printed report includes the following gain/loss columns: 

Total Short-Term
Total Long-Term

28% Rate Long-Term
5-Year Gain Purchased Before 2001
Other Long-Term

Select the Suppress Zero Columns item to exclude columns containing only 
zeroes from the printed report.
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SPECIFYING CASES TO PRINT ON THE REPORT
As an initial default, the program includes all transactions for all cases on the 
printed report. You can choose to print transactions or not, depending upon 
which cases are selected for printing.
To change the current handling of cases on the report, click the Cases button. 
The Print Cases dialog opens.

Those cases with check marks will print. If all cases are selected to print, even 
those transactions with None specified for Include in Case will print.

PRINT DEFAULTS
HEADERS AND FOOTERS

As an initial default, the header and footers are blank. To save header and/or 
footer entries as the default for new analyses:

1. Enter the desired default in the Header & Footer Lines dialog. For more 
information, see Including Headers or Footers on page 292.

2. Select Save as Default on the Header & Footer Lines dialog. The 
program will issue a message indicating that the changes were saved to 
the initialization file. Then the dialog closes, returning the focus to the Page 
Setup dialog.

To restore the headers and footers for a client file to the default headers and 
footers, click on the Restore Default button in the Header & Footer Lines 
dialog. This will return the text in the header and footer lines to the most recent 
default settings.

PAGE SPECIFICATIONS
As an initial default, the page specifications are:

Print current date and time

Print page number
Print underlines
Print notes

dPrintCases.png
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Print Table of Contents and Index
Don’t print empty rows and worksheets

Print multiple worksheets per report page
To save page specification entries as the default for new analyses:
1. Enter the desired default(s) on the Page Setup and Page Style dialogs. 

For more information, see How to Customize the Printed Reports on 
page 291.

2. Select Save as Default on the Page Setup and Page Style dialogs. The 
program will issue a message indicating that the changes were saved to 
the initialization file. Then the dialog will close.

Note. The font selection is also saved as the default along with the other Page 
Setup items.

MARGINS
As an initial default, the margin settings for the printed reports are blank. To 
save margin entries as the default for new analyses:

1. Enter the desired default in the Margins dialog. For more information, see 
Changing the Report Margins on page 299.

2. Select Save as Default on the Margins dialog. The program issues a 
message indicating that the changes were saved to the initialization file. 
Then the dialog closes, returning the focus to the Page Setup dialog or 
Print Preview window.

COLUMN WIDTHS
The width of the columns (and the space between the columns) is determined 
by:

whether the amounts include cents or are dollar-rounded (selected on the 
Calculation Options dialog accessed from the Options menu)
the number of dollar digits selected (selected on the Calculation Options 
dialog accessed from the Options menu)
the size of the printer font (selected on the Font dialog accessed from the 
Page Setup command on the File menu)

To save the first two settings above as the default for new analyses, click Save 
as Default on the Calculation Options dialog.
To save the last setting above as the default for new analyses, click Save as 
Default on the Page Setup dialog.
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FONTS
To save printer font entries as the default for new analyses:
1. Enter the desired default(s) in the Font dialog. For more information, see 

Selecting a Font for the Printed Reports on page 304.
2. Click OK to close the Font dialog.

3. The focus will either return to the Page Setup dialog or the Print Preview 
window. If the focus returns to the Print Preview window, click the Setup 
button.

4. Select Save as Default on the Page Setup dialog. The program will issue 
a message indicating that the changes were saved to the initialization file. 
Then the dialog will close.

PRINTER
The default printer is changed each time you select a different printer. This 
printer selection may also change the default printer for other Windows 
programs.

To change the default printer, see Selecting a Different Printer on page 280.
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A
Appendix A Keyboard Shortcuts

KEYBOARD SHORTCUTS

FILE

Command Shortcut
Open File Menu Alt+F

New Client File Alt+F, N

Open Client File Alt+F, O

Merge Client File Alt+F, M

Save Client File Alt+F, S

Save Client File As Alt+F, A

New Client Letter Alt+F, W

Open Letter Template Alt+F, L

Save Letter Template As Alt+F, R

Page Setup Alt+F, T

Print Preview Alt+F, V

Print Alt+F, P

Send as PDF Attachment Alt+F, D, P

Send as IT Attachment Alt+F, D, I

Erase Worksheets Alt+F, E

Exit (Close Program) Alt+F, X
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EDIT 

ASSUMPTIONS DIALOG

Command Shortcut
Alternate
Shortcut

Open Edit Menu Alt+E

Undo Last Entry Ctrl+Z Alt+E, U

Show Undo List (Prior Entries) Alt+E, N

Copy Ctrl+C Alt+E, C

Paste Ctrl+V Alt E, P

Paste Link Alt+E, L

Select All Alt E, S

Edit Cell F2 Alt+E, E

Auto Copy Within A Case A Alt+E, W

Auto Copy Same Year Shift+A Alt+E, Y

Auto Copy All Columns Ctrl+A Alt+E, A

Clear or Restore Prior Value C Alt+E, V

Increase by Constant or % I Alt+E, Shift+5

Kill Subworksheet K Alt+E, B

Zap Custom Worksheet Z Alt+E, T

Open Math Calculator M Alt+E, H

Repeat Previous Cell Value R Alt+E, R

Spread Annualization S Alt+E, Z

Open Case Titles Ctrl+E Alt+E, T

Move Case Ctrl+M Alt+E, V

Hide Columns Ctrl+H Alt+E, D

Protect Columns Ctrl+L Alt+E, M

View Dynamic Data Exchange Links Alt+E, X

Add or Edit a Note Ctrl+N Alt+E, O

Command Shortcut
Annualization Analysis On/Off Alt+A

Minor Child Analysis On/Off Alt+M

Change Case Titles Alt+T

Enter Client Address Alt+S

Choose Resident State Alt+R

Choose Nonresident State Alt+N



315

K
EY

B
O

A
R

D
 

SH
O

R
TC

U
TS

K
EY

B
O

A
R

D
 

SH
O

R
TC

U
TS

K
EY

B
O

A
R

D
 

SH
O

R
TC

U
TS

K
EY

B
O

A
R

D
 

SH
O

R
TC

U
TS

K
EY

B
O

A
R

D
 

SH
O

R
TC

U
TS

::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::

WORKSHEETS

Command Shortcut
Alternate
Shortcut

Hide/Show Worksheet List Ctrl+W Alt+W, K

Open Worksheet Alt+W, K, O

Close Worksheet Alt+W, K, C

Kill Worksheet Alt+W, K, K

Zap Custom Worksheet Alt+W, K, Z

Print Worksheet Alt+W, K, P

Sort Worksheet List Alt+W, K, S

Help For Worksheet List Alt+W, K, H

Go to Subworksheet W, or double-click row (see 
Types of Rows on page 20)

Alt+W, G

Cascade Alt+W, D

Tile Horizontally Alt+W, H

Tile Vertically Alt+W, V

Tile Optimally Alt+W, O

Arrange Icons (minimized worksheets) Alt+W, N

Close On Escape Alt+W, L

Minimize On Escape Alt+W, Z

Use Same Window Alt+W, U

Batch Input B Alt+W, 

Individual Activities Alt+W, I

Summary Report X Alt+W, 

Present Value Alt+W, P

W-4 Worksheet Alt+W, W

W-4 Form Alt+W, F

Alternative Capital Gains Tax Alt+W, A

Security Transaction Analyzer Alt+W, T

Watch Window Alt+W, W

1040-ES Payment Vouchers Alt+W, M

Close All Subworksheets Alt+W, C

View Federal Worksheets Alt+W, F

View Resident State Worksheets Alt+W, R

View NY Nonresident State Worksheets Alt+W, N

View Other Nonresident State Worksheets Alt+W, O

Leave a Worksheet Esc
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CUSTOM WORKSHEETS

OPTIONS

Command Shortcut
Create a Custom Worksheet W, or double-click any input row (see Types of Rows on 

page 20)

Insert a Row Ctrl+I

Delete a Row Ctrl+D

Designate as Title Row
(inserts a blank row below title row)

Ctrl+T 

Designate as Subtotal Row Ctrl+S

Command Shortcut
Alternate
Shortcut

Auto Backup Alt+O, A

Calculations Alt+O, C

Colors Alt+O, L

Default Directory Alt+O, D

Deactivate Program Alt+O, G

Link Options Alt+O, K

Password Protect Alt+O, P

Screen Font Alt+O, F

Resident State Specifications Alt+O, R

Nonresident State Specifications Alt+O, N

Calculations On/Off Alt+C Alt+O, O

Save Desktop Alt+O, S

View Filename Alt+O, M

View Toolbar Alt+O, V

View Tabs Top Alt+O, T

VIew Tabs Bottom Alt+O, B

View Worksheet List Left Alt+O, E

View Worksheet List Right Alt+O, I

View Worksheet Row Numbers Alt+O, U
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GRAPH & CLIENT LETTER

HELP

Command Shortcut
Open Graph Alt+G

Open Client Letter Alt+L

Command Shortcut
Alternate
Shortcut

Show Help Contents Alt+H, C

Search For Help On... Alt+H, S

Help For Current Row F1 Alt+H, H

Tax Reference Guide Alt+H, R

Operations Guide Alt+H, O

Tutorial Alt+H, T

Merge Conflict Log Alt+H, M

Web Update Alt+H, W

Go To Updates Web Site Alt+H, G

About Income Tax Planner Alt+H, A
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B
Appendix B Program Files

PROGRAM FILES

<<desktop program edition only>>
This appendix is provided for users who may be interested in the program files 
on your hard drive. The program files are in [local drive]:\ITWIN, and are listed 
below, sorted first by extension and then by file name.

Extension File Name Description
CHM ITHELP.CHM Help file

CONFIG ITWIN.EXE.config CONFIG file

DAT blm.dat BLM Client Data file

DAT Update.dat TrueUpdate Client Data file

DLL asycfilt.dll VB6 System file

DLL atx45ole.dll Bennet-Tec AllText 4.5 Support file

DLL atx45PIC.dll Bennet-Tec AllText 4.5 Support file

DLL BLM.DLL BLM Client

DLL comcat.dll VB6 runtime files

DLL gsjpg32.dll Graphics Serve Support file

DLL gswag32.dll Graphics Serve Support file

DLL gswdll32.dll Graphics Serve Support file

DLL ISLICENSE50.dll BLM License Module

DLL ITUTIL32.DLL General Purpose Utility Support file

DLL mfc42.dll Ocx dependency files

DLL msvbvm60.dll VB6 runtime files

DLL msvcrt.dll VB6 runtime files

DLL oleaut32.dll VB6 runtime files
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DLL olepro32.dll VB6 runtime files

EXE BLMITPActivationTool.exe Program Activation Tool

EXE BLMITPDeactivationTool.exe Program Deactivation Tool

EXE gsw32.exe Graphics Server

EXE Itwin.exe Program executable file

EXE Update.exe TrueUpdate Client

ICO FEDERAL.ICO Program icon
<<Federal edition only>>

ICO STATE.ICO Program icon
<<Income Tax Planner with Fifty 
States only>>

INI it.ini Program Initialization/settings file

IT SAMPLE.IT Sample client plan file

ITL SAMPLE.ITL Sample letter template file

NDX ITBATCH.NDX Batch Input Worksheet Index file

NR *.NR Nonresident state specification files

OCX atx45.ocx Bennet-Tec AllText 4.5 Control

OCX COMDLG32.ocx CMDialog ActiveX Control file

OCX fpSPR80.ocx FarPoint Spread Control (OLEDB) file

OCX graphs32.ocx Graphics Server Control file

OCX Tab32x30.ocx FarPoint TabPro ActiveX Control file

OCX threed20.ocx Sheridan ActiveThreed Control file

OCX TList8.ocx Bennet-Tec TList ActiveX Control fie

PDF 1040-ES 1040-ES form

PDF 1041-ES 1041-ES form

PDF W4_CURRENTYEAR W-4 form

PDF W4_FUTUREYEAR W-4 form

RND ITCAP.RND Program caption support file

RND ITWINMSG.RND Program message file

ST *.ST Resident state specification files

TLB stdole2.tlb VB6 runtime files

TXT Income Tax Planner Update Log.txt TrueUpdate Log file

TXT ITLICENS.TXT License Agreement

WMF 1040*.WMF ES1040 Voucher Meta file

WMF 1041*.WMF ES1041 Voucher Meta file

WMF W4_1 W-4 Meta file

Extension File Name Description
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Within the ITWIN folder is a subfolder called Module Retargetable Folder 
containing the following files:

The program also uses:

IT.INI (initialization file). It is located in [local drive]:\Users\[user 
name]\AppData\Local\Bloomberg Tax Technology\Income Tax 
Planner.
blm.dat file. In the network program editions, this file is located in [local 
drive]:\itwin. In the stand-alone program editions, it is located in [local 
drive]:\Users\[user name]\AppData\Local\Bloomberg Tax Technol-
ogy\Income Tax Planner.
blmac.dat file. It is located in [local drive]:\Users\[user 
name]\AppData\Local\VirtualStore\ProgramData\Bloomberg Tax 
Technology\Income Tax Planner\Income Tax Planner Federal and 50 
States.

WMF W4_2 W-4 Meta file

XML PAYMENTVOUCHER_FIELD-
KEYS.XML

XML document

XML W4_FIELDKEYS.XML XML document

Extension File Name Description

Extension File Name
DLL Microsoft.InteropFormTools.dll

DLL O2S.Components.PDF4NET.dll

DLL O2S.Components.PDFRen-
der4NET.dll

DLL O2S.Components.PDFVIew4NET.dll

DLL Pdf4VBControl.dll

TLB Microsoft.InteropFormTools.tlb

TLB Pdf4VBControl.tlb
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INDEX

NUMERICS
1040-ES/1041-ES Payment Vouchers 53
1099 data, see K–1 and 1099 input

A
Access rows, defined 20
Acrive row, defined 19
Activating worksheets 36, 39, 161
Active cell, defined 19
Adjustment, Analysis type 130
Adobe Acrobat file

creating 94
Alternative Capital Gains Tax

in general 180
worksheet 53, 160, 180

Alternative Minimum Tax
worksheet, in general 37

Analysis type
Adjustment 128, 130
Annualization 146
Cases and Years 129
Cases within Years 128
Cases within years 130
Difference 128, 133
Minor Child Analysis 153
Multi Nonresident Analysis 139
Number of Cases in Analysis 128
Taxpayer and Spouse 131
Taxpayer & Spouse 128
Years within Cases 128
Years within cases 128

Annualization analysis
in general 146
Assumptions item 146
Filing Status 128
Security Transaction Analyzer 184
1040-ES Payment Vouchers 191
Year of Analysis 128

Application workspace, defined 19
Area graph 202

Arithmetic calculations, Math command 115
Arrange icons, see Arranging worksheets
Arranging worksheets

in general 164
arrange icons 167
Cascade 166
Default 165
default arrangement 164
Tile Horizontally 166
Tile Optimally 167
Tile Vertically 167

Assumptions
in general 127
accepting changes 157
Annualization analysis 128, 146
Assumptions items 129
cancelling changes 157
Case Titles 138
Client Address 138
client letter 138
Client Name 76
Client name 129
defaults 52, 129
dialog overview 51
Estimated Tax Annualization Analysis 146
First Year of Analysis 136
Help 157
Minor Child Analysis 153
Minor child analysis 128
Multi nonresident analysis 139
Nonresident State 157
Number of Cases in Analysis 129
Number of Children (in Minor Child 

Analysis) 155
Number of Years in Analysis 129
Resident State 156
Salutation Name for client letter 138
Save as Default 157
State, Nonresident 157
State, Resident 156
Year of Analysis, Minor Child Analysis 156

Asterisks next to row titles 38
ATAGI adjustments

see also Alternative Minimum Tax
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Auto Backup
backup procedure 241

Auto backup 55, 64
In general 241
in general 55
Compared to Save command 64
Interval 239, 242
Setting the auto backup interval 242
Turning on or off 242
Using 64
using 241

Auto copy commands
Auto copy all columns 113
Auto copy same year 113
Auto copy within a case 113

B
Backup file

backing up client (data) files 31
temporary file 241

Batch Input
in general 14, 169
Go to Batch Input Line Number command 51, 

122
worksheet 53, 122, 160

Borders
customizing printed reports 295
printing reports 295

Bridge files
adding default headers and footers 71, 294

Bridging tax data from other programs 29
Bullets next to row titles 38

C
Calculated rows, defined 20
Calculation Options

in general 239, 243
Consumer Price Index Adjustment 246
Inflation Percent 245
Maximum OASDI Contribution Base 247
OASDI Contribution Base, maximum 247
option items 244–250
Underpayment Penalty Rate 249–250

Calculation options
in general 55

Calculator 115

Cancel printing 92, 94
cancelling 92
Carryovers

Adjustment analysis 132
Difference analysis 132
Taxpayer and Spouse analysis 132
Taxpayer & Spouse analysis 132

Cascade worksheets 166
see also Worksheet operations

Case Titles
entering 138

Case titles 105
In general 128, 134
in general 128
Annualization analysis 138
Character limit 138
Entering 138
Minor child analysis 138

Cases within Years 128
in analysis 128

Cases within years
Analysis type 128, 130

Cases/years analysis, setting up analysis 129
Cell entry

Auto copy
all years, all cases 50
Other years, same case 104
other years, same case 50
Same year, all cases 104
same year, all cases 50

Clear 50, 104
Copy 50, 104
Decrease 50, 104
Edit 50, 104
Hide columns 105
Increase 50, 104
Links 51
Math calculator 50, 104
Note 51
Paste 50, 104
paste link 50
Protect columns 51, 105
Repeat 50, 104
Restore 50, 104
Spread Annualization 104
Spread annualization 50
Undo 49, 104
Undo list 104
Zap contents on custom worksheet 50, 104
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Cells
active 38
definition of 38
selecting all 50

Cents, displaying 244, 306
Changing screen colors for a worksheet 

item 253
Choose Case for Multi Nonresident dialog 145
Choose replicate case dialog 135, 155
Choosing columns to print 287

In general 74
Setting up in page setup 287

Clear or restore prior value command 114
Client data files

Creating 58
Deleting 61
Directory location 61
File name 60, 109, 124–125
List of last files opened 101
Merging 62
New 58
Opening 58

Files linked to other applications 59
Overwriting existing file 64
Overwriting worksheet data 59
Peeking 60
Renaming 61
Saving 64
Saving under new name or location 65
Sort names 58

Client data, storage of data 28
Client date files, see Client files
Client file names

DDE linked files 109, 124–125
Client files

creating new 48
deleting 49
list of last files opened 49
new 48
opening 49
saving 49
saving under new name or location 49
storing data 28
using with text files 28

Client files, list of recently opened files 101
Client letter 49, 66

Adding worksheet data to 217
Address 138
aligning links 223

Aligning text 222
Copying data into 218
Creating a new letter 216
Default template 227
Displaying links 219
Editing templates 228
Formatting 222
Headers and footers 220
Indents 224
Inserting information automatically 220–221
Layout 222
Margins and indents 224
New 66
Open template 66
Opening 211, 228
Overview 209
overview 54
Paragraph markers 226
Printing 230
Ruler 213, 226
Sample 213
Save template as 67
Saving 216
Selecting text 104
Space between lines 223
Templates 210
Toolbar 211
Using letters to make templates 226
Window 211

Client Name
Assumptions 76

Client name 127, 129
From headers & footers 75
Printing in reports 76, 292

Clipboard 107, 110
Close button, defined 19
Color display, in general 28
Color options

In general 239, 251
in general 55
Available colors 255
Color palette 255
Creating a custom color set 256
Option items 251–257
Preset colors 254
Prior default 254
Restoring default colors 254
Sample worksheet 256
Worksheet area 252
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Columns
Adjustment analysis 130
Choosing which to print 287
Column headings 134

Defaults 134
Setting in the Assumptions dialog 138

column headings
Case Titles 138

Defined 129
Deleting 136
Difference analysis 133
Factors affecting column width 134
Heading titles 134
Hiding 119
Locking 120
Protecting historical data 120
Viewing on-screen 134

Commands
Alignment 233
Analyzer setup 94
Auto backup 242
Auto copy all columns 113
Auto copy same year 113
Auto copy within a case 113
Back button 272
Calculations 243
Calculations on 263
Clear 114, 232
Clear or restore prior value 114
client letter links 120, 237
Close 174, 186
close on escape 168
closing all subworksheets 192
Combine 173
Combine individual activities 173
Copy 46, 107–108, 124, 207, 231
Create link 120
Creating a custom worksheet 164
Cut 231
Data 207
Default directory 257
Delete 185
Delete row 47
Delete/view link 120
Dynamic Links command, Edit menu 120
Edit cell 47, 112–113

Inserting numbers 112
Edit menu 106
Erase worksheets 99

Exit 31, 102
Federal worksheets 192
Find 232
Find next 232
Find previous 232
Find & replace 232
Font 233
Go to activity 173
Go to Batch Input Line Number 122
Go to Excel Link 121
Go to subworksheet 164
Headers & footers 236
Hide columns 119
hide links 237
Hide ¶ 237
Increase by constant or percent 113–114
Insert 235
Insert individual activities 173
Insert item 174
Insert row 47
Insert, security transaction analyzer 185
Kill custom worksheets 44
Kill individual activities 173
Kill item 174
Kill subworksheets 48, 122
Link options 258
Margins... 236
Math calculator 115–117
Minimize on escape 168
New client file 58
New client letter 66
New York nonresident state worksheets 193
Note 121
Open client file 58
Open letter template 66
Opening a built-in worksheet 164
Other nonresident state worksheets 193
Page setup 69
Paste 46, 109–112, 231
Paste link 46, 124, 232
Print 89, 186
Print button 272
Print preview 81
Print setup 97
Printer 97
Protect columns 120
Repeat previous cell 117
Resident state worksheets 193
Ruler 233
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Save client file 64
Save client file as 65
Save desktop 263
Save letter template as 67
Screen font 261
Select all 112, 232
Select all on custom worksheets 47
Select Worksheet 21
show links 237
Show ¶ 237
Spread annualization 117
Style 77
Subtotal row on/off 47
Summary report 176
Tax Reference Guide 265
Title 207
Title row on/off 47
Toolbars 233
Type 207
Undo 106
Undo last entry 231
Undo list 107
Use same window 169
View 185
View filename 263
View tabs bottom 263
View tabs top 263
View toolbar 263
View worksheet list left 264
View worksheet list right 264
Viewing worksheets 192
Web update 265
Zap custom worksheets 48, 123

Consumer price index adjustment 246
Contents page for reports, printing 302
Context-sensitive help 266, 268
Copies of printed report, specifying number 

of 91, 280
Copy command 124

In general 107
Custom worksheet row titles 46
Graph 207
Using with 1040-ES vouchers 109
Using with graphs 109, 206

Copying
In general 107
Calculated cells 108
Graph to another application 109, 206
Multiple cells 108

Note text 122
One cell 108
Payment vouchers to another application 109

Copying worksheets, selecting cells 112
Creating a custom color set 256
Creating a new client data file 58
Creating a print file 92, 94, 281
Creating a spreadsheet file 92, 94, 282–283
Creating a text file 92, 281
Creating an Adobe Acrobat file 92, 284
Credit for other state tax worksheets 142
Cursor, defined 19
Custom worksheets

In general 41, 122
Clearing 101
Creating 41
Creating templates/overlays 45
Data entry commands 46
Deleting custom worksheets 45
Deleting rows 42, 47
Edit menu 46

Copy command 46
Delete row command 47
Edit cell command 47
Insert row command 47
Kill subworksheet command 48
Open custom worksheet command 48
Paste command 46
Paste link command 46
Select all command 47
Subtotal row command 47
Title row command 47
Zap custom worksheet command 48

Entering numeric data 42
Entering row titles or descriptions 42
Inserting rows 42, 47
Killing 44, 122
Moving between rows 42
Nesting 44
Numeric cell section 41
overview 41
Printing 41, 70
Row title section 41
Storing templates 46
Subtotal rows 43
Title rows 42
Totals 44
Using as overlays 45
Zapping 104, 123
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zapping 50

D
Data command, Graph 207
Data directory, default 257
Data entry

in general 13
Batch input 169
batch input 14
changing information, ripple effect 13
Client letter 138
Custom worksheets 41, 46
Edit commands 106
Multiple cases 129
Multiple years 129
worksheets 13, 35

Data file, see Client data files
Data security 31
DDE commands

Copy 104, 124
links 51
Paste link 46, 124
paste link 50

DDE procedures
Saving linked client files under a new name 65

Decrease by constant or percent 115
Default

Auto backup interval 242
Data directory 257
Font, printer 311
Graph

Data selections 200
Titles 204
Type 201

Headers/Footers 71
Letter template 66, 68, 227
Margins 74, 310
Page setup 309
Page specifications 309
Printer, selecting 97, 311
Report Contents 291
Saving calculation options 240
Screen colors 254
Worksheet rows on graph 200

Defaults
Analysis assumptions defaults 129
Assumptions 52, 129
saving Assumptions 157

Delete command
Custom worksheets, rows 47
Security Transaction Analyzer, rows 185

Deleting a passive activity item 174
Deleting cases 136
Depreciation recapture, see Recapture
Detailed explanation 64
Dialog

defined 20
Item 61

Directories 61
File 60, 66

Dialogs
Assumptions 51

Difference, Analysis type 133
Digits, number of

See also Dollar digits
Calculated number with more digits than 

selected 245
Cents displayed 244
Cents not displayed 244
Dollar digits 244

Directories 61
Directory, default 61
Display cents option 244
Display options, in general 239
Dollar digits 244

Expanding number of 244
Dynamic data exchange (DDE)

in general 28

E
Edit cell

Custom worksheets, row titles 47
Using the insert mode 112

Edit menu
Auto copy all columns 113
Auto copy same year 113
Auto copy within a case 113
Case titles 105
Cell-level commands 106
Clear or restore prior value 114
Copy 107–108, 124
Custom worksheet 46
Edit cell 112
Go to Batch Input Line Number 122
Graph 206
Hide columns 105
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Increase by constant or percent 113–114
Individual activities worksheet 172–173
Insert item 174
Kill item 174
Kill the subworksheet 122
Math calculator 115–117
Move case 105
Note 121
overview 49
Paste 109–112
Paste link 124
Protect columns 105, 120
Repeat previous cell 117
Select all 112
Spread annualization 117
Undo 106
Undo list 107
Worksheet-level commands 122

Editing a cell 112, 116
Ending a session 31
Erase worksheets

In general 99
Erase worksheet data 100
Erase worksheet data and zap custom 

worksheets 101
Selecting the Erase Worksheets command 99

Estimated and withholding worksheets 143
Estimated payment vouchers 189
Estimated tax 189
Estimated tax annualization analysis, see Annual-

ization analysis
Excel file

Creating 84, 94, 282
Excel, loading files into 283
Exiting

Page setup 81, 302
Print 98
Print preview 88, 277
Print selections 284–285
Program 102

Exiting the program 31, 49
Expanding dollar digits 244

F
Features of the program 21
File menu

Erase worksheets 99
Exit 31, 102

List of recently opened client files 101
New client file 58
New client letter 66
Open client file 58
Open letter template 66
Overview 57
overview 48
Page setup 69, 92, 94, 273
Print command 89, 273
Print preview 81, 273
Save client file 64
Save client file as 65
Save letter template as 67

File name 60, 70, 93, 101, 109, 124–125
DDE linked files 109, 125

Filename 263
Files

see also Program files
bridge files 71, 294
Changing list on File menu dialogs 62
Deleting 61
File name 61
it.itb 241
loading files from previous versions 31
opening a client file 31
Renaming 62
Selecting files from file list box 61

Filing Status
Annualization analysis 128

First Year of Analysis
Assumptions 136

First year of analysis, default 129
Folders, see Directories
Fonts

Changing the font settings 304
Default 73
Font style 72, 262
Graph 197
Printer 71, 85, 261
Saving default printer fonts 73, 311
Screen font 72, 261
Selection 72, 262
Size 72, 262

Error message 73, 262
Points 72, 262

Types 72, 261
Footers

In general 75
Entering text 76, 292
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Length limit 75
Placement on report 299
Save as default 76

Form 1040/1041-ES vouchers 189
Accessing 160
Printing 290

Form 4868 Extension 160
Form W-4 160

G
Go to Batch Input Line Number command 122
Graph 91

In general 195
Amount axis 196
appearance 54
Case axis 196
Copying to another application 109, 206
Data selections 198

Data items 197
Predefined 198
User defined 200

Edit menu 206
Copy command 207
Data command 207
Title command 207
Type command 207

Fonts 197
Graph Data dialog 198
Graph Titles dialog 204
Graph Type dialog 201
items 54
Labels 202
overview 54
Patterns 202
Percent axis 196
Printing 204
Properties 202
properties 54
Selection considerations 200
Titles 54, 204

In general 195
Bottom 204
Dialog 204
Graph 204
Left 204
Right 204

Toolbar 197
Types 202

In general 195, 201
Dialog 201

types 54
Window 195
Worksheet rows 195, 198

Graph properties
Absolute area 203
Horizontal bar graphs 202

Percent stacked property 203
Stacked property 203

Labels 202
Lines 203
Patterns 202
Percent area 203
Stacked area 203
Symbols 203
Vertical bar graphs 202

Percent stacked property 203
Stacked property 203

Graph types
Area 202
Dialog 201
Line 202
3D bar 202
2D bar 202

H
Headers/footers

In general 75
Entering text 76, 292
In the Client Letter 220
Length limit 75
Placement on report 299
Printing in reports 292
Save as default 76, 309
Use default if no other specified 71

Help
Buttons

In general 272
Back 272
Hide/Show 272
Options 272
Print 272

Commands 272
Context-sensitive 266, 268
Menu bar 272
Search dialog 269
Topic illustration 271
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Help menu
In general 265
About Income Tax Planner command 266
Contents command 265–266
Go to updates web site command 268
Help for current row command 265–266
overview 55
Search for help on... command 265–266
Tax Reference Guide command 265–266
Tutorial command 267
Web update command 265, 267

Hide columns command 105, 119
Highlight, defined 20
Historical data, protecting 120
How to use this guide

keyboard 12
mouse pointer shapes 12

I
.it files 61, 66, 93
.itb files 93, 241
.itp files 93
Increase command

By constant, in general 114
By percent, in general 114
Using with auto copy command 113

Index page for reports, printing 70, 302
Individual Activities worksheets

using Worksheets menu commands 53
Individual activities worksheets 14

In general 170
Activities menu 173
Close command 174, 186
Combine command 173
Completing the worksheet 175
Edit menu 172
Go to activity command 173
Insert command 173
Kill command 173
Using menu commands 160

Inflation adjustments 251
Inflation Percent

in general 245
Calculations Options 245

Initialization file
Assumptions 157
Calculation options 240

Input rows, defined 20

Insert command
Custom worksheets, rows 47
Security Transaction Analyzer, rows 185

Inserting a passive activity item 174
Insertion point, defined 20
Installation

program updates 32
Installing program updates 32
Interfacing with other tax programs 29
Itemized deductions

fiduciaries, see Fiduciaries

K
Kiddie tax, see Minor child calculations
Kill the subworksheet command 48, 122
Killing a passive activity item 174

L
Labels on graph 202
Landscape paper orientation 97
Launching the program 14
Letter template 49, 66
Letter to client 49, 66
Line graph 202
Linking data

see also Bridging tax data from other programs
aligning linked data in a client letter 223
client letter links dialog 237
delete link 120
deleting a case with a link to a client letter 221
displaying links in a letter 219
dynamic links command, Edit menu 120
edit letter link columns dialog 237
editing links in a client letter 219
go to Excel link, Edit menu 121
In general 239
link options 258
link options command, Options menu 55
show/hide links command in client letters 237
timeout 259

List
Client file names 61
Recently opened client files 101

Loading files from previous versions 31
Lotus 1-2-3 file

Creating 84, 94, 283–284
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Lotus 1-2-3, loading files into 284

M
Magnify view 83, 277
Margins

Changing from print preview 300
Changing using margin handles 86, 300
Changing using Margins dialog 299
Client letter 224
Error message 74
In print text file 92
Margin handles defined 86, 300
Printed to text files 74, 299
Saving 74
Saving default 74, 310
Setting from page setup 73
Setting from print preview 85
Valid entries 73

Material participation rental real estate activities, 
see MAPRRA activities

Math calculator 115
Maximum OASDI Contribution Base

Calculation Options 247
Medical expenses

fiduciaries, see Fiduciaries
Medicare wages, see HI wages
Menu bar

in general 35
Assumptions 127
Graph, In general 195

Menu bar, defined 15
Menus

in general 35
File menu 57
Help menu, in general 265
Individual activity’s activities menu 173
Individual activity’s edit menu 172
Options menu, in general 239
options of 35
selections 35
Worksheets menu, In general 159

Minimize & Maximize buttons, defined 19
Minimize/maximize buttons, defined 19
Minor Child Analysis

in general 153
Assumptions 155
Assumptions item 153
Number of children 155

Year of Analysis, Assumptions 156
Minor child analysis

In general 128
Number of children 128
Selecting 154
1040-ES payment vouchers 191
Year of analysis 128

Mouse pointer shapes 12
Move case 105
Multi nonresident analysis 139
Multiple case analysis

Choosing columns to print 74, 287
Security Transaction Analyzer 184

Multiple case calculation 74
In general 129
Access and operation 129
Assumptions 129
beginning year 136
Case Titles 138
Deleting cases 136
Replication feature 130, 134, 155
Scrolling 134

Multiple year analysis
Choosing columns to print 74, 287

Multiple year calculation
Replication feature 135

Multiple years calculation 74
In general 129
Access and operation 129
beginning year 136
Changing beginning year 137
Replication feature 130, 134
Scrolling 134

N
Name of client 75, 127, 129, 291–292
Name of current client file 109
Net long-term capital gain or loss, see Capital 

gains and losses
Net short-term capital gain or loss, seeCapital 

gains and losses
Network operation

requirements for use 28
Next button (Print preview) 83
Next page, in print preview 277
Nonpassive items

In general 175
Summary worksheet 175
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Worksheet 175
Nonrefundable credits, see Credits
Nonresident state specifications, accessing 262
Nonresident states, list of 13
Note command 121
Notes 105

Attaching to a worksheet cell 121
Printing 70

Number of Cases
in analysis 128

Number of cases
Default 129
In analysis 128

Number of Children (in Minor Child Analysis)
Assumptions 155

Number of printed copies 91, 280
Number of report pages 83, 277
Number of years

Analysis type 128, 133
Default 129
default 52

O
OASDI contribution base 247
Open custom worksheet command 48
Opening a client data file 58
Opening a client file 31

from a previous version 31
Opening a letter template 66
Opening the program 14
Operation of system

in general 35
arranging the workspace 164
calling up the program 14
Changing printers 280
Clearing worksheets 101
Creating a new client file 58
Deleting cases 136
Deleting linked rows 47
ending a session 31
Entering case titles 138
Entering client letter information 138
Entering client name 129
Erase worksheets 99
Exit command 31
Exiting system 102
Locking columns 120
Main Worksheet and subworksheets 35

Merging client data file 62
Multiple cases calculation 129
Multiple years calculation 129
Opening client file 58
opening the program 14
Pasting link data to a remote application 109
Previewing printed reports 273
Previewing Security Transaction Analyzer 94
Printing 89, 278
Program files 319
Protecting historical data 120
Replicating data into new columns 134, 155
Saving client data file 64
Saving client data file as 65
Searching for a help topic 269
Selecting a nonresident state 157
Selecting a resident state 156
Selecting a worksheet 160
Selecting minor child analysis 154
Sending reports to a printer 278
Setting up the report page 69–81, 291–306
Shortcut to re-opening a client file 101
specifying case titles 138
starting the program 14
Using a client letter as a template 215
Using the help system 266
Worksheet list 162
Years analysis 129

Options menu
In general 239
Auto backup 242
Calculation Options 243
Calculations on 263
Consumer price index adjustment 246
Default directory command 257
Display cents 244
First quarter underpayment penalty rate 249–

250
Fourth quarter underpayment penalty rate 250
Inflation Percent 245
Link options command 258
Maximum OASDI contribution base 247
network adiministrative options command 258
network administrative options, overview 239
Nonresident state specifications 262
Number of dollar digits 244
overview 55
Resident state specifications 262
Save desktop 263
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Screen font 261
View filename 263
View tabs bottom 263
View tabs top 263
View toolbar 263
View worksheet list left 264
View worksheet list right 264

Output
expanded output, see expanded output
printing results, see printing results, printing

Overview
Assumptions dialog 51
Client letter 54
custom worksheets 41
Edit menu 49
File menu 48
Graph 54
Help menu 55
Options menu 55
Worksheets menu 52

P
.prn files 94
Page setup

In general 69, 92, 291
Adding borders to reports 295
Adding shading to reports 295
Changing headers/footers 292
Changing margins 299
Changing the font 304
Client name included in headers/footers 76
Column widths 310
Columns 74
Customizing report appearance 291
Defaults 309
Don’t print empty rows 70, 303
Don’t print empty worksheets 71, 303
Filename 69
Font 71, 304
Footers 75, 292
Formatting 77
Headers 75, 292
Items saved with client file 81
Leaving 81
Making parts of the report bold 296
Modifying page specifications 291
Multiple worksheets per page 306
Notes 303

One worksheet per page 71, 306
Page numbers 298
Print custom worksheets 70
Print date 78, 297
Print index 70, 302
Print notes 70, 303
Print page numbers 78, 298
Print report table of contents 70, 302
Print time 78, 297
Print underlines 70, 305
Printing the filename on reports 302
Reviewing margins 73
Save as default 73–74, 77, 81
Selecting 85
Setting margins 73
Setting printer font 71
Setting up page specifications 291
Skip input rows containing all zeros 70, 303
Skip worksheets containing all zeros 303
Start each worksheet at the top of the page 71, 

306
Style 77
Use default header/footer if no other header/foot-

er specified 71
Page specifications, saving default 309
Page style

In general 291
Accessing the page style dialog 294
Adding borders to reports 295
Adding shading to reports 295
Customizing printed reports 294
Making parts of the report bold 296
Page numbers 298
Print date 297
Print page numbers 298
Print time 297

Page style dialog 77
Paper size 97
Partnerships

publicly traded, see Publicly Traded Partner-
ships

Parts of the screen 15
Passive activities

Entering 174
Passive activities worksheet

Insert item 174
Kill item 174

Paste command 109
In general 109–112
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Custom worksheet row titles 46
Paste to a group of cells 110
Paste to a single cell 110

Paste link command
In general 124
Custom worksheets, row titles 46
Valid input areas 112

Payment Vouchers 53
Payment vouchers 189
Pointer shapes 12
Portrait paper orientation 97
Present value

Worksheet 160
Present Value worksheet

using Worksheets menu commands 53
Preset colors 254
Previewing print

Security Transaction Analyzer 94
Previewing reports, see Print preview
Previous button (Print preview) 83
Previous page, in print preview 277
Previously loaded client files 101
Print command 89

See also Printing
Print file

Default extension, Adobe Acrobat files 94
Default extension, spreadsheet files 94
Default extension, text files 93
File name 70, 93
Margins 92
Overwriting 93

Print Manager 98
Print preview 273–278

In general 81, 97, 273
Analyzer setup 94
Browsing through the reports 277
Button bar commands 82
Changing margins 300
Changing the font 304
Enlarging/decreasing preview image size 277
Fonts 85
From print dialog 97
Leaving 88, 277
Margins 74, 85
Moving to another page 277
Next page 83, 277
Number of report pages 83, 277
Page setup 85
Previous page 83, 277

Printing from 84, 97
Reviewing column selection 75
Reviewing font selection 73
Reviewing margin selections 74, 85
Reviewing page setup 69
Selecting reports to preview 275–277
Zoom 83
Zoom In/Out 277

Print to a file 284
Print to a Lotus file 94
Print to a spreadsheet file 92, 94, 282–283
Print to a text file 92
Print to an Adobe Acrobat file 92, 94
Print to an Excel file 94, 282
Printer

Default 97, 311
Effects on font selection 304
Fonts 304
Options 97, 280
Selecting 280
Setting fonts 304
Setup 280

Printer fonts
Default 73
Selecting 71, 85

Printer setup 97, 280
Options 97
Paper orientation 97
Paper size 97

Printer, default 97, 311
Printing 281

In general 89, 273
Adding borders to reports 295
Adding shading to reports 295
Analyzer setup 94
canceling 92
cancelling 94
Cases, see Printing Columns
Cents 306
Changing column widths 310
Client letter 89, 91, 289
Client name 292
Close button 98
Collate graph 91
Columns 74
Columns, all 289
Columns, specific 287
Completing the task 98
Copies, number of 91, 280
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Creating a spreadsheet file 92, 94
Excel 94
Lotus 1-2-3 94

Creating a text file 92
Creating an Adobe Acrobat file 92
creating an Adobe Acrobat file

Adobe Acrobat 94
Custom worksheets 70
Customizing printed reports 291
Customizing reports 77
Date on reports 78, 297
Deselect all worksheets 90
Dollar rounded amounts 306
Empty rows 303
Empty worksheets 71, 303
File name on report 302
Font selection 71, 85, 304
Footers 75, 292
Formatting reports 77
From print preview 84
Getting ready to print 273
Graph 91, 204
Headers/footers 75, 292
Index 302
Making parts of the report bold 296
Multiple report copies 91, 280
Multiple worksheets per page 71, 306
Notes 70, 303
Number of copies 91, 280
One worksheet per page 71, 306
Page numbers on reports 78, 298
Page setup 94
Paper orientation 97
Paper size 97
Previewing 81, 273
Print active worksheets 279
Print button 98
Print current worksheet 89, 279
Print selected worksheets 89, 279
Printer setup 97, 280
Printing to a spreadsheet file

Excel 84, 94, 282
File name extension 94
Lotus 1-2-3 84, 94, 283–284

Printing to a text file 84, 92–94, 281
File name extension 93

Printing to an Adobe Acrobat file 84, 94
File name extension 94

Printing to an Excel file 282

Report index 70
Report styles 77
Report table of contents 70
Security Transaction Analyzer 290, 306
Select graph 91
Selecting a printer 280
Selecting all active worksheets 90
Selecting current worksheet to print 90, 279
Selecting reports to print 285
Selecting supporting documents 91
Selecting the printer 97, 280
Selecting worksheets to preview 275
Selecting worksheets to print 90, 279, 285
Sending reports to a printer 92, 278
Setting fonts 85
Skip empty input rows 70, 303
Skip empty worksheets 71, 303
Specifying output destination 92
Table of Contents 302
1040-ES/1041-ES payment vouchers 290
Time on reports 78, 297
To a printer 84, 278
Underlines 70, 305
Use default header/footer if no other 

specified 71
Printing custom worksheets, see also Printing, 

Selecting worksheets
Printing reports 278
Printing to a file 84, 281
Printing to a printer 84, 92, 278
Printing to a text file 281
Program commands, see data entry
Program features 21

calculations
credits 23
itemized deductions 22
limitations and phaseouts 21
taxes 23

other features 26
present value computations 26

Program files 319
Protect columns command 105, 120

R
Repeat previous cell command 117
Replication feature

In general 130
Multiple cases 130, 134, 155
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Multiple years 130, 134–135
Reports

Adding borders 295
Adding shading 295
Changing margins 299
Changing the page style 294
Customizing 291
Customizing printed reports 92
Don’t print empty rows 70
Don’t print empty worksheets 71
Footers 75, 292
Formatting 77
Headers 75, 292
Index page 70, 302
Making parts of the report bold 296
Modifying page setup 291
Number of pages 83
One worksheet per page 71
Page numbers 83
page setup 49
Page setup, previewing, and printing 273
previewing print 49
Print custom worksheets 70
Print date 78, 297
Print filename 70
Print index 70
Print notes 70
Print page numbers 78
Print table of contents 70
Print time 78, 297
Print underlines 70
printing 49
Printing page numbers 298
Printing the filename 302
Printing to a file 84, 281
Printing to a printer 84
Skip input rows containing all zeros 70
Styles 77
Table of contents 70, 302
Use default header/footer if no other 

specified 71
Resident state specifications, accessing 262
Retrieving files from previous versions 31
Row

title on worksheets 38
types

access 20
calculated 20
entry 20

input 20
Row types, defined 20

S
Save as Default

Assumptions 157
Save as default

Auto backup interval 240
Calculation options 240
Custom screen colors 256
Fonts, printer 311
Footers 76, 309
Headers 76, 309
Margins 310
Page specifications 309
Preset screen colors 254
Printer 98, 311

Save desktop option 263
In general 240

Saving client letters 216
Saving files

Save client file as command 65
Save client file command 64

Screen colors
In general 251
in general 55
Changing

Active cell background 253
Active cell text 253
Calculated cell background 252
Calculated cell text 252
Calculated title background 253
Calculated title text 253
Cell grid lines 253
Cell underlines 253
Input cell background 252
Input cell text 252
Input title background 253
Input title text 253
Protected cell background 252
Protected cell text 252
Title grid lines 253

Screen font option 55, 240, 261
Screen, parts of 15
Scroll bar, defined 19
Scrolling

Multiple case calculation 134
Multiple years calculation 134
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Security information dialog 182
Security of client files 31
Security Transaction Analyzer

In general 180
see also Security Transactions
Annualization analysis 184
Delete command 185
Entering data on 181
Insert command 185
Multiple case analysis 184
Print command 186
Printing 290
Security information dialog 182
Setting up the report 306
View command 185
Worksheet 160, 180
worksheet 53

Select all command 112
Select worksheet command 38
Selecting worksheets

Changing the selection 286
Current worksheet, print 279
Deselecting specific worksheets 276
Overview 286
Saving the selection 287
Selecting all active 287
Selecting specific worksheets 276
Specific worksheets, printing 279
To print 90, 279
To view, Print preview 275

Self-employment tax
OASDI contribution base 247

Setting up page specifications
See Page setup, Printing

Shading
Customizing printed reports 295
Printing in reports 295

Shortcut keys
Ctrl+Tab to switch worksheets 166
Escape 165, 168
W to go to activity 173
W to go to subworksheet 164
W, Go to Subworksheet 39

Social security old age tax
OASDI contribution base 247

Sort client file names in list box 58
Spread annualization command 117
Spreadsheet file, creating 94, 282–284
Starting the program 14

State specifications files
Accessing 128, 156, 240, 262
accessing 55
Nonresident 157
Resident 156

State Tax Main Worksheet 141
Storage of data, see Client files, storing data
Styles

In general 77
Bold options 78
Frame options 77–78
Options 77
Preset styles 79–80
Print date 78
Print page numbers 78
Print time 78
Separator line 78
Shade options 78
Worksheet titles, larger 78

Subworksheets
In general 122
activated automatically 36
Killing 104, 122
killing 50
opening 39
using 36

Summary Report
accessing 53

Summary report
In general 176
Accessing 160
Worksheet 176

Supporting worksheets 14
System icon, defined 15

T
.txt files 94
Table of contents, reports 70, 302
Tax brackets, see Brackets
Taxable income

total prior three years taxable income, see Total 
prior three years taxable income

Taxpayer and Spouse, Analysis type 131
Templates

Creating from letters 226
Editing 228

Temporary file 241
1040-ES/1041-ES payment vouchers 189
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In general 189
Accessing 160
Copying to another application 109
Printing 290

Text 84
Text file, creating 281
Theft losses, see Casualty and theft losses
3D bar graph 202
Tile commands

in general 53, 160
Tile Horizontally 166
Tile Optimally 167
Tile Vertically 167

Tiling, see Worksheet operations
Title Bar 37
Title bar 37
Title bar, defined 15
Title command, Graph 207
Title of cases 128
Titles on graphs 195, 204
Toolbar 263
Toolbar option 240
Toolbar, defined 16
2D bar graph 202
Type command, Graph 207
Type of graph 195, 201

U
Underlines 305
Underlines, on printed reports 70
Underpayment penalty

see also Annualization
quarterly interest rate penalty, setting on Calcu-

lation Options 249–250
Underpayment penalty rate 250
Underpayment Penalty Rate, Calculation 

Options 249–250
see also Annualization

Undo last entry command
In general 106
Using with auto copy commands 106

Undo list command
In general 107

Updates
installing program updates 32

Using the help system 266
Using this manual 12

V
View filename option 240, 263
View tabs bottom option 263
View tabs top option 263
View toolbar option 263
View worksheet list left option 264
View worksheet list right option 264
View worksheets submenu 192
Viewing worksheets 192
Vouchers, estimated payment 189

W
W-4

Form 177
Worksheet 160, 177

Watch window 160
Windows Print Manager 97
Word processing file, creating 92, 281
Worksheet area, illustrated 252
Worksheet commands, see Commands
Worksheet list pane

In general 162
Close worksheet 163
Displaying 264
Help for list 164
Hiding the list 264
Kill worksheet 163
Open worksheet 162
Operations 162
Sort list 163

Worksheet list, defined 18
Worksheet operations

in general 13, 35, 52
access to subworksheets 14
accessing the nonpassive items 

worksheet 175
accessing the passive activity items 

worksheet 174
accessing the Summary report 176
activating 36
Active and inactive worksheets 123
active and inactive worksheets 122
active cell 38
active subworksheet indicator 38
arranging worksheet icons 53, 160, 167
batch Input worksheet 35
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batch input worksheets 35
built-in worksheet indicator 38
calculated row 38
cascade worksheets 53, 160, 166
changing a row with an active worksheet 40
changing information, ripple effect 13
close on escape 168
closing all subworksheets 192
column heading 38

case title 37
Year 37
year 37

Creating a custom color set 256
cursor movement 40
Custom worksheets 41, 164
custom worksheets 14, 35
data entry 35
data entry row 38
Definition

Active worksheet 162
Closed worksheet 162
Inactive worksheet 162
Open worksheet 162

definition
active worksheet 36

Deleting cases 136
Displaying the worksheet list pane 160
entering numeric data 40
erasing 49
Erasing worksheets 99
individual activities 14
input row 37
Killing custom worksheets 44
Killing subworksheets 48, 122
Leave open on escape 168
List of open and active worksheets 160
list of open and active worksheets 54
Main Worksheet, in general 13
Minimize on escape 168
Moving between worksheets 166
Multiple cases calculation 129
Multiple years calculation 129
Opening a subworksheet 164
opening a subworksheet 39
opening through Select Worksheet 

command 39
Renaming a file 61
row title 37–38
scroll bar 38

Selecting a worksheet 160
selecting a worksheet 38
selecting entire 50
subworksheets 14, 35–36
supporting worksheets 14
Switching worksheets 166
Tile Horizontally
title bar 37
types of worksheets 35
Use same window 169
use same window 160
Using custom worksheets as templates 45
Using the list to bring open worksheet to the 

top 193
Viewing worksheets 192
Zapping custom worksheets 48, 123

Worksheet range 89
Worksheet row numbers, defined 18
Worksheet tables, defined 19
Worksheet tabs

In general 240
Worksheets 91

1040-ES/1041-ES Payment Vouchers 53
In general 122, 164, 192
Alternative Capital Gains Tax 53, 160, 180
As windows 160
Batch Input 53
Batch input 169
Close or minimize 160
Color of title bar 165
Color sample 256
Erase worksheet data 100–101
Erasing 99
Escape command 165, 168
Individual Activities 53
Individual activities

Entering data 171
Nonpassive, in general 171
Passive, in general 171

Nonpassive items 175
Open all federal 192
Open all New York nonresident state 193
Open all nonresident state 193
Open all resident state 193
Passive activity item 174
Present Value 53
Present value 160
Previewing 81, 273
Printing
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Graph 91
Selecting all active worksheets 90

scroll bar 38
Security Transaction Analyzer 53, 160, 180
Selecting cells 104
Selecting to print 89
Set up Security Transaction Analyzer page for 

printing 94
Summary Report 53
Summary report 176
Summary report for nonpassive items 175
1040-ES/1041-ES payment vouchers 189
Title Bar 37
View all federal 192
View all New York nonresident state 193
View all nonresident state 193
View all resident state 193
W-4 53, 160, 177
Zapping custom worksheets 101

Worksheets menu
1040-ES/1041-ES payment vouchers 160
4868 Extension 160
Alternative Capital Gains Tax 160, 180
Batch Input 160
Hide worksheet list 160
Individual activities 160

Nonpassive items 175
Passive activity items 174

List of open worksheets 193
Overview 52, 159
Present value worksheet 160
Security Transaction Analyzer 160
Security transaction analyzer 180
Select Worksheet 39
Select Worksheet command 21
Show worksheet list 160
Summary report 160, 176
1040-ES/1041-ES payment vouchers 189
View worksheets

Federal 192
New York nonresident state 193
Other nonresident state 193
Resident state 193

W-4 Form 53, 177
W-4 Worksheet 53, 160, 177
Watch window 160

Y
Years, In general 128
Years, in general 128
Years analysis

in general 128
Access and operation 129
beginning year 136
Changing beginning year 137

Years within Cases
analysis type 128

Z
Zapping custom worksheets 45, 48, 50, 104, 123
Zoom

In general 83, 277
Zoom in illustrated 83
Zoom out illustrated 82



This page is intentionally left blank.


	Income Tax Planner™ Operations Guide
	Copyright
	Contents

	1 Introduction
	About this Guide
	Customer Support
	Conventions Used in this Guide
	Keyboard
	Mouse Pointers

	Getting to Know the Program
	Introduction to Income Tax Planner
	Opening the Program
	Parts of the Screen
	Program Calculations and Features
	Bridging Tax Data from Other Programs
	Assumptions
	Loading Files from Previous Versions
	Opening a Client File
	Installing Program Updates


	2 Worksheets & Menus
	Overview of Worksheets
	Types of Worksheets
	Types of Rows
	What is an Active Worksheet?
	When to Use Subworksheets
	Why Are Some Worksheets Activated Automatically?
	Use Subworksheets for Best Results
	Which Worksheets Do I Need?
	Parts of a Worksheet
	Selecting a Worksheet
	Numeric Data Entry and Cursor Movement
	Changing Information on a Worksheet
	Custom Worksheets

	Overview of Menus
	File Menu
	Edit Menu
	Assumptions Dialog
	Worksheets Menu
	Graph
	Client Letter
	Options Menu
	Help Menu


	3 File Menu
	Overview
	New Client File
	Open Client File
	Closing a Client File
	Loading Client Files Linked to Other Applications
	Common Options and Buttons

	Merge Client File
	Custom worksheets
	Individual Activities & Securities
	Merge Conflicts & Merge Conflict Log

	Save Client File
	Save vs. Auto Backup

	Save Client File As
	Saving Linked Client Files under a Different Name

	New Client Letter
	Open Letter Template
	Save Letter Template As
	Default Letter Template

	Page Setup
	Print
	Don’t Print
	One Worksheet per Page
	Use Default Header/Footer if No Other Header/Footer
	Font
	Margins
	Columns
	Header/Footer
	Style

	Print Preview
	Hide/Show List
	Next
	Previous
	Zoom In/Out
	Print
	Print Page
	Setup
	Font
	Margins
	Close

	Print
	Worksheet Range
	Copies
	Print To
	Setup
	Analyzer Setup
	Preview
	Printer

	Send To
	Sending an Analysis as an IT Attachment
	Sending an Analysis as a PDF Attachment

	Erase Worksheets
	Erase Worksheet Data
	Erase Worksheet Data and Zap Custom Worksheets

	Previously Loaded Client Files
	Exit

	4 Edit Menu
	Overview
	Edit Menu Commands
	Cell Commands
	Worksheet Commands
	Custom Worksheet Commands
	Graph Commands
	Client Letter Commands
	Note command (Edit menu)


	5 Assumptions
	Overview
	Assumptions Items
	Client Name
	Cases and Years
	Client Address
	Multi Nonresident Analysis
	Annualization Analysis
	Annualization Overview
	Minor Child Analysis
	Resident State
	Nonresident State


	6 Worksheets Menu
	Menu Commands
	Show/Hide Worksheet List
	Using the Worksheet List
	Worksheet List Commands

	Go to Subworksheet
	Arranging the Program Workspace
	The Default Worksheet Arrangement
	Cascade
	Tile Horizontally
	Tile Vertically
	Tile Optimally
	Arrange Icons

	Escape Commands
	Leave Open On Escape — Default
	Close On Escape
	Minimize On Escape

	Use Same Window
	Specialized Worksheets
	Batch Input
	Individual Activities (Passive and Nonpassive Items)
	Summary Report
	Present Value
	W-4
	Alternative Capital Gains Tax
	Security Transaction Analyzer Worksheet
	Watch Window
	4868 Extension
	1040-ES and 1041-ES Payment Vouchers

	Close All Subworksheets
	View Worksheets
	Federal Worksheets
	Resident State Worksheets
	New York Nonresident Worksheets
	Other Nonresident State Worksheets

	List of Open Worksheets

	7 Graph
	Overview
	Graph Items
	Graph Window
	Graph Data Dialog
	Graph Selection Considerations
	Type
	Titles

	Graph Operations
	Printing Graphs
	Copying Graphs

	Graph Edit Menu for Row Titles
	Copy
	Data
	Type
	Titles


	8 Client Letter
	Overview
	Client Letters: Types and Uses
	Templates
	Tools

	Client Letter Items
	Sample Client Letter
	Using a Client Letter as a Template
	Starting a New Client Letter
	Client File Does Not Have a Letter
	Client File Contains a Letter

	Saving a Client Letter
	Working Within the Client Letter
	Bringing Data from the Client File into a Letter
	Adding Headers and Footers
	Adding Date, Time, and Page Number
	Forcing a Page Break
	Deleting Text or Fields
	Deleting a Case with a Link to a Client Letter
	Text Alignment and Layout
	Adding Space Between Lines
	Aligning Text
	Aligning Linked Data
	Setting the Margins and Indents of the Letter
	Showing Paragraph Markers

	Saving a Letter as a Template
	Saving a Template as the Default
	Opening an Existing Client Letter
	Opening an Existing Letter Template
	Editing a Letter Template
	Adding a Letter to a Client File from a Template
	Deleting a Client Letter

	Printing a Client Letter
	Using the Edit Menu for the Client Letter

	9 Options Menu
	Overview
	Save as Default

	Auto Backup
	What is Auto Backup?
	Save or Auto Backup?
	How the Auto Backup File is Used
	Changing the Auto Backup Interval
	Turning Auto Backup On and Off

	Calculation Options Dialog
	Inflation Adjustments
	Colors
	Worksheet Area
	Preset Colors
	Underlines
	Gradient Background
	Row Height
	Color Palette
	Sample Worksheet
	Applying Changes
	Creating a Custom Color Set

	Default Directory
	Network Administrative Options
	Deactivate Workstation
	Link Options
	Timeout
	Save linked file to same directory as IT file

	Password Protect
	Screen Font
	Resident State Specifications
	Nonresident State Specifications
	Calculations On
	Save Desktop
	View Filename
	View Toolbar
	View Tabs Top/Bottom
	View Worksheet List Left/Right
	View Worksheet Row Numbers

	10 Help Menu
	Overview
	Using the Help System
	Using the Help Commands
	A Sample Search for Help
	Help Menu Bar and Commands


	11 Printing
	Overview
	How to Preview Reports
	Using the File Menu’s Print Preview Command
	Using the Print Dialog’s Preview Button
	Selecting Worksheets to Preview
	Browsing through the Preview Reports
	Taking a Closer Look: Zoom In/Out
	Leaving the Preview Window

	How to Send Reports to a Printer
	Accessing the Print Dialog
	Selecting Multiple Copies
	Selecting a Different Printer

	How to Create Output Files from Report Data
	Creating a Text File that You Can Edit
	Creating an Excel File
	Creating a Lotus 1-2-3 File
	Creating an Adobe Acrobat File

	Selecting What to Print
	Printing Specific Reports
	Printing Specific Columns of the Analysis
	Printing All Columns within the Analysis
	Printing or Previewing the Client Letter and Graph
	Printing 1040–ES/1041–ES Payment Vouchers
	Printing the Security Transaction Analyzer

	How to Customize the Printed Reports
	Including the Client’s Name on the Report
	Including Headers or Footers
	Adding the Default Headers/Footers to Bridge Files
	Changing the Page Style
	Changing the Report Margins
	Printing the File Name on the Report
	Including a Table or Index with the Printed Reports
	Including Notes with Printed Reports
	Excluding Empty Rows or Worksheets from Reports
	Selecting a Font for the Printed Reports
	Including Total and Subtotal Lines on the Reports
	Printing Multiple Reports or One Report per Page
	Including Cents or Printing Dollar-Rounded Amounts
	Customizing the Security Transaction Analyzer Results

	Print Defaults
	Headers and Footers
	Page Specifications
	Margins
	Column Widths
	Fonts
	Printer


	Appendix A Keyboard Shortcuts
	Appendix B Program Files
	Index

